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CHAPTER1

Préambule

1.1 Avant-propos

Bienvenue dans notre cours! Nous allons vous montrer comment utiliser facilement et efficacement QGIS. Si vous
êtes nouveaux utilisateurs de SIG, nous vous dirons ce que vous avez besoin de savoir pour commencer. Si vous êtes
un utilisateur expérimenté, vous verrez combien QGIS remplit toutes les fonctions que vous attendez d’un programme
SIG, et plus encore!

1.1.1 Pourquoi QGIS?

L’information étant de plus en plus sensible à l’espace, les outils capables de remplir certaines ou toutes les fonctions
SIG couramment utilisées ne manquent pas. Pourquoi utiliser QGIS plutôt qu’un autre logiciel SIG ?
Voici quelques unes des raisons :

• Rien ne vaut un repas gratuit. Installer et utiliser le programme QGIS ne vous coûte pas d’argent. Pas de frais
initiaux, pas de frais récurrents, rien.

• C’est libre! Si vous avez besoin d’une fonctionnalité dans QGIS, vous pouvez faire plus que seulement
espérer que celle-ci soit incluse dans la prochaine version. Vous pouvez sponsoriser le développement d’une
fonctionnalité ou l’ajouter vous-même si vous êtes familier avec la programmation.

• C’est en développement constant. Parce que chacun peut ajouter de nouvelles fonctionnalités et améliorer les
existantes, QGIS ne stagne jamais. Le développement d’un nouvel outil peut se dérouler aussi rapidement que
nécessaire.

• Aide et documentation approfondies sont disponibles. Si vous êtes bloqués, vous pouvez vous tourner vers la
documentation approfondie, vos camarades utilisateurs QGIS, ou encore les développeurs.

• Multiplatforme. QGIS peut être installé sur macOS, Windows et Linux.
Maintenant que vous savez pourquoi utiliser QGIS, les exercices suivants vous apprendront comment.
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1.1.2 Préparation

En 2008, nous avons lancé Une rapide introduction aux SIG, une ressource complètement libre et ouverte pour les
personnes désirant apprendre à utiliser des SIG sans être surchargées par le jargon et la terminologie. Ce travail a été
sponsorisé par le gouvernement Sud-Africain et a été un succès phénoménal car des personnes de toute la terre nous
ont écrit pour nous décrire comment elles avaient utilisé ce travail pour réaliser des formations universitaires, pour
apprendre les SIG par eux-mêmes, etc. L’introduction rapide n’est pas un tutoriel de logiciel mais plutôt un texte
générique (bien que des exemples sous QGIS soient montrés) permettant de comprendre les SIG. Il existe également
le Manuel QGIS qui fournit un aperçu détaillé des fonctionnalités de l’application QGIS. Néanmoins, il n’est pas
structuré sous forme de tutoriel mais plus comme un guide de référence. A Linfiniti Consulting CC., nous organisons
fréquement des formations et nous avons réalisé qu’il manquait une troisième ressource, une qui permettrait de guider
séquentiellement le lecteur à travers l’apprentissage des aspects clefs de QGIS sous forme d’un échange formateur-
élève. Nous avons alors produit ce document.
Ce manuel d’exercices est prévu pour permettre de conduire une formation de 5 jours sur QGIS, PostgreSQL et
PostGIS. La formation est structurée pour s’adapter aux utilisateurs novices, intermédiaires et avancés et elle dispose
de plusieurs exercices complets avec des réponses annotées tout au long du texte.

1.1.3 Licence

Le manuel de formation QGIS est gratuit de Linfiniti Consulting CC. est basé sur une version antérieure de Linfiniti
et est sous licence Creative Commons Attribution 4.0 International. Des autorisations au-delà de la portée de cette
licence peuvent être disponibles à l’adresse ci-dessous.
Nous avons publié ce manuel d’exercice QGIS sous une licence libre pour vous permettre de le copier, de le modifier
et de le redistribuer librement. Une copie complète de la licence est disponible à la fin de ce document. En termes
simples, les recommandations d’utilisation sont les suivantes:

• Vous ne pouvez pas déclarer que cette œuvre est la votre ou supprimer le texte sur les auteurs de cette oeuvre.
• Vous ne pouvez pas redistribuer cette oeuvre sous des permissions plus restrictives que celles qui vous ont été
attribuées.

• Si vous ajoutez une portion significative à cette œuvre et que vous livrez votre contribution en retour au projet
(au moins un module complet), vous pouvez ajouter votre nom à la fin de la liste des auteurs de ce document
(qui apparaît en page de garde).

• Si vous avez effectué des changements mineurs ou des corrections, vous pouvez vous ajouter à la liste des
contributeurs ci-dessous.

• Si vous traduisez le document en entier, vous pouvez ajouter votre nom à la liste des auteurs sous la forme
« Translated by Joe Bloggs ».

• Si vous financez un module ou une leçon, vous pouvez demander à l’auteur d’inclure une note au début de
chaque leçon financée, par exemple:

Note: Ce cours a été sponsorisé par MegaCorp.

• Si vous n’êtes pas certain de ce que vous pouvez faire sous cette licence, merci de nous contacter à l’adresse
office@linfiniti.com et nous vous donnerons des conseils sur l’acceptabilité de vos intentions.

• Si vous souhaiter publier ce travail sous un site d’hébergement autonome comme https://www.lulu.com nous
demandons que vous transmettiez les profits au projet QGIS.

• Vous ne pouvez pas commercialiser cette œuvre sans la permission expresse des auteurs. Pour être clair, par
commercialisation, nous entendons que vous ne pouvez pas la revendre pour le profit, pour créer un travail dérivé
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commercial (ex: vendre le contenu pour l’inclure dans des articles de magazines). L’exception à cette règle
consiste à reverser tous les profits au projet QGIS. Vous pouvez (et nous vous encourageons à le faire) utiliser
cette œuvre comme un livre pour gérer votre formation même si cette formation est de nature commerciale.
En d’autres termes, vous pouvez vous rémunérer en réalisant une formation basée sur cette œuvre mais vous
ne pouvez pas réaliser de profits en vendant le livre en lui-même, de tels profits devant être reversés au projet
QGIS.

1.1.4 Sponsoriser des chapitres

Cette oeuvre ne prétend pas être une référence complète de toutes les choses que vous pouvez accomplir avec QGIS
et nous vous encourageons à ajouter de nouveaux éléments pour combler les vides. Linfiniti Consulting CC. peut
également créer du contenu pour vous sur la base d’un service commercial avec le fait que tout le travail produit
devriendra partie de l’oeuvre et sera publié sous la même licence.

1.1.5 Auteurs

• Rüdiger Thiede - Rudi a rédigé des éléments sur QGIS et des parties sur PostGIS.
• Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts.

• Horst Düster (horst.duester@kappasys.ch ) - Horst a co-produit les parties sur PostgreSQL et PostGIS.
• Marcelle Sutton - Marcelle a réalisé la relecture et donné des conseils éditoriaux lors de la création de cette
œuvre.

1.1.6 Contributeurs individuels

Votre nom ici!

1.1.7 Sponsors

• Cape Peninsula University of Technology

1.1.8 Fichiers sources et signalement de bugs

La source de ce document est disponible sur GitHub, dans le dépôt QGIS-Documentation. Consultez GitHub.com
pour les instructions d’utilisation du système de contrôle de versionnement git.
Malgré nos efforts, vous pourriez trouver certaines erreurs ou informations manquantes en suivant ce manuel. Nous
vous remercions de bien vouloir les signaler à https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Dernière version

Vous pouvez toujours obtenir la dernière version de ce document en visitant la version en ligne qui fait partie du site
de documentation du QGIS (https://www.qgis.org/resources/hub/#documentation).

Note: Le site web de documentation contient des liens vers les versions en ligne et PDF du manuel de formation et
d’autres parties de la documentation QGIS.
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1.2 A propos des exercices

Maintenant que vous savez pourquoi utiliser QGIS, nous allons vous montrer comment le faire.

Avertissement: Ce manuel d’exercices, ce cours comprend des instructions sur l’ajout, la suppression et la
modification des jeux de données SIG. Nous avons fourni des ensembles de données de formation à cet effet. Avant
d’utiliser les techniques décrites ici sur vos propres données, assurez vous toujours de disposer des sauvegardes
appropriées !

1.2.1 Comment utiliser ce tutoriel ?

Le texte qui ressemble à ça se réfère à quelque chose que vous pouvez voir dans l’interface de QGIS.
Le texte qui ressemble ► à ► ça pointe sur un menu.
Ce type de texte se réfère à quelque chose que vous devez taper, comme une commande.
Ce/type/de.texte se réfère à un chemin ou un nom de fichier.
Ceci+Cela se réfère à un raccourci clavier composé de deux touches.

1.2.2 Objectifs du cours à plusieurs niveaux

Ce cours s’adresse à différents niveaux d’expérience des utilisateurs. En fonction de la catégorie dans laquelle vous
vous considérez, vous pouvez vous attendre à des résultats différents. Chaque catégorie contient des informations qui
sont essentielles pour la suivante, il est donc important de faire tous les exercices qui sont à votre niveau d’expérience
ou en dessous.

��� (Niveau basique) Basique

Dans cette catégorie, le cours suppose que vous avez peu ou pas d’expérience préalable en matière de connaissances
théoriques sur les SIG ou de fonctionnement des logiciels SIG.
Une formation théorique limitée sera fournie pour expliquer le but d’une action que vous effectuerez dans le cadre du
programme, mais l’accent est mis sur l’apprentissage par la pratique.
À l’issue du cours, vous aurez une meilleure idée des possibilités des SIG et de la manière d’exploiter leur puissance
via s QGIS.

��� (Niveau intermédiaire) Intermédiaire

Dans cette catégorie, il est supposé que vous avez une connaissance et une expérience pratique des utilisations
quotidiennes des logiciels SIG.
Les instructions pour le niveau débutant vous permettront de vous familiariser avec le terrain, et vous feront prendre
conscience des cas où QGIS fait les choses un peu différemment des autres logiciels auxquels vous êtes habitués. Vous
apprendrez également comment utiliser les fonctions d’analyse dans QGIS.
En suivant ce cours, vous aurez une bonne maîtrise des fonctionnalités usuelles de QGIS.
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��� (Niveau avancé) Avancé

Dans cette catégorie, on suppose que vous avez une expérience des logiciels SIG, une connaissance et une expérience
des bases de données spatiales, de l’utilisation des données sur un serveur distant, peut-être de l’écriture de scripts à
des fins d’analyse, etc.
Les instructions des deux autres niveaux vous familiariseront avec l’approche suivie par l’interface QGIS et vous
permettront de savoir comment accéder aux fonctions de base dont vous avez besoin. On vous montrera également
comment utiliser le système de plugin QGIS, l’accès aux bases de données, etc.
À l’issue du cours, vous devriez être bien familiarisé avec le fonctionnement quotidien du logiciel QGIS, ainsi qu’avec
ses fonctions plus avancées.

1.2.3 Données

Les données qui accompagnent ce manuel sont disponibles librement et proviennent des sources suivantes :
• Streets and Places datasets from OpenStreetMap
• Property boundaries (urban and rural), water bodies from NGI
• SRTM DEM from the CGIAR CSI

Téléchargez l’ensemble de données préparé à partir du Training data repository et décompressez le fichier. Toutes
les données nécessaires sont fournies dans le dossier exercise_data.
Si vous êtes un instructeur et que vous souhaitez utiliser des données plus pertinentes, vous trouverez des instructions
pour créer des données locales dans l’annexe Préparation des données d’exercice.
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CHAPTER2

Module : Création et exploration d’une carte de base

Dans ce module, vous allez créer une carte de base qui servira plus tard de support aux démonstrations des
fonctionnalités de QGIS.

2.1 Leçon : Un Aperçu de l’Interface

Nous allons explorer l’interface utilisateur de QGIS afin de vous familiariser avec les menus, les barres d’outils, le
canevas de carte et la liste des couches, ces éléments formant la structure de base de l’interface.
Le but de cette leçon: Comprendre les notions de base de l’interface de QGIS.
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2.1.1 ��� Essayez vous-même : Les basiques

Les éléments identifiés sur la figure ci-dessous sont:
1. Liste de couches / Panneau Explorateur
2. Barres d’outils
3. Canevas de carte
4. Barre d’état
5. Barre d’outils latérale
6. Barre de localisation

��� The Layers List

Dans la liste des couches, vous pouvez voir à tout moment toutes les couches qui sont disponibles dans le projet.
Dérouler les boutons à plusieurs options (en cliquant sur la petite flèche juste à côté du bouton) vous donnera les
différentes fonctions de ses options.
En survolant la couche, vous obtiendrez quelques informations de base : nom de la couche, type de géométrie, système
de référence des coordonnées et le chemin complet de l’emplacement sur votre appareil.
Cliquer sur la couche avec le bouton droit affichera un menu avec plein d’options. Durant ce cours, vous en utiliserez
certaines, alors restez attentifs !

Note: Une couche vecteur est un jeu de données, généralement d’un seul type d’objets, comme des routes, arbres,
etc. Une couche vectorielle peut contenir soit des points, soit des lignes ou des polygones.

10 Chapter 2. Module : Création et exploration d’une carte de base
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��� The Browser Panel

L’Explorateur de QGIS est un panneau qui permet de naviguer aisément dans votre base de données. Vous pouvez
accéder aux fichiers vectoriels courants (shapefiles ESRI, fichiersMapInfo…), aux bases de données (PostGIS, Oracle,
SpatiaLite, GeoPackage, MS SQL Server…) et aux connections WMS/WFS. Vous pouvez aussi voir les données
GRASS.
Si vous avez enregistré un projet, le panneau du navigateur vous donnera également un accès rapide à toutes les
couches stockées dans le même chemin d’accès au fichier de projet dans le Project Home.
De plus, vous pouvez définir un ou plusieurs dossiers comme Favoris: recherchez sous votre chemin et une fois que
vous avez trouvé le dossier, faites un clic droit dessus et cliquez sur Ajouter comme favori. Vous devriez alors
pouvoir voir votre dossier dans les Favoris.

Astuce: Il peut arriver que les dossiers ajoutés à l’élément favori aient un nom très long: ne vous inquiétez pas, faites
un clic droit sur le chemin et choisissez Renommer favori ... pour définir un autre nom.

��� Toolbars

Les groupes d’outils que vous utilisez le plus peuvent être présents sous forme de barre d’outils pour un accès facilité.
Par exemple, la barre d’outils Projet vous permet de sauvegarder, charger, imprimer, et démarrer un nouveau projet.
Vous pouvez facilement personnaliser l’interface pour n’afficher que les outils que vous utilisez le plus, en ajoutant ou
retirant des barres d’outils via le menu Vue ► Barres d’outils.
Même s’ils ne sont pas visibles dans les barres d’outils, tous vos outils sont accessibles via les menus. Par exemple, si
vous supprimez la barre d’outils Projet (qui contient le bouton Enregistrer le projet), vous pouvez toujours sauvegarder
votre carte en cliquant sur le menu Projet puis sur Enregistrer.

��� The Map Canvas

C’est là que la carte elle-même est affichée et où les couches sont chargées. Dans le canevas de carte, vous pouvez
interagir avec les couches visibles: zoom avant / arrière, déplacer la carte, sélectionner des entités et de nombreuses
autres opérations que nous verrons dans les sections suivantes.

��� The Status Bar

Affiche des informations sur la carte actuelle. Vous permet également d’ajuster l’échelle de la carte, la rotation de la
carte et de voir les coordonnées du curseur de la souris sur la carte.

��� The Side Toolbar

Par défaut, la barre d’outils latérale contient les boutons pour charger les couches et tous les boutons pour créer une
nouvelle couche. Mais n’oubliez pas que vous pouvez déplacer toutes les barres d’outils là où cela vous convient le
mieux.

2.1. Leçon : Un Aperçu de l’Interface 11
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��� The Locator Bar

Dans cette barre, vous pouvez accéder à presque tous les objets de QGIS: couches, entités de couches, algorithmes,
signets spatiaux, etc. Vérifiez toutes les différentes options dans la section locator_options du manuel de l’utilisateur
de QGIS.

Astuce: Avec le raccourci Ctrl + K vous pouvez facilement accéder à la barre.

2.1.2 ��� Essayez vous-même : 1

Essayez d’identifier les quatre éléments listés ci-dessus sur votre écran, sans vous référer au diagramme ci-dessus.
Voyez si vous pouvez retrouver leurs noms et fonctions. Vous vous familiarisez avec ces éléments au fur et à mesure
que vous les utiliserez.

Réponse
En vous référant à l’image montrant la disposition de l’interface, vérifiez que vous vous souvenez du nom et de la
fonction des éléments de l’écran.

2.1.3 ��� Essayez vous-même : 2

Essayez de retrouver chacun de ces outils dans votre interface. A quoi servent-ils?

1.

2.

3.

4. Rendu

5.

Note: Si un de ces outils n’est pas visible à l’écran, essayez d’activer certaines barres d’outils qui sont actuellement
cachées. Gardez à l’esprit que s’il n’y a pas assez d’espace sur l’écran, une barre d’outils peut être raccourcie, masquant
certains de ses outils. Vous pouvez voir les outils cachés en cliquant sur le bouton double flèche à droite de toute barre
d’outils repliée. Vous pouvez voir une info-bulle avec le nom de n’importe quel outil en maintenant votre souris sur
l’outil pendant un certain temps.

Réponse
1. Enregistrer sous
2. Zoom sur couche(s)

3. Inverse sélection
4. Rendu on/off
5. Mesure ligne
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2.1.4 La suite ?

Maintenant que vous êtes familiarisé avec les bases de l’interfaceQGIS, nous verrons dans la prochaine leçon comment
charger certains types de données courants.

2.2 Leçon : Ajout de vos premières couches

Nous allons lancer l’application, et créer une carte de base à utiliser pour les exemples et les exercices.
Objectif de cette leçon: Démarrer avec une carte d’exemple.

Note: Avant de commencer cet exercice, QGIS doit être installé sur votre ordinateur. De plus, vous devriez avoir
téléchargé le jeu de données à utiliser.

Lancez QGIS à partir de son raccourci sur le bureau, depuis le menu, etc., selon la façon dont vous avez configuré
son installation.

Note: Les captures d’écran de ce cours ont été prises dans QGIS 3.4 sous Linux. Selon votre configuration, les
écrans que vous rencontrerez peuvent sembler quelque peu différents. Cependant, tous les mêmes boutons seront
toujours disponibles et les instructions fonctionneront sur n’importe quel système d’exploitation. Vous aurez besoin
de QGIS 3.4 (la dernière version au moment de la rédaction) pour utiliser ce cours.

Commençons dès maintenant !

2.2.1 ��� Pas à pas : Préparer une carte

1. Ouvrez QGIS. Vous aurez une carte vierge.

2.2. Leçon : Ajout de vos premières couches 13
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2. La boîte de dialogueGestionnaire de source de donnees vous permet de choisir les données à charger en fonction
du type de données. Nous allons l’utiliser pour charger notre jeu de données: cliquez sur le bouton
Open Data Source Manager.
Si vous ne trouvez pas l’icône, vérifiez que la barre d’outils Gestionnaire des sources de données est activée dans
le menu Vue ► Barres d’outils.

3. Chargez le fichier protected_areas.shp:
1. Cliquez sur l’onglet Vecteur.

2. Activez le type de source Fichier.
3. Appuyez sur le bouton… à côté de Ensemble (s) de données vecteur.
4. Sélectionnez le fichier exercise_data/shapefile/protected_areas.shp dans votre

répertoire d’entraînement.
5. Cliquez sur Ouvrir. Vous verrez la boîte de dialogue source, avec le chemin du fichier rempli.
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6. Cliquez sur Ajouter ici aussi. Les données que vous avez spécifiées vont maintenant se charger: vous
pouvez voir un élément protected_areas dans le panneau couches (en bas à gauche) avec ses entités
affichées dans le canevas de la carte principale.

2.2. Leçon : Ajout de vos premières couches 15
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Félicitations ! Vous avez désormais une carte de base. Il est maintenant temps de sauver votre travail.

1. Cliquez sur le bouton Sauvegarder sous :
2. Enregistrez la carte dans un dossier solution à côté de exercise_data et appelez-le basic_map.

qgz.

2.2.2 ��� Essayez vous-même

Répétez les étapes ci-dessus pour ajouter les couches places.shp et rivers.shp du même dossier
(exercise_data/shapefi) à la carte.

Answer
Dans la partie principale de la fenêtre, vous devriez voir plusieurs formes avec des couleurs différentes. Chaque
forme appartient à une couche que vous pouvez identifier par sa couleur dans le panneau de gauche (vos couleurs sont
peut-être différentes de celles de Fig. 2.1 ci-dessous) :

Figure2.1: Une carte basique

2.2.3 ��� Pas à pas : Charger des données vectorielles depuis une base de
données GeoPackage

Les bases de données vous permettent de stocker un grand volume de données combinées dans un seul fichier. Vous
êtes peut-être déjà familiarisé avec un système de gestion de base de données (SGBD) tel que Libreoffice Base ou
MS Access. Les applications SIG peuvent également utiliser des bases de données. Les SGBD spécifiques aux SIG
(tels que PostGIS) ont des fonctions supplémentaires, car ils doivent traiter des données spatiales.
Le format ouvert GeoPackage est un conteneur qui vous permet de stocker des données SIG (couches) dans un seul
fichier. Contrairement au format ESRI Shapefile (par exemple le jeu de données protected_areas.shp que
vous avez chargé précédemment), un seul fichier GeoPackage peut contenir diverses données (tant vectorielles que
matricielles) dans différents systèmes de référence de coordonnées, ainsi que des tableaux sans information spatiale ;
toutes ces fonctionnalités vous permettent de partager facilement les données et d’éviter la duplication des fichiers.
Pour charger une couche à partir d’un GeoPackage, vous devez d’abord créer la connexion avec celui-ci :
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1. Cliquez sur le bouton Gestionnaire des sources de données.

2. Cliquez à gauche sur l’onglet GeoPackage.
3. Cliquez sur le bouton Nouveau et naviguez jusqu’au fichier training_data.gpkg dans le dossier

exercise_data que vous avez téléchargé précédemment.
4. Sélectionnez le fichier et appuyez surOuvrir. Le chemin du fichier est maintenant ajouté à la liste des connexions

Geopackage, et apparaît dans le menu déroulant.
Vous êtes maintenant prêt à ajouter n’importe quelle couche de ce GeoPackage à QGIS.

1. Cliquez sur le bouton Connecter. Dans la partie centrale de la fenêtre, vous devriez maintenant voir la liste de
toutes les couches contenues dans le fichier GeoPackage.

2. Sélectionnez la couche roads et cliquez sur le bouton ajouter.

Une couche roads est ajoutée au panneau couches avec les entités affichées sur le canevas de la carte.
3. Cliquez sur Fermer.

Félicitations ! Vous avez chargé la première couche d’un GeoPackage.

2.2.4 ��� Pas à pas : Charger des données vectorielles depuis une base de
données SpatiaLite à l’aide de l’explorateur

QGIS donne accès à de nombreux autres formats de base de données. Comme GeoPackage, le format de base de
données SpatiaLite est une extension de la bibliothèque SQLite. Et l’ajout d’une couche provenant d’un provider
SpatiaLite suit les mêmes règles que celles décrites ci-dessus : Créer la connexion –> L’activer –> Ajouter la ou les
couches.
Bien que ce soit une façon d’ajouter des données SpatiaLite à votre carte, explorons une autre façon puissante d’ajouter
des données : le Navigateur.

1. Cliquez sur l’icône pour ouvrir la fenêtre gestionnaire sources de données.

2.2. Leçon : Ajout de vos premières couches 17
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2. Cliquez sur l’onglet du Navigateur.
3. Dans cet onglet, vous pouvez voir tous les disques de stockage connectés à votre ordinateur ainsi que les entrées

pour la plupart des onglets à gauche. Ceux-ci permettent un accès rapide aux bases de données ou aux dossiers
connectés.

Par exemple, cliquez sur l’icône déroulante à côté de l’entrée GeoPackage. Vous verrez le fichier
training-data.gpkg auquel nous nous sommes précédemment connectés (et ses couches, si elles sont
développées).

4. Faites un clic droit sur l’entrée SpatiaLite et sélectionnez Nouvelle Connexion….
5. Naviguez vers le dossier exercise_data, sélectionnez le fichier landuse.sqlite et cliquez surOuvrir.

Notez qu’une entrée landuse.sqlite a été ajoutée sous celle de SpatiaLite.

6. Développez l’entrée landuse.sqlite.

7. Double-cliquez sur la couche landuse ou sélectionnez-la et faites-la glisser sur le canevas de la carte. Une
nouvelle couche est ajoutée au panneau couches et ses entités sont affichées sur le canevas de la carte.

Astuce: Activez le panneau navigateur dans le menu Vue ► Panneaux ► et utilisez-le pour ajouter vos données.
C’est un raccourci pratique pour l’onglet gestionnaire source de donnees ► navigateur, avec la même fonctionnalité.

Note: N’oubliez pas de sauvegarder votre projet fréquemment ! Le fichier de projet ne contient aucune donnée en
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soi, mais il se souvient des couches que vous avez chargées dans votre carte.

2.2.5 ��� Essayez vous-même : Charger plus de données vectorielles

Chargez les ensembles de données suivants du dossier exercise_data dans votre carte en utilisant l’une des
méthodes expliquées ci-dessus :

• buildings

• water

Answer
Votre carte devrait avoir sept couches :

• protected_areas

• places

• rivers

• roads

• landuse

• buildings (pris dans training_data.gpkg) et
• water (pris dans exercise_data/shapefile).

2.2.6 ��� Pas à pas : Réorganisation des couches

Les calques dans votre liste de calques sont dessinés sur la carte dans un certain ordre. Le calque en bas de la liste
est dessiné en premier, et le calque en haut est dessiné en dernier. En changeant leur ordre dans la liste, vous pouvez
changer l’ordre suivant lesquel ils sont dessinés.

Note: Vous pouvez modifier ce comportement en utilisant la case à cocher contrôler l’ordre du rendu située sous le
panneau ordre couches. Nous ne discuterons cependant pas encore de cette fonctionnalité.

L’ordre dans lequel les couches ont été chargées dans la carte n’est probablement pas logique à ce stade. Il est possible
que la couche des routes soit complètement cachée parce que les autres couches sont au-dessus d’elle.
Par exemple, cet ordre de couche…

… aurait pour conséquence de cacher les routes et les endroits qui passent en dessous des polygones de la couche
d’occupation des sols.

2.2. Leçon : Ajout de vos premières couches 19
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Pour résoudre le problème :
1. Cliquez et glissez sur la couche dans la légende de la carte.
2. Réorganiser-les pour obtenir ça :

Vous verrez que la carte a maintenant visuellement plus de sens, avec les routes et les bâtiments qui apparaissent
au-dessus des régions d’utilisation du sol.

2.2.7 Conclusion

Maintenant, vous avez ajouté toutes les couches dont vous avez besoin à partir de plusieurs sources différentes et créé
une carte de base !

2.2.8 La suite ?

Vous connaissez maintenant la fonction de base du bouton ouvrir le gestionnaire de sources de donnees, mais qu’en
est-il de tous les autres ? Comment fonctionne cette interface ? Avant de continuer, jetons un coup d’œil à quelques
interactions de base avec l’interface QGIS. C’est le sujet de la prochaine leçon.

2.3 Leçon : Naviguer sur le canevas de carte

Cette section se concentrera sur les outils de navigation de base QGIS utilisés pour naviguer dans le canevas de la
carte. Ces outils vous permettront d’explorer visuellement les couches à différentes échelles.
Le but de cette leçon: Apprendre à utiliser les outils Panoramique et Zoom au sein de QGIS et se familiariser avec
l’échelle des cartes.
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2.3.1 ��� Pas à pas : Outils de navigation basique

Avant d’apprendre comment naviguer dans le canevas de carte, ajoutons des couches que nous explorerons au cours
de ce tutoriel.

1. Ouvrez un nouveau projet vierge et en utilisant les étapes apprises dans Créer une carte, chargez les couches
protected_areas, roads et buildings vues précédemment dans le projet. La vue du résultat devrait
ressembler à l’extrait dans Fig. 2.2 ci-dessous (les couleurs n’ont pas d’importance) :

Figure2.2: Protected areas, roads et buildings ajoutes

Commençons par apprendre à utiliser l’outil de déplacement.

1. Dans la barre d’outils de navigation cartographique, assurez-vous que le bouton Déplacer est activé.
2. Déplacez la souris au centre de la zone du canevas de carte.
3. Cliquez sur le bouton gauche et maintenez-le enfoncé, puis faites glisser la souris dans n’importe quelle direction

pour faire un panoramique de la carte.
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Ensuite, faisons un zoom avant et examinons de plus près les couches que nous avons importées.

1. Dans la barre d’outils de navigation cartographique, cliquez sur le bouton Zoom avant.
2. Déplacez votre souris à peu près dans la partie supérieure gauche de la zone où la densité des bâtiments et des

routes est la plus élevée.
3. Cliquez sur le bouton gauche et maintenez-le enfoncé.
4. Ensuite, faites glisser la souris, ce qui créera un rectangle, et couvrez la zone dense de bâtiments et de routes

(Fig. 2.3).

Figure2.3: Zoom avant

5. Relâchez le clic gauche. Cela permettra de zoomer pour inclure la zone que vous avez sélectionnée avec votre
rectangle.
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6. Pour effectuer un zoom arrière, sélectionnez le bouton Zoom arrière et effectuez la même action que pour le
zoom avant.

Lorsque vous effectuez un panoramique, un zoom avant ou un zoom arrière, QGIS enregistre ces vues dans un
historique. Cela vous permet de revenir à une vue précédente.

1. Dans la barre d’outils de navigation cartographique, cliquez sur le bouton Zoom Last pour aller à votre vue
précédente.

2. Cliquez sur le bouton Zoom suivant pour continuer à avancer dans votre histoire.
Parfois, après avoir exploré les données, nous devons remettre notre vue à l’échelle de toutes les couches. Au lieu
d’essayer d’utiliser plusieurs fois l’outil Zoom Out, QGIS nous fournit un bouton pour faire cette action à notre place.

1. Cliquez sur le bouton Zoom etendue complete.
En effectuant un zoom avant et arrière, vous remarquerez que la valeur de echelle dans la barre d’état change. La
valeur echelle représente l’échelle de la carte. En général, le chiffre à droite de : représente le nombre de fois que
l’objet que vous voyez dans le canevas de carte est plus petit que l’objet réel dans le monde réel.
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Vous pouvez également utiliser ce champ pour régler manuellement l’échelle de la carte.
1. Dans la barre d’état, cliquez sur le champ de texte Échelle.
2. Tapez 50000 et appuyez sur entrer. Cela redessinera les éléments de la carte pour refléter l’échelle que

vous avez saisie.
3. Vous pouvez également cliquer sur la flèche d’options du champ échelle pour voir les échelles prédéfinies de la

carte.

4. Sélectionnez 1:5000. Cela mettra également à jour l’échelle de la carte dans le canevas de carte.
Maintenant, vous connaissez les bases de la navigation sur le canevas de la carte. Consultez le manuel de l’utilisateur
dans la section zoomer et se déplacer pour connaître les autres façons de naviguer dans la carte.

2.3.2 Conclusion

Il est important de savoir comment naviguer sur le canevas de la carte, car cela permet d’explorer et d’inspecter
visuellement les couches. Cela peut être fait pour l’exploration initiale des données, ou pour valider les résultats d’une
analyse spatiale.

2.4 Leçon : Symbologie

La symbologie d’une couche correspond à son apparence visuelle sur la carte. La force de base des SIG par rapport
aux autres façons de représenter des données spatiales est qu’avec les SIG, il est possible d’avoir une représentation
visuelle des données avec lesquelles vous travaillez.
Ainsi, l’apparence visuelle de la carte (qui dépend de la symbologie individuelle des couches) est très importante.
L’utilisateur final des cartes que vous produisez a besoin d’être capable de voir facilement ce que la carte représente.
Un aspect tout aussi important est le fait que vous devez être en mesure d’explorer les données avec lesquelles vous
travaillez, et une bonne symbologie aide beaucoup.
En d’autres mots, posséder sa propre symbologie n’est pas un luxe ou tout simplement quelque chose d’agréable à
avoir. En fait, c’est essentiel pour vous d’utiliser un SIG proprement et produire des cartes et informations que les
gens seront en mesure d’utiliser.
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Objectif de cette leçon : Être capable de créer n’importe quelle symbologie souhaitée pour n’importe quelle couche
vectorielle.

2.4.1 ��� Follow Along: Changing Colors

Pour changer la symbologie d’une couche, ouvrez ses Propriétés de Couche. Commencez par changer la couleur de la
couche landuse (occupation du sol).

1. Clic droit sur la couche landuse (occupation du sol) dans la liste de couches.
2. Sélectionnez l’élément Propriétés dans le menu qui apparaît.

Note: Par défaut, vous pouvez aussi accéder aux propriétés de la couche en double-cliquant sur la couche dans
la légende.

Astuce: Le bouton en haut du panneau Couches ouvrira le panneau Style de Couche. Vous pouvez utiliser
ce panneau pour modifier certaines propriétés de la couche : par défaut, les modifications seront appliquées
immédiatement !

3. Dans la fenêtre Propriétés de couche, sélectionnez l’onglet Symbologie :

4. Cliquez sur le bouton de sélection de la couleur à côté de l’étiquette couleur. Une boîte de dialogue de couleur
standard apparaîtra.

5. Choisissez une couleur grise et cliquez sur OK.
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6. Cliquez encore sur OK dans la fenêtre Propriétés de couche, et vous verrez le changement de couleur appliqué
à la couche.

2.4.2 ��� Essayez vous-même

Changez la couleur de la couche eau en bleu clair. Essayez d’utiliser le panneau Style de Couche au lieu du menu
Propriétés de la couche.

Solution
• Vérifiez que les couleurs changent bien comme vous le souhaitez.

• Il suffit de sélectionner la couche eau dans la légende et ensuite de cliquer sur le bouton
Ouvrir le panneau Style de Couche. Choisissez une couleur appropriée pour la couche eau.

Si vous voulez travailler sur une couche à la fois et vous ne voulez pas être distrait par les autres couches, vous pouvez
cacher une couche en décochant la case à côté de son nom dans la liste des couches. Si la case est décochée, la couche
est cachée.

2.4.3 ��� Follow Along: Changing Symbol Structure

Ce sont de bonnes choses jusqu’à présent, mais il y a plus que juste sa couleur dans la symbologie d’une couche. Par
la suite, nous éliminerons les lignes entre les différentes zones d’utilisation du sol afin de rendre la carte visuellement
moins encombrée.

1. Ouvrez la fenêtre Propriétés de Couche pour la couche landuse (occupation du sol).

Sous l’onglet Symbologie, vous verrez le même type de dialogue qu’auparavant. Cette fois, cependant,
vous faites plus que changer rapidement la couleur.

2. Dans l’arborescence des symboles, développez le menu déroulant remplissage et sélectionnez l’option
remplissage simple.

3. Cliquez sur le menu déroulant Style de ligne. Pour l’instant, il devrait afficher une ligne courte et les mots Ligne
simple.
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4. Change this to No Line.

5. Cliquez sur OK.
Désormais la couche landuse (occupation du sol) n’aura plus de lignes entre zones.

2.4.4 ��� Essayez vous-même

• Changez à nouveau la symbologie de la couche eau pour qu’elle ait un contour bleu plus foncé.
• Changez la symbologie de la couche rivière en une représentation délicate des cours d’eau.

Rappelez-vous : vous pouvez utiliser le bouton ouvrir le panneau style couche et voir tous les changements
instantanément. Ce panneau vous permet également d’annuler des modifications individuelles tout en symbolisant
une couche.

Réponse
Votre carte devrait ressembler à ceci :
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Si vous êtes un utilisateur débutant, vous pouvez vous arrêter ici.
• Utilisez la méthode ci-dessus pour changer les couleurs et les styles pour toutes les autres couches.
• Essayez d’utiliser des couleurs naturelles pour les objets. Par exemple, une route ne devrait pas être rouge ou
bleue, mais peut être grise ou noire.

• N’hésitez pas non plus à expérimenter avec différents paramètres de Style de remplissage et de Style de contour
pour les polygones.
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2.4.5 ��� Follow Along: Scale-Based Visibility

Parfois, vous trouverez que la couche ne fonctionne pas pour une échelle donnée. Par exemple, un jeu de données de
tous les continents peut avoir peu de détails, et ne pas être très précis au niveau d’une rue. Quand cela se passe, vous
voulez être capable de cacher le jeu de données aux échelles inappropriées.
Dans notre cas, nous pouvons décider de cacher les bâtiments à la vue à petite échelle. Cette carte, par exemple…

… n’est pas très utile. Les bâtiments sont difficiles à distinguer à cette échelle.
Pour autoriser le rendu selon l’échelle :

1. Ouvrez la fenêtre Propriétés de la couche pour la couche landuse (occupation du sol).

2. Activez l’onglet Rendu.
3. Activez le rendu basé sur l’échelle en cliquant sur la case à cocher intitulée Visibilité dépendante de l’échelle :
4. Changez la valeur de Minimum à 1:10000.
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5. Cliquez sur OK.
Testez-en les effets en zoomant et dézoomant sur votre carte, en notant quand la couche bâtiments disparaît et
réapparaît.

Note: Vous pouvez utiliser votre molette de souris pour zoomer par incrément. Une alternative est d’utiliser l’outil
de zoom pour zoomer sur une fenêtre.

2.4.6 ��� Follow Along: Adding Symbol Layers

Maintenant que vous savez comment changer une simple symbologie pour des couches, la prochaine étape est de
créer des symbologies plus complexes. QGIS vous permet de faire cela en utilisant les couches de symboles.

1. Revenez au panneau des propriétés de symboles de la couche landuse (occupation du sol) (en cliquant sur
Remplissage Simple dans l’arborescence des symboles).
In this example, the current symbol has no outline (i.e., it uses the No Line border style).
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2. Sélectionnez le niveau Remplissage dans l’arborescence et cliquez sur le bouton Ajouter une couche symbole. Le
dialogue va changer pour ressembler à ceci, avec une nouvelle couche de symboles ajoutée :
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Il peut sembler quelque peu différent en couleur, par exemple, mais vous allez quand même le changer.
Désormais, vous avez une seconde couche symbole. La nouvelle étant de remplissage continu, elle masquera
complètement l’ancienne. De plus, elle possède un style de bordure Ligne continue, que nous ne voulons pas. Ce
symbole doit être changé.

Note: Un point très important est de ne pas confondre une couche et une couche de symbole. Une couche est un
ensemble de vecteurs (ou une image raster) qui a été chargé dans la carte. Une couche de symbole est une partie
des symboles utilisés pour représentés la couche. Dans ce cours, nous ferons toujours la distinction et ce, pour éviter
toute confusion.

Avec la nouvelle couche symbole Remplissage simple sélectionnée :
1. Set the border style to No Line, as before.
2. Changez le style de remplissage avec quelque chose d’autre que Continu ou Pas de brosse. Par exemple :
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3. Cliquez sur OK.
Vous pouvez maintenant voir vos résultats et les modifier si nécessaire. Vous pouvez même ajouter plusieurs couches
de symboles supplémentaires et créer ainsi une sorte de texture pour votre couche.

Joli ! Mais il y a trop de couleurs pour pouvoir l’utiliser dans une belle carte.
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2.4.7 ��� Essayez vous-même

En vous souvenant de zoomer si nécessaire, créez, avec la méthode que nous venons de voir, une texture simple et
efficace pour la couche des bâtiments bâtiments.

Réponse
Personnalisez votre couche de bâtiments comme vous voulez, mais souvenez-vous qu’il doit être facile de différencier
visuellement les couches sur la carte.
Voici un exemple :

2.4.8 ��� Follow Along: Ordering Symbol Levels

Quand des couches de symboles sont dessinées, elles sont, tout comme des couches, dessinées dans un certain ordre.
Dans certains cas, des résultats inattendus peuvent apparaître avec plusieurs couches de symboles.

1. Ajoutez une couche symbole supplémentaire à la couche routes (en utilisant la méthode apprise ci-dessus).
2. Donnez à la ligne une Largeur de trait de 1.5 et une couleur noire.
3. Donnez à la nouvelle couche supérieure une épaisseur de « 0,8 » et une couleur blanche.

Ce qui devrait donner celà :
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Eh bien, les routes ont maintenant une symbologie de type rue, mais vous voyez que les lignes se chevauchent à chaque
croisement. Ce n’est pas du tout ce que nous voulons !
Pour éviter que celà advienne, vous pouvez trier les niveaux de symboles et ainsi choisir dans quel ordre les couches
de symboles se dessinent.
Pour changer l’ordre des couches de symboles :

1. Sélectionnez la couche supérieure Ligne dans l’arborescence des symboles.
2. Cliquez sur avance ► niveaux de symbole… dans le coin inférieur droit de la fenêtre.
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Cela permettra d’ouvrir un dialogue comme celui-ci :

3. Cocher la Activer les niveaux de symboles. Vous pouvez ensuite définir l’ordre des couches de chaque
symbole en entrant le numéro du niveau correspondant. 0 est la couche inférieure.
Dans notre cas, nous voulons juste activer l’option, comme ceci :

Cela rendra la ligne blanche au-dessus des limites de la ligne noire épaisse :
4. Cliquez deux fois sur OK pour retourner à la carte.

La carte doit maintenant ressembler à cela :
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Lorsque vous avez terminé, n’oubliez pas de sauvegarder le symbole lui-même afin de ne pas perdre votre travail si
vous changez encore le symbole à l’avenir. Vous pouvez sauvegarder votre style de symbole actuel en cliquant sur le
bouton Sauvegarder style … en bas de la boîte de dialogue Propriétés couche. Nous utiliserons le format fichier QGIS
QML Style.
Enregistrez votre style dans le dossier solution/styles/better_roads.qml. Vous pouvez à tout moment
charger un style précédemment sauvegardé en cliquant sur le bouton Charger style…. Avant de modifier un style,
gardez à l’esprit que tout style non sauvegardé que vous remplacez sera perdu.

2.4.9 ��� Essayez vous-même

Changez encore une fois l’apparence de la couche routes.
Les routes doivent être étroites et jaunes, avec un fin contour gris pâle et une fine ligne noire au milieu. N’oubliez pas
que vous devrez peut-être modifier l’ordre de rendu des couches via le dialogue Avance ► Niveaux de symboles….

Réponse
Pour créer le symbole voulu, vous avez besoin de trois couches de symboles :
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La couche de symbole la plus basse est une ligne grise, large et pleine. Par-dessus se trouve une ligne jaune plus fine
et pleine ; finalement, on ajoute une ligne noire pleine encore plus fine.
Si vos couches de symboles ressemblent à ci-dessus mais vous n’obtenez pas le résultat voulu :

1. Vérifiez que vos niveaux de symboles sont définis comme ceci :

2. A présent, votre carte devrait ressembler à ceci :
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2.4.10 ��� Essayez vous-même

Les niveaux de symboles fonctionnent également pour les couches classées (c’est-à-dire les couches ayant plusieurs
symboles). Comme nous n’avons pas encore abordé la classification, vous travaillerez avec quelques données
rudimentaires pré-classifiées.

1. Créez un nouveau projet et ajoutez-y le jeu de données routes.
2. Appliquez à la couche le fichier de style advanced_levels_demo.qml disponible dans le dossier

exercise_data/styles. Cette opération peut s’effectuer via le menu déroulant Style► Charger Style…
en bas de la fenêtre des Propriétés de la Couche.

3. Zoomez sur la zone Swellendam.
4. Grâce aux couches de symboles, créez une carte où les intersections des routes semblent connectées les unes

avec les autres comme dans l’image suivante :
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Réponse
1. Ajustez les niveaux de symbole avec ces valeurs :

1. Essayez des valeurs différentes pour obtenir des résultats différents.
2. Réouvrez votre carte d’origine avant de continuer avec l’exercice suivant.

40 Chapter 2. Module : Création et exploration d’une carte de base



QGIS Training Manual

2.4.11 ��� Follow Along: Symbol layer types

En plus de définir les couleurs de remplissage et d’utiliser des motifs prédéfinis, vous pouvez utiliser différents types
de couches de symboles. Le seul type que nous utilisions jusqu’à présent était le type Remplissage simple. Les types
de couches de symboles plus avancés vous permettent de personnaliser encore plus vos symboles.
Chaque type de vecteur (point, ligne et polygone) a son propre set de types de couche de symbole. Premièrement,
nous allons voir les différents types possibles pour les points.

Types de couches de symbole de point

1. Décochez toutes les couches sauf pour emplacements.
2. Changez les propriétés du symbole pour la couche emplacements :

3. Vous pouvez accéder aux différents types de couches de symboles en sélectionnant la coucheMarqueur simple
dans l’arborescence des symboles, puis cliquez sur le menu déroulant Type de couche de symbole :
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4. Étudiez les différentes options qui s’offrent à vous, et choisissez un symbole avec un style que vous pensez
approprié.

5. En cas de doute, utilisez un marqueur rond Symbole Simple avec un bord blanc et un remplissage vert pâle,
avec un taille de 3.00 et une largeur de trait de 0.5.

Types de couches de symbole de ligne

Pour voir les différentes options disponibles pour les données lignes :
1. Changez le Type de symbole pour la couche de symboles supérieure de la couche roads (routes) en Ligne de

symboles :
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2. Sélectionnez la couche Symbole simple dans l’arborescence des symboles. Modifiez les propriétés du symbole
pour qu’elles correspondent à ce dialogue :
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3. Sélectionnez la couche Ligne de symboles et changez l’intervalle en 1.00 :
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4. Assurez-vous que les niveaux de symboles sont corrects (via la boîte de dialogue menuselection:Avancé –>
Niveaux de symboles, étudiée auparavant) avant d’appliquer le style.

Une fois appliqué, visualisez le résultat sur la carte. Comme vous pouvez l’observer, ces symboles suivent les directions
des routes mais ne les suivent pas parfaitement partout. Cet aspect peut être utile dans certains cas, dans d’autres pas
du tout. Si vous préfériez le style précédent, vous pouvez lui affecter de nouveau son style d’origine.

Types de couches de symbole de polygone

Pour voir les différentes options possibles pour les données polygones :
1. Changez le Type de Symbole pour la couche water (eau), comme précédemment pour les autres couches.
2. Étudiez ce que les différentes options de la liste peuvent faire.
3. Choisissez l’une d’entre elles que vous trouvez adéquate.
4. Si vous doutez, utilisez le remplissage Motif de point avec les options suivantes :
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5. Ajoutez une nouvelle couche symbole avec un Remplissage simple normal.
6. Mettez-lui le même bleu clair avec une bordure bleu foncé.
7. Déplacez-la sous la couche symbole motif de points à l’aide du bouton Descendre.
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Par conséquent, vous avez un symbole texturé pour la couche de l’eau, avec le bénéfice supplémentaire que vous
pouvez changer la taille, la forme et la distance des pointillés individuels qui composent la texture.

2.4.12 ��� Essayez vous-même

Appliquez une couleur de remplissage transparente verte sur la couche zones protégées, et modifiez le contour pour
qu’il ressemble à ceci :
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Réponse
Voici un exemple de la structure du symbole :
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2.4.13 ��� Follow Along: Geometry generator symbology

Vous pouvez utiliser la symbologie du générateur de géométrie avec tous les types de couches (points, lignes et
polygones). Le symbole résultant dépend directement du type de couche.
Très brièvement, la symbologie du générateur de géométrie vous permet d’effectuer quelques opérations spatiales au
sein de la symbologie elle-même. Par exemple, vous pouvez exécuter une opération spatiale de centroïde réel sur une
couche de polygones sans créer de couche de points.
De plus, vous disposez de toutes les options de style pour modifier l’apparence du symbole résultant.
Essayons !

1. Sélectionnez la couche eau.
2. Cliquez sur Remplissage simple et changez le Type de symbole en Générateur de géométrie.
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3. Avant de commencer à écrire la requête spatiale, nous devons choisir le type de géométrie en sortie. Dans cet
exemple, nous allons créer des centroïdes pour chaque élément, donc changez le type de géométrie en Point /
Multipoint.

4. Maintenant, écrivons la requête dans le panneau de requête:

centroid($geometry)
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5. Lorsque vous cliquerez sur OK vous verrez que la couchewater est rendue comme une couche de points ! Nous
venons de lancer une opération spatiale au sein même de la symbologie de la couche, n’est-ce pas étonnant ?
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Avec la symbologie du générateur de géométrie, vous pouvez vraiment dépasser les limites de la symbologie normale.

��� Essayez vous-même

Les générateurs de géométrie ne sont qu’un autre niveau de symbole. Essayez d’ajouter un autre Remplissage simple
sous celui du Générateur de géométrie.
Modifier également l’apparence du marqueur simple de la symbologie du générateur de géométrie.
Le résultat final devrait ressembler à ceci :
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Réponse

1. Cliquez sur le bouton pour ajouter un niveau de symbole.

2. Déplacez le nouveau symbole en bas de la liste en cliquant sur le bouton .
3. Choisissez une couleur appropriée pour remplir les polygones d’eau.
4. Cliquez sur le Symbole de la symbologie du générateur de géométrie et remplacez le cercle par une autre forme

de votre choix.
5. Expérimentez d’autres options pour obtenir plus de résultats utiles.
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2.4.14 ��� Follow Along: Creating a Custom SVG Fill

Note: Pour faire cet exercice, vous aurez besoin d’installer le logiciel gratuit d’édition vectorielle Inkscape.

1. Lancez le programme Inkscape. Vous verrez l’interface suivante :

Vous pouvez la trouver familière si vous avez utilisé d’autres programmes d’édition d’image vectorielle, comme
Corel.
Premièrement, nous allons changer le canevas à une taille appropriée pour une petite texture.

2. Cliquez sur l’élément du menu Fichier ► Propriétés du document. Cela vous ouvrira la boîte de dialogue
Propriétés du document .

3. Changez les Unités en px.
4. Changez largeur et la hauteur en 100.
5. Fermez la boîte de dialogue quand c’est fait.
6. Cliquez sur l’élément dumenuVue► Zoom► Page pour voir la page sur laquelle vous êtes en train de travailler.
7. Sélectionnez l’outil Cercle.
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8. Cliquez et faites glisser sur la page pour dessiner une ellipse. Pour que l’ellipse devienne un cercle, tenez appuyé
le bouton ctrl pendant que vous dessinez.

9. Faites un clic droit sur le cercle que vous venez de créer et ouvrez les options Remplissage et Contour Vous
pouvez en modifier l’apparence, comme par exemple:
1. Changez la couleur de Remplissage pour obtenir un bleu clair,
2. Choisissez une couleur plus sombre pour le contour dans l’onglet Couleur de trait,
3. Et réduisez l’épaisseur de la bordure dans l’onglet Largeur de trait
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10. Dessinez une ligne en utilisant l’outil Crayon:
1. Cliquez une fois pour commencer la ligne. Maintenez la touche Ctrl enfoncée pour l’incrémenter de

15 degrés.
2. Déplacez le pointeur horizontalement et placez le point avec un simple clic.
3. Cliquez et accrochez-vous au sommet de la ligne et tracez une ligne verticale, terminée par un clic simple.
4. Maintenant, rassemblez les deux sommets terminaux.
5. Modifiez la couleur et la largeur du symbôle de triangle pour correspondre au trait du cercle et déplacez-le

autour de manière à obtenir un symbole qui ressemble au suivant:
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11. Si le symbole vous satisfait, vous pouvez le sauver comme landuse_symbol dans le dossier du cours, sous
exercise_data/symbols, en tant que fichier SVG.

Dans QGIS :
1. Ouvrez les Propriétés de la couche landuse (occupation du sol).

2. Dans l’onglet Symbologie , modifiez la structure du symbole en changeant le Type de symbole en
Remplissage SVG``` indiqué ci-dessous.

3. Cliquez sur le bouton… et ensuite sur Sélection fichier… pour sélectionner votre image SVG.
Il a été ajouté à l’arbre des symboles et vous pouvez maintenant personnaliser ses différentes caractéristiques
(couleurs, angle, effets, unités…).
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Une fois le dialogue validé, les entités dans la couche``landuse`` (occupation du sol) devraient être recouvertes d’un
ensemble de symboles, montrant une texture semblable à la carte suivante. Si les textures sont invisibles, vous devriez
zoomer dans le canevas de carte ou définir dans les propriétés de la couche une plus grande Largeur de Texture.
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2.4.15 ��� Follow Along: Masking

Masking feature allows you to mask some symbol layer using another symbol layer or label.
In the following exercise, we want to configure rendering so that polygon labels will mask the black part of lines layer.

1. Load the selective_masking.qgs from dataset in directory exercise_data/masking.
2. Open the Layer Properties window for the polys layer.

Under the Labels tab, you will see that Single Labels have already been defined.

3. From the Labels tab, select the Mask (and not Masks in general category list)

4. Enable label mask by checking the Enable mask option
A message tells you that the now defined label mask shape can be later selected as a mask source to mask other
symbol layers. Let’s do that.

5. Click OK
6. Open the Layer Properties window for the lines layer.

7. Go to the Masks tab
8. Click on the black line part of lines checkbox from masked symbol layers

Amessage warns you that you have to select both masking and masked symbol layers to be able to save masking
configuration. Again, let’s do that.

9. Click on polys Label mask checkbox
The message disappears, you can now safely save your configuration.
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10. Click OK
You can see now that labels are masking the black part of lines, leaving only the yellow part.
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2.4.16 ��� Follow Along: Masking using points symbols

We want now to mask the black part of lines using only black planes that represent the points layer (i.e. B52 and
Jet points categories). For the sake of visibility, you can switch off polys layer visibility.

1. Open the Layer Properties window for the points layer.

Under the Symbology tab, you will see that a Categorized renderer has been defined with 3 different
symbols depending on the Class field value.

2. Double click on B52 plane icon, within the Symbol column

3. Click the Add symbol layer button and select the Mask Symbol layer type
A new hierarchy Mask (symbol layer) > Marker (symbol) > Simple Marker (symbol layer) appear below
the root symbol Marker.
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Now, let’s define a mask that is identical to our plane marker but a little bit bigger.
4. Select the newly created Simple Marker symbol layer and change its Symbol layer type to SVG marker

5. Set the SVG file path to be the same as the already existing SVG marker, and the size to be bigger (24
millimeters is a pretty good choice for this use case).
Mask color doesn’t matter here, only the shape is used in masking. Symbol layer order is also irrelevant in that
situation.
You should get something like that:

6. Repeat the same operations on Jet symbol.
7. Click OK
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8. Open the Layer Properties window for the lines layer.

9. Go to the Masks tab.
The black line part of lines checkbox from masked symbol layers is already checked from our previous
configuration.

10. Uncheck the Label mask polys checkbox and check both B52 and Jet Mask symbol layer
11. Click OK

You now see that black planes are masking the black part of lines, with only the yellow part visible.

2.4.17 Conclusion

Changer la symbologie des différentes couches a transformé un empilement de vecteurs en une belle carte lisible.

2.4.18 Pour aller plus loin

Exemples de belles cartes
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2.4.19 La suite ?

Changer la symbologie pour une couche entière est utile, mais l’information contenue dans chaque couche n’est pas
disponible pour quelqu’un qui lit la carte. Comment se nomment les rues ? A quelles régions ces zones appartiennent
? Quelles sont les surfaces des exploitations agricoles ? Toutes ces informations sont encore invisibles. La prochaine
leçon expliquera comment représenter ces données sur une carte.

Note: Avez-vous pensé à sauvegarder votre carte récemment ?
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Module : Classer des données vectorielles

La classification des données vectorielles vous permet d’attribuer différents symboles aux entités (différents objets dans
la même couche), dépendamment de leurs attributs. Cela permet à quelqu’un qui utilise la carte de voir facilement
les attributs des différentes entités.

3.1 Leçon : Attributs de données vectorielles

Les données vecteur sont sans doute le type de données le plus courant dans l’utilisation quotidienne des SIG. Le
modèle vecteur représente l’emplacement et la forme d’entités géographiques à l’aide de points, de lignes et de
polygones (et pour les données 3D, également des surfaces et des volumes), tandis que leurs autres propriétés sont
incluses en tant qu’attributs (souvent présentés sous forme de tableau dans QGIS).
Jusqu’à maintenant, aucune des modifications que nous avons apportées à la carte ont été influencées par les objets
qui sont représentés. En d’autres termes, toutes les zones d’occupation du sol se ressemblent, et toutes les routes
également. En regardant la carte, les observateurs ne savent rien à propos des routes qu’ils regardent ; seulement qu’il
y a une route d’une certaine forme à un certain endroit.
Mais toute la force des SIG est que tous ces objets visibles sur la carte ont également des attributs. Des cartes dans
un SIG ne sont pas uniquement des images. Elles ne représentent pas seulement des objets dans des endroits, mais
également des informations sur ces objets.
L’objectif de cette leçon : Étudier la structure de données vectorielles et explorer les données attributaires d’un objet

3.1.1 ��� Follow Along: Viewing Layer Attributes

Il est important de comprendre que les données avec lesquelles vous êtes en train de travailler ne montrent pas
seulement où ces objets se trouvent dans l’espace, mais aussi vous informent sur ce que sont ces objets.
D’après l’exercice précédent, vous devriez avoir la couche « protected_areas » chargée dans votre carte. Si elle n’est
pas chargée, alors vous pouvez trouver le jeu de données au format protected_areas.shp ESRI Shapefile dans
le répertoire exercise_data/shapefile.
Les polygones représentant les zones protégées constituent les données spatiales, mais nous pouvons en apprendre
davantage sur les zones protégées en explorant la table d’attributs.

1. Dans le panneau couches, cliquez sur la couche protected_areas pour la sélectionner.
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2. Dans le menu Couche, cliquez sur le bouton Ouvrir la Table Attributaire (aussi accessible depuis la barre d’outils
en haut). Cela ouvrira une nouvelle fenêtre montrant la table d’attributs de la couche protected_areas.

Une ligne est appelée un enregistrement et est associée à une entité dans la carte sur le canevas, comme
un polygone. Une colonne est appelée champ (ou attribut), et porte un nom qui aide à la décrire, comme
name ou id. Les valeurs dans les cellules sont connues sous le nom de valeur d’attribut. Ces définitions sont
couramment utilisées dans les SIG, il est donc bon de se familiariser avec elles.
Dans la couche protected_areas, il y a deux entités, qui sont représentées par les deux polygones que
nous voyons sur la carte.

Note: Afin de comprendre ce que représentent les champs et les valeurs d’attribut, il peut être nécessaire
de trouver de la documentation (ou des métadonnées) décrivant la signification des valeurs d’attribut. Cette
documentation est généralement disponible auprès du créateur du jeu de données.

Ensuite, voyons comment un enregistrement dans la table d’attributs est lié à une entité de polygone que nous voyons
sur la carte.

1. Retournez à la fenêtre principale QGIS.

2. In the Edit ► Select menu, click on the Select Feature(s) button.
3. Assurez-vous que la couche protected_areas est toujours sélectionnée dans le panneau Couches.
4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Attribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.
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Vous pouvez également sélectionner une entité à l’aide de la table d’attributs.
1. Dans la fenêtre table attributs, à gauche, cliquez sur le numéro de ligne de l’enregistrement qui n’est actuellement

pas sélectionné.

2. Retournez à la fenêtre principale de QGIS et regardez le canevas cartographique. Vous devriez voir le plus
grand des deux polygones colorés en jaune.

3. Pour désélectionner l’entité, allez dans la fenêtre Table d’attributs et cliquez sur
Désélectionner toutes les entités de la couche.

Parfois, de nombreuses entités sont affichées sur la carte et il peut être difficile de voir quelle entité est sélectionnée
dans la table d’attributs. Une autre façon d’identifier l’emplacement d’un élément est d’utiliser l’outil Faire clignoter
l’entité.

1. Dans la table attributs, faites un clic droit sur toute cellule de la ligne qui a la valeur d’attribut r2855697 pour
le champ full_id.

2. Dans le menu contextuel, cliquez sur Flash Feature et regardez le canevas de carte.

Vous devriez voir le polygone clignoter en rouge plusieurs fois. Si vous l’avez manqué, essayez-le à nouveau.
Un autre outil utile est l’outil zoomer à l’entité, qui indique à QGIS de zoomer sur l’élément qui l’intéresse.

1. Dans la table attributs, faites un clic droit sur toute cellule de la ligne qui a la valeur d’attribut r2855697 pour
le champ full_id.
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2. Dans le menu contextuel, cliquez sur zoomer à l’entité.

Regardez le canevas de la carte. Le polygone devrait maintenant occuper l’étendue de la zone.
Vous pouvez maintenant fermer la table d’attributs.

3.1.2 ���Essayez vous-même : Explorer des attributs de données vectorielles

1. Combien de champs sont disponibles dans la couche rivers ?
2. Parlez-nous un peu des endroits town de votre jeu de données.
3. Ouvrez la table des attributs de la couche places. Quel champ serait le plus utile à représenter sous forme

d’étiquette, et pourquoi ?

Réponse
• Il devrait y avoir 9 champs dans la couche rivers :

1. Sélectionnez la couche dans le panneau Couches.

2. Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View ► Toolbars menu).

3. Comptez le nombre de colonnes.
A quicker approach could be to double-click the rivers layer, open the Layer properties► Fields tab, where you
will find a numbered list of the table’s fields.

• Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

• The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 Conclusion

Vous savez maintenant comment utiliser la table d’attributs pour étudier les données que vous utilisez. Les jeux
de données seront seulement intéressants lorsqu’ils comporteront des attributs qui vous concerne. Si vous savez de
quels attributs vous avez besoin, vous pouvez savoir rapidement si vous serez capable d’utiliser un jeu de données
spécifiques ou si vous avez besoin d’un autre qui dispose des données nécessaires.

3.1.4 La suite ?

Des différents attributs sont utiles à différentes fins. Certains d’entre eux peuvent être représentés directement sous
forme de texte dans la carte que voit l’utilisateur. Vous apprendrez comment faire cela dans la prochaine leçon.

3.2 Leçon : Étiquettes

Des étiquettes peuvent être ajoutées à une carte pour afficher de l’information sur un objet. N’importe quelle couche
vecteur peut avoir des étiquettes qui lui sont associées. Le contenu de ces étiquettes repose sur les données attributaires
de la couche.
Le but de ce cours: Appliquer des étiquettes utiles, jolies et lisibles à une couche.

3.2.1 ��� Pas à pas : Utiliser les étiquettes

Premièrement, assurez-vous que le bouton est visible dans l’interface graphique :
1. Aller à l’élément du menu Vue ► Barres d’outils

2. Assurez-vous que l’élément Barre d’outils Étiquettes est coché. Si ce n’est pas le cas, cliquez sur l’élément Barre
d’outils Étiquettes pour l’activer.

3. Cliquez sur la couche places dans le panneau Couches pour qu’il soit mis en évidence
4. Cliquez sur le bouton de la barre d’outils pour ouvrir l’onglet Etiquettes du panneau Style de couche
5. Passez de Pas d’étiquettes à Etiquettes simples.

Vous devrez choisir le champ des attributs qui sera utilisé pour les étiquettes. Dans la leçon précédente, vous
avez décidé que le champ name était le plus approprié à cette fin.

6. Select name from the Value list :
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7. Cliquez sur Appliquer
La carte devrait maintenant afficher des étiquettes comme ceci:
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3.2.2 ��� Follow Along: Changing Label Options

Selon les styles que vous avez choisis pour votre carte dans les leçons précédentes, vous pourriez trouver que les
étiquettes ne sont pas formatées correctement et soit se chevauchent, soit sont trop éloignées de leurs marqueurs de
points.

Note: Ci-dessus, vous avez utilisé le bouton dans la barre d’outils Etiquettes pour ouvrir le panneau Style de
couches. Comme pour Symbologie, les mêmes options d’étiquetage sont disponibles dans le panneau Style de couches
que dans la fenêtre Propriétés de la couche. Ici, vous utiliserez la boîte de dialogue Propriétés de la couche.

1. Ouvrez le dialogue Propriétés de la couche en double-cliquant sur la couche places.
2. Sélectionnez l’onglet Etiquettes

3. Assurez-vous que Texte est sélectionné dans la liste d’options à gauche, puis mettez à jour les options de
formatage de texte pour les faire correspondre à celles montrées ci-dessous:
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4. Cliquez sur Appliquer
Cette police est peut-être plus grande et plus familière aux utilisateurs, mais sa lisibilité dépend toujours des
couches qui sont rendues en dessous. Pour résoudre ce problème, regardons l’option Tampon.

5. Sélectionnez Tampon dans la liste d’options de gauche
6. Sélectionnez la case à cocher à côté de Afficher un tampon, puis choisissez les options qui correspondent aux

suivantes:
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7. Cliquez sur Appliquer
Vous constaterez que cela ajoute une bordure ou un tampon coloré autour des étiquettes des places, les rendant
plus faciles à repérer sur la carte:
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Maintenant, nous pouvons aborder le positionnement des étiquettes par rapport à leurs points de repères.
8. Sélectionnez Placement dans la liste d’options de gauche
9. Sélectionnez Autour du point et changez la valeur de Distance à 2.0 millimètres :
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10. Cliquez sur Appliquer
Vous verrez que les étiquettes ne chevauchent plus désormais les points.

3.2.3 ��� Follow Along: Using Labels Instead of Layer Symbology

Dans de nombreux cas, l’emplacement d’un point n’a pas besoin d’être très précis. Par exemple, la plupart des points
de la couche « places » se réfèrent à des villes ou des banlieues entières, et le point spécifique associé à de telles entités
n’est pas si spécifique à grande échelle. En fait, donner un point trop spécifique est souvent déroutant pour quelqu’un
qui lit une carte.
Par exemple: sur une carte du monde, le point indiquant l’Union Européenne peut être quelque part en Pologne, par
exemple. Pour quelqu’un qui lit la carte, voir un point marqué Union Européenne en Pologne peut sembler vouloir
dire que la capitale de l’Union Européenne est donc en Pologne.
Aussi, pour prévenir ce genre d’incompréhension, il est souvent utile de désactiver les symboles de points et les
remplacer complètement par les étiquettes.
Dans QGIS, vous pouvez faire ça en positionnant l’étiquette directement à la place du point auquel elle se réfère.

1. Ouvrez l’onglet etiquettes du dialogue proprietes couches pour la couche places.
2. Sélectionnez l’option Placement dans la liste des options
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3. Cliquez sur le bouton décalage du point
Ceci va révéler les options Quadrant que vous pourrez utiliser pour définir la position de l’étiquette par rapport
au marqueur de point. Dans le cas-ci, nous souhaitons centrer l’étiquette sur le point donc choisissez le centre
du quadrant:

4. Cachez les symboles de points en éditant la couche symbologie comme d’habitude, et en fixant la taille du
Marker à 0.0 :
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5. Cliquez sur Appliquer et vous verrez ce résultat :
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Si vous effectuez un zoom arrière sur la carte, vous verrez que certaines des étiquettes disparaissent à des échelles plus
grandes pour éviter les chevauchements. C’est parfois ce que vous souhaitez lorsque vous traitez des ensembles de
données qui comportent de nombreux points, mais à d’autres moments, vous perdrez des informations utiles de cette
manière. Il existe une autre possibilité pour traiter ce genre de cas, que nous aborderons dans un exercice ultérieur
de cette leçon. Pour l’instant, faites un zoom arrière et cliquez sur le bouton dans la barre d’outils et voyez ce qui
se passe.

3.2.4 ��� Essayez vous-même : Personnaliser les étiquettes

• Réinitialisez les paramètres des étiquettes et des symboles pour avoir un marqueur de points et un décalage
d’étiquettes de 2,0 millimètres.

Réponse
Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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• Mettez la carte à l’échelle 1:100000. Vous pouvez le faire en la tapant dans la case Echelle dans la barre
statut. Modifiez vos étiquettes pour qu’elles puissent être visualisées à cette échelle.

Réponse
One possible solution has this final product:
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Pour obtenir ce résultat :
• Utilisez une taille de police de 10
• Use an around point placement distance of 1.5 mm

• Utilisez un marqueur d’une taille de 3.0 mm

• In addition, this example uses theWrap on character option:
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• Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.
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3.2.5 ��� Follow Along: Labeling Lines

Maintenant que vous comprenez le fonctionnement de l’étiquetage, il y a un nouveau problème. Points et polygones
sont faciles à étiqueter, mais qu’en est-il des lignes? Si vous les étiquetez de la même manière que les points, vos
résultats devraient ressembler à quelque chose comme ceci:

Nous allons maintenant reformater les étiquettes de la couche roads afin qu’elles soient faciles à comprendre.
1. Cachez la couche « places » pour qu’elle ne vous distraie pas
2. Activez etiquette simple pour la couche roads comme vous l’avez fait ci-dessus pour places.
3. Définissez la police taille` à 10 pour que vous puissiez voir plus d’étiquettes
4. Zoom sur la zone Swellendam de la ville
5. Dans l’onglet etiquettes de l’onglet Placement, choisissez les paramètres suivants :
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Vous constaterez probablement que le style du texte a utilisé des valeurs par défaut et que les étiquettes sont
par conséquent très difficiles à lire. Mettez à jour le Texte pour utiliser une Couleur gris foncé ou noire et le
Tampon pour utiliser une Couleur jaune clair.
Selon l’échelle, la carte devrait ressembler à peu près à ceci:
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Vous verrez que certains noms de voies apparaissent plus d’une fois sans que ce ne soit toujours nécessaire.
Pour empêcher cela:

6. Dans l’onglet etiquettes du dialogue proprietes couche, choisissez l’option rendu et sélectionnez Fusionner les
lignes connectées pour éviter les doublons comme indiqué :
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7. Cliquez sur OK
Une autre fonction utile permet d’empêcher l’affichage des entités trop courtes pour être indiquées.

8. Dans le même panneau Rendu, définissez la valeur de Supprimer l’étiquetage des entités plus petites que à 5.00
mm et notez les résultats lorsque vous cliquez sur Appliquer.
Essayez également différents réglages de Position. Comme nous l’avons vu précédemment, l’option Horizontal
n’est pas une bonne idée dans ce cas, alors essayons plutôt l’option Incurvé.

9. Sélectionnez l’option Incurvé dans le panneau Placement de l’onglet Etiquettes
Voici le résultat:
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Comme vous pouvez le voir, cela cache certaines étiquettes qui étaient auparavant visibles, en raison de la difficulté
de faire suivre à certaines d’entre elles des lignes de rue sinueuses tout en étant lisibles. Cela rend d’autres étiquettes
beaucoup plus utiles, car elles suivent les routes plutôt que de flotter dans l’espace entre elles. Vous pouvez décider
laquelle de ces options utiliser, en fonction de ce qui vous semble le plus utile ou le plus esthétique.

3.2.6 ��� Follow Along: Data Defined Settings

1. Désactiver l’étiquetage pour la couche roads
2. Réactiver l’étiquetage pour la couche places

3. Ouvrez la table d’attributs pour les places via le bouton
Il y a un champ qui nous intéresse maintenant : place qui définit le type de zone urbaine pour chaque
enregistrement. Nous pouvons utiliser ces données pour influencer les styles d’étiquettes.

4. Naviguez vers le sous-panneau Texte de l’onglet Etiquettes de la couche places.

5. Cliquez sur le bouton à côté du bouton de texte en italique sous Style et sélectionnez Editer… pour ouvrir
le Constructeur d’expression :
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6. Sous Champs et valeurs, double-cliquez sur place puis cliquez sur Tous. Cela permettra de lister toutes les
valeurs uniques du champ place de cette couche. Ajoutez un = dans l’éditeur de texte, puis double-cliquez
sur town.
Vous pouvez aussi taper : "place" = "town" directement dans l’éditeur de texte.

7. Cliquez deux fois sur OK :
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Notez que les étiquettes de tous les lieux dont le champ place correspond à town sont affichées en italique.

3.2.7 ��� Essayez vous-même : Utiliser des paramètres définis par les
données

Note: Nous allons aller un peu plus loin ici pour vous présenter quelques paramètres avancés d’étiquetage. A ce
niveau avancé, nous assumons que vous avez suffisamment de connaissances sur le sujet pour comprendre ce qui va
suivre. Si ce n’est pas le cas, quittez cette section et revenez plus tard lorsque vous aurez étudiez les pré-requis.

1. Ouvrez la table des attributs pour les « places ».

2. Entrez en mode édition en cliquant sur le bouton .

3. Ajouter une nouvelle colonne avec le bouton
4. Configurez-le comme ceci:
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5. Utilisez cette fonction pour définir des tailles de police personnalisées pour chaque type de lieu (chaque clé
dans le champ place)

Réponse
1. Still in edit mode, set the FONT_SIZE values to whatever you prefer. The example uses 16 for towns, 14 for

suburbs, 12 for localities, and 10 for hamlets.
2. Remember to save changes and exit edit mode
3. Return to the Text formatting options for the places layer and select FONT_SIZE in the Attribute field of

the font size data defined override dropdown:

Your results, if using the above values, should be this:
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3.2.8 ��� Further Possibilities With Labeling

Nous ne pouvons pas couvrir toutes les options dans ce cours, mais sachez que l’onglet etiquette a de nombreuses
autres fonctions utiles. Vous pouvez définir un rendu basé sur l’échelle, modifier la priorité de rendu des étiquettes
dans une couche, et définir chaque option d’étiquette à l’aide des attributs de la couche. Vous pouvez même définir la
rotation, la position XY et d’autres propriétés d’un label (si des champs d’attributs ont été attribués à cet effet), puis
modifier ces propriétés à l’aide des outils adjacents au bouton principal options étiquetage des couches :

(Ces outils seront actifs tant que les champs requis existent dans la table d’attributs et que vous êtes en mode édition.)
N’hésitez pas à explorer les diverses possibilités offertes par le système d’étiquetage.
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3.2.9 Conclusion

Vous avez appris comment utiliser les attributs d’une couche pour créer des étiquettes dynamiques. Cela peut rendre
votre carte plus informative et plus élégante.

3.2.10 La suite ?

Maintenant que vous savez comment les attributs peuvent apporter une différence visuelle à votre carte, que diriez-
vous de les utiliser pour changer la symbologie des objets eux-mêmes ? C’est l’objet de la leçon suivante!

3.3 Leçon : Classification

Les étiquettes sont un bonmoyen de communiquer des informations telles que les noms de lieux individuels, mais elles
ne peuvent pas être utilisées pour tout. Par exemple, disons que quelqu’un veut savoir à quoi sert chaque landuse.
En utilisant des étiquettes, vous obtiendriez ceci :

Cela rend les étiquettes de la carte difficiles à lire car trop nombreuses si vous avez de nombreuses utilisation du
territoires différentes à afficher.
Objectif de cette leçon : Apprendre comment classifier des données vectorielles efficacement.

3.3.1 ��� Follow Along: Classifying Nominal Data

1. Ouvrez le dialogue Propriétés de la couche pour la couche landuse.
2. Aller à l’onglet Symbologie
3. Cliquez sur le menu déroulant qui indique Symbole unique et changez-le en Categorisé:
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4. Dans le nouveau panneau, changez la Valeur en landuse et la Palette de couleur en Couleurs aléatoires.
5. Cliquez sur le bouton intitulé Classer.

6. Cliquez sur OK
Vous verrez quelque chose comme ça :
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7. Cliquez sur la flèche (ou le signe plus) à côté de landuse dans le panneau Couches, vous verrez les catégories
expliquées :
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Maintenant, nos polygones d’utilisation des terres sont colorés et sont classés de manière à ce que les zones
ayant la même utilisation des terres soient de la même couleur.

8. Si vous le souhaitez, vous pouvez changer le symbole de chaque zone d’utilisation des terres en double-cliquant
sur le bloc de couleur correspondant dans le panneau Couches ou dans la boîte de dialogue Propriete couche :
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Notez qu’il y a une catégorie qui est vide :
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Cette catégorie vide est utilisée pour colorier tous les objets qui n’ont pas de valeur d’utilisation du sol définie ou qui
ont une valeur NULL. Il peut être utile de conserver cette catégorie vide afin que les zones ayant une valeur NULL
soient toujours représentées sur la carte. Vous pouvez changer la couleur pour représenter plus clairement une valeur
vide ou NULL.
Pensez à sauvegarder votre carte maintenant afin de ne pas perdre toutes vos modifications « durement » effectuées !

3.3.2 ��� Essayez vous-même : Plus de classification

Utilisez les connaissances acquises ci-dessus pour classer la couche buildings. Définissez la catégorisation par
rapport au champ building et utilisez la palette de couleurs Spectrale.

Note: Rappelez-vous de zoomer sur une zone urbaine pour voir les résultats.

3.3.3 ��� Follow Along: Ratio Classification

Il y a quatre types de classification : nominale, ordinale, d’intervalle et de ratio.
Dans la classification nominale, les catégories dans lesquelles les objets sont classés sont basées sur le nom ; elles
n’ont pas d’ordre. Par exemple : noms des villes, codes des districts, etc. Les symboles utilisés pour les données
nominales n’impliquent aucun ordre ni aucune grandeur.

• Pour les points, on peut utiliser des symboles de forme différente.
• Pour les polygones, on peut utiliser différents types de hachures ou différentes couleurs (éviter de mélanger les
couleurs claires et foncées).

• Pour les lignes, nous pouvons utiliser différents motifs de tirets, différentes couleurs (évitez de mélanger les
couleurs claires et foncées) et différents symboles le long des lignes.
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Dans la classification ordinale, les catégories sont classées dans un certain ordre. Par exemple, les villes du monde
sont classées en fonction de leur importance pour le commerce mondial, les voyages, la culture, etc. Les symboles
utilisés pour les données ordinales doivent impliquer un ordre, mais pas une magnitude.

• Pour les points, nous pouvons utiliser des symboles de couleurs claires à foncées.
• Pour les polygones, on peut utiliser des couleurs graduées (de claire à foncée).
• Pour les lignes, nous pouvons utiliser des couleurs graduées (de claire à foncée).

Dans la classification à intervalle, les chiffres sont sur une échelle avec des valeurs positives, négatives et zéro. Par
exemple : hauteur au-dessus/au-dessous du niveau de la mer, température en degrés Celsius. Les symboles utilisés
pour les données d’intervalle doivent indiquer l’ordre et la magnitude.

• Pour les points, on peut utiliser des symboles de taille variable (de petit à grand).
• Pour les polygones, on peut utiliser des couleurs graduées (de claire à foncée) ou ajouter des diagrammes à
taille variable.

• Pour les lignes, on peut utiliser l’épaisseur (de fine à épaisse).
Dans la classification ratio, les chiffres sont sur une échelle avec seulement des valeurs positives et zéro. Par exemple
: la température au-dessus du zéro absolu (0 degré Kelvin), la distance par rapport à un point, le volume moyen de
trafic dans une rue donnée par mois, etc. Les symboles utilisés pour les données de ratios doivent impliquer l’ordre
et l’ampleur.

• Pour les points, on peut utiliser des symboles de taille variable (de petit à grand).
• Pour les polygones, on peut utiliser des couleurs graduées (de claire à foncée) ou ajouter des diagrammes à
taille variable.

• Pour les lignes, on peut utiliser l’épaisseur (de fine à épaisse).
Dans l’exemple ci-dessus, nous avons utilisé la classification nominale pour colorer chaque enregistrement de la couche
landuse en fonction de son attribut landuse. Nous allons maintenant utiliser la classification par ratio pour
classer les enregistrements par zone.
Nous allons reclassifier la couche, de sorte que les classes existantes seront perdues si elles ne sont pas sauvegardées.
Pour stocker la classification actuelle :

1. Ouvrez le dialogue des propriétés de la couche
2. Cliquez sur le bouton sauvegarder style … dans le menu déroulant Style.
3. Sélectionnez renommer courant…, entrez land usage et appuyez sur OK.

Les catégories et leurs symboles sont maintenant enregistrés dans les propriétés de la couche.
4. Cliquez maintenant sur l’entrée ajouter… du menu déroulant Style et créez un nouveau style nommé ratio.

Ceci enregistrera la nouvelle classification.
5. Fermez la boîte de dialogue proprietes couche

Nous voulons classer les zones d’utilisation des terres par taille, mais il y a un problème : elles n’ont pas de champ de
taille, donc nous devrons en faire un.

1. Ouvrez la table d’attributs pour la couche landuse.

2. Entrez en mode édition en cliquant sur le bouton basculer mode edition

3. Ajoutez une nouvelle colonne de type décimal, appelée AREA, en utilisant le bouton Nouveau champ :
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4. Cliquez sur OK
Le nouveau champ sera ajouté (à l’extrême droite du tableau ; vous devrez peut-être faire défiler le tableau
horizontalement pour le voir). Cependant, pour le moment, il n’est pas rempli, il y a juste beaucoup de valeurs
NULL.
Pour résoudre ce problème, nous devrons calculer les superficies.

1. Ouvrez la calculatrice de champ avec le bouton .
Vous obtiendrez ce dialogue :
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2. Cochez la case Mettre à jour les champs existants

3. Sélectionnez AREA dans le menu déroulant des champs

4. Sous l’onglet Expression, développez le groupe de fonctions Geometry dans la liste et trouvez $area.
5. Double-cliquez dessus pour qu’il apparaisse dans le champ Expression

6. Cliquez sur OK
7. Faites défiler le champ AREA dans la table attributaires et vous remarquerez qu’il est rempli de valeurs

(vous devrez peut-être cliquer sur l’en-tête de la colonne pour actualiser les données).

Note: Ces zones respectent les paramètres des unités de surface du projet, elles peuvent donc être en mètres
carrés ou en degrés carrés.

5. Appuyez sur pour enregistrer les modifications et quittez le mode d’édition avec basculer en mode édition.
6. Fermer la table d’attributs

Maintenant que nous avons les données, utilisons-les pour rendre la couche landuse.
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1. Ouvrez l’onglet proprietes couche du dialogue Symbologie pour la couche landuse.
2. Changer le style de classification de Categorise à Gradue.
3. Changer la Valeur à AREA.
4. Sous plage couleurs, choisissez l’option créer une nouvelle plage de couleurs … :

5. Choisissez degrade (si ce n’est pas déjà sélectionné) et cliquez sur OK. Vous verrez ceci :
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Vous utiliserez ceci pour désigner la zone, avec des petites zones comme Couleur 1 et des grandes zones comme
Couleur 2.

6. Choisissez les couleurs appropriées
Dans cet exemple, le résultat doit ressembler à cela :
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7. Cliquez sur OK
8. Vous pouvez enregistrer la plage de couleur en sélectionnant sauvegarder la plage couleurs… sous l’onglet plage

de couleurs. Choisissez un nom approprié pour la plage de couleurs et cliquez sur sauvegarder. Vous pourrez
maintenant sélectionner la même plage de couleurs facilement sous toutes les plages de couleurs.

9. Sous Mode choisissez Nombre égal (Quantile) .
10. Cliquez sur Classer.

Maintenant, vous aurez quelque chose comme ça :
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Laissez tout le reste tel quel.
11. Cliquez sur OK :
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3.3.4 ��� Essayez vous-même : Affiner la classification

• Modifiez les valeurs Mode et Classes jusqu’à obtention d’une classification qui ait du sens.

Réponse
The settings you used might not be the same, but with the values Classes = 6 andMode = Natural Breaks (Jenks) (and
using the same colors, of course), the map will look like this:

3.3.5 ��� Follow Along: Rule-based Classification

Il est souvent utile de combiner plusieurs critères pour une classification, mais une classification normale ne prend
malheureusement d’un seul attribut en compte. C’est là que la classification basée sur de règles est très pratique.
Dans cette leçon, nous allons représenter la couche landuse de manière à identifier facilement la ville principale
de l’autre zone résidentielle et des autres types d’utilisation du sol (en fonction de leur superficie).

1. Ouvrez le dialogue Propriétés de la couche pour la couche landuse.
2. Passez à l’onglet Symbologie
3. Changez le style de classification en basé sur des règles.

QGIS affichera automatiquement les règles qui représentent la classification actuelle mise en œuvre pour cette
couche. Par exemple, après avoir terminé l’exercice ci-dessus, vous pouvez voir quelque chose comme ceci :
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4. Cliquez et glissez pour sélectionner toutes les règles

5. Utilisez le bouton Supprimer règles sélectionnées pour supprimer toutes les règles existantes
Ajoutons maintenant nos règles coutumières.

1. Cliquez sur le bouton ajouter regle.
2. Le dialogue modifier regle apparaît alors
3. Entrez Swellendam city sous la forme etiquette

4. Cliquez sur le bouton à côté de la zone de texte Filtre pour ouvrir le construire une expression.
5. Entrez le critère "name" = "Swellendam" et validez

6. Back to the Edit rule dialog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border

108 Chapter 3. Module : Classer des données vectorielles



QGIS Training Manual

7. Cliquez sur OK
8. Répétez les étapes ci-dessus pour ajouter les règles suivantes :

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam'. Choose a pale blue-grey Fill color

2. etiquette Big non residential areas avec le critère "landuse" <> 'residential' and
"AREA" >= 605000. Choisissez une couleur verte moyenne.

Ces filtres sont exclusifs, en ce sens qu’ils excluent des zones sur la carte (les zones non résidentielles
inférieures à 605 000 (mètres carrés) ne sont incluses dans aucune des règles).

3. Nous allons capturer les entités restantes en utilisant une nouvelle règle intitulée Small non residential
areas. Au lieu d’une expression de filtre, vérifiez le Else. Donnez à cette catégorie une couleur vert
pâle appropriée.
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Vos règles devraient maintenant ressembler à ceci :

9. Appliquer cette symbologie
Votre carte ressemblera à quelque chose comme ça :
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Maintenant que vous avez une carte avec Swellendam, le quartier résidentiel le plus important et d’autres quartiers
non résidentiels colorés en fonction de leur taille.

3.3.6 Conclusion

La symbologie nous permet de représenter les attributs d’une couche d’une façon facile à lire. Cela nous permet aussi
bien qu’au lecteur de carte de comprendre la signification de caractéristiques, en utilisant tout attribut pertinent que
nous choisissons. En fonction des problèmes auxquels vous faites face, vous appliquerez différentes techniques de
classification pour les résoudre.

3.3.7 La suite ?

Nous avons maintenant une carte de belle apparence, mais comment allons-nous sortir de QGIS dans un format que
nous pouvons imprimer, ou en faire une image ou un PDF ? C’est le sujet de la prochaine leçon !
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Module : Mise en page des cartes

Dans ce module, vous apprendrez à utiliser la mise en page de QGIS pour produire des cartes de qualité avec tous les
composants de carte nécessaires.

4.1 Leçon : Utilisation de mise en page

Maintenant que vous avez une carte, vous devez pouvoir l’imprimer ou l’exporter vers un document. La raison en
est qu’un fichier de carte SIG n’est pas une image. Il enregistre plutôt l’état du programme SIG, avec des références
à toutes les couches, leurs étiquettes, leurs couleurs, etc. Ainsi, pour quelqu’un qui ne dispose pas des données ou
du même programme SIG (comme QGIS), le fichier de carte sera inutile. Heureusement, QGIS peut exporter son
fichier de carte dans un format que n’importe quel ordinateur peut lire, ainsi qu’imprimer la carte si vous avez une
imprimante connectée. L’exportation et l’impression sont toutes deux gérées par la fonction Mise en page.
L’objectif de cette leçon: Utiliser Mise en page QGIS pour créer une carte avec tous les paramètres requis.

4.1.1 ��� Pas à pas : Le gestionnaire de mise en page

QGIS vous permet de créer plusieurs cartes en utilisant le même fichier cartographique. Pour cette raison, il dispose
d’un outil appelé Gestionnaire mise en page.

1. Cliquez sur l’entrée de menu Projet ► Gestionnaire de msie en page… pour ouvrir cet outil. Vous verrez
apparaître un dialogue Gestionnaire de mise en page vide.
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2. Sous Un nouveau depuis le modèle, sélectionnez Mise en page vide et appuyez sur le bouton Créer….
3. Donnez à la nouvelle mise en page le nom de Swellendam et cliquez sur OK.
4. Vous verrez maintenant la fenêtre Mise en page :

Vous pouvez également créer cette nouvelle mise en page via le menu Projet ► Nouvelle mise en page….
Quel que soit le chemin que vous empruntez, la nouvelle mise en page est désormais accessible depuis le menu Projet
► Mise en page ►, comme dans l’image ci-dessous.
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4.1.2 ��� Pas à pas : Composition basique de carte

Dans cet exemple, la composition était déjà telle que nous la voulions. Assurez-vous de faire de même.
1. Faites un clic droit sur la feuille dans la partie centrale de la fenêtre de mise en page et choisissez Propriétés de

page… dans le menu contextuel.
2. Vérifiez que les valeurs dans l’onglet Propriétés élément sont définies comme suit :

• taille: A4.
• Orientation : Paysage.

Vous avez maintenant la mise en page que vous souhaitez, mais cette page est encore vierge. Il manque
clairement une carte. Ajoutons cela !

3. Cliquez sur le bouton Ajouter une carte.
Avec cet outil activé, vous pourrez placer une carte sur la page.

4. Cliquez et faites glisser un bloc sur la page blanche :
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La carte apparaîtra sur la page.
5. Déplacez la carte en cliquant et en vous déplaçant autour:

6. Redimensionnez-le en cliquant et en faisant glisser sur les bords :
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Note: Votre carte peut être très différente, bien sûr ! Cela dépend de comment est configuré votre propre
projet. Mais pas de panique ! Ces instructions sont générales, donc elles fonctionneront de la même manière,
peu importe à quoi ressemble la carte.

7. N’oubliez pas de laisser des marges sur les bords, et un espace sur le dessus pour le titre.
8. Zoomez et dézoomez sur la page (mais pas sur la carte !) en utilisant ces boutons :

9. Zoomez et faites un panoramique de la carte dans la fenêtre principale de QGIS. Vous pouvez également
effectuer un panoramique de la carte en utilisant l’outil déplacer le contenu de l’element.
La vue de la carte s’actualise au fur et à mesure que vous faites un zoom avant ou arrière.

10. Si, pour une raison quelconque, la vue de la carte ne se rafraîchit pas correctement, vous pouvez forcer la carte
à se rafraîchir en cliquant sur le bouton Rafraîchir la vue.
N’oubliez pas que la taille et la position que vous avez indiquées sur la carte n’ont pas besoin d’être définitives.
Vous pouvez toujours revenir et la modifier plus tard si vous n’êtes pas satisfait. Pour l’instant, vous devez vous
assurer que vous avez bien enregistré votre travail sur cette carte. Étant donné qu’une mise en page dans QGIS
fait partie du fichier principal de la carte, vous devez enregistrer votre projet.

11. Allez à la page mise en page ► sauvegarder projet. C’est un raccourci pratique vers celui du dialogue
principal.
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4.1.3 ��� Pas à pas : Ajout d’un titre

Votre carte a maintenant fière allure sur la page, mais vos lecteurs/utilisateurs ne sont pas encore informés de ce qui se
passe. Ils ont besoin d’un contexte, et c’est ce que vous leur fournirez en ajoutant des éléments de carte. Commençons
par ajouter un titre.

1. Cliquez sur le bouton ajouter etiquette.
2. Cliquez sur la page, au-dessus de la carte, acceptez les valeurs suggérées dans le dialogue nouvelles proprietes

element, et une étiquette apparaîtra en haut de la carte.
3. Redimensionnez-la et place-la en haut au centre de la page. Elle peut être redimensionnée et déplacée de la

même façon que lorsque vous avez redimensionné et déplacé la carte.
Lorsque vous déplacez le titre, vous remarquerez que des lignes directrices apparaissent pour vous aider à
positionner le titre au centre de la page.
Cependant, il existe également un outil dans la barre d’outils des actions pour aider à positionner le titre par
rapport à la carte (et non à la page) :

4. Cliquez sur la carte pour la sélectionner
5. Maintenez Shift sur votre clavier et cliquez sur l’étiquette de sorte que la carte et l’étiquette soient toutes

deux sélectionnées.

6. Cherchez le bouton aligner les éléments sélectionnés à gauche et cliquez sur la liste déroulante à côté pour faire
apparaître les options de positionnement et cliquez sur aligner centré :

Maintenant, le cadre de l’étiquette est centré sur la carte, mais pas le contenu. Pour centrer le contenu de
l’étiquette :
1. Sélectionnez l’étiquette en cliquant dessus.
2. Cliquez sur l’onglet proprietes element dans le panneau latéral de la fenêtre de mise en page.
3. Changez le texte de l’étiquette en « Swellendam » :
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4. Utilisez cette interface pour définir les options de police et d’alignement sous la section Apparence :
1. Choisissez une police large mais raisonnable (l’exemple utilisera la police par défaut avec une taille

de 36)
2. Définissez le Alignement horizontal à Centrer.

Vous pouvez également changer la couleur de la police de caractère, mais il est probablement préférable
de la laisser en noir, comme par défaut.

5. La configuration par défaut n’ajoute pas de cadre autour de la boîte de texte du titre. Cependant, si vous
le souhaitez, vous pouvez le faire :
1. Dans l’onglet Propriétés de l’objet, faites défiler vers le bas jusqu’à ce que vous voyiez l’option Cadre.
2. Cochez la case Cadre pour activer le cadre. Vous pouvez également changer la couleur et l’épaisseur

du cadre.
Dans cet exemple, nous n’activerons pas le cadre, ainsi voici notre page telle qu’actuellement :
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Pour vous assurer que vous ne déplacez pas accidentellement ces éléments maintenant que vous les avez alignés,
vous pouvez les verrouiller :
1. Sélectionnez à la fois l’étiquette et les éléments de la carte

2. Cliquez sur le bouton Bloquer éléments sélectionnés dans la barre d’outils Actions.

Note: Cliquez sur le bouton Déverrouiller tous les éléments dans la barre d’outils Actions pour pouvoir
modifier à nouveau les éléments.

4.1.4 ��� Pas à pas : Ajout d’une légende

Le lecteur de carte doit également être capable de voir ce que signifient réellement les différents éléments de la carte.
Dans certains cas, comme les noms de lieux, cela est assez évident. Dans d’autres cas, c’est plus difficile à deviner,
comme les couleurs des forêts. Ajoutons une nouvelle légende.

1. Cliquez sur le bouton Ajouter légende.
2. Cliquez sur la page pour placer la légende, acceptez les valeurs suggérées dans le dialogue Nouvelle propriété

de élément,
3. Une légende est ajoutée à la page de mise en page, montrant la symbologie des couches telle qu’elle est définie

dans le dialogue principal.
4. Comme d’habitude, vous pouvez cliquer et déplacer l’objet là où vous le souhaitez :
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4.1.5 ��� Pas à pas : Personnalisation des éléments de légende

Pas tout dans la légende n’est nécessaire, alors enlevons quelques éléments non souhaités.
1. Dans l’onglet Propriétés de l’élément, vous trouverez le groupe Eléments légende.

2. Décochez la case Mise à jour automatique, vous permettant de modifier directement les éléments de la
légende

3. Sélectionnez l’entrée avec buildings.

4. Supprimez-le de la légende en cliquant sur le bouton
Vous pouvez aussi renommer les éléments.

1. Sélectionnez une couche dans la même liste.

2. Cliquez sur le bouton Editer les propriétés de l’élément sélectionné.
3. Renommez les couches en Places, Roads and Streets, Surface Water et Rivers.

Vous pouvez également les commander à nouveau :
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Comme la légende sera probablement élargie avec les nouveaux noms des couches, vous pouvez déplacer et
redimensionner la légende et/ou la carte. Voici le résultat :
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4.1.6 ��� Pas à pas : Exporter sa carte

Note: Avez-vous pensé à souvent sauvegarder votre travail ?

La carte est enfin prête pour l’exportation ! Vous verrez les boutons d’exportation dans le coin supérieur gauche de la
fenêtre de mise en page :

• Imprimer : interface avec une imprimante. Comme les options d’impression diffèrent selon le modèle
d’imprimante avec lequel vous travaillez, il est probablement préférable de consulter le manuel de l’imprimante
ou un guide général d’impression pour plus d’informations sur ce sujet.
Les autres boutons vous permettent d’exporter la page de la carte vers un fichier.

• Exporter comme image : vous donne une sélection de divers formats d’images courants parmi lesquels vous
pouvez choisir. C’est probablement l’option la plus simple, mais l’image qu’elle crée est « figée » et difficile à
modifier.

• Exporter au format SVG : Si vous envisagez d’envoyer la carte à un cartographe (qui peut vouloir l’éditer pour la
publier), il est préférable de l’exporter en SVG. SVG signifie « Scalable Vector Graphic », et peut être importé
dans des programmes comme Inkscape ou d’autres logiciels d’édition d’images vecteur.

• Exporter au format PDF : Si vous devez envoyer la carte à un client, il est plus courant d’utiliser un PDF, car il
est plus facile de configurer les options d’impression pour un PDF. Certains cartographes peuvent également
préférer le format PDF, s’ils disposent d’un programme qui leur permet d’importer et de modifier ce format.

Pour nos fins, nous allons utiliser un PDF.

1. Cliquez sur le bouton Exporter au format PDF

2. Choisissez un emplacement de sauvegarde et un nom de fichier comme d’habitude. La boîte de dialogue
suivante s’affiche.
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3. Vous pouvez maintenant utiliser en toute sécurité les valeurs par défaut et cliquer sur Sauvegarder.
QGIS procédera à l’exportation de la carte et ajoutera un message au dialogue de mise en page dès qu’il sera
terminé.

4. Cliquez sur l’hyperlien dans le message pour ouvrir le dossier dans lequel le PDF a été enregistré dans le
gestionnaire de fichiers de votre système

5. Ouvrez-le et voyez à quoi ressemble votre mise en page.
Tout va bien ? Félicitations pour votre premier projet de carte QGIS achevé !

6. Quelque chose d’insatisfaisant ? Retournez à la fenêtre QGIS, faites les modifications appropriées et exportez
à nouveau.

7. N’oubliez pas de sauvegarder votre fichier de projet.
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4.1.7 Conclusion

Vous savez maintenant comment créer une carte statique de base. Nous pouvons aller plus loin et créer une mise en
page de carte qui s’adapte dynamiquement, avec plus d’éléments de mise en page.

4.2 Leçon : Créer une mise en page dynamique

Maintenant que vous avez appris à créer une mise en page de base, nous allons un peu plus loin et créons une mise en
page qui s’adapte dynamiquement à l’étendue de notre carte et aux propriétés de la page, par exemple lorsque vous
changez la taille de la page. De même, la date de création s’adaptera de manière dynamique.

4.2.1 ��� Follow Along: Creating the dynamic map canvas

1. Chargez les jeux de données au format ESRI Shapefile protected_areas.shp, places.shp,
rivers.shp etwater.shp dans le canevas de carte et modifiez leurs propriétés à votre propre convenance.

2. Une fois que tout est rendu et symbolisé à votre convenance, cliquez sur Nouvelle mise en page d’impression dans la
barre d’outils Projet ou choisissez Projet ► Nouvelle mise en page d’impression. Vous serez invité à choisir
un titre pour la nouvelle mise en page.

3. Nous voulons créer une mise en page cartographique composée d’un en-tête et d’une carte de la région près de
Swellendam, en Afrique du Sud. La mise en page doit avoir une marge de 7,5 mm et l’en-tête doit avoir une
hauteur de 36 mm.

4. Créez un élément de carte appelé carte principale sur le canevas et allez dans le panneau mise en
page. Descendez jusqu’à la section Variables et trouvez la partie mise en page. Ici, nous définissons quelques
variables que vous pouvez utiliser dans toute la mise en page dynamique. Allez dans le panneau mise en page
et descendez jusqu’à la section Variables. La première variable définira la marge. Appuyez sur le bouton
et tapez le nom sw_layout_margin. Définissez la valeur à 7.5. Appuyez à nouveau sur le bouton et
tapez le nom w_layout_height_header. Mettez la valeur à 36.

5. Vous êtes maintenant prêt à créer automatiquement la position et la taille du canevas de la carte au moyen des
variables. Assurez-vous que votre élément de carte est sélectionné, allez dans le panneau proprietes element,
faites défiler vers le bas et ouvrez la section Position et taille. Cliquez sur l’expression passer outre les donnees

pour X et à partir de l’entrée Variables, choisissez @sw_layout_margin.

6. Cliquez sur l’expression passer outre les données définies pour Y, choisissez editer… et tapez la formule: :

to_real(@sw_layout_margin) + to_real(@sw_layout_height_header)

7. Vous pouvez créer la taille de l’élément de carte en utilisant les variables largeur et hauteur. Cliquez sur
l’expression passer outre les donnees definies pour largeur et choisissez Edit … à nouveau. Remplissez la formule: :

@layout_pagewidth - @sw_layout_margin * 2

Cliquez sur l’expression passer outre les donnees definies pour hauteur et choisissez Edit …. Remplissez ici la
formule: :

@layout_pageheight - @sw_layout_height_header - @sw_layout_margin * 2

8. Nous allons également créer une grille contenant les coordonnées de l’étendue du canevas de la carte principale.
Allez à nouveau sur proprietes element et choisissez la section grille. Insérez une grille en cliquant sur le bouton

. Cliquez sur modifier grille … et définissez l’intervalle Intervalle pour X, Y et Offset selon l’échelle de la
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carte que vous avez choisie dans le canevas principal du QGIS. Le Type de grille Cross est très bien adapté à
nos besoins.

4.2.2 ��� Follow Along: Creating the dynamic header

1. Insérez un rectangle qui contiendra l’en-tête avec le bouton Ajouter une forme. Dans le panneau:
guilabel:Éléments, entrez le nom header.

2. Encore une fois, allez dans la section proprietes element et ouvrez la section position et taille. En utilisant
passer outre les donnees definies, choisissez la variable sw_layout_margin pour X ainsi que pour Y. largeur sera
définie par l’expression: :

@layout_pagewidth - @sw_layout_margin * 2

et hauteur par la variable sw_layout_height_header.
3. Nous allons insérer une ligne horizontale et deux lignes verticales pour diviser l’en-tête en différentes sections

à l’aide de la fonction ajouter element noeud. Créez une ligne horizontale et deux lignes verticales et nommez-les
Ligne horizontale, Ligne verticale 1, Ligne verticale 2.
1. Pour la ligne horizontale

1. Mettez X à la variable sw_layout_margin.
2. Définissez l’expression pour Y à: :

@sw_layout_margin + 8

3. Définissez l’expression pour largeur à: :

@layout_pagewidth - @sw_layout_margin * 3 - 53.5

2. Pour la première ligne verticale :
1. Définissez l’expression pour X à: :

@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Mettez Y à la variable sw_layout_margin.
3. La hauteur doit être la même que celle de l’en-tête que nous avons créé, donc mettez hauteur à la

variable sw_layout_height_header.
3. La deuxième ligne verticale est placée à gauche de la première

1. Définissez l’expression pour X à: :

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. Mettez Y à la variable sw_layout_margin.
3. La hauteur doit être la même que celle de l’autre ligne verticale, donc mettez hauteur à la variable

sw_layout_height_header.
La figure ci-dessous montre la structure de notre mise en page dynamique. Nous allons remplir les zones créées
par les lignes avec quelques éléments.
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4.2.3 ��� Follow Along: Creating labels for the dynamic header

1. Le titre de votre projet QGIS peut être inclus automatiquement. Le titre est défini dans les proprietes projet.
Insérez un label avec le bouton ajouter etiquette et entrez le nom project title (variable). Dans
le panneau Main Properties du panneau proprietes element, entrez l’expression: :

[%@project_title%]

Définissez la position de l’étiquette.
1. Pour X, utilisez l’expression: :

@sw_layout_margin + 3

2. Pour Y, utilisez l’expression: :

@sw_layout_margin + 0.25

3. Pour largeur, utilisez l’expression: :

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Entrez 11,25 pour hauteur.
Sous Apparence, définissez la taille de la police à 16 pt.

2. La deuxième étiquette comprendra une description de la carte que vous avez créée. Là encore, insérez une
étiquette et nommez-la description de la carte. Dans le champ Propriétés principales, entrez le
texte description de la carte. Nous inclurons également

printed on: [%format_date(now(),'dd.MM.yyyy')%]

Nous avons utilisé ici deux fonctions Date et Heure (now et format_date).
Définissez la position de l’étiquette.
1. Pour X, utilisez l’expression: :
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@sw_layout_margin + 3

2. Pour Y, utilisez l’expression: :

@sw_layout_margin + 11.5

3. La troisième étiquette comprendra des informations sur votre organisation. Nous allons d’abord créer quelques
variables dans le menu Variables des Propriétés de l’élément. Allez dans le menu Mise en page, cliquez sur
le bouton à chaque fois et entrez les noms o_department, o_name, o_adress et o_postcode.
Dans la deuxième ligne, entrez les informations concernant votre organisation. Nous utiliserons ces variables
dans la section Propriétés principales.
Dans Propriétés principales, entrez

[% @o_name %]
[% @o_department %]
[% @o_adress %]
[% @o_postcode %]

Définissez la position de l’étiquette.
1. Pour X, utilisez l’expression: :

@layout_pagewidth - @sw_layout_margin - 49.5

2. Pour Y, utilisez l’expression: :

@sw_layout_margin + 15.5

3. Pour largeur, utilisez 49.00.
4. Pour hauteur, utilisez l’expression: :

@sw_layout_height_header - 15.5
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4.2.4 ��� Follow Along: Adding pictures to the dynamic header

1. Utilisez le bouton ajouter image pour placer une image au-dessus de votre étiquette information
d'organisation. Après avoir saisi le nom logo de l'organisation, définissez la position et
la taille du logo :
1. Pour X, utilisez l’expression: :

@layout_pagewidth - @sw_layout_margin - 49.5

2. Pour Y, utilisez l’expression: :

@sw_layout_margin + 3.5

3. Pour largeur, utilisez 39.292
4. Pour hauteur, utilisez 9.583

Pour inclure un logo de votre organisation, vous devez enregistrer votre logo sous votre répertoire d’origine et
entrer le chemin sous Propriétés principales ► Source de l’image.

2. Notre tracé a encore besoin d’une flèche nord. Celle-ci sera également insérée en utilisant Ajouter flèche du nord.
Nous utiliserons la flèche nord par défaut. Définissez la position :
1. Pour X, utilisez l’expression: :

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Pour Y, utilisez l’expression: :
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@sw_layout_margin + 9

3. Pour Largeur, utilisez 21.027
4. Pour Hauteur, utilisez 21.157.

4.2.5 ��� Follow Along: Creating the scalebar of the dynamic header

1. Pour insérer une barre d’échelle dans l’en-tête, cliquez sur Ajouter barre d’échelle et placez-la dans le rectangle
au-dessus de la flèche nord. Dans Carte sous Propriétés principales choisissez votre carte principale
(Carte 1). Cela signifie que l’échelle change automatiquement selon l’étendue que vous choisissez dans le
canevas principal de QGIS. Choisissez le Style Numérique. Cela signifie que nous insérons une échelle simple
sans barre d’échelle. L’échelle a encore besoin d’une position et d’une taille.
1. Pour X, utilisez l’expression: :

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Pour Y, utilisez l’expression: :

@sw_layout_margin + 1

3. Pour Largeur, utilisez 25.
4. Pour Hauteur, utilisez 8.
5. Placez le Point de référence au centre.

Félicitations ! Vous avez créé votre première mise en page de carte dynamique. Jetez un coup d’œil à la mise en
page et vérifiez si tout est comme vous le souhaitez ! La mise en page de la carte dynamique réagit automatiquement
lorsque vous modifiez les propriétés de la Page. Par exemple, si vous changez la taille de la page de DIN A4 à DIN
A3, cliquez sur le bouton Rafraîchir la vue et la conception de la page est adaptée.
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4.2.6 La suite ?

Sur la page suivante, vous aurez un devoir à compléter. Cela vous permettra de pratiquer les techniques que vous
avez apprises jusqu’à présent.

4.3 Tâche 1

Ouvrez votre projet de carte existant et révisez le complètement. Si vous observez de petites erreurs ou des éléments
que vous vouliez réparer auparavant, faites-le maintenant.
Lors de la personnalisation de votre carte, posez-vous continuellement des questions. La carte est-elle facile à lire et
à comprendre pour quelqu’un qui n’est pas familier avec les données ? Si je voyais cette carte sur Internet, ou sur une
affiche ou dans un magazine, serait-elle capable de capturer mon attention ? Est-ce que je serais intéressé à lire cette
carte si elle n’était pas la mienne ?
Si vous suivez ce cours à un niveau ★☆☆ Basique ou ★★☆ Intermédiaire, étudiez aussi les techniques dans les sections
plus avancées. Si vous voyez quelque chose que vous aimeriez faire dans votre carte, pourquoi ne pas essayer de
l’appliquer ?
Si vous suivez ce cours avec l’aide de quelqu’un, cette personne peut vous demander de soumettre une version finale
de votre carte, exportée au format PDF, pour l’évaluation. Si vous suivez ce cours en auto-apprentissage, il est
recommandé que vous évaluiez votre propre carte en utilisant les mêmes critères de sélection. Votre carte sera évaluée
sur l’apparence générale et la symbologie de la carte elle-même, aussi bien que sur l’apparence et la disposition de la
page et des éléments de la carte. Rappelez-vous que l’élément clé pour évaluer l’apparence des cartes sera toujours
la facilité d’utilisation. Une carte est faite pour être regardée et plus il est facile de la comprendre d’un simple coup
d’œil, mieux c’est.
Joyeuse personnalisation!

4.3.1 Conclusion

Les quatre premiers modules vous ont appris à créer et mettre en forme une carte vecteur. Dans les quatre prochains
modules, vous apprendrez à utiliser QGIS pour une complète analyse en SIG. Il s’agira notamment de créer et éditer
des données vectorielles ; analyser des données vectorielles ; utiliser et analyser des données raster ; et utiliser le SIG
pour résoudre un problème de bout en bout, à l’aide de données raster et vecteur.
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Module : Créer des données vectorielles

Créer des cartes à partir de données existantes n’est qu’un début. Dans ce module, vous apprendrez à modifier des
données vectorielles existantes et créer entièrement de nouveaux jeux de données.

5.1 Leçon : Création d’un nouveau jeu de données vectorielles

Les données que vous utilisez doivent venir de quelque part. Pour la plupart des applications, les données existent
déjà ; mais plus le projet est particulier et spécifique, moins il est probable que les données soient déjà disponibles.
Dans ce cas, vous devez créer vos propres données.
Objectif de cette leçon : Créer un nouveau jeu de données vectorielles.

5.1.1 ��� Follow Along: The Layer Creation Dialog

Avant que vous puissiez créer de nouvelles données vectorielles, vous avez besoin d’un jeu de données vectorielles
auquel les ajouter. Dans notre cas, vous commencerez par créer entièrement des nouvelles données, plutôt que de
modifier un jeu de données existant. Par conséquent, vous devrez définir votre propre nouvel ensemble de données
en premier.

1. Ouvrez QGIS et créez un nouveau projet vierge.
2. Naviguez et cliquez sur l’entrée de menu Couche ► Créer une couche ► Nouvelle couche de fichier de forme.

Le dialogue nouvelle couche Shapefile s’affiche, vous permettant de définir une nouvelle couche .
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3. Cliquez sur… pour le champ Nom fichier. Un dialogue de sauvegarde apparaîtra.
4. Naviguez vers le répertoire exercise_data.
5. Enregistrez votre nouvelle couche sous le nom de school_property.shp.

C’est important de décider quelle sorte de jeu de données vous voulez à ce stade. Chaque différent type de
couche vectorielle est « construit différemment » dans le fond, alors une fois que vous avez créé la couche, vous
ne pouvez changer son type.
Pour le prochain exercice, nous allons créer de nouvelles entités qui décrivent des zones. Pour ces éléments,
vous devrez créer un ensemble de données polygone .

6. Pour type geometrie, sélectionnez Polygone dans le menu déroulant :
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Cela n’a pas d’impact sur le reste de la boîte de dialogue, mais cela produira le bon type de géométrie à utiliser
quand le jeu de données vectorielles sera créé.
Le champ suivant vous permet de spécifier le système de référence des coordonnées, ou CRS. Le CRS est
une méthode permettant d’associer des coordonnées numériques à une position à la surface de la Terre. Voir
Utiliser les projections dans le manuel d’utilisation pour en savoir plus.
Pour cet exemple, nous utiliserons le CRS par défaut associé à ce projet, qui est WGS84.

Ensuite, il y a une collection de champs regroupés sous nouvel attribut. Par défaut, une nouvelle couche n’a qu’un
seul attribut, le champ « id » (que vous devriez voir dans la liste des champs champs) ci-dessous. Cependant,
pour que les données que vous créez soient utiles, vous devez en fait dire quelque chose sur les entités que vous
allez créer dans cette nouvelle couche. Pour nos besoins actuels, il suffira d’ajouter un champ appelé « nom »
qui contiendra des « données textuelles » et sera limité à une longueur de texte de 80 caractères.

7. Reproduisez la configuration ci-dessous, puis cliquez sur le bouton Reproduisez la configuration ci-dessous, puis
cliquez sur le bouton :guilabel:`ajouter attribut a la liste

8. Vérifiez que votre fenêtre ressemble maintenant à ceci:
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9. Cliquez sur OK
La nouvelle couche devrait apparaître dans votre panneau Légende de carte.

5.1.2 ��� Follow Along: Data Sources

Quand vous créez de nouvelles données, cela doit évidemment être sur des objets qui existent réellement sur le terrain.
Par conséquent, vous devrez obtenir vos informations à quelque part.
Il y a plusieurs façons différentes d’obtenir des données sur des objets. Par exemple, vous pouvez utiliser un GPS
pour prendre des points dans le monde réel, puis importer les données dans QGIS par la suite. Ou vous pouvez lever
des points à l’aide d’un théodolite, et entrer manuellement les coordonnées pour créer de nouvelles fonctionnalités.
Ou vous pouvez utiliser le processus de numérisation pour localiser des objets à partir de données de télédétection,
telles que l’imagerie par satellite ou la photographie aérienne.
Pour notre exemple, vous utiliserez l’approche de numérisation. Des échantillons de jeu de données raster sont fournis,
ainsi vous pourrez les importer si nécessaire.
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1. Cliquez sur le bouton gestionnaire source de donnees.

2. Sélectionnez Raster sur le côté gauche.
3. Dans le panneau Source, cliquez sur le bouton… :
4. Naviguez vers exercise_data/raster/.
5. Sélectionnez le fichier 3420C_2010_327_RGB_LATLNG.tif.
6. Cliquez sur Open pour fermer la fenêtre de dialogue.

7. Cliquez sur ajouter et fermer. Une image se chargera dans votre carte.
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8. Si vous ne voyez pas apparaître une image aérienne, sélectionnez la nouvelle couche, faites un clic droit et
choisissez zoom sur la couche dans le menu contextuel.
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9. Cliquez sur le bouton Zoom In, et zoomez sur la zone surlignée en bleu ci-dessous :
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Vous êtes maintenant prêt à numériser ces trois champs :
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Avant de commencer à numériser, déplaçons la couche school_property au-dessus de l’image aérienne.
1. Sélectionnez la couche school_property dans le panneau couches et faites-la glisser vers le haut.

Afin de commencer la numérisation, vous devez entrer enmode d’édition. Les logiciels SIG nécessitent souvent cela
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pour vous empêcher de modifier ou de supprimer accidentellement des données importantes. Le mode d’édition est
activé ou désactivé pour chaque couche individuellement.
Pour entrer en mode édition pour la couche school_property :

1. Cliquez sur la couche school_property dans le panneau couches pour la sélectionner.

2. Cliquez sur le bouton basculer en edition.
Si vous ne trouvez pas ce bouton, vérifiez que la barre d’outil Numérisation est activée. Il devrait y avoir une
coche à côté de l’entrée du menu Vue ► Barre d’outils ► Numérisation.
Dès que vous êtes en mode édition, vous verrez que certains outils de numérisation sont devenus actifs :

• Capture Polygone.

• outil noeud

D’autres boutons pertinents sont toujours inactifs, mais deviendront actifs lorsque nous commencerons à
interagir avec nos nouvelles données.
Notez que la couche school_property dans le panneau couches a maintenant l’icône du crayon, indiquant
qu’elle est en mode édition.

3. Cliquez sur le bouton Capture Polygone pour commencer à numériser nos champs d’école.
Vous remarquerez que le curseur de votre souris est devenu un réticule. Cela vous permet de placer plus
précisément les points que vous allez numériser. N’oubliez pas que même lorsque vous utilisez l’outil de
numérisation, vous pouvez faire un zoom avant et arrière sur votre carte en faisant tourner la molette de la
souris, et vous pouvez faire un panoramique en maintenant la molette de la souris enfoncée et en faisant glisser
la carte.
La première entité que vous allez numériser est le athletics field :

4. Commencez à numériser en cliquant sur un point n’importe où le long du bord du champ.
5. Placez plus de points en cliquant davantage le long du bord, jusqu’à ce que la forme que vous dessinez recouvre

complètement le champ.
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6. Après avoir placé votre dernier point, cliquez avec le bouton droit de la souris pour terminer le dessin du
polygone. Cela finalisera l’élément et vous montrera le dialogue Attributs.

7. Entrer les valeurs comme ci-dessous :
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8. Cliquez sur OK, et vous avez créé une nouvelle entité !

9. Dans le panneau couches, sélectionnez la couche school_property.
10. Faites un clic droit et choisissez ouvrir table d’attributs dans le menu contextuel.
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Dans la table, vous verrez l’élément que vous venez d’ajouter. En mode édition, vous pouvez mettre à jour les
données des attributs en double-cliquant sur la cellule que vous souhaitez mettre à jour.

5.1. Leçon : Création d’un nouveau jeu de données vectorielles 145



QGIS Training Manual

11. Fermez la table d’attribut.

12. Pour enregistrer la nouvelle entité que nous venons de créer, cliquez sur Bouton Enregistrer les modifications.
Souvenez-vous, si vous avez fait une faute pendant la numérisation d’une entité, vous pouvez toujours la modifier
après que vous l’ayez créée. Si vous avez fait une faute, continuez à numériser jusqu’à ce que vous ayez créé l’entité
comme au-dessus. Puis :

1. Cliquez sur le bouton outil de noeud.
2. Passez la souris sur un sommet que vous souhaitez déplacer et cliquez sur le sommet avec le bouton gauche de

la souris.
3. Déplacez la souris à l’emplacement correct du sommet, puis cliquez sur le bouton gauche. Le sommet sera

alors déplacé vers le nouvel emplacement.
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La même procédure peut être utilisée pour déplacer un segment de ligne, mais vous devrez survoler le point
médian du segment de ligne.

Si vous voulez annuler un changement, vous pouvez appuyer sur le bouton Annuler ou Ctrl+Z.

4. N’oubliez pas de sauvegarder vos modifications en cliquant sur le bouton Sauvegarder.

5. Une fois l’édition terminée, cliquez sur le bouton Basculer en mode Edition pour sortir du mode d’édition.
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5.1.3 ��� Essayez vous-même : Numériser des polygones

Numérisez l’école elle-même et le champ du haut. Utilisez cette image pour vous guider :

N’oubliez pas que chaque nouvelle entité doit avoir une valeur d’id unique !

Note: Quand vous avez fini d’ajouter des entités à une couche, rappelez-vous de sauvegarder vos modifications et
ensuite de quitter le mode d’édition.

Note: Vous pouvez styliser le remplissage, le contour et l’emplacement des étiquettes et le formatage de la
school_property en utilisant les techniques apprises dans les leçons précédentes.
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5.1.4 ��� Follow Along: Using Vertex Editor Table

Une autre façon d’éditer une entité est d’entrer manuellement les valeurs des coordonnées réelles pour chaque sommet
en utilisant la table Editeur de noeuds.

1. Assurez-vous que vous êtes en mode édition sur la couche school_property.

2. Si ce n’est pas déjà fait, cliquez sur le bouton outil noeud.
3. Déplacez la souris sur une des entités polygone que vous avez créé dans la couche school_property et

cliquez dessus avec le bouton droit de la souris. Cela sélectionnera l’entité et un panneau editeur de noeud
apparaîtra.

Note: Ce tableau contient les coordonnées des sommets de l’entité. Notez qu’il y a sept sommets pour cet
élément, mais que seuls six sont identifiés visuellement dans la zone de la carte. En y regardant de plus près,
on remarque que les lignes 0 et 6 ont des coordonnées identiques. Il s’agit des sommets de début et de fin de la
géométrie de l’entité, et ils sont nécessaires pour créer une entité polygone fermée.

4. Cliquez et faites glisser une case sur un ou plusieurs sommets de l’entité sélectionnée.
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Les sommets sélectionnés prendront une couleur bleue et la table editeur de noeuds aura les lignes
correspondantes en surbrillance, qui contiennent les coordonnées des sommets.
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5. Pourmettre à jour une coordonnée, double-cliquez à gauche sur la cellule du tableau que vous souhaitezmodifier
et saisissez la valeur mise à jour. Dans cet exemple, la coordonnée x de la ligne 4 est mise à jour de 20.4450
à 20.4444 .
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6. Après avoir saisi la valeur actualisée, appuyez sur la touche « Entrée » pour appliquer la modification. Vous
verrez le sommet se déplacer vers le nouvel emplacement dans la fenêtre de la carte.

7. Une fois l’édition terminée, cliquez sur le bouton Basculer en mode Edition pour sortir du mode d’édition et
enregistrer vos modifications.

5.1.5 ��� Essayez vous-même : Numériser des lignes

Nous allons numériser deux itinéraires qui ne sont pas déjà marqués sur la couche des routes ; l’un est un chemin,
l’autre est une piste. Notre chemin longe la bordure sud de la banlieue de Railton, commençant et se terminant à des
routes marquées :
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Notre piste est un peu plus loin au sud :
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1. Si la couche « roads » n’est pas dans votre carte, ajoutez-la à partir du fichier GeoPackage training-data.
gpkg inclus dans le dossier exercise_data des données d’entraînement que vous avez téléchargées. Voir
��� Pas à pas : Charger des données vectorielles depuis une base de données GeoPackage pour rappel de la
démarche.

2. Créez un nouveau jeu de données ESRI Shapefile appelé routes.shp``dans le dossier
:file:`exercise_data`, avec les attributs ``id et type (utilisez l’approche ci-dessus
pour vous guider).

3. Activez le mode édition de la couche guilabel:routes.

4. Puisque vous travaillez avec une entité linéaire, cliquez sur le bouton Ajouter ligne pour lancer le mode de
numérisation.

5. Un à la fois, numérisez le chemin et la piste sur la couche « routes ». Essayez de suivre les itinéraires aussi
précisément que possible, en ajoutant des points supplémentaires le long des virages ou des tournants.

6. Définissez la valeur de l’attribut type à path ou track.
7. Utilisez la boîte de dialogue proprietes couche pour ajouter du style à vos itinéraires. N’hésitez pas à utiliser
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des styles différents pour les chemins et les pistes.

8. Enregistrez vos modifications et quittez le mode d’édition en appuyant sur le bouton basculer mode édition.

Réponse
La symbologie n’a que peu d’importance, mais les résultats devraient ressembler plus ou moins à ceci :

5.1.6 Conclusion

Vous savez maintenant comment créer des entités ! Ce cours ne couvre pas l’ajout d’entités ponctuelles, car ce n’est
pas vraiment nécessaire une fois que vous avez travaillé avec des entités plus compliquées (lignes et polygones). Cela
fonctionne exactement de la même manière, hormis le fait que vous cliquez seulement une fois où vous voulez que le
point soit, lui donnez des attributs comme d’habitude, et ensuite l’entité est créée.
Savoir comment numériser est important car c’est une activité très courante dans les programmes SIG.

5.1.7 La suite ?

Les éléments d’une couche SIG ne sont pas seulement des images, mais des objets dans l’espace. Par exemple, les
polygones adjacents savent où ils se trouvent les uns par rapport aux autres. C’est ce qu’on appelle la topologie. Dans
la prochaine leçon, vous verrez un exemple de l’utilité de cette méthode.
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5.2 Leçon : Topologie des données

La topologie est un aspect utile des couches de données vectorielles, car il minimise les erreurs telles que les
chevauchements ou les lacunes.
Par exemple : si deux entités partagent une bordure, et que vous modifiez la bordure avec la topologie, alors vous
n’aurez pas besoin de modifier d’abord une entité, puis l’autre, et soigneusement aligner les bordures afin qu’elles
correspondent l’une avec l’autre. Vous pouvez plutôt modifier leur bordure commune et les deux entités changeront
en même temps.
Objectif de cette leçon: Comprendre la topologie par les exemples.

5.2.1 ��� Follow Along: Snapping

Le snapping facilite l’édition topologique. Le curseur de votre souris peut ainsi se fixer sur d’autres objets pendant
que vous numérisez. Pour définir les options d’accrochage :

1. Rendez-vous dans le menu Projet ► Options d’accrochage….
2. Configurez votre dialogue options Snapping (accrochage) pour activer la couche landuse avec Type vertex et

tolérance 12 pixels :

3. Assurez-vous que la case dans la colonne eviter les chevauchements est cochée.
4. Quittez le dialogue.

5. Sélectionnez la couche landuse et entrez en mode d’édition ( )
6. Vérifiez (sous Vue ► barre d’outils) que la barre d’outils numerisation avancee est activée.
7. Zoomez jusqu’à cette zone (activez des couches et des étiquettes si nécessaire) :
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8. Digitize this new (fictional) area shown in red:

9. Lorsque vous y êtes invité, donnez-lui un OGC_FID de 999, mais n’hésitez pas à laisser les autres valeurs
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inchangées.
Si vous faites attention lors de la numérisation, et que vous laissez le curseur se positionner sur les sommets des
zones adjacentes, vous remarquerez qu’il n’y aura pas d’écart entre votre nouvelle zone et les zones adjacentes
existantes.

10. Notez les outils undo et redo dans la barre d’outils numérisation avancée.

5.2.2 ��� Follow Along: Correct Topological Features

La topologie des entités peut parfois devoir être mise à jour. Dans notre zone d’étude, une zone a été transformée en
forêt, donc la couche landuse a besoin d’une mise à jour. Nous allons donc étendre et faire se rejoindre certaines
entités de la forêt dans cette zone :

Au lieu de créer de nouveaux polygones pour rejoindre les zones forestières, nous allons utiliser l’outil outil noeud
pour modifier et rejoindre les polygones existants.

1. Entrez en mode édition (s’il n’est pas déjà actif)

2. Sélectionnez l’outil outil noeud.
3. Choisissez une zone de forêt, sélectionnez un sommet et déplacez-le vers un sommet voisin afin que les deux

entités de la forêt se rencontrent :
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4. Cliquez sur les autres sommets et enclenchez-les en place.
Les bordures topologiquement correctes ressemblent à cela :
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Allez-y et rejoignez quelques autres domaines en utilisant l’outil outil de noeud.

Vous pouvez également utiliser l’outil ajouter entité polygone pour combler l’espace entre les deux polygones de
la forêt. Si vous avez activé l’option éviter les chevauchements, vous n’avez pas besoin d’ajouter chaque sommet
- ils seront ajoutés automatiquement si votre nouveau polygone chevauche les existants.
Si vous utilisez nos données d’exemple, vous devriez avoir une zone forestière ressemblant à celle-ci :

Ne vous inquiétez pas si vous avez regroupé plus, moins ou différentes zones de forêt.

5.2.3 ��� Follow Along: Tool: Simplify Feature

En continuant sur la même couche, nous allons tester l’outil Simplifier l’entité

1. Cliquez dessus pour l’activer.
2. Cliquez sur l’une des zones que vous avez jointes à l’aide de l’outil outil de noeud ou ajouter une entité. Vous

verrez ce dialogue :
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3. Modifiez le Tolérance et regardez ce qui se passe :

Cela vous permet de réduire le nombre de sommets.
4. Cliquez sur OK
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L’avantage de cet outil est qu’il vous offre une interface simple et intuitive pour la généralisation. Mais remarquez que
l’outil enlève de la topologie. Le polygone simplifié ne partage plus les limites avec ses polygones adjacents, comme
il le devrait. Cet outil est donc mieux adapté aux entités autonomes.
Avant de continuer, remettez le polygone dans son état d’origine en annulant le dernier changement.

5.2.4 ��� Essayez vous-même : Ajouter un anneau

L’outil Ajouter anneau vous permet d’ajouter un anneau intérieur à un élément de polygone (couper un trou dans
le polygone), à condition que le trou soit complètement contenu dans le polygone (toucher la limite est OK). Par
exemple, si vous avez numérisé les limites extérieures de l’Afrique du Sud et que vous devez ajouter un trou pour le
Lesotho, vous utiliserez cet outil.
Si vous expérimentez avec cet outil, vous remarquerez peut-être que les options d’accrochage peuvent vous empêcher
de créer un anneau à l’intérieur d’un polygone. Il vous est donc conseillé de désactiver l’option d’accrochage avant de
découper un trou.

1. Désactivez l’accrochage pour la couche landuse en utilisant le bouton activer accrochage (ou utilisez le
raccourci s).

2. Utilisez l’outil ajouter anneau pour créer un trou au milieu d’une géométrie de polygone.

3. Dessinez un polygone sur l’entité cible, comme si vous utilisiez l’outil Ajouter un polygone.
4. Lorsque vous cliquez avec le bouton droit de la souris, le trou est visible.

5. Remove the hole you just created using the Delete Ring tool. Click inside the hole to delete it.

Réponse
The exact shape doesn’t matter, but you should be getting a hole in the middle of your feature, like this one:
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• Undo your edit before continuing with the exercise for the next tool.

5.2.5 ��� Essayez vous-même : Ajouter une partie

L’outil Ajouter une partie vous permet d’ajouter une nouvelle partie à une entité, qui n’est pas en contact direct avec
la géométrie existante de l’entité. Par exemple, si vous avez numérisé les limites de l’Afrique du Sud continentale,
mais que vous n’avez pas encore ajouté les îles du Prince-Édouard, vous utiliserez cet outil pour les créer.

1. Sélectionnez le polygone auquel vous souhaitez ajouter la partie en utilisant l’outil
Sélectionner les entités par zone ou par clic simple.

2. Utilisez l’outil ajouter partie pour ajouter une zone périphérique.

3. Supprimez la partie que vous venez de créer à l’aide de l’outil supprimer la partie.

Note: Cliquez à l’intérieur de la partie pour la supprimer.

Réponse
1. First select the Bontebok National Park:

2. Now add your new part:
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3. Undo your edit before continuing with the exercise for the next tool.

5.2.6 ��� Follow Along: Tool: Reshape Features

L’outil Remodeler les entités est utilisé pour étendre un élément de polygone ou en couper une partie (le long de la
limite).
Extension :

1. Sélectionnez le polygone à l’aide de l’outil sélectionner les entités par surface ou par simple click.
2. Cliquez avec le bouton gauche de la souris à l’intérieur du polygone pour commencer à dessiner.
3. Dessinez une forme à l’extérieur du polygone. Le dernier sommet doit se trouver à l’intérieur du polygone.
4. Cliquez sur le bouton droit pour terminer la forme :
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Cela doit donner un résultat similaire à ça :

Coupez une partie :

1. Sélectionnez le polygone à l’aide de l’outil sélectionner les entités par surface ou par simple click.
2. Cliquez à l’extérieur du polygone.
3. Dessinez une forme à l’intérieur du polygone. Le dernier sommet doit se trouver à l’extérieur du polygone.
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4. Cliquez avec le bouton droit de la souris à l’extérieur du polygone :

Le résultat de ce qui précède :

5.2. Leçon : Topologie des données 167



QGIS Training Manual

5.2.7 ��� Essayez vous-même : Diviser des entités

L’outil Couper les entités est similaire à l’outil Remodeler les entités, sauf qu’il ne supprime aucune des deux parties.
Au lieu de cela, il les conserve toutes les deux.
Nous utiliserons cet outil pour séparer un coin d’un polygone.

1. Tout d’abord, sélectionnez la couche « landuse » et réactivez la fonction d’accrochage pour celle-ci.

2. Sélectionnez l’outil couper entités et cliquez sur un sommet pour commencer à tracer une ligne.
3. Tracez la ligne de démarcation.
4. Cliquez sur un sommet du côté « opposé » du polygone que vous souhaitez diviser et faites un clic droit pour

compléter la ligne :

5. À ce stade, il peut sembler que rien ne s’est passé. Mais n’oubliez pas que la couche landuse est rendue sans
ligne de démarcation, de sorte que la nouvelle ligne de démarcation ne sera pas affichée.

6. Utilisez l’outil Sélectionner les entités par surface ou par simple clic pour sélectionner la partie que vous venez de découper
; la nouvelle entité sera alors mise en évidence :
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5.2.8 ��� Essayez vous-même : Fusionner les entités

Nous allons maintenant réintégrer l’élément que vous venez de séparer dans la partie restante du polygone :

1. Testez donc les outils Fusionner les entités sélectionnées et Fusionner les attributs des entités sélectionnées.
2. Remarquez les différences.

Réponse
• Use the Merge Selected Features tool, making sure to first select both of the polygons you wish to merge.
• Use the feature with the OGC_FID of 1 as the source of your attributes (click on its entry in the dialog, then
click the Take attributes from selected feature button):

If you’re using a different dataset, it is highly likely that your original polygon’s OGC_FID will not be 1. Just choose
the feature which has an OGC_FID.
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Using theMerge Attributes of Selected Features tool will keep the geometries distinct, but give them the same attributes.

5.2.9 Conclusion

L’édition topologique est un outil puissant qui vous permet de créer et de modifier des objets rapidement et facilement,
tout en veillant à ce qu’ils restent topologiquement corrects.

5.2.10 La suite ?

Vous savez maintenant comment numériser facilement la forme des objets, mais l’ajout d’attributs reste un peu un
casse-tête ! Nous vous montrerons ensuite comment utiliser les formes, en rendant la modification des attributs plus
simple et plus efficace.

5.3 Leçon : Formulaires

Quand vous ajoutez de nouvelles données via la numérisation, une boîte de dialogue vous est présentée pour
vous permettre de remplir les attributs pour cette fonction. Cependant, cette boîte de dialogue n’est, par défaut,
visuellement pas très agréable. Cela peut causer un problème d’utilisation, en particulier si vous avez de grands jeux
de données à créer, ou si vous voulez que d’autres personnes vous aident à numériser et qu’elles trouvent les formulaires
par défaut source de confusion.
Heureusement, QGIS vous laisse créer vos propres boîtes de dialogue personnalisées pour une couche. Cette leçon
vous montre comment.
Objectifs de cette leçon : Créer un formulaire pour une couche.
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5.3.1 ��� Follow Along: Using QGIS” Form Design Functionality

1. Sélectionnez la couche roads dans le panneau Couches.
2. Entrez comme avant en Mode d’édition.
3. Ouvrez la table attributaire de la couche roads.
4. Faites un clic-droit sur une cellule dans la table. Un petit menu apparaîtra, avec l’entrée Ouvrir formulaire.
5. Cliquez dessus pour voir le formulaire que QGIS génère pour cette couche.

Évidemment, il serait bien de pouvoir faire cela tout en regardant la carte, plutôt que d’avoir besoin de chercher une
rue spécifique dans la table d’attribut tout le temps.

1. Sélectionnez la couche roads dans le panneau Couches.

2. En utilisant l’outil Identifier, cliquez sur une rue dans la carte.
3. Le panneau Résultats identifiés s’ouvre et affiche une arborescence montrant les valeurs des champs et d’autres

informations générales sur l’entité cliquée.

4. At the top of the panel, check the Auto open form for single feature results checkbox in the Identify Settings

menu.
5. Cliquez maintenant sur une des rues de la carte. À coté du dialogue Résultats Identité vous verrez la forme

maintenant familière :

6. Chaque fois que vous cliquez sur un élément avec l’outil Identifier, sa forme apparaît tant que la case Formulaire
d’ouverture automatique est activée

5.3. Leçon : Formulaires 171



QGIS Training Manual

5.3.2 ��� Essayez vous-même : Éditer des valeurs à l’aide d’un formulaire

Si vous êtes en mode d’édition, vous pouvez utiliser ce formulaire pour modifier les entités des attributs.
1. Activez le mode d’édition (si ce n’est déjà fait).

2. En utilisant l’outil identifier des entités, cliquez sur la rue principale qui traverse Swellendam :

3. Modifier sa valeur highway pour qu’elle soit secondary.
4. Quitter le mode édition et enregistrer vos modifications
5. Ouvrez la Table attributaire et notez que la valeur a été mise à jour dans la table des attributs et donc dans les

données sources

5.3.3 ��� Follow Along: Setting Form Field Types

C’est bien de modifier les choses en utilisant un formulaire, mais vous devez encore tout entrer à la main.
Heureusement, les formulaires ont différentes sortes de soi-disant outils qui vous permettent de modifier les données
de différentes manières.

1. Ouvrez les Propriétés… de la couche roads
2. Basculez sur l’onglet Champs. Vous verrez ceci :
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3. Passez à l’onglet Formulaire d’attributs. Vous verrez ceci :

4. Cliquez sur la ligne oneway et choisissez Case à cocher comme Type de widget dans la liste des options :
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5. Cliquez sur OK
6. Entrez en mode édition (si la couche roads n’est pas déjà en mode édition)

7. Cliquez sur l’outil Identifier des entités

8. Cliquez sur la même route principale que vous avez choisie précédemment
Vous verrez maintenant que l’attribut oneway a une case à cocher à côté de lui indiquant true (coché) ou false
(non coché).

5.3.4 ��� Essayez vous-même

Définissez un outil de formulaire plus approprié pour le champ highway.

Réponse
For the TYPE, there is obviously a limited amount of types that a road can be, and if you check the attribute table for
this layer, you’ll see that they are predefined.

1. Set the widget to Value Map and click Load Data from Layer.
2. Select roads in the Label dropdown and highway for both the Value and Description options:
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3. Cliquez sur OK trois fois.
4. If you use the Identify tool on a street now while edit mode is active, the dialog you get should look like this:
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5.3.5 ��� Essayez vous-même : Créer des données de test

Vous pouvez également concevoir votre propre formulaire personnalisé en partant de zéro.
1. Créez une simple couche de points appelé « test-data » avec deux attributs :

• name (text)
• age (entier)

2. Capturez quelques points sur votre nouvelle couche en utilisant les outils de numérisation afin que vous ayez
un peu de données pour jouer avec. Il se peut qu’on vous présente le formulaire de capture d’attribut généré
par défaut par QGIS chaque fois que vous capturez un nouveau point.

Note: Vous pouvez devoir désactiver l’Accrochage s’il est encore activé des tâches précédentes.
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5.3.6 ��� Follow Along: Creating a New Form

Nous voulons maintenant créer notre propre formulaire personnalisé pour la phase de saisie des données attributaire.
Pour ce faire, vous devez avoir installéQTDesigner (nécessaire uniquement pour la personne qui crée les formulaires).

1. Démarrer QT Designer.
2. Dans la boîte de dialogue qui apparaît, créez une nouvelle boîte de dialogue :

3. Cherchez l”Outil boîte sur le côté gauche de votre écran (par défaut). Il contient un élément appelé Édition de
ligne.

4. Cliquez sur cet élément et faites-le glisser dans votre formulaire. Cela crée une nouvelle Édition de ligne dans
le formulaire.

5. Avec le nouvel élément d’édition de ligne sélectionné, vous verrez ses propriétés le long du côté de votre écran
(par défaut sur la droite) :
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6. Appelez-le name
7. En utilisant la même approche, créez une nouvelle spinbox et donnez-lui le nom age.
8. Ajoutez une Etiquette intitulée Ajouter une nouvelle personne en caractères gras (regardez dans

les propriétés de l’objet pour savoir comment la définir). Vous pouvez également définir le titre du dialogue
lui-même (plutôt que d’ajouter un label).

9. Ajoutez un Label à chacun de vos widgets Line Edit et Spin Box.
10. Organisez les éléments comme bon vous semble.
11. Cliquez n’importe où dans votre boîte de dialogue.
12. Trouvez le boutonMettre en page dans un layout de formulaire (dans une barre d’outils le long du bord supérieur

de l’écran, par défaut). Votre dialogue s’affichera alors automatiquement.
13. Définissez la taille maximale du dialogue (dans ses propriétés) à 200 (largeur) par 150 (hauteur).
14. Votre formulaire devrait maintenant ressembler à ça:
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15. Enregistrez votre nouveau formulaire sous le nom de exercise_data/forms/add_people.ui
16. Lorsque l’enregistrement est terminé, vous pouvez fermer Qt Designer.

5.3.7 ��� Follow Along: Associating the Form with Your Layer

1. Retour à QGIS
2. Double-cliquez sur la couche test-data dans la liste des couches pour accéder à ses propriétés.
3. Cliquez sur l’onglet Formulaire d’attributs dans la fenêtre Propriétés de la couche.
4. Dans la liste déroulante Mise en page de l’éditeur d’attribut, sélectionnez Fournir un fichier-ui.
5. Cliquez sur le bouton avec les trois points et choisissez le fichier add_people.ui que vous venez de créer :

6. Cliquez sur OK dans la boîte de dialogue Propriétés de la couche
7. Passer en mode édition et capturer un nouveau point
8. Lorsque vous faites cela, on vous présentera votre boîte de dialogue personnalisée (à la place de la boîte de

dialogue générique que QGIS crée habituellement).
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9. Si vous cliquez sur un de vos points en utilisant l’outil Identifier les entités, vous pouvez maintenant faire
apparaître le formulaire en faisant un clic droit dans la fenêtre des résultats d’identification et en choisissant
Voir le formulaire des entités dans le menu.

10. Si vous êtes en mode édition pour cette couche, ce menu contextuel affichera plutôt modifier le formulaire
d’attribut, et vous pourrez alors ajuster les attributs dans la nouvelle forme même après la capture initiale.

5.3.8 Conclusion

En utilisant des formulaires, vous vous facilitez la vie lorsque vous modifiez ou créez des données. En modifiant
des types d’outil ou en créant entièrement un nouveau formulaire à partir de rien, vous pouvez contrôler l’expérience
de quelqu’un qui numérise des nouvelles données pour cette couche, en minimisant les malentendus et les erreurs
inutiles.

5.3.9 Pour aller plus loin

Si vous avez complété la section avancée ci-dessus et avez des connaissances en Python, vous voudrez peut-être
consulter cette entrée de blog sur la création de formulaires d’entités personnalisées avec la logique Python, qui
permet des fonctions avancées, notamment la validation des données, l’autocomplétion, etc.

5.3.10 La suite ?

L’ouverture d’un formulaire pour l’identification d’une entité est une des actions standards que QGIS effectue.
Cependant, vous pouvez également le diriger pour effectuer des actions personnalisées que vous définissez. C’est
le sujet de la prochaine leçon.

5.4 Leçon : Actions

Maintenant que vous avez vu une action par défaut dans la leçon précédente, il est temps de définir vos propres actions.
Une action est une chose qui se produit lorsque vous cliquez sur une entité. Elle peut ajouter beaucoup de
fonctionnalités supplémentaires à votre carte, vous permettant de récupérer des informations supplémentaires sur
un objet, par exemple. L’attribution d’actions peut ajouter une toute nouvelle dimension à votre carte !
Objectif de cette leçon : Apprendre à ajouter des actions personnalisées.
Dans cette leçon, vous utiliserez la couche school_property que vous avez créé précédemment. Les exemples de
données comprennent des photos de chacune des trois propriétés que vous avez numérisées. Ce que nous allons faire,
c’est associer chaque propriété à son image. Ensuite, nous allons créer une action qui ouvrira l’image d’une propriété
en cliquant sur celle-ci.

5.4.1 ��� Pas à pas : Ajouter un champ pour les images

La couche school_property n’a pas encore la possibilité d’associer une image à une propriété. Nous allons
d’abord créer un champ à cet effet.

1. Ouvrez la fenêtre Propriétés de la couche.
2. Cliquez sur l’onglet Champs.
3. Basculez en mode édition :
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4. Ajoutez une nouvelle colonne :

5. Entrez les valeurs ci-dessous :
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6. Une fois le champ créé, allez dans l’onglet formulaire d’attribut et sélectionnez le champ image.
7. Définissez type wiget à pièce jointe :

8. Cliquez sur OK dans la boîte de dialogue proprietes couche.
9. Utilisez l’outil Identifier pour cliquer sur une des trois entités dans la couche school_property.

Puisque vous êtes toujours en mode édition, le dialogue devrait être actif et ressembler à ceci :
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10. Cliquez sur le bouton parcourir (le… à côté du champ image).
11. Sélectionnez le chemin d’accès de votre image. Les images se trouvent dans exercise_data/

school_property_photos/ et portent le même nom que les entités auxquelles elles doivent être
associées.

12. Cliquez sur OK.
13. Associez toutes les images avec les bonnes entités en utilisant cette méthode :
14. Sauvegardez vos modifications et sortez du mode d’édition.

5.4.2 ��� Pas à pas : Créer une action

1. Ouvrez l’onglet Actions pour la couche school_property, et cliquez sur le bouton Ajouter nouvelle action.

2. Dans le dialogue Ajouter une nouvelle action, entrez les mots Show Image dans le champ Description :
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Ce qui faut ensuite faire varie selon votre système d’exploitation, ainsi choisissez la ligne de conduite appropriée
à suivre :

• Windows
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Cliquez sur le menu déroulant Type et choisissez Ouvrir.
• Ubuntu Linux
Sous Action, écrivez eog pour leGnome Image Viewer, ou écrivez display pour utiliser ImageMagick.
N’oubliez pas de mettre un espace après la commande !

• macOS
1. Cliquez sur le menu déroulant Type et choisissez Mac.
2. Sous Action, écrivez open. N’oubliez pas de mettre un espace après la commande !

Vous pouvez maintenant continuer à écrire la commande.
Vous souhaitez ouvrir l’image, et QGIS connaît son emplacement. Il ne reste plus qu’à passer la localisation de
l’image à Action.

3. Sélectionnez image dans la liste :
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4. Cliquez sur le bouton Insérer un champ. QGIS ajoutera la phrase [% "image" %] dans le champ Texte de
l’action.

5. Cliquez sur le bouton OK pour fermer le dialogue Ajouter une nouvelle action.
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6. Cliquez sur OK pour fermer la boîte de dialogue Proprietes couche
Il est maintenant temps de tester la nouvelle action :

1. Cliquez sur la couche school_property dans le panneau couches afin qu’elle soit mise en évidence.

2. Trouvez le bouton Exécuter action d’entité (dans la barre d’outils Attributs).
3. Cliquez sur la flèche vers le bas à droite de ce bouton. Une seule action a été définie pour cette couche jusqu’à

présent, celle que vous venez de créer.

4. Cliquez sur le bouton pour activer l’outil.
5. En utilisant cet outil, cliquez sur une des trois propriétés de l’école.

L’image de cette propriété doit s’ouvrir.

5.4.3 ��� Pas à pas : Rechercher sur Internet

Disons que nous regardons la carte et que nous voulons en savoir plus sur la région où se trouve une ferme. Supposons
que vous ne connaissez rien de la zone en question et que vous vouliez trouver des informations générales à son sujet.
Votre première action, si l’on considère que vous utilisez un ordinateur en cemoment, serait probablement de chercher
sur Google le nom de la zone. Alors disons à QGIS de le faire automatiquement pour nous !

1. Ouvrez la table d’attribut pour la couche landuse.
Nous utiliserons le champname pour chacune de nos zones d’utilisation des terres pour effectuer des recherches
sur Google.

2. Fermez la table d’attribut.
3. Retournez à Actions dans Propriétés des couches.
4. Cliquez sur le bouton créer l’action par défaut pour ajouter un certain nombre d’actions prédéfinies.
5. Supprimez toutes les actions sauf l’action ouvrir l’URL avec le nom court Search Web en utilisant le bouton

ci-dessous. supprimez l’action sélectionnée

6. Double-cliquez sur l’action restante pour la modifier
7. Remplacez le champ Description par Google Search, et supprimez le contenu du champ nom court.
8. Assurez-vous que le Canevas figure parmi les champs d’action de Action.

Ce qui faut ensuite faire varie selon votre système d’exploitation, ainsi choisissez la ligne de conduite appropriée
à suivre :

• Windows
Sous Type, choisissez Ouvrir. Cela va dire à Windows d’ouvrir une adresse internet dans votre navigateur
par défaut, tel qu’Internet Explorer.

• Ubuntu Linux
Sous Action, écrivez xdg-open. Cela indiquera à Ubuntu d’ouvrir une adresse Internet dans votre
navigateur par défaut, tel que Chrome ou Firefox.

• macOS
Sous Action, écrivez open. Cela indiquera à macOS d’ouvrir une adresse Internet dans votre navigateur
par défaut, tel que Safari.
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Vous pouvez maintenant continuer à rédiger la commande
Quelle que soit la commande que vous avez utilisée en-dessus, vous devez dire quelle adresse internet ouvrir
après. Vous voulez visiter Google, et rechercher automatiquement une phrase.
En général, lorsque vous utilisez Google, vous entrez votre phrase de recherche dans la barre de recherche
Google. Mais dans ce cas, vous voulez que votre ordinateur le fasse pour vous. La façon dont vous dites à
Google de rechercher quelque chose (si vous ne voulez pas utiliser directement sa barre de recherche) est de
donner à votre navigateur Internet l’adresse « https://www.google.com/search?q=SEARCH_PHRASE », où
« SEARCH_PHRASE » est ce que vous voulez rechercher. Comme nous ne savons pas encore quelle phrase
rechercher, nous ne saisirons que la première partie (sans la phrase de recherche).

9. Dans le champ Action, écrivez https://www.google.com/search?q=. N’oubliez pas d’ajouter un
espace après votre commande initiale avant d’écrire ceci !
Maintenant, vous voulez que QGIS dise au navigateur d’indiquer à Google de rechercher la valeur de name
pour toute entité sur laquelle vous pourriez cliquer.

10. Sélectionnez le champ name.
11. Cliquez sur le bouton Insérer :
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Cela signifie que QGIS va ouvrir le navigateur et l’envoyer à l’adresse https://www.google.com/search?q=[%
« name » %]``. L’adresse [% "name" %] indique à QGIS d’utiliser le contenu du champ name comme
expression à rechercher.
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Ainsi, si, par exemple, la zone d’utilisation des terres sur laquelle vous cliquez est appelée Réserve
naturelle de Marloth, QGIS va envoyer le navigateur à https://www.google.com/search?
q=Marloth%20Nature%20Reserve, ce qui amènera votre navigateur à visiter Google, qui à son tour
cherchera « Réserve naturelle de Marloth ».

12. Si vous ne l’avez pas encore fait, mettez tout en place comme expliqué ci-dessus.
13. Cliquez sur le bouton OK pour fermer le dialogue Ajouter une nouvelle action.
14. Cliquez sur OK pour fermer la boîte de dialogue Proprietes couche

Il est maintenant temps de tester la nouvelle action.

1. Avec la couche landuse active dans le panneau Couches, cliquez sur la flèche vers le bas à droite du bouton
Exécuter action entité, et sélectionnez la seule action (Google Search) définie pour cette couche.

2. Cliquez sur n’importe quelle zone d’utilisation des terres que vous pouvez voir sur la carte. Votre navigateur
s’ouvre alors et lance une recherche sur Google pour trouver le lieu qui est enregistré comme la valeur name
de cette zone.

Note: Si votre action ne fonctionne pas, vérifiez que tout a été correctement entré ; les fautes de frappe sont
communes avec ce genre de travail !

5.4.4 ��� Pas à pas : Ouvrir une page web directement depuis QGIS

Ci-dessus, vous avez vu comment ouvrir une page web dans un navigateur externe. Cette approche présente quelques
inconvénients en ce sens qu’elle ajoute une dépendance inconnaissable : l’utilisateur final disposera-t-il du logiciel
nécessaire pour exécuter l’action sur son système ? Comme vous l’avez vu, ils n’ont pas nécessairement le même type
de commande de base pour le même type d’action, si vous ne savez pas quel système d’exploitation ils utiliseront.
Avec certaines versions de systèmes d’exploitation, les commandes ci-dessus pour ouvrir le navigateur peuvent ne pas
fonctionner du tout. Cela peut être un problème insurmontable.
Cependant, QGIS se trouve au-dessus de la bibliothèque Qt, incroyablement puissante et polyvalente. De plus, les
actions de QGIS peuvent être arbitraires, tokenisées (c’est-à-dire utilisant des informations variables basées sur le
contenu d’un attribut de champ), des commandes Python !
Vous allez maintenant voir comment utiliser une action python pour afficher une page web. C’est la même idée
générale que l’ouverture d’un site dans un navigateur externe, mais elle ne nécessite pas de navigateur sur le système
de l’utilisateur puisqu’elle utilise la classe Qt QWebView (qui est un widget html basé sur un webkit) pour afficher le
contenu dans une fenêtre pop-up.
Cette fois, utilisons Wikipédia. L’URL que vous demandez ressemblera donc à ceci :
https://wikipedia.org/wiki/SEARCH_PHRASE

Créer l’action associée à la couche:
1. Ouvrez la boîte de dialogue Propriétés de la couche et rendez-vous sur l’onglet Actions.
2. Paramétrez une nouvelle action en utilisant les propriétés suivantes:

• Type: Python
• Description: Wikipedia
• Portée : Entité, Canevas
• Texte de l’action:

from qgis.PyQt.QtCore import QUrl
from qgis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView(None)

(suite sur la page suivante)
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(suite de la page précédente)
myWV.load(QUrl('https://wikipedia.org/wiki/[%name%]'))
myWV.show()

Il y a quelques choses qui se passent par ici :
• [%name%] sera remplacé par la valeur réelle de l’attribut lorsque l’action est invoquée (comme
précédemment).

• Le code crée simplement une nouvelle instance de QWebView, définit son URL, puis appelle show()
sur celle-ci pour la rendre visible comme une fenêtre sur le bureau de l’utilisateur.

Vous pouvez également utiliser cette approche pour afficher une image sans exiger que les utilisateurs disposent
d’un visualiseur d’images particulier sur leur système.

3. Essayez d’utiliser les méthodes décrites ci-dessus pour charger une page Wikipédia en utilisant l’action
Wikipédia que vous venez de créer.
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5.4.5 Conclusion

Les actions vous permettent de donner à votre carte des fonctionnalités supplémentaires, utiles à l’utilisateur final qui
visualise la même carte dans QGIS. Étant donné que les processus utilisés peuvent être aussi bien des commandes shell
pour n’importe quel système d’exploitation que du Python, les fonctions que vous pourriez incorporer sont illimitées
!

5.4.6 La suite ?

Maintenant que vous avez créé toutes sortes de données vecteur, vous allez apprendre à analyser les données pour
résoudre les problèmes. C’est le sujet du prochain module.
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Module : Analyse Vectorielle

Maintenant que vous avez modifié quelques entités, vous souhaitez sûrement savoir ce que l’on peut faire d’autre avec
elles. Avoir des entités avec des attributs, c’est bien, mais une fois finie, la carte ne vous apprendra rien de plus qu’une
carte non-SIG.
Le principal avantage d’un SIG est qu’un SIG peut répondre à des questions.

Pour les trois prochains modules, nous nous efforcerons de répondre à une question de recherche en utilisant des
fonctions SIG. Par exemple, vous êtes un agent immobilier recherchant une propriété résidentielle dans Swellendam
pour des clients ayant comme critères :

1. La propriété doit être dans Swellendam.
2. Elle doit être à une distance correcte en voiture (disons 1km) d’une école.
3. Sa taille doit être supérieure à 100 m².
4. Être située à moins de 50 m de la route principale.
5. Être située à moins de 500 m d’un restaurant.

Dans les prochains modules, nous allons exploiter la puissance des outils d’analyses SIG pour localiser les terrains
adaptés pour ce nouveau quartier résidentiel.

6.1 Leçon : Reprojeter et transformer des données

Parlons à nouveau des systèmes de référence de coordonnés (CRS). Nous en avons déjà parlé brièvement, mais nous
n’avons pas discuté de ce que cela signifie concrètement.
Le but de cette leçon : Reprojeter et transformer des jeux des données.
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6.1.1 ��� Pas à pas : Projections

Le CRS dans lequel se trouvent actuellement toutes les données, ainsi que la carte elle-même, s’appelle WGS84. Il
s’agit d’un système de coordonnées géographiques (GCS) très courant pour représenter les données. Mais il y a un
problème, comme nous allons le voir.

1. Enregistrez votre carte actuelle
2. Ensuite, ouvrez la carte du monde que vous trouverez sous exercise_data/world/world.qgs
3. Zoomez sur l’Afrique du Sud à l’aide de l’outil Zoom +

4. Essayez de définir une échelle dans le champ echelle, qui se trouve dans la barre de statut en bas de l’écran.
Lors de votre passage en Afrique du Sud, réglez cette valeur sur « 1:5 000 000 » (un à cinq millions).

5. Parcourez la carte tout en gardant un œil sur le champ échelle
Vous avez remarqué que l’échelle change ? C’est parce que vous vous éloignez du point sur lequel vous avez zoomé
à « 1:5 000 000 », qui était au centre de votre écran. Tout autour de ce point, l’échelle est différente.
Pour comprendre pourquoi, pensez au globe terrestre. Il y a des lignes imaginaires s’étendant du Nord au Sud. Ce
sont les lignes de longitude qui sont éloignées à l’équateur, mais qui se rejoignent aux pôles.
Dans un GCS, vous travaillez sur cette sphère, mais votre écran est plat. Lorsque vous essayez de représenter la
sphère sur une surface plane, il se produit une distorsion, semblable à ce qui se produirait si vous coupiez une balle de
tennis et essayiez de l’aplatir. Cela signifie que sur une carte, les lignes de longitude restent à égale distance les unes
des autres, même aux pôles (où elles sont censées se rencontrer). Cela signifie qu’à mesure que vous vous éloignez
de l’équateur sur votre carte, l’échelle des objets que vous voyez devient de plus en plus grande. Ce que cela signifie
pour nous, en pratique, c’est qu’il n’y a pas d’échelle constante sur notre carte !
Pour résoudre ce problème, utilisons à la place un Système de Coordonnées Projeté (SCP). Un SCP « projette » ou
convertit la donnée de manière à prendre en compte les changements d’échelle et de les corriger. Par conséquent,
pour garder une échelle constante, nous devrons reprojeter nos données et utiliser un SCP.

6.1.2 ��� Pas à pas : Reprojection « à la volée »

Par défaut, QGIS reprojete les données « à la volée ». Cela signifie que même si les données elles-mêmes se trouvent
dans un autre CRS, QGIS peut les projeter comme si elles se trouvaient dans un CRS de votre choix.

Vous pouvez changer le CRS du projet en cliquant sur le bouton Projection courante dans le coin inférieur droit de
QGIS.

1. Dans la boîte de dialogue qui apparaît, tapez le mot « global » dans le champ Filtre. Quelques CRS devraient
apparaître dans le champ Systèmes de référence prédéfinis ci-dessous.

2. Sélectionnez l’entréeWGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 en cliquant dessus, puis cliquez sur
OK.
Remarquez comment la forme de l’Afrique du Sud change. Toutes les projections fonctionnent en modifiant
la forme apparente des objets sur Terre.

3. Zoomez à nouveau à l’échelle 1:5 000 000, comme précédemment.
4. Déplacez vous sur la carte.

Notez que l’échelle reste fixe !
La reprojection “à la volée” est également utilisée pour visualiser des jeux de données ayant des SCR différents.

1. Ajoutez une autre couche vecteur à votre carte qui contient les données pour l’Afrique du Sud uniquement.
Vous la trouverez sous la forme exercise_data/world/RSA.shp.

2. Chargez-le. Un moyen rapide de voir son CRS est de passer la souris sur la couche de la légende. Il s’agit de
« EPSG:3410 ».
Que remarquez-vous ?
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La couche est visible même si elle a un CRS différent de celui de continents.

6.1.3 ��� Pas à pas : Sauvegarder un jeu de données dans un autre SCR

Parfois, vous devez exporter un ensemble de données existant avec un autre CRS. Comme nous le verrons dans la
prochaine leçon, si vous devez faire des calculs de distance sur une couche, il est toujours préférable d’avoir la couche
dans un système de coordonnées projetées.
Sachez que la reprojection « à la volée » est liée au projet et non à des couches individuelles. Cela signifie qu’une
couche peut avoir un CRS différent du projet même si vous le voyez dans la position correcte.
Vous pouvez facilement exporter la couche avec un autre CRS.

1. Ajoutez le jeu de données buildings à partir de training_data.gpkg
2. Cliquez avec le bouton droit sur la couche buildings dans le panneau Couches
3. Sélectionnez Exporter ► Sauvegarder les entités sous … dans le menu qui apparaît. La boîte de dialogue

Enregistrer la couche vecteur sous … s’affiche.
4. Cliquez sur le bouton Parcourir à côté du champ Nom de fichier

5. Naviguez vers exercise_data/ et spécifiez le nom de la nouvelle couche comme
buildings_reprojected.shp.

6. Changez la valeur du CRS. Seuls les CRS récents utilisés seront affichés dans le menu déroulant. Cliquez sur le
bouton Sélectionner la projection à côté du menu déroulant.

7. Le dialogue Sélecteur de système de référence de coordonnées apparaîtra. Dans son champ filtre, recherchez
34S.

8. SélectionnezWGS 84 / UTM zone 34S | EPSG:32734 dans la liste
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9. Laissez les autres options inchangées. La boîte de dialogue Enregistrer la couche vecteur sous … ressemble
maintenant à ceci :
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10. Cliquez sur OK
Vous pouvez maintenant comparer les anciennes et les nouvelles projections de la couche et voir qu’elles sont dans
deux CRS différents mais qu’elles se chevauchent toujours.
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6.1.4 ��� Pas à pas : Créer votre propre projection

Il existe beaucoup plus de projections que celles incluses dans QGIS par défaut. Vous pouvez également créer vos
propres projections.

1. Commencer une nouvelle carte
2. Chargez le fichier world/oceans.shp
3. Allez à Parametres ► Projection personnalisee… et vous verrez ce dialogue.

4. Cliquez sur le bouton ajouter nouveau CRS pour créer une nouvelle projection
5. Une projection intéressante à utiliser s’appelle Van der Grinten I. Entrez son nom dans le champ Nom.

Cette projection représente la Terre dans un champ circulaire plutôt que rectangulaire, comme la plupart des
autres projections.

6. Dans Format, sélectionnezWKT (Recommandé)
7. Ajoutez la chaîne suivante dans le champ Paramètres

PROJCRS["unknown",
BASEGEOGCRS["unknown",

DATUM["unknown",
ELLIPSOID["unknown",6371000,0,

LENGTHUNIT["metre",1,
ID["EPSG",9001]]]],

PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],

CONVERSION["unknown",
METHOD["Van Der Grinten"],
PARAMETER["Longitude of natural origin",0,

(suite sur la page suivante)
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(suite de la page précédente)
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre",1],
ID["EPSG",8806]],

PARAMETER["False northing",0,
LENGTHUNIT["metre",1],
ID["EPSG",8807]]],

CS[Cartesian,2],
AXIS["(E)",east,

ORDER[1],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]],
AXIS["(N)",north,

ORDER[2],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]]]

8. Cliquez sur OK

9. Cliquez sur le bouton CRS courant à droite de la barre d’état pour modifier le CRS du projet
10. Choisissez votre projection nouvellement définie (recherchez son nom dans le champ Filtre)
11. En appliquant la projection, voici ce à quoi doit ressembler la carte :

6.1. Leçon : Reprojeter et transformer des données 199



QGIS Training Manual

6.1.5 Conclusion

Différentes projections sont utiles à différentes fins. En choisissant une projection correcte, vous vous assurez que les
entités de votre carte seront représentées de manière précise.

6.1.6 Pour aller plus loin

Le matériel de la section Avancé de cette leçon est tiré de cet article.
Pour plus d’informations, lire Système de Coordonnées de Référence.

6.1.7 La suite ?

Dans la prochaine leçon, vous apprendrez comment analyser des données vecteur en utilisant les différents outils
d’analyse vecteur de QGIS.

6.2 Leçon : Analyse Vectorielle

Les données vecteur peuvent également être analysées pour révéler comment différentes entités interagissent les unes
avec les autres dans l’espace. Il existe de nombreuses fonctions différentes liées à l’analyse, nous ne les passerons donc
pas toutes en revue. Nous allons plutôt poser une question et essayer de la résoudre à l’aide des outils que fournit le
QGIS.
Objectif de cette leçon : Poser une question et la résoudre en utilisant les outils d’analyse.
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6.2.1 ��� Le processus SIG

Avant de commencer, il serait utile de donner un bref aperçu d’un processus qui peut être utilisé pour résoudre un
problème. La marche à suivre est la suivante :

1. Énoncer le problème
2. Obtenir les données
3. Analyser le problème
4. Présenter les résultats

6.2.2 ��� Le problème

Nous allons commencer le processus en décidant d’un problème à résoudre. Par exemple, vous êtes un agent
immobilier et vous recherchez une propriété résidentielle à Swellendam pour des clients dont les critères sont les
suivants:

1. Il doit être dans Swellendam
2. Elle doit se trouver à une distance raisonnable d’une école (disons 1 km)
3. Il doit avoir une taille supérieure à 100 mètres carrés
4. A moins de 50m d’une route principale
5. A moins de 500m d’un restaurant

6.2.3 ��� Les données

Pour répondre à ces questions, nous allons avoir besoin des données suivantes :
1. Les propriétés résidentielles (bâtiments) dans la région
2. Les routes dans et autour de la ville
3. L’emplacement des écoles et des restaurants
4. La taille des bâtiments

Ces données sont disponibles par le biais d’OSM, et vous devriez constater que l’ensemble de données que vous avez
utilisé tout au long de ce manuel peut également être utilisé pour cette leçon.
Si vous souhaitez télécharger des données à partir d’une autre zone, passez au Introduction Chapter pour lire comment
le faire.

Note: Bien que les données OSM en téléchargement ont des champs cohérentes, la couverture et le détail varie. Si
vous trouvez que votre région choisie ne contient pas d’informations sur les restaurants, par exemple, vous devriez
peut-être choisir une région différente.
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6.2.4 ��� Pas à pas : Démarrer un projet et obtenir les données

Nous devons d’abord charger les données pour travailler.
1. Démarrer un nouveau projet QGIS
2. Si vous le souhaitez, vous pouvez ajouter un fond de carte. Ouvrez le Navigateur et chargez le fond de carte

OSM dans le menu tuiles XYZ.

3. Dans la base de données training_data.gpkg Geopackage, vous trouverez la plupart des jeux de
données que nous utiliserons dans ce chapitre :
1. buildings
2. roads
3. restaurants
4. schools

Chargez-les, et aussi landuse.sqlite.
4. Zoomer sur l’étendue de la couche pour voir Swellendam, South Africa

Avant de poursuivre, nous allons filtrer la couche roads, afin de n’avoir que quelques types de routes spécifiques
avec lesquelles travailler.
Certaines routes dans les ensembles de données OSM sont répertoriées comme unclassified, tracks,
path``et ``footway. Nous voulons les exclure de notre ensemble de données et nous concentrer sur les
autres types de routes, plus appropriés pour cet exercice.
De plus, les données OSM pourraient ne pas être mises à jour partout, et nous exclurons également les valeurs
NULL.

5. Faites un clic droit sur la couche roads et choisissez Filtre….
6. Dans le dialogue qui s’affiche, nous filtrons ces entités avec l’expression suivante: :
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"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS␣
↪→NOT NULL

La concaténation des deux opérateurs NOT et IN exclut toutes les entités qui ont ces valeurs d’attribut dans le
champ highway.
IS NOT NULL combiné avec l’opérateur AND exclut les routes sans valeur dans le champ highway.

Notez l’icône à côté de la couche roads. Elle vous aide à vous rappeler que cette couche a un filtre activé,
de sorte que certaines entités peuvent ne pas être disponibles dans le projet.

La carte avec toutes les données doit ressembler à la suivante :

6.2.5 ��� Essayez vous-même : Convertir le SCR d’une couche

Comme nous allons mesurer des distances à l’intérieur de nos couches, nous devons changer le CRS des couches.
Pour ce faire, nous devons sélectionner chaque couche à tour de rôle, enregistrer la couche dans une nouvelle couche
avec notre nouvelle projection, puis importer cette nouvelle couche dans notre carte.
Vous disposez de nombreuses options différentes, par exemple vous pouvez exporter chaque couche comme un jeu
de données au format ESRI Shapefile, vous pouvez ajouter les couches à un fichier GeoPackage existant, ou vous
pouvez créer un autre fichier GeoPackage et le remplir avec les nouvelles couches reprojetées. Nous allons montrer la
dernière option, de sorte que le fichier training_data.gpkg restera propre. N’hésitez pas à choisir le meilleur
flux de travail pour vous-même.

Note: Dans cet exemple, nous utilisons le CRSWGS 84 / UTM zone 34S, mais vous devriez utiliser un CRS UTM
qui est plus approprié pour votre région.

1. Cliquez avec le bouton droit sur la couche roads dans le panneau couches
2. Cliquez sur Exporter –> Sauvegarder les entités sous…
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3. Dans le dialogue sauvegarder les couches sous, choisissez GeoPackage comme Format.
4. Cliquez sur… pour le Nom du fichier, et nommez le nouveau GeoPackage vector_analysis.
5. Changer le Nom de la couche en roads_34S.
6. Remplacer le CRS parWGS 84 / UTM zone 34S

7. Cliquez sur OK :

Cela va créer la nouvelle base de données GeoPackage et ajouter la couche roads_34S.
8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file

with _34S appended to the original name.
On macOS, press the Replace button in the dialog that pops up to allow QGIS to overwrite the existing
GeoPackage.
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Note: When you choose to save a layer to an existing GeoPackage, QGIS will add that layer next to the
existing layers in the GeoPackage, if no layer of the same name already exists.

9. Remove each of the old layers from the project
10. Une fois que vous avez terminé le processus pour toutes les couches, faites un clic droit sur n’importe quelle

couche et cliquez sur zoomer jusqu’à l’étendue de la couche pour centrer la carte sur la zone d’intérêt.
Maintenant que nous avons converti les données OSM en une projection UTM, nous pouvons commencer nos calculs.

6.2.6 ��� Pas à pas : Analyse du problème : Distances des écoles aux routes

QGIS vous permet de calculer les distances entre n’importe quel objet vecteur.
1. Assurez-vous que seules les couches routes_34S et buildings_34S sont visibles (pour simplifier la

carte pendant que vous travaillez)
2. Cliquez sur le lien traitement ► boite outils pour ouvrir le cœur analytique de QGIS. Fondamentalement, tous

les algorithmes (pour l’analyse vecteur et raster) sont disponibles dans cette boîte à outils.
3. Nous commençons par calculer la zone autour de roads_34S en utilisant l’algorithme tampon. Vous pouvez

le trouver dans le groupe Géométrie vecteur.
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Vous pouvez également taper tampon dans le menu de recherche situé dans la partie supérieure de la boîte à
outils :

4. Double-cliquez dessus pour ouvrir le dialogue de l’algorithme
5. Sélectionnez roads_34S comme couche entrée, mettez Distance` à 50 et utilisez les valeurs par défaut pour

le reste des paramètres.
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6. La valeur par défaut de Distance est en mètres car notre jeu de données d’entrée est dans un système de
coordonnées projetées qui utilise le mètre comme unité de mesure de base. Vous pouvez utiliser la boîte
combinée pour choisir d’autres unités de projection comme les kilomètres, les yards, etc.

Note: Si vous essayez de créer un tampon sur une couche avec un système de coordonnées géographiques,
Processing vous avertira et vous proposera de reprojeter la couche dans un système de coordonnées métriques.

7. Par défaut, traitement crée des couches temporaires et les ajoute au panneau Couches. Vous pouvez également
ajouter le résultat à la base de données GeoPackage en
1. Cliquant sur le bouton… et choisir sauvegarder GeoPackage….
2. Nommer la nouvelle couche « roads_buffer_50m ».
3. Enregistrez-le dans le fichier vector_analysis.gpkg
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8. Cliquez sur Exécuter, puis fermez le dialogue tampon.
Maintenant, votre carte devrait ressembler à peu près à ceci:
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Si votre nouvelle couche se trouve en haut de la liste couches, elle obscurcira probablement une grande partie de votre
carte, mais cela vous donne toutes les zones de votre région qui se trouvent à moins de 50m d’une route.
Remarquez qu’il existe des zones distinctes dans votre zone tampon, qui correspondent à chaque route individuelle.
Pour vous débarrasser de ce problème :

1. Décochez la couche roads_buffer_50m et recréez le tampon avec dissoudre résultat activé.
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2. Enregistrez la sortie sous le nom de roads_buffer_50m_dissolved.
3. Cliquez sur executer et fermez le dialogue tampon.

Une fois que vous avez ajouté la couche au panneau couches, il ressemblera à ceci :
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Il n’y a maintenant plus de subdivisions inutiles.

Note: La brève aide sur le côté droit du dialogue explique comment l’algorithme fonctionne. Si vous avez besoin
de plus d’informations, il vous suffit de cliquer sur le bouton aide dans la partie inférieure pour ouvrir un guide plus
détaillé de l’algorithme.

6.2.7 ��� Essayez vous-même : Distance depuis les écoles

Utilisez la même approche qu’en haut et créez un tampon pour vos écoles.
It shall be 1 km in radius. Save the new layer in the vector_analysis.gpkg file as
schools_buffer_1km_dissolved.

Réponse
• Your buffer dialog should look like this:
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The Buffer distance is 1 kilometer.
• The Segments to approximate value is set to 20. This is optional, but it’s recommended, because it makes the
output buffers look smoother. Compare this:
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To this:
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The first image shows the buffer with the Segments to approximate value set to 5 and the second shows the value set
to 20. In our example, the difference is subtle, but you can see that the buffer’s edges are smoother with the higher
value.

6.2.8 ��� Follow Along: Overlapping Areas

Nous avons maintenant identifié les zones où la route est à moins de 50 mètres et les zones où il y a une école dans un
rayon de 1 km (ligne directe, pas de route). Mais évidemment, nous ne voulons que les zones où ces deux critères sont
satisfaits. Pour ce faire, nous devrons utiliser l’outil Intersection. Vous pouvez le trouver dans le groupe superposition
vecteur dans la boite à outils traitement.

1. Utilisez les deux couches tampons comme Couche d’entrée et Couche de recouvrement, choisissez
analyse_vectorielle.gpkg GeoPackage dans Intersection avec Nom de la couche
road_school_buffers_intersect. Laissez le reste comme suggéré (par défaut).
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2. Cliquez sur Exécuter.
Dans l’image ci-dessous, les zones bleues correspondent aux endroits où les deux critères de distance sont
satisfaits.
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3. Vous pouvez enlever les deux couches de tampon et garder seulement celle qui montre où elles se croisent,
étant donné que c’est ce que nous voulons vraiment savoir en premier lieu :
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6.2.9 ��� Follow Along: Extract the Buildings

Maintenant, vous avez la zone où les bâtiments doivent se chevaucher. Ensuite, vous voulez extraire les bâtiments
dans cette zone.

1. Cherchez l’entrée de menu Sélection de vecteurs► Extraction par emplacement dans la Boîte à outils traitement
2. Sélectionnez buildings_34S dans Extrayez les entités de`. Vérifiez intersection dans Où les éléments

(prédicat géométrique), sélectionnez la couche d’intersection tampon dans En comparant avec les éléments de `.
Enregistrez dans le fichier :file:`vector_analysis.gpkg, et nommez la couche well_located_houses.

3. Cliquez sur Executer et fermez le dialogue
4. Vous constaterez probablement que peu de choses semblent avoir changé. Si c’est le cas, déplacez la couche

well_located_houses en haut de la liste des couches, puis zoomez.
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Les bâtiments en rouge sont ceux qui correspondent à nos critères, tandis que les bâtiments en vert sont ceux
qui n’y correspondent pas.

5. Vous avez maintenant deux couches séparées et vous pouvez supprimer buildings_34S de la liste des
couches.

6.2.10 ��� Try Yourself: Further Filter our Buildings

Nous avons maintenant une couche qui nous montre tous les bâtiments à 1km d’une école et à 50m d’une route. Nous
devons maintenant réduire la sélection pour ne montrer que les bâtiments qui sont à 500m d’un restaurant.
En utilisant les processus décrits ci-dessus, créez une nouvelle couche appelée houses_restaurants_500m qui filtre
davantage votre couche well_located_houses pour ne montrer que celles qui sont à moins de 500m d’un restaurant.

Réponse
To create the new houses_restaurants_500m layer, we go through a two step process:

1. First, create a buffer of 500m around the restaurants and add the layer to the map:
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2. Next, extract buildings within that buffer area:
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Your map should now show only those buildings which are within 50m of a road, 1km of a school and 500m of a
restaurant:
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6.2.11 ��� Follow Along: Select Buildings of the Right Size

Pour savoir quels bâtiments sont de la bonne taille (plus de 100 mètres carrés), nous devons calculer leurs dimensions.
1. Sélectionnez la couche houses_restaurants_500m et ouvrez la Calculatrice de champs en cliquant sur le bouton

Ouvrir calculatrice champs dans la barre d’outils principale ou dans la fenêtre de la table d’attributs
2. Sélectionnez créer un nouveau champs, mettez le nom de champ de sortie à AREA, choisissez nombre decimal

(real) as type de champ sortie, et choisissez $area dans le groupe Geometry.

Le nouveau champ AREA contiendra la superficie de chaque bâtiment en mètres carrés.
3. Cliquez sur OK. Le champ AREA a été ajouté à la fin de la table d’attributs.

4. Cliquez sur le bouton basculer en mode edition pour terminer l’édition, et enregistrez vos modifications lorsque
vous y êtes invité.

5. Dans l’onglet Source des propriétés de la couche, réglez le filtre Provider Feature Filter à "AREA >= 100.
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6. Cliquez sur OK.
Votre carte ne doit maintenant vous montrer que les bâtiments qui correspondent à nos critères de départ et qui ont
une superficie de plus de 100 mètres carrés.

6.2.12 ��� Essayez vous-même

Sauvegardez votre solution comme une nouvelle couche, en utilisant pour ce faire l’approche que vous avez apprise
ci-dessus. Le fichier doit être enregistré dans la même base de données GeoPackage, sous le nom de solution.
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6.2.13 Conclusion

En utilisant l’approche de résolution de problèmes des SIG avec les outils d’analyse vecteur de QGIS, vous avez pu
résoudre un problème à critères multiples rapidement et facilement.

6.2.14 La suite ?

Dans la prochaine leçon, nous verrons comment calculer la distance la plus courte le long des routes d’un point à un
autre.

6.3 Leçon : Analyse de réseau

La recherche de la plus petite distance entre deux points est une des utilisations récurrente d’un SIG. Les outils pour
réaliser cette tache se trouvent dans la Boîte à outils de Traitements.
Objectif de cette leçon: apprendre à utiliser l’algorithme Network analysis.

6.3.1 ��� Follow Along: The Tools and the Data

Vous pouvez trouver tous les algorithmes d’analyse de réseau dans le menu traitement► analyse reseau. Vous pouvez
constater que de nombreux outils sont disponibles :
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Ouvrez le fichier de projet exercise_data/network_analysis/network.qgz. Il contient deux couches
:

• network_points

• network_lines

La couche network_lines a déjà un style qui aide à comprendre le réseau routier.

Les outils de calcul du chemin le plus court permettent de calculer le chemin le plus court ou le plus rapide entre deux
points d’un réseau donné :

• points de départ et d’arrivée sélectionnés sur la carte
• point de départ sélectionné sur la carte et points d’arrivée pris dans une couche de points
• points de départ pris à partir d’une couche de points et point final sélectionné sur la carte

Commençons.

6.3.2 ��� Calculate the shortest path (point to point)

Analyse réseau► Chemin le plus court (point à point) vous permet de calculer la plus courte distance entre deux points
sélectionnés manuellement sur la carte.
Dans cet exemple, nous allons calculer le plus court chemin (et non le plus rapide) entre deux points.

1. Ouvrez l’algorithme Le plus court chemin (point à point).
2. Sélectionnez network_lines pour Couche vecteur représentant le réseau.
3. Utilisez le plus court pour Type de chemin pour calculer.

Utilisez ces deux points comme points de départ et d’arrivée pour l’analyse :
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4. Click on the… button next to Start point (x, y) and choose the location tagged with Starting Point in the
picture. Enable the snapping options for an accurate selection. The coordinates of the clicked point are added.

5. Faites la même chose, mais en choisissant l’emplacement marqué avec point final pour End point (x, y).
6. Cliquez sur le bouton executer :

7. Une nouvelle couche de lignes est créée, représentant le chemin le plus court entre les points choisis. Décochez
la couche network_lines pour mieux voir le résultat :
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8. Ouvrez la table des attributs de la couche de sortie. Elle contient trois champs, représentant les coordonnées
des points de départ et d’arrivée et le coût.
Nous avons choisi le plus court comme Type de chemin à calculer, donc le coût représente la distance,
en unités de couche, entre les deux endroits.
Dans notre cas, la distance la plus courte entre les points choisis est d’environ « 1000`` mètres :

Maintenant que vous savez comment utiliser l’outil, n’hésitez pas à tester d’autres lieux.

6.3.3 ��� Essayez vous-même : Trajet le plus rapide

Avec les mêmes données de l’exercice précédent, essayez de calculer le chemin le plus rapide entre les deux points.
De combien de temps avez-vous besoin pour passer du début à la fin ?

Answer
1. Open Network Analysis ► Shortest Path (Point to Point) and fill the dialog as:
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2. Make sure that the Path type to calculate is Fastest.
3. Cliquez sur Exécuter et fermez le dialogue.
4. Open now the attribute table of the output layer. The cost field contains the travel time between the two points

(as fraction of hours):

6.3.4 ��� Follow Along: Advanced options

Let us explore some more options of the Network Analysis tools. In the previous exercise we calculated the fastest
route between two points. As you can imagine, the time depends on the travel speed.
Nous utiliserons les mêmes couches et points de départ et d’arrivée des exercices précédents.

1. Ouvrez l’algorithme Le plus court chemin (point à point).
2. Remplissez les paramètres Couche en entrée, Point de départ (x, y) et Point d’arrivée (x, y) comme nous l’avons

fait auparavant
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3. Choisissez le plus rapide comme Type de chemin à calculer
4. Ouvrez le menu Paramètres avancés.
5. Changez la Vitesse par défaut (km/h) de la valeur par défaut 50 à 4.
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6. Cliquez sur executer.
7. Une fois l’algorithme terminé, fermez le dialogue et ouvrez la table d’attributs de la couche de sortie.
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Le champ coût contient la valeur en fonction du paramètre de vitesse que vous avez choisi. Nous pouvons
convertir le champ coût des heures avec fractions en valeurs minutes plus lisibles.

8. Open the field calculator by clicking on the icon
9. Add a new field to store the path cost in minutes.

That’s it! Now you know how many minutes it will take to get from one point to the other one if the whole network
speed is at 4 km/h.

6.3.5 ��� Shortest path with speed limit

La boîte à outils d’analyse du réseau propose d’autres options intéressantes. Regardez la carte suivante :
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nous aimerions connaître l’itinéraire le plus rapide compte tenu des limites de vitesse de chaque route (les étiquettes
représentent les limites de vitesse en km/h). Le chemin le plus court sans tenir compte des limitations de vitesse serait
bien sûr le chemin violet. Mais sur cette route, la limite de vitesse est de 20 km/h, alors que sur la route verte, vous
pouvez aller à 100 km/h !
Comme nous l’avons fait dans le premier exercice, nous utiliserons le Analyse de réseau► Chemin le plus court (point
à point) et nous choisirons manuellement les points de départ et d’arrivée.

1. Ouvrez l’algorithme Analyse du réseau ► Chemin le plus court (point à point).
2. Sélectionnez network_lines pour le paramètre Couche vecteur représentant le réseau.
3. Choisissez le plus rapide comme Type de chemin à calculer
4. Select the Start point (x, y) and End point (x, y) as we did before
5. Ouvrez le menu Paramètres avancés.
6. Choisissez le champ vitesse comme paramètre Champ de vitesse. Avec cette option, l’algorithme prendra en

compte les limites de vitesse pour chaque route.
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7. Cliquez sur le bouton Exécuter.
8. Désactivez la couche network_lines pour mieux voir le résultat
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Comme vous pouvez le constater, l’itinéraire le plus rapide ne correspond pas au plus court.

6.3.6 ��� Service area (from layer)

L’algorithme analyse reseau ► zone service (depuis la couche) peut répondre à la question : étant donné une couche
de points, quelles sont toutes les zones atteignables en fonction d’une distance ou d’une valeur temporelle ?

Note: Le analyse reseau ► zone service (depuis point) est le même algorithme, mais il vous permet de choisir
manuellement le point sur la carte.

Etant donné une distance de 250 mètres, nous voulons savoir jusqu’où nous pouvons aller sur le réseau à partir de
chaque point de la couche network_points.

1. Décochez toutes les couches sauf network_points.
2. Ouvrez l’algorithme analyse reseau ► zone service (depuis couche).
3. Choisissez network_lines pour Couche vecteur représentant le réseau.
4. Choisissez network_points pour Couche vecteur avec points de départ.
5. Choisissez le plus court dans Type de chemin à calculer.
6. Entrez 250 pour le paramètre Coût du voyage
7. Cliquez sur executer et fermez le dialogue
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La couche de sortie représente le chemin maximum que vous pouvez atteindre à partir des caractéristiques du
point étant donné une distance de 250 mètres :
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C’est cool, n’est-ce pas ?

6.3.7 Conclusion

Vous savez maintenant comment utiliser l’algorithme analyse reseau pour résoudre les problèmes de chemin le plus
court et le plus rapide.
Nous sommes maintenant prêts à effectuer des statistiques spatiales sur les données de la couche vectorielle. Allons-y
!

6.3.8 La suite ?

Vous verrez ensuite comment exécuter des algorithmes de statistiques spatiales sur des jeux de données vectorielles.

6.4 Leçon : Statistiques Spatiales

Note: Leçon développée par Linfiniti et S Motala (Cape Peninsula University of Technology)

Les statistiques spatiales vous permettent d’analyser et de comprendre ce qui se passe dans un ensemble de données
vecteur donné. QGIS comprend de nombreux outils utiles pour l’analyse statistique.
Le but de cette leçon: Savoir comment utiliser les outils de statistiques spatiales de QGIS dans la boite à outils
traitement.
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6.4.1 ��� Follow Along: Create a Test Dataset

Nous allons créer un ensemble de points aléatoires, pour obtenir un ensemble de données avec lesquelles travailler.
Pour ce faire, vous aurez besoin d’un ensemble de données polygonales pour définir la zone dans laquelle vous
souhaitez créer les points.
Nous utiliserons la zone couverte par les rues.

1. Démarrer un nouveau projet
2. Ajoutez votre jeu de données roads, ainsi que srtm_41_19 (données d’élévation) qui se trouve dans le

fichier exercise_data/raster/SRTM/.

Note: Vous constaterez peut-être que la couche SRTM DEM a un CRS différent de celui de la couche des
routes. QGIS reprojette les deux couches dans un seul CRS. Pour les exercices suivants, cette différence n’a
pas d’importance, mais n’hésitez pas à faire des reprojections (comme indiqué plus haut dans ce module).

3. Ouvrir la boite d’outils Traitement
4. Utilisez l’outil Géométrie vecteur ► Etendue minimum de la géométrie pour générer une zone englobant toutes

les routes en sélectionnant Convex Hull comme Type de géométrie :

Comme vous le savez, si vous ne spécifiez pas la sortie, Traitement crée des couches temporaires. C’est à vous
de sauvegarder les couches immédiatement ou à un stade ultérieur.
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Création de points aléatoires

• Créez 100 points aléatoires dans cette zone en utilisant l’outil Création de vecteur ► Points aléatoires dans les
limites de la couche, avec une distance minimale de 0.0 :

Note: Le panneau d’avertissement jaune vous indique que ce paramètre concerne les distances. La couche
Emprise de la géométrie se trouve dans un système de coordonnées géographiques et l’algorithme ne fait que
vous le rappeler. Pour cet exemple, nous n’utiliserons pas ce paramètre, vous pouvez donc l’ignorer.

Si nécessaire, déplacez le point aléatoire généré vers le haut de la légende pour mieux les voir :
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Échantillonage des données

Pour créer un échantillon de données à partir du raster, vous devez utiliser l’algorithme Analyse raster ► Exemple
de valeur raster. Cet outil échantillonne le raster à l’emplacement des points et ajoute les valeurs du raster dans de
nouveaux champs en fonction du nombre de bandes du raster.

1. Ouvrez la boîte de dialogue de l’algorithme Exemple de valeurs raster
2. Sélectionnez Points_aléatoires comme couche contenant les points d’échantillonnage, et la trame

SRTM comme bande à partir de laquelle obtenir les valeurs. Le nom par défaut du nouveau champ est
rvalue_N, où N est le numéro de la bande du raster. Vous pouvez changer le nom du préfixe si vous le
souhaitez.
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3. Appuyez sur Run
Vous pouvez maintenant vérifier les données échantillonnées du fichier raster dans la table des attributs de la couche
Points échantillonnés. Elles se trouveront dans un nouveau champ avec le nom que vous avez choisi.
Voici un exemple de représentation de la couche:
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Les points d’échantillonnage sont classés à l’aide du champ « rvalue_1 », de sorte que les points rouges se trouvent à
une altitude plus élevée.
Vous utiliserez cette couche d’échantillonnage pour le reste des exercices statistiques.

6.4.2 ��� Follow Along: Basic Statistics

Maintenant, récupérez les statistiques basiques de cette couche.

1. Cliquez sur l’icône voir le résumé statistique dans la barre d’outils attribut. Un nouveau panneau apparaîtra.
2. Dans la boîte de dialogue qui apparaît, spécifiez la couche « Points échantillonnés » comme source.
3. Sélectionnez le champ rvalue_1 dans la liste déroulante des champs. C’est le champ pour lequel vous allez

calculer les statistiques.
4. Le panneau Statistiques sera automatiquement mis à jour avec les statistiques calculées:
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Note: Vous pouvez copier les valeurs en cliquant sur le bouton copier les statistiques dans le presse papier et coller les
résultats dans une feuille de calcul.

5. Fermez le panneau statistiques quand vous aurez terminé
De nombreuses statistiques différentes sont disponibles :
Compte

Le nombre d’échantillons/valeurs.
Somme

Les valeurs ajoutées ensemble.
Moyenne

La valeur moyenne est simplement la somme des valeurs divisée par le nombre de valeurs.
Médiane

Si vous rangez toutes les valeurs de la plus petite à la plus grande, la valeur moyenne (ou la moyenne des deux
valeurs moyennes, si N est un nombre pair) est la médiane des valeurs.

St Dev (pop)
La déviation standard. Donne une indication sur la manière dont les valeurs sont regroupées autour de la
moyenne. Plus la déviation est faible, plus les valeurs tendent à se situer à la moyenne.

Minimum
La valeur minimale.

Maximum
La valeur maximale.

Portée
La différence entre les valeurs minimale et maximale.

Q1
Premier quartile des données.

Q3
Troisième quartile des données.

Valeurs (nulles) manquantes
Le nombre de valeurs manquantes.

6.4.3 ��� Follow Along: Compute statistics on distances between points

1. Créer une nouvelle couche de points temporaire.
2. Entrez en mode édition, et numérisez trois points parmi les autres points.

Alternativement, utilisez lamêmeméthode de génération de points aléatoires que précédemment, mais spécifiez
seulement trois points.

3. Enregistrez votre nouvelle couche sous distance_points dans le format que vous préférez.
Pour générer des statistiques sur les distances entre les points dans les deux couches:

1. Ouvrez l’outil Analyse vecteur ► Matrice de distance.
2. Sélectionnez la couche distance_points comme couche d’entrée, et la couche Sampled Points

comme couche cible.
3. Set their id field as unique field references
4. Change the Output matrix type option into Summary distance matrix.
5. set value of Use only the nearest (k) target points to 2.
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6. Si vous le souhaitez, vous pouvez enregistrer la couche de sortie sous forme de fichier ou simplement exécuter
l’algorithme et enregistrer la couche de sortie temporaire plus tard.

7. Cliquez sur Exécuter pour générer la couche de matrice de distance.
8. Ouvrez la table attributaire de la couche générée: les valeurs font référence aux distances entre les entités

distance_points et leurs deux points les plus proches dans la couche Sampled Points:

With these parameters, the Distance Matrix tool calculates distance statistics for each point of the input layer with
respect to their two nearest points in the target layer. The fields of the output layer contain the mean, standard
deviation, minimum and maximum for the calculated distances.
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For further testing, you may want to modify the Output matrix type option or the number of target points.

6.4.4 ��� Follow Along: Nearest Neighbor Analysis (within layer)

Pour effectuer une analyse du voisin le plus proche d’une couche de points:
1. Choisissez Analyse vecteur ► Analyse du plus proche voisin.
2. Dans la boîte de dialogue qui apparaît, sélectionnez la couche Points aléatoires et cliquez sur Exécuter.
3. Les résultats apparaîtront dans le panneau Processing Visualiseur de résultats.

4. Cliquez sur le lien bleu pour ouvrir la page html avec les résultats:
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6.4.5 ��� Follow Along: Mean Coordinates

Pour obtenir les coordonnées moyennes d’un jeu de données:
1. Démarrez Analyse vecteur ► Coordonnée(s) moyenne(s)

2. Dans le dialogue qui apparaît, spécifiez Random points comme couche entree, et laissez les choix optionnels
inchangés.

3. Cliquez sur Exécuter.
Comparons cela à la coordonnée centrale du polygone qui a été utilisée pour créer l’échantillon aléatoire.

1. Démarrer Géométrie vecteur ► Centroïdes

2. Dans la boîte de dialogue qui apparaît, sélectionnez la géométrie limite comme couche d’entrée.
Comme vous pouvez le voir, les coordonnées moyennes (point rose) et le centre de la zone d’étude (en vert) ne
coïncident pas nécessairement.
Le centroïde est le barycentre de la couche (le barycentre d’un carré est le centre du carré) tandis que les coordonnées
moyennes représentent la moyenne de toutes les coordonnées des nœuds.
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6.4.6 ��� Follow Along: Image Histograms

L’histogramme d’un jeu de données montre la distribution de ses valeurs. Le moyen le plus simple de le démontrer
dans QGIS est via l’histogramme d’image, disponible dans la boîte de dialogue Propriétés de la couche de n’importe
quelle couche d’image (jeu de données raster).

1. Dans votre panneau couches, faites un clic droit sur la couche srtm_41_19
2. Sélectionnez Propriétés
3. Choisissez l’onglet Histogramme. Vous devrez peut-être cliquer sur le bouton Calculer l’histogramme pour

générer le graphique. Vous verrez un graphique qui montre la distribution des fréquences pour les valeurs de
raster.
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4. Le graphique peut être exporté comme image à l’aide du bouton Enregistrer le graphique

5. Vous pouvez voir des informations plus détaillées sur la couche dans l’onglet Information (les valeurs moyennes
et maximales sont estimées, et peuvent ne pas être exactes).

La valeur moyenne est de 332,8 (estimée à 324,3), et la valeur maximale est de 1699 (estimée à 1548) ! Vous
pouvez zoomer dans l’histogramme. Comme il y a beaucoup de pixels de valeur 0, l’histogramme semble compressé
verticalement. En zoomant pour couvrir tout sauf le pic à 0, vous verrez plus de détails :
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Note: Si les valeurs moyennes et maximales ne sont pas les mêmes que celles indiquées ci-dessus, cela peut être dû
au calcul de la valeur min/max. Ouvrez l’onglet Symbologie et développez le menu Paramètres des valeurs Min / Max.
Choisissez Min / max et cliquez sur Appliquer.

N’oubliez pas qu’un histogramme vous montre la distribution des valeurs, et que toutes les valeurs ne sont pas
nécessairement visibles sur le graphique.
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6.4.7 ��� Follow Along: Spatial Interpolation

Supposons que vous ayez une collection d’exemples de points à partir desquels vous souhaitez extrapoler des données.
Par exemple, vous pourriez avoir accès au jeu de données Sampled points que nous avons créé plus tôt, et vous
souhaitez avoir une idée de l’apparence du terrain.

1. Pour commencer, lancez l’outil GDAL ► Analyse raster ► Grid (IDW avec recherche du plus proche voisin)
dans la Boîte à outils Traitement.

2. Pour Couche de points, sélectionnez Points échantillonnés.
3. Réglez Pouvoir de pondération sur 5.0.
4. Dans Paramètres avancés, mettez Valeur Z depuis le champ à rvalue_1
5. Enfin, cliquez sur Exécuter et attendez la fin du traitement
6. Fermez la boîte de dialogue

Voici une comparaison entre l’ensemble de données original (à gauche) et celui construit à partir de nos points
d’échantillonnage (à droite). Les vôtres peuvent sembler différentes en raison de la nature aléatoire de l’emplacement
des points d’échantillonnage.

Comme vous pouvez le voir, 100 points d’échantillonnage ne sont pas vraiment suffisants pour obtenir une impression
détaillée du terrain. Cela donne une idée très générale, mais elle peut aussi être trompeuse.

6.4.8 ��� Essayez vous-même : Différentes méthodes d’interpolation

1. Utilisez les processus indiqués ci-dessus pour créer un ensemble de 10 000 points aléatoires

Note: Si le nombre de points est vraiment important, le temps de traitement peut être long.

2. Utilisez ces points pour échantillonner le DEM original
3. Utilisez l’outil Grid (IDW avec recherche du plus proche voisin) sur cet ensemble de données.
4. Réglez Power et Smoothing sur 5.0 et 2.0, respectivement.

Les résultats (dépendamment de la position de vos points aléatoires) ressembleront plus ou moins à cela :
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C’est une meilleure représentation du terrain, en raison de la plus grande densité des points d’échantillonnage.
N’oubliez pas que des échantillons plus grands donnent de meilleurs résultats.

6.4.9 Conclusion

QGIS dispose d’un certain nombre d’outils pour analyser les propriétés statistiques spatiales des ensembles de données.

6.4.10 La suite ?

Maintenant que nous avons couvert l’analyse des vecteurs, pourquoi ne pas voir ce que l’on peut faire avec les rasters
? C’est ce que nous ferons dans le prochain module !
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Module : Rasters

Nous avons précédemment utilisé des rasters pour la digitalisation, mais les données raster peuvent aussi être utilisées
directement. Dans ce module, vous verrez comme cela est fait dans QGIS.

7.1 Leçon : Les données raster

Les données raster sont très différentes des données vecteur. Les données vecteur ont des caractéristiques discrètes
avec des géométries construites à partir de sommets, et peut-être reliées à des lignes et/ou des zones. Les données
raster, cependant, sont comme n’importe quelle image. Bien qu’elles puissent représenter diverses propriétés des
objets dans le monde réel, ces objets n’existent pas en tant qu’objets séparés. Ils sont plutôt représentés à l’aide de
pixels de valeurs différentes.
Au cours de ce module, vous allez utiliser des données raster pour compléter votre analyse SIG existante.
Le but de cette leçon: Apprendre à travailler avec des données raster dans QGIS.

7.1.1 ��� Pas à pas : Charger des données rasters

Les données raster peuvent être chargées avec les mêmes méthodes que celles que nous avons utilisées pour les
données vecteur. Cependant, nous suggérons d’utiliser le panneau navigateur.

1. Ouvrez le panneau Navigateur et développez le dossier exercise_data/raster.
2. Chargez toutes les données dans ce dossier :

• 3320C_2010_314_RGB_LATLNG.tif

• 3320D_2010_315_RGB_LATLNG.tif

• 3420B_2010_328_RGB_LATLNG.tif

• 3420C_2010_327_RGB_LATLNG.tif

Vous devriez voir la carte suivante :
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Nous l’avons ici - quatre images aériennes couvrant notre zone d’étude.

7.1.2 ��� Pas à pas : Créer un raster virtuel

Comme vous pouvez le voir, votre couche de solution se trouve sur les quatre images. Cela signifie que vous allez
devoir travailler avec quatre raster tout le temps. Ce n’est pas l’idéal. Il serait préférable d’avoir un seul fichier pour
travailler.
Heureusement, QGIS vous permet de faire exactement cela, et sans avoir besoin de créer un nouveau fichier raster.
Vous pouvez créer un Raster virtuel. On l’appelle aussi souvent Catalogue, ce qui explique sa fonction. Ce n’est pas
vraiment un nouveau raster. C’est plutôt un moyen d’organiser vos rasters existants en un seul catalogue : un seul
fichier pour un accès facile.
Pour faire un catalogue, nous utiliserons traitement ► boîte à outils.

1. Ouvrez l’algorithme construire raster virtuel du menu GDAL ► Raster miscellaneous ;
2. Dans la boîte de dialogue qui apparaît, cliquez sur le bouton… à côté du paramètre couche en entree et vérifiez

toutes les couches ou utilisez le bouton sélectionner tous ;
3. Décochez Placer chaque fichier d’entrée dans une bande séparée. Remarquez le code qui est généré en bas de

la boîte de dialogue sous Appel de la console GDAL/OGR. C’est la commande qui sera exécutée lorsque vous
cliquez sur Exécuter. Le texte se met à jour lorsque vous modifiez différentes options dans la boîte de dialogue.

Note: N’oubliez pas que vous pouvez copier et coller le texte dans le « OSGeo Shell » (utilisateur Windows)
ou le « Terminal » (utilisateurs Linux et OSX) pour exécuter la commande. Vous pouvez également créer un
script pour chaque commande GDAL. C’est très pratique lorsque la procédure prend beaucoup de temps ou
lorsque vous souhaitez programmer des tâches spécifiques. Utilisez le bouton Help pour obtenir plus d’aide sur
la syntaxe de la commande.

4. Pour finir, cliquez sur Exécuter

Note: Comme vous le savez des modules précédents, le menu Traitement crée des couches temporaires par défaut.
Pour enregistrer le fichier, cliquez sur le bouton… sous Virtuel.
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Vous pouvez maintenant supprimer les quatre raster originaux du panneau couches et ne laisser que le raster du
catalogue virtuel de sortie.
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7.1.3 ��� Essayez vous-même : Transformer des données raster

Les méthodes ci-dessus vous permettent de fusionner les jeux de données en utilisant un catalogue, et de les reprojeter
« à la volée ». Cependant, si vous configurez les données que vous allez utiliser pendant un certain temps, il peut être
plus efficace de créer de nouveaux rasters qui sont déjà fusionnés et reprojetés. Cela améliore les performances tout
en utilisant les rasters dans une carte, mais cela peut prendre un certain temps à d’abord mettre en place.

Reprojection de rasters

OuvrezWarp (reproject) du menu GDAL ► Projection raster.
Vous pouvez également reprojeter des rasters virtuels (catalogues), activer le traitement multithreading, etc.
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Fusion de rasters

Si vous avez besoin de créer une nouvelle couche raster et de la sauvegarder sur le disque, vous pouvez utiliser
l’algorithme de fusion.

Note: Selon le nombre de fichiers raster que vous fusionnez et leur résolution, le nouveau fichier raster créé peut
être très volumineux. Pensez plutôt à créer un catalogue raster comme décrit dans la section Create a Virtual Raster.

1. Cliquez sur l’algorithme fusionner du menu GDAL ► Raster miscellaneous.
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2. Comme nous l’avons fait pour la commandeCreate a Virtual raster, utilisez le bouton… pour choisir les couches
que vous voulez fusionner.
Vous pouvez également spécifier un raster virtuel comme entrée, puis tous les raster qui la composent seront
traitées.

3. Si vous connaissez la bibliothèque GDAL, vous pouvez également ajouter vos propres options en ouvrant le
menu Advanced parameters.
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7.1.4 Conclusion

Dans QGIS, il est facile d’inclure des données raster dans vos projets existants.

7.1.5 La suite ?

Ensuite, nous utiliserons les données raster qui ne sont pas de l’imagerie aérienne, et verrons comment la symbolisation
est ainsi utile dans le cas des rasters.

7.2 Leçon : Modification de la symbologie des rasters

Toutes les données raster ne sont pas des photos aériennes. Il existe de nombreuses autres formes de données raster
et, dans beaucoup de cas, il est essentiel de les symboliser pour qu’elles soient bien visibles et utiles.
Objectif de cette leçon : Changer la symbologie d’une couche raster.

7.2.1 ��� Essayez vous-même

1. Utilisez le panneau navigateur pour charger srtm_41_19.tif, qui se trouve sous exercise_data/
raster/SRTM/

2. Zoomez sur l’étendue de cette couche en faisant un clic droit dessus dans le panneau couches et en sélectionnant
Zoomer sur couche.

Cet ensemble de données est un Modèle numérique d’élévation (MNE). Il s’agit d’une carte d’altitude du terrain, qui
nous permet de voir où se trouvent les montagnes et les vallées, par exemple.
Alors que chaque pixel de l’ensemble de données de la section précédente contenait des informations sur les couleurs,
dans un DEM, chaque pixel contient des valeurs d’élévation.
Une fois que le DEM est chargé, vous remarquerez qu’il s’agit d’une représentation en niveaux de gris :
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QGIS a automatiquement appliqué un étirement aux valeurs des pixels de l’image à des fins de visualisation, et nous
en apprendrons davantage sur la façon dont cela fonctionne au fur et à mesure.

7.2.2 ��� Pas à pas : Modifier la symbologie d’une couche raster

Vous avez deux options différentes pour changer la symbologie raster :
1. Dans la boîte de dialogue proprietes couche, en faisant un clic droit sur la couche dans l’arbre des couches et

en sélectionnant l’option proprietes. Ensuite, passez à l’onglet Symbologie.

2. En cliquant sur le bouton ouvrir le panneau de style de la couche juste au-dessus du panneau couches (raccourci F7).

Cela ouvrira le panneau style couche, où vous pourrez passer à l’onglet Symbologie.
Choisissez la méthode avec laquelle vous préférez travailler.
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7.2.3 ��� Pas à pas : Bande unique grise

Lorsque vous chargez un fichier raster, s’il ne s’agit pas d’une image photo comme celles de la section précédente, le
style par défaut est défini sur un dégradé de gris.
Examinons quelques-unes des caractéristiques de ce moteur de rendu.

La valeur par défaut de Color gradient est fixée à noir vers blanc, ce qui signifie que les valeurs de pixels
faibles sont noires et que les valeurs élevées sont blanches. Essayez d’inverser ce paramètre en Blanc vers noir
et voyez le résultat.
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Le paramètre amelioration contraste est très important : par défaut, il est réglé sur etirer jusqu'au MinMax,
ce qui signifie que les valeurs des pixels sont étirées aux valeurs minimales et maximales.
Regardez la différence avec l’amélioration (à gauche) et sans (à droite) :

Mais quelles sont les valeurs minimales et maximales qui doivent être utilisées pour le tronçon ? Celles qui se trouvent
actuellement sous paramètre valeur Min / Max. Il existe de nombreuses façons de calculer les valeurs minimales et
maximales et de les utiliser pour étirer :

1. défini par utilisateur : vous entrez les valeurs Min et Max manuellement
2. Coupure du comptage cumulatif : c’est utile lorsque vous avez des valeurs extrêmement basses ou élevées.

Il coupe 2% (ou la valeur que vous choisissez) de ces valeurs
3. Min / max : les valeurs minimales et maximales réelles ou estimées du raster
4. Moyenne +/- écart-type : les valeurs seront calculées en fonction de la valeur moyenne et de l’écart-type

7.2.4 ��� Pas à pas : Bande unique en pseudo-couleurs

Les niveaux de gris ne sont pas toujours de bons styles pour les couches rasters. Essayons de rendre le DEM plus
coloré.

• Changez le type de rendu en pseudocouleur bande unique. Si vous n’aimez pas les couleurs chargées par défaut,
sélectionnez une autre rampe couleurs.

• Cliquez sur le bouton classer pour générer une nouvelle classification des couleurs
• Si elle n’est pas générée automatiquement, cliquez sur le bouton OK pour appliquer cette classification au DEM
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Vous verrez le raster qui ressemble à ceci :
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C’est une façon intéressante d’envisager le DEM. Vous verrez maintenant que les valeurs du raster sont à nouveau
correctement affichées, passant du bleu pour les zones inférieures au rouge pour les zones supérieures.

7.2.5 Pas à pas : Modifier la transparence

Parfois, changer la transparence de toute la couche raster peut vous aider à voir les autres couches couvertes par le
raster lui-même et à mieux comprendre la zone d’étude.
Pour modifier la transparence de l’ensemble du raster passez à l’onglet Transparence et utilisez le curseur de l’onglet
Opacite globale pour réduire l’opacité :
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Il est plus intéressant de modifier la transparence pour certaines valeurs de pixels. Par exemple, dans le raster que
nous avons utilisé, vous pouvez voir une couleur homogène aux coins. Pour définir ces pixels comme transparents,
allez dans Options de transparence personnalisées dans l’onglet Transparence.

• En cliquant sur le bouton ajouter valeur manuellement, vous pouvez ajouter une gamme de valeurs et définir leur
pourcentage de transparence

• Pour les valeurs uniques, le bouton ajouter des valeurs à partir affichage est plus utile

• Cliquez sur le bouton ajouter des valeurs depuis l’affichage. La boîte de dialogue disparaît et vous pouvez interagir
avec la carte.

• Cliquez sur la couleur homogène dans un coin du DEM
• Vous verrez que le tableau de transparence sera rempli avec les valeurs cliquées :
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• Cliquez sur OK pour fermer le dialogue et voir les changements.

Vous voyez ? Les coins sont maintenant 100% transparents.
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7.2.6 Conclusion

Voici quelques-unes des fonctions de base pour vous permettre de vous familiariser avec la symbologie raster. QGIS
vous offre également de nombreuses autres options, telles que la symbolisation d’une couche à l’aide de valeurs
palette/unique, la représentation de différentes bandes avec différentes couleurs dans une image multispectrale, ou la
création d’un effet d’ombrage automatique (utile uniquement avec les fichiers matriciels DEM).

7.2.7 Références

The SRTM dataset was obtained from CGIAR CSI website.

7.2.8 La suite ?

Maintenant que nous pouvons voir nos données correctement affichées, étudions comment nous pouvons davantage
les analyser.

7.3 Leçon : Analyse de terrain

Certains types de raster vous permettent de gagner plus de perspicacité dans le terrain que ce qu’ils représentent. Les
Modèles Numériques d’Élévation (MNE) sont particulièrement utiles dans ce sens. Dans cette leçon, vous utiliserez
les outils d’analyse de terrain pour en savoir plus sur la zone d’étude pour le développement résidentiel proposé plus
tôt.
Objectif de cette leçon : Utiliser les outils d’analyse de terrain pour avoir plus d’information sur le terrain.

7.3.1 ��� Follow Along: Calculating a Hillshade

Nous allons utiliser la même couche DEM que dans la leçon précédente. Si vous commencez ce chapitre à partir de
zéro, utilisez le panneau navigateur et chargez le fichier raster/SRTM/srtm_41_19.tif.
La couche DEM vous montre l’élévation du terrain, mais elle peut parfois sembler un peu abstraite. Elle contient
toutes les informations 3D sur le terrain dont vous avez besoin, mais elle ne ressemble pas à un objet 3D. Pour avoir
une meilleure impression du terrain, il est possible de calculer un ombrage, qui est un raster qui cartographie le terrain
en utilisant la lumière et les ombres pour créer une image d’aspect 3D.
Nous allons utiliser des algorithmes du menu Raster ► Analyse de terrain.

1. Cliquez sur le menu Ombrage
2. L’algorithme vous permet de spécifier la position de la source lumineuse : Azimuth a des valeurs de 0 (Nord) à

90 (Est), 180 (Sud) et 270 (Ouest), tandis que Angle vertical définit la hauteur de la source lumineuse (0 à 90
degrés).

3. Nous utiliserons les valeurs suivantes :
• Facteur Z de 1.0
• Azimuth (angle horizontal) à 300.0°
• angle vertical de 40.0°
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4. Save the file in a new folder exercise_data/raster_analysis/ with the name hillshade.tif
5. Pour finir, cliquez sur Exécuter

Vous aurez maintenant une nouvelle couche appelée hillshade qui ressemble à cela :
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Le résultat semble sympathique et en 3D. Mais pouvons-nous l’améliorer ? L’ombrage semble un peut en plâtre.
Pouvons-nous le combiner avec nos autres rasters plus colorés ? C’est effectivement possible en utilisant l’ombrage
en tant que couverture.

7.3.2 ��� Follow Along: Using a Hillshade as an Overlay

Un ombrage peut fournir des informations très utiles sur la lumière du soleil à un moment donné de la journée. Mais
il peut aussi être utilisé à des fins esthétiques, pour donner à la carte une meilleure apparence. La clé pour cela est de
configurer l’ombrage pour qu’il soit presque complètement transparent.

1. Changer la symbologie de la couche srtm_41_19 originale pour utiliser le schéma Pseudo-couleur comme dans
l’exercice précédent

2. Cacher toutes les couches sauf les couches srtm_41_19 et ombrage
3. Cliquez et faites glisser le srtm_41_19 pour qu’il se trouve sous la couche ombrage dans le panneau Couches
4. Réglez la couche ombrage pour qu’elle soit transparente en cliquant sur l’onglet Transparence dans les propriétés

de la couche
5. Définissez l” Opacité globale à 50%.

Vous obtiendrez le résultat suivant :

6. Désactivez et réactivez la couche ombrage dans le panneau Couches pour voir la différence que cela fait.
En utilisant un ombrage de cette façon, il est possible d’améliorer la topographie du paysage. Si l’effet ne vous semble
pas suffisamment fort, vous pouvez changer la transparence de la couche hillshade ; mais bien sûr que plus l’ombrage
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devient brillant, plus les couleurs derrière lui seront sombres. Vous devrez trouver un équilibre qui fonctionne pour
vous.
N’oubliez pas de sauvegarder le projet lorsque vous avez terminé.

7.3.3 Follow Along: Finding the best areas

Revenons au problème de l’agent immobilier, que nous avons abordé pour la dernière fois dans la leçon Analyse
vecteur. Imaginons que les acheteurs souhaitent maintenant acheter un bâtiment et construire un petit chalet sur la
propriété. Dans l’hémisphère sud, nous savons qu’une parcelle idéale pour le développement doit comporter des zones
qui :

• sont orientés vers le nord
• dont la pente est inférieure à 5 degrés
• Mais si la pente est inférieure à 2 degrés, l’aspect n’a pas d’importance.

Trouvons les meilleures zones pour eux.

7.3.4 ��� Follow Along: Calculating the Slope

La pente informe sur le degré d’inclinaison du terrain. Si, par exemple, vous voulez construire des maisons sur ce
terrain, il vous faut un terrain relativement plat.
Pour calculer la pente, vous devez utiliser l’algorithme pente de traitement ► analyse de terrain raster.

1. Ouvrir l’algorithme
2. Choisissez srtm_41_19 comme Couche d’élévation.
3. Gardez le Facteur Z à 1.0.
4. Save the output as a file with the name slope.tif in the same folder as the hillshade.tif
5. Cliquez sur Exécuter

Vous voyez maintenant la pente du terrain, chaque pixel contenant la valeur de pente correspondante. Les pixels noirs
indiquent un terrain plat et les pixels blancs un terrain escarpé.
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7.3.5 ��� Try Yourself: Calculating the aspect

Aspect est la direction de la boussole à laquelle fait face la pente du terrain. Un aspect de 0 signifie que la pente est
orientée vers le nord, 90 vers l’est, 180 vers le sud et 270 vers l’ouest.
Comme cette étude se déroule dans l’hémisphère sud, les propriétés devraient idéalement être construites sur une
pente orientée vers le nord afin qu’elles puissent rester à la lumière du soleil.
Use the Aspect algorithm of the Processing► Raster terrain analysis to get the aspect.tif layer saved along with
the slope.tif.

Réponse
Configurez la fenêtre Aspect comme ci-après :
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Votre résultat :
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7.3.6 ��� Follow Along: Finding the north-facing aspect

Maintenant, vous avez des rasters vous montrant la pente ainsi que l’aspect, mais vous n’avez aucun moyen de savoir
où les conditions idéales sont satisfaites à la fois. Comment cette analyse pourrait-elle être effectuée ?
La réponse réside dans la Calculatrice Raster.
QGIS dispose de différents calculateurs rasters :

• Raster ► Calculatrice Raster

• Via le menu Traitement :
– Analyse raster ► Calculatrice raster

– GDAL ► Raster miscellaneous ► calculatrice raster

– SAGA ► Raster calculus ► calculatrice raster

Chaque outil conduit aux mêmes résultats, mais la syntaxe peut être légèrement différente et la disponibilité des
opérateurs peut varier.
Nous utiliserons analyse rasteer ► calculatrice raster dans la boîte à outils traitement

1. Ouvrez l’outil en double-cliquant dessus.
• La partie supérieure gauche de la boîte de dialogue répertorie toutes les couches raster chargées sous la
forme name@N, où name est le nom de la couche et N est la bande.

• Dans la partie supérieure droite, vous verrez un grand nombre d’opérateurs différents. Arrêtez-vous un
instant pour vous rappeler qu’un raster est une image. Vous devriez la voir comme unematrice 2D remplie
de chiffres.

2. Le nord est à 0 (zéro) degré, donc pour que le terrain soit orienté vers le nord, son aspect doit être supérieur à
270 degrés ou inférieur à 90 degrés. La formule est donc:

aspect@1 <= 90 OR aspect@1 >= 270

3. Vous devez maintenant configurer les détails du raster, comme la taille de la cellule, l’étendue et le CRS. Cela
peut être fait manuellement ou automatiquement en choisissant une couche de référence. Choisissez
cette dernière option en cliquant sur le bouton… à côté du paramètre couche de référence.

4. Dans le dialogue, choisissez la couche aspect, car nous voulons obtenir une couche avec la même résolution.
5. Save the layer as aspect_north.tif.

Le dialogue devrait ressembler à :
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6. Pour finir, cliquez sur Exécuter
Votre résultat doit être cela :
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Les valeurs de sortie sont 0 ou 1. Qu’est-ce que cela signifie ? Pour chaque pixel raster, la formule que nous avons
écrite indique s’il correspond aux conditions ou non. Le résultat final sera donc Faux (0) et Vrai (1).

7.3.7 ��� Essayez vous-même : Plus de critères

Maintenant que vous avez fait l’aspect, créez deux nouvelles couches à partir du DEM.
• La première identifie les zones où la pente est inférieure ou égale à 2 degrés
• La seconde est similaire, mais la pente doit être inférieure ou égale à 5 degrés.
• Enregistrez-les sous exercise_data/raster_analysis sous les noms slope_lte2.tif et
slope_lte5.tif.

Réponse
• Configurez la fenêtre Calculatrice raster comme ci-après :
• l’expression suivante : slope@1 <= 2

• la couche slope en tant que Couche(s) de référence
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• Pour la version avec 5 degrés, remplacez le 2 dans l’expression et le nom de fichier par 5.
Vos résultats :

• 2 degrés :
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• 5 degrés :
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7.3.8 ��� Follow Along: Combining Raster Analysis Results

Vous avez maintenant généré trois couches raster à partir du DEM :
• aspect_north : terrain orienté au nord
• slope_lte2 : pente égale ou inférieure à 2 degrés
• slope_lte5 : pente égale ou inférieure à 5 degrés

Lorsque la condition est remplie, la valeur du pixel est 1. Ailleurs, elle est de 0. Par conséquent, si vous multipliez
les rasters, les pixels qui ont une valeur de 1 pour tous les rasters auront une valeur de 1 (les autres auront 0).
Les conditions à remplir sont les suivantes :

• à 5 degrés de pente ou moins, le terrain doit être orienté vers le nord
• à 2 degrés de pente ou en dessous, la direction à laquelle le terrain fait face n’a pas d’importance.

Par conséquent, vous devez trouver des zones où la pente est égale ou inférieure à cinq degrés AND le terrain est
orienté vers le nord, OR la pente est égale ou inférieure à 2 degrés. Un tel terrain serait propice au développement.
Pour calculer les zones qui satisfont ces critères :

1. Ouvrir à nouveau la Calculatrice raster.
2. Utilisez cette expression dans Expression: :
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( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

3. Définissez le paramètre couche reference à aspect_north (peu importe si vous en choisissez un autre - ils
ont tous été calculés à partir de srtm_41_19)

4. Enregistrez le résultat sous exercise_data/raster_analysis/ sous all_conditions.tif
5. Cliquez sur Exécuter

Le résultat :

Indication: Les étapes précédentes auraient pu être simplifiées en utilisant la commande suivante :

((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 <= 5) OR slope@1 <= 2
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7.3.9 ��� Follow Along: Simplifying the Raster

Comme vous pouvez le voir sur l’image ci-dessus, l’analyse combinée nous a laissé de nombreuses et très petites
zones où les conditions sont remplies (en blanc). Mais ces zones ne sont pas vraiment utiles pour notre analyse, car
elles sont trop petites pour qu’on puisse y construire quoi que ce soit. Débarrassons-nous de toutes ces petites zones
inutilisables.

1. Ouvrez l’outil tamis (GDAL ► Analyse raster dans la boite a outil traitement)
2. Mettez le fichier Input à all_conditions, et le fichier tamis à all_conditions_sieve.tif (sous

exercise_data/raster_analysis/).
3. Réglez le Threshold à 8 (minimum huit pixels contigus), et vérifiez le Use 8-connectedness.

Une fois le traitement terminé, la nouvelle couche sera chargée.
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Que se passe-t-il ? La réponse se trouve dans les métadonnées du nouveau fichier raster.
4. Visualisez les métadonnées sous l’onglet Information du dialogue proprietes couche. Regardez la valeur

STATISTICS_MINIMUM :
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Ce raster, comme celui dont il est dérivé, ne doit comporter que les valeurs 1 et 0, mais il comporte également
un très grand nombre de négatif. L’examen des données montre que ce nombre agit comme une valeur nulle.
Puisque nous ne recherchons que les zones qui n’ont pas été filtrées, fixons ces valeurs nulles à zéro.

5. Ouvrez la calculatrice raster, et construire cette expression: :

(all_conditions_sieve@1 <= 0) = 0

Cela permettra de maintenir toutes les valeurs non négatives, et de mettre les nombres négatifs à zéro, laissant
toutes les zones avec la valeur 1 intactes.

6. Enregistrez le résultat sous exercise_data/raster_analysis/ sous le nom de
all_conditions_simple.tif.

Votre sortie ressemble à cela :

C’est ce qui était attendu : une version simplifiée des résultats précédents. Souvenez-vous que si les résultats que vous
obtenez à partir d’un outil ne sont pas ceux que vous attendiez, visualiser les métadonnées (et les attributs vectoriels,
si applicable) peut s’avérer essentiel pour résoudre le problème.

7.3.10 ��� Follow Along: Reclassifying the Raster

Nous avons utilisé la calculatrice raster pour effectuer des calculs sur des couches raster. Il existe un autre outil
puissant que nous pouvons utiliser pour extraire des informations des couches existantes.
Retour à la couche « aspect ». Nous savons maintenant qu’elle a des valeurs numériques dans une fourchette de 0 à
360. Ce que nous voulons faire, c’est reclasser cette couche en d’autres valeurs discrètes (de 1 à 4), selon l’aspect :

• 1 = Nord (de 0 à 45 et de 315 à 360)
• 2 = Est (de 45 à 135)
• 3 = Sud (de 135 à 225)
• 4 = Ouest (de 225 à 315)
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Cette opération peut être réalisée avec la calculatrice raster, mais la formule deviendrait très très grande.
L’outil alternatif est l’outil reclassifier par table dans le menu analyse raster dans la boite outils.

1. Lancez l’outil
2. Choisissez aspect comme Couche raster d'entrée.
3. Cliquez sur le … de Table de reclassement. Un dialogue semblable à un tableau apparaîtra, dans lequel vous

pourrez choisir les valeurs minimales, maximales et les nouvelles valeurs pour chaque classe.
4. Cliquez sur le bouton Ajouter ligne et ajoutez 5 lignes. Remplissez chaque rangée comme suit et cliquez sur

OK :

La méthode utilisée par l’algorithme pour traiter les valeurs seuils de chaque classe est définie par la limite de
gamme.

5. Enregistrez la couche comme reclassified.tif dans le dossier exercise_data/
raster_analysis/.
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6. Cliquez sur Exécuter
Si vous comparez la couche native aspect avec celle reclassifiée, il n’y a pas de grandes différences. Mais en regardant
la légende, vous pouvez voir que les valeurs vont de 1 à 4.
Donnons à cette couche un meilleur style.

1. Ouvrez le panneau style couches
2. Choisissez Paletted/Unique values, au lieu de Singleband gray.
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3. Cliquez sur le bouton classer pour récupérer automatiquement les valeurs et leur attribuer des couleurs aléatoires
:

La sortie doit ressembler à ceci (vous pouvez avoir différentes couleurs étant donné qu’elles ont été générées de
manière aléatoire) :
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Grâce à cette reclassification et au style palettisé appliqué à la couche, vous pouvez immédiatement différencier les
zones d’aspect.

7.3.11 ��� Follow Along: Querying the raster

Contrairement aux couches vecteur, les couches raster n’ont pas de table d’attributs. Chaque pixel contient une ou
plusieurs valeurs numériques (rasters à bande unique ou multibandes).
Toutes les couches rasters que nous avons utilisées dans cet exercice ne consistent qu’en une seule bande. Selon la
couche, les valeurs des pixels peuvent représenter des valeurs d’élévation, d’aspect ou de pente.
Comment pouvons-nous interroger la couche raster pour obtenir la valeur d’un pixel ? Nous pouvons utiliser le bouton

Identifier des entités !
1. Sélectionnez l’outil dans la barre d’outils Attributs.
2. Cliquez sur un emplacement aléatoire de la couche srtm_41_19. identifier résultat apparaîtra avec la valeur de

la bande à l’emplacement cliqué :
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3. Vous pouvez changer la sortie du panneau Résultat de l’identification du mode arbre actuel à un mode table
en sélectionnant Table dans le menu Vue en bas du panneau :

Cliquer sur chaque pixel pour obtenir la valeur du raster pourrait devenir ennuyeux après un certain temps. Nous
pouvons utiliser le plugin outil valeur pour résoudre ce problème.

1. Allez à Extensions ► Gérer/Installer des extensions…

2. Dans l’onglet tous, tapez value t dans la zone de recherche
3. Sélectionnez l’extension Value Tool, appuyez sur Installer l’extension et ensuite Fermer la fenêtre.
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Le nouveau panneau Value Tool apparaîtra.

Astuce: Si vous fermez le panneau, vous pouvez le rouvrir en l’activant dans la section Vue ► Panneaux ►
Value Tool ou en cliquant sur l’icône dans la barre d’outils.

4. Pour utiliser le plugin, il suffit de cocher la case Activer et de s’assurer que la couche srtm_41_19 est active
(cochée) dans le panneau Couches.

5. Déplacez le curseur sur la carte pour voir la valeur des pixels.
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6. Mais il y a plus. Le plugin Value Tool vous permet d’interroger toutes les couches raster actives dans le panneau
couches. Activez à nouveau les couches aspect et pente et passez la souris sur la carte :

7.3.12 Conclusion

Vous avez vu comment dériver toutes sortes de produits d’analyse à partir d’un DEM. Il s’agit notamment des calculs
de la hauteur, de la pente et de l’aspect. Vous avez également vu comment utiliser la calculatrice matricielle pour
analyser et combiner ces résultats. Enfin, vous avez appris comment reclasser une couche et comment interroger les
résultats.

7.3.13 La suite ?

Maintenant que vous avez deux analyse : l’analyse vectorielle qui vous montre les parcelles susceptibles de convenir,
et l’analyse raster qui vont montre le terrain susceptibles de convenir. Comment peut-on les combiner pour arriver à
un résultat final pour ce problème ? C’est le sujet de la prochaine leçon, qui commence dans le module suivant.
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Module : Compléter l’analyse

Vous avez maintenant deux moitiés de l’analyse: une partie vecteur et une partie raster. Dans ce module, vous verrez
comment combiner les deux. Vous conclurez l’analyse et présenterez les résultats définitifs.

8.1 Leçon : Conversion Raster vers Vecteur

La conversion entre les formats raster et vecteur vous permet d’utiliser des données raster et vectorielles lors de la
résolution d’un problème de SIG, aussi bien que l’utilisation des différentes méthodes d’analyse propres à ces deux
formes de données géographiques. Cela augmente la flexibilité que vous avez lors de l’examen des sources de données
et méthodes de traitement pour résoudre un problème de SIG.
Pour combiner une analyse raster et vectorielle, vous devez convertir un type de données à l’autre. Convertissons le
résultat raster de la précédente leçon en un vecteur.
Objectif de cette leçon : Obtenir le résultat rater dans un vecteur qui peut être utilisé pour compléter l’analyse.

8.1.1 ��� Pas à pas : L’outil Raster vers vecteur

Débutez avec la carte du dernier module, raster_analysis.qgs. Ici, vous devriez avoir le
all_conditions_simple.tif calculé durant les derniers exercices.

• Cliquez sur Raster ► Conversion ► Polygoniser (Raster à Vecteur). La boîte de dialogue de l’outil apparaîtra.
• Configurez-la comme ceci :
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• Changez le nom du champ (décrivant les valeurs du raster) en suitable.
• Enregistrez la couche sous exercise_data/residential_development sous all_terrain.
shp.

Vous avez maintenant un fichier vecteur qui contient toutes les valeurs raster, mais les seules zones qui vous intéressent
sont celles qui sont appropriées ; c’est-à-dire les polygones où la valeur de suitable est « 1 ». Vous pouvez changer le
style de cette couche si vous voulez en avoir une visualisation plus claire.

8.1.2 ��� Essayez vous-même

Reportez-vous au module sur l’analyse vectorielle.
• Créez un nouveau fichier vecteur qui ne contient que les polygones où suitable a la valeur de 1.
• Enregistrez le nouveau fichier sous exercise_data/residential_development/ sous
suitable_terrain.shp.

Réponse
1. Ouvrez le Constructeur de requêtes en faisant un clic droit sur la couche all_terrain dans le panneau Couches

puis en sélectionnant l’onglet Propriétés ► Source.
2. Construisez ensuite la requête "suitable" = 1.
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3. Cliquez sur OK pour valider et enlever tous les polygones qui ne remplissent pas cette condition. Lorsque
visualisés par-dessus le raster, on constatera que les périmètres se superposent parfaitement :

4. Vous pouvez sauvegarder cette couche en faisant un clic droit sur la couche all_terrain dans le panneau Couches
et sélectionnant Enregistrer sous…, puis suivez les instructions.

8.1.3 ��� Pas à pas : L’outil Vecteur vers raster

Bien qu’inutile pour notre problème actuel, il est utile de connaître la conversion inverse de celle effectuée ci-dessus.
Convertissez en raster le fichier vecteur suitable_terrain.shp que vous venez de créer à l’étape précédente.

• Cliquez sur Raster ► Conversion ► Rastériser (Vecteur à Raster) pour démarrer cet outil, puis configurez-le
comme dans la capture d’écran ci-dessous :
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• la Couche d’entrée est all_terrain.
• Le nom du champ est suitable.
• L”Unité de la taille du raster en sortie est Pixels.
• largeur et hauteur sont respectivement 837 et 661
• Récupérez l”Emprise de la sortie à partir de la couche all_terrain.
• Enregistrez le fichier de sortie Rasterisé sous exercise_data/residential_development/
raster_conversion.tif.

Note: La taille de l’image de sortie est spécifiée ici pour être la même que dans le raster d’origine qui a été vectorisé.
Pour voir les dimensions d’une image, ouvrez ses métadonnées (ongletMétadonnées dans les Propriétés de la couche).

• Cliquez sur OK dans la boîte de dialogue pour commencer le processus de conversion.
• Quand le processus est terminé, jugez son résultat en comparant le nouveau raster avec le raster original. Ils
devraient correspondre parfaitement, pixel sur pixel.
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8.1.4 Conclusion

La conversion entre les formats raster et vecteur vous permet d’accroître l’applicabilité des données, et ne doit pas
conduire à la dégradation des données.

8.1.5 La suite ?

Maintenant que nous avons les résultats de l’analyse de terrain disponible dans un format vectoriel, ils peuvent
être utilisés pour résoudre le problème de quels bâtiments nous devons prendre en compte pour le développement
résidentiel.

8.2 Leçon : Combiner les analyses

Utiliser les résultats vectorisés de l’analyse raster vous permettra de sélectionner seulement ces bâtiments sur un terrain
approprié.
Objectif de cette leçon : Utiliser les résultats de la vectorisation du terrain pour sélectionner des parcelles
appropriées.

8.2.1 ��� Essayez vous-même

1. Enregistrez votre carte actuelle (raster_analysis.qgs).
2. Ouvrez la carte que vous avez créée lors de l’analyse vecteur précédente (vous devriez avoir enregistré le fichier

sous le nom analysis.qgs).
3. Dans le panneau Couches, activez ces couches :

• ombrage,
• solution (ou buildings_over_100)

4. En plus de ces couches, qui devraient déjà être chargées dans la carte lorsque vous avez travaillé dessus
auparavant, ajoutez également l’ensemble de données suitable_terrain.shp.

5. S’il vous manque certaines couches, vous devriez les trouver dans exercise_data/
residential_development/

6. Utilisez l’outil Intersection (Vecteur ► Outils géoprocessing) pour créer une nouvelle couche vecteur appelée
new_solution.shp qui contient uniquement les bâtiments qui croisent la couche suitable_terrain.

Vous devriez maintenant avoir une couche qui montre certains bâtiments comme votre solution, par exemple :
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8.2.2 ��� Essayez vous-même : Inspecter les résultats

Regardez chacun des bâtiments de votre couche new_solution. Comparez-les avec la couche suitable_terrain en
changeant la symbologie pour la couche new_solution afin qu’elle n’ait que des bordures. Que remarquez-vous à
propos de certains de ces bâtiments ? Sont-ils tous appropriés juste parce qu’ils croisent la couche suitable_terrain ?
Pourquoi ou pourquoi pas ? Lesquels allez-vous estimer comme non appropriés ?

Réponse
You may notice that some of the buildings in your new_solution layer have been « sliced » by the Intersection
tool. This shows that only part of the building - and therefore only part of the property - lies on suitable terrain. We
can therefore sensibly eliminate those buildings from our dataset.

8.2.3 ��� Essayez vous-même : Affiner l’analyse

Vous pouvez voir dans les résultats que certains bâtiments qui ont été inclus ne sont pas vraiment appropriés, nous
pouvons donc affiner l’analyse.
Nous voulons nous assurer que notre analyse ne renvoie que les bâtiments qui se situent entièrement dans la couche
suitable_terrain. Comment y parviendrez-vous ? Utilisez un ou plusieurs outils d’analyse vecteur et souvenez-vous
que nos bâtiments ont tous une superficie supérieure à 100 mètres carrés.

Réponse
À l’heure actuelle, votre analyse devrait ressembler à ceci :
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Considérez une zone circulaire, continue sur 100 mètres dans toutes les directions.

Si elle est supérieure à 100 mètres de rayon, alors soustraire 100 mètres de sa taille (de toutes les directions) laissera
une partie au milieu.
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Therefore, you can run an interior buffer of 100 meters on your existing suitable_terrain vector layer. In the output
of the buffer function, whatever remains of the original layer will represent areas where there is suitable terrain for
100 meters beyond.
Pour démontrer :

1. Go to Vector ► Geoprocessing Tools ► Buffer(s) to open the Buffer(s) dialog.
2. Définissez-le comme ceci:
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3. Use the suitable_terrain layer with 10 segments and a buffer distance of -100. (The distance is automatically
in meters because your map is using a projected CRS.)

4. Save the output in exercise_data/residential_development/ as
suitable_terrain_continuous100m.shp.

5. If necessary, move the new layer above your original suitable_terrain layer.
Vos résultats ressembleront à peu près à ceci :
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6. Now use the Select by Location tool (Vector ► Research Tools ► Select by location).
7. Définissez-le comme ceci :

8. Select features in new_solution that intersect features in suitable_terrain_continuous100m.shp.
Voici le résultat :
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The yellow buildings are selected. Although some of the buildings fall partly outside the new
suitable_terrain_continuous100m layer, they lie well within the original suitable_terrain layer and therefore
meet all of our requirements.

9. Enregistrez le nouveau fichier dans le dossier exercise_data/residential_development/ sous
le nom final_answer.shp.

8.2.4 Conclusion

Vous avez maintenant répondu à la question originale de recherche, et pouvez donner une opinion (avec raisons,
soutenu par l’analyse) pour une recommandation concernant la propriété à développer.

8.2.5 La suite ?

Vous présenterez ensuite ces résultats dans le cadre de votre deuxième travail.

8.3 Mission

À l’aide de la mise en page d’impression, créez une nouvelle carte représentant les résultats de votre analyse. Inclure
ces couches:

• places (avec étiquettes)
• ombrage,
• solution (ou nouvelle_solution),
• roads et
• au choix photos_aeriennes ou MNE.
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Rédigez un court paragraphe en guise d’accompagnement. Incluez dans ce texte les critères qui ont été utilisés
dans la considération d’une maison pour l’achat et le développement ultérieur, aussi bien que l’explication de vos
recommandations pour lesquelles les bâtiments sont appropriées.

8.4 Leçon : Exercice Supplémentaire

Dans cette leçon, vous serez guidé à travers une analyse complète de SIG dans QGIS.

Note: Leçon élaborée par Linfiniti Consulting (Afrique du Sud) et Siddique Motala (Université de technologie de
la péninsule du Cap)

8.4.1 Énoncé du problème

Vous êtes mandaté pour trouver les aires de la Péninsule du Cap et alentours adaptées à l’accueil d’espèces rares
de plante « fynbos ». L’étendue de votre aire d’investigation couvre Cape Town et la péninsule du Cap entre
Melkbosstrand au nord et Strand au sud. Les botanistes vous ont fourni les caractéristiques suivantes adaptées aux
espèces en question:

• elle se développe sur les pentes orientées à l’est
• elle se développe sur des pentes d’inclinaison comprises entre 15% et 60%
• elle se développe sur des surfaces qui enregistrent un cumul annuel de pluies >1000mm
• elle devra se situer à au moins 250m de tout aménagement humain
• la zone de végétation dans laquelle elle se situera, doit être d’au moins 6000 m²

En tant qu’étudiant à l’université, vous avez accepté de rechercher la plante dans quatre zones différentes de terrain
approprié. Vous voulez que ces quatre zones soient les plus proches de l’université du Cap où vous vivez. Utilisez vos
compétences en SIG pour déterminer où vous devez aller pour chercher.

8.4.2 Aperçu de la solution

Les données de cet exercice se trouvent dans le dossier :file`exercise_data/more_analysis`.
Vous devez trouver les quatre sites adaptés le plus proche de l’Université de Cape Town.
La solution impliquera :

1. Analyse d’une couche rasterMNE (DEM) pour trouver les pentes orientées à l’est et les pentes avec les gradients
corrects

2. Analyse d’une couche raster des précipitations pour trouver les zones ayant la bonne quantité de pluie
3. Analyse d’une couche vectorielle de zonage pour trouver des secteurs éloignés des sociétés humaines et de la

bonne taille
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8.4.3 Follow Along: Setting up the Map

1. Cliquez sur le bouton CRS courant dans le coin inférieur droit de l’écran. Sous l’onglet CRS du dialogue qui
apparaît, utilisez l’outil « Filtre » pour rechercher « 33S ». Sélectionnez l’entréeWGS 84 / UTM zone 33S (avec
le code EPSG 32733).

2. Cliquez sur OK

Figure8.1: Mise en place du SCR

3. Enregistrez le fichier de projet en cliquant sur le bouton Enregistrer le projet de la barre d’outils, ou utilisez
l’élément de menu Projet► Enregistrer sous….
Enregistrez-le dans un nouveau dossier appelé Rasterprac, que vous devez créer quelque part sur votre
ordinateur. Vous enregistrerez également les couches que vous aurez créées dans ce dossier. Enregistrez le
projet sous le nom votre_nom_fynbos.qgs.
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8.4.4 Chargement de données dans la carte

Afin de traiter les données, vous devrez charger les couches nécessaires (noms des rues, zones, précipitations, MNE,
quartiers) dans le canevas de la carte.

Pour les données vectorielles…

1. Cliquez sur le bouton | dataSourceManager | Ouvrir le gestionnaire de sources de données dans la barre d’outils du

gestionnaire de sources de données, et activez l’onglet Vecteur dans la boîte de dialogue qui apparaît, ou
utilisez Layer -> Add Layer -> Ajouter un calque vectoriel …

2. Assurez-vous que Fichier est sélectionné
3. Cliquez sur le bouton… pour rechercher le(s) jeu(x) de données vecteur
4. Dans la boîte de dialogue qui apparaît, ouvrez le dossier exercise_data/more_analysis/Streets.
5. Sélectionnez le fichier Street_Names_UTM33S.shp
6. Cliquer sur Ouvrir.

Le dialogue se ferme et affiche le dialogue original, avec le chemin d’accès au fichier spécifié dans le champ
de texte à côté de Jeu(x) de données vectorielles. Cela vous permet de vous assurer que le bon fichier est
sélectionné. Il est également possible de saisir manuellement le chemin d’accès au fichier dans ce champ, si
vous le souhaitez.

7. Cliquez sur ajouter. La couche vecteur sera chargée dans votre carte. Sa couleur est automatiquement assignée.
Vous la changerez plus tard.

8. Renommez la couche en Streets.
1. Faites un clic droit dessus dans le panneau couches (par défaut, le panneau situé sur le côté gauche de

l’écran)
2. Cliquez sur renommer dans le dialogue qui apparaît et renommez-le, en appuyant sur la touche Entrée

lorsque vous avez terminé
9. Répétez le processus d’ajout de vecteurs, mais cette fois, sélectionnez le fichier

Generalised_Zoning_Dissolve_UTM33S.shp dans le dossier Zoning.
10. Renommez-le en Zoning.
11. Chargez également la couche vecteur admin_boundaries/Western_Cape_UTM33S.shp dans votre

carte.
12. Renommez-la en districts.

Pour les raster…

1. Cliquez sur le bouton Ouvrir le Gestionnaire des sources de données et activez l’onglet Raster dans le dialogue qui
apparaît, ou utilisez l’élément de menu Couche ► Ajouter une couche ► Ajouter une couche raster….

2. Assurez-vous que Fichier est sélectionné
3. Naviguez vers le fichier approprié, sélectionnez-le et cliquez sur Ouvrir.
4. Faites-le pour chacun des deux fichiers raster suivants, DEM/SRTM.tif et rainfall/reprojected/

rainfall.tif.
5. Renommez la grille SRTM en DEM et la grille des précipitations en Rainfall (avec une majuscule initiale)
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8.4.5 Changement de l’ordre des couches

Cliquez et faites glisser les couches de haut en bas dans le panneau couches pour modifier l’ordre dans lequel elles
apparaissent sur la carte afin que vous puissiez voir autant de couches que possible.
Maintenant que toutes les données sont chargées et correctement visibles, l’analyse peut commencer. Il est préférable
que l’opération de découpage soit effectuée en premier. De cette façon, aucune puissance de calcul n’est gaspillée
pour calculer des valeurs dans des domaines qui ne seront pas utilisés de toute façon.

8.4.6 Trouver les bons districts

En raison du domaine d’investigation susmentionné, nous devons limiter nos districts aux suivants :
• Bellville

• Cape

• Goodwood

• Kuils River

• Mitchells Plain

• Simon Town

• Wynberg

1. Cliquez avec le bouton droit de la souris sur la couche Districts dans le panneau Couches.
2. Dans le menu qui apparaît, sélectionnez l’élément de menu Filtrer…. La boîte de dialogue Constructeur de

requêtes apparaît.
3. Vous allez maintenant construire une requête pour sélectionner uniquement les districts candidats :

1. Dans la liste des champs, double-cliquez sur le champ NAME_2 pour le faire apparaître dans le champ
de texte SQL where clause ci-dessous

2. Cliquez sur le bouton IN pour l’ajouter à la requête SQL
3. Ouvrez les parenthèses
4. Cliquez sur le bouton tous sous la liste (actuellement vide) valeurs.

Après un court délai, cela remplira la liste valeurs avec les valeurs du champ sélectionné (NAME_2).
5. Double-cliquez sur la valeur Bellville dans la liste valeurs pour l’ajouter à la requête SQL.
6. Ajoutez une virgule et double-cliquez pour ajouter le district Cape
7. Répétez l’étape précédente pour les autres districts
8. Fermer les parenthèses

Figure8.2: Constructeur de requêtes
La dernière requête doit être (l’ordre des districts entre parenthèses n’a pas d’importance): :

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Note: Vous pouvez également utiliser l’opérateur OR ; la requête ressemblerait à ceci: :

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'
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1. Cliquez deux fois sur OK.
Les districts indiqués sur votre carte sont désormais limités à ceux de la liste ci-dessus.

8.4.7 Découper les rasters

Maintenant que vous avez une zone d’intérêt, vous pouvez couper les rasters sur cette zone.
1. Ouvrez le dialogue de découpage en sélectionnant l’élément de menu Raster► Extraction► découper le raster

à partir d’une couche de masque…

2. Dans la liste déroulante Couche source, sélectionnez la couche DEM.
3. Dans la liste déroulante Couche de masquage, sélectionnez la couche Districts.
4. Faites défiler vers le bas et spécifiez un emplacement de sortie dans le champ de texte Découpé (masque) en

cliquant sur le bouton… et en choisissant Enregistrer vers un fichier…
1. Naviguez vers le répertoire Rasterprac.
2. Entrez un nom de fichier - DEM_clipped.tif
3. Enregistrer

5. Assurez-vous que la case ouvrir le fichier en sortie après exécution de l’algorithme est cochée
6. Cliquez sur Exécuter

Une fois l’opération de découpage terminée, laissez la boîte de dialogue découper le raster à partir d’une couche
masque ouverte, afin de pouvoir réutiliser la zone de découpage

7. Sélectionnez la couche raster Rainfall dans la liste déroulante Couche d’entrée et enregistrez votre sortie
sous le nom Rainfall_clipped.tif.

8. Ne modifiez pas les autres options. Laissez tout comme avant et cliquez sur Exécuter.
9. Une fois la deuxième opération de découpage terminée, vous pouvez fermer la boîte de dialogue découper le

raster à partir d’une couche masque

10. Enregistrer la carte
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Figure8.3: Vue de la carte avec des couches vectorielles filtrées, rasters découpées et réagencées

Aligner les raster

Pour notre analyse, nous avons besoin que les rasters aient le même CRS et qu’ils soient alignés.
Nous commençons par modifier la résolution de nos données pluviométriques à 30 mètres (taille du pixel) :

1. Dans le panneau Couches, assurez-vous que Rainfall_clipped est la couche active (c’est-à-dire qu’elle
est mise en évidence en ayant été cliquée)

2. Cliquez sur le menu Raster ► Projections ► Projection(Warp) ` pour ouvrir le dialogue de l’algorithme
:guilabel:`Projection (warp)

3. Sous Méthode de ré-échantillonnage à utiliser, sélectionnez Bilinear (2x2 kernel) dans le menu déroulant
4. Fixez la Résolution du fichier de sortie dans les unités de géoréférencement de la cible à 30
5. Scrollez jusqu’à Reprojeté et enregistrez la sortie vers le dossier rainfall/reprojected sous le nom

Rainfall30.tif.

6. Assurez-vous que la case ouvrir le fichier en sortie après exécution de l’algorithme est cochée

Figure8.4: Warp (Reproject) Rainfall_clipped

Ensuite, nous alignons le MNE:
1. Dans le panneau Couches, assurez-vous que DEM_clipped est la couche sélectionnée (càd qu’elle soit mise

en évidence après un clic)
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2. Cliquez sur le menu Raster ► Projections ► Projection(Warp) ` pour ouvrir le dialogue de l’algorithme
:guilabel:`Projection (warp)

3. Sous SCR cible, sélectionnez SCR du Project: EPSG:32733 - WGS 84 / UTM zone 33S dans le menu déroulant
4. Sous Méthode de ré-échantillonnage à utiliser, sélectionnez Bilinear (2x2 kernel) dans le menu déroulant
5. Fixez la Résolution du fichier de sortie dans les unités de géoréférencement de la cible à 30
6. Descendez jusqu’à Etendue du fichier de sortie qui va être créé. Utilisez le bouton à droite du champ texte pour

sélectionner Calculer depuis la couche ► Rainfall30.
7. Descendez jusqu’àReprojecté et sauvez la sortie dans votre dossierDEM/reprojected sous le nomDEM30.

tif.

8. Assurez-vous que la case ouvrir le fichier en sortie après exécution de l’algorithme est cochée
Afin de bien voir ce qu’il se passe, la symbologie des couches doit être changée.

8.4.8 Changement de la symbologie des couches vectorielles

1. Dans le panneau Couches, faites un clic droit sur la couche Streets.
2. Sélectionnez Propriétés dans le menu qui apparaît
3. Passez à l’onglet Symbologie dans la boîte de dialogue qui apparaît
4. Cliquez sur l’entrée Ligne dans le widget du haut
5. Sélectionnez un symbole dans la liste ci-dessous ou fixez-en un nouveau (couleur, transparence, …)
6. Cliquez sur OK pour fermer la boîte de dialogue Propriétés couche. Cela va changer le rendu de la couche

Streets.
7. Suivez un processus similaire pour la couche Zoning et choisissez une couleur appropriée pour celle-ci

8.4.9 Changement de la symbologie des couches raster

La symbologie des couches raster est quelque peu différente.
1. Ouvrez le dialogue Propriétés pour la couche raster Rainfall30
2. Passez à l’onglet Symbologie. Vous remarquerez que ce dialogue est très différent de la version utilisée pour les

couches vectorielles.
3. Développer Paramètres des valeurs min/max
4. Assurez-vous que le bouton moyenne +/- écart-type est selectionne
5. Assurez-vous que la valeur dans la case associée est 2.00.
6. Pour amelioration du contraste, assurez-vous qu’il est écrit Etirer jusqu’au MinMax.
7. Pour Color gradient, changez-le enWhite to Black.
8. Cliquez sur OK

Figure8.5: Symbologie raster

Le raster Rainfall30, s’il est visible, doit changer de couleur, ce qui vous permet de voir différentes valeurs
de luminosité pour chaque pixel

9. Répétez ce processus pour la couche DEM30, mais fixez les écarts types utilisés pour l’étirement à 4,00.
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8.4.10 Nettoyer la carte.

1. Supprimez les couches originales Rainfall et DEM, ainsi que Rainfall_clipped et DEM_clipped
du panneau couches :

• Faites un clic-droit sur ces couches et sélectionnez Supprimer.

Note: Cela ne va pas supprimer les données de votre périphérique de stockage, cela va seulement l’ôter
de votre carte.

2. Enregistrer la carte
3. Vous pouvez maintenant cacher les couches vecteur en décochant la case à côté d’elles dans le panneau couches.

Cela accélérera le rendu de la carte et vous fera gagner du temps.

8.4.11 Créer l’ombrage

Afin de créer l’ombrage, vous devrez utiliser un algorithme créé dans ce but.
1. Dans le panneau couches, assurez-vous que DEM30 est la couche active (c’est-à-dire qu’elle est mise en évidence

en ayant été cliquée)
2. Cliquez sur le menu Raster ► Analyse ► Ombrage… pour ouvrir le dialogue ombrage
3. Descendez jusqu’à Ombrage et enregistrez la sortie dans votre répertoire Rasterprac sous le nom

hillshade.tif.

4. Assurez-vous que la case ouvrir le fichier en sortie après exécution de l’algorithme est cochée
5. Cliquez sur Exécuter
6. Attendez que le processus se termine.

Figure8.6: Raster analysis Hillshade

La nouvelle couche hillshade est apparue dans le panneau Couches.
1. Faites un clic droit sur la couche hillshade dans le panneau Couches” et faites apparaître la fenêtre des

:guilabel:`Propriétés

2. Cliquez sur l’onglet Transparence et réglez le curseur Opacité globale sur 20%.
3. Cliquez sur OK
4. Notez l’effet lorsque l’ombre transparente est superposée sur le MNE (DEM) coupé. Vous devrez peut-être

changer l’ordre de vos couches, ou cliquer sur la couche Rainfall30 pour voir l’effet.

8.4.12 Slope

1. Cliquez sur le menu Raster ► Analyse ► Pente… pour ouvrir le dialogue de l’algorithme Pente
2. Sélectionnez DEM30 comme Couche d’entrée.

3. Check Pente exprimée en pourcentage au lieu de degrés. La pente peut être exprimée en différentes unités
(pourcentage ou degrés). Nos critères suggèrent que la plante d’intérêt pousse sur des pentes dont la pente est
comprise entre 15 et 60 %. Nous devons donc nous assurer que nos données sur la pente sont exprimées en
pourcentage.

4. Indiquez un nom de fichier et un emplacement appropriés pour votre sortie.
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5. Assurez-vous que la case ouvrir le fichier en sortie après exécution de l’algorithme est cochée
6. Cliquez sur Exécuter

Figure8.7: Raster analysis Slope

L’image de la pente a été calculée et ajoutée à la carte. Comme d’habitude, elle est rendue en niveaux de gris. Changez
la symbologie pour une symbologie plus colorée :

1. Ouvrez la couche Dialogue des propriétés (comme d’habitude, via le menu contextuel de la couche)
2. Cliquez sur l’onglet Symbologie
3. Là où il est écrit Bande grise unique (dans le menu déroulant Type de rendu), changez-le en Pseudo-couleur à

bande unique.
4. Choisissez moyenne +/- écart-type x pour parametre valeur Min / Max ` avec une valeur de ``2.0`.
5. Sélectionnez une rampe de couleurs appropriée
6. Cliquez sur Exécuter

8.4.13 Try Yourself: Aspect

Utilisez la même approche que pour le calcul de la pente, en choisissant Aspect… dans le menu Raster ► analyse.
N’oubliez pas de sauvegarder le projet régulièrement.

8.4.14 Reclassement des rasters

1. Choisissez Raster ► calculatrice raster…

2. Indiquez votre répertoire Rasterprac comme emplacement pour la couche Output (cliquez sur le bouton
…), et enregistrez-le sous le nom slope15_60.tif.

3. Assurez-vous que la case ouvrir le fichier sortie après exécution de l’algorithme est sélectionnée.
Dans la liste bandes raster sur la gauche, vous verrez toutes les couches raster dans votre panneau couches.
Si votre couche Pente est appelée slope, elle sera répertoriée comme pente@1. Indication de la bande 1 du
raster de pente.

4. La pente doit être comprise entre 15 et 60 degrés.
En utilisant les éléments de la liste et les boutons de l’interface, construisez l’expression suivante: :

(slope@1 > 15) AND (slope@1 < 60)

5. Configurez le champ Couche de sortie avec un emplacement approprié et un nom de fichier.
6. Cliquez sur Exécuter.

Figure8.8: Raster calculator Slope

Trouvez maintenant l’aspect correct (face est : entre 45 et 135 degrés) en utilisant la même approche.
1. Construisez l’expression suivante: :
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(aspect@1 > 45) AND (aspect@1 < 135)

Vous saurez que cela a fonctionné lorsque toutes les pentes orientées vers l’est seront blanches dans le raster résulta t
(c’est presque comme si elles étaient éclairées par le soleil du matin).
Trouvez de la même manière la bonne pluviométrie (supérieure à 1000 mm). Utilisez l’expression suivante: :

Rainfall30@1 > 1000

Maintenant que vous disposez de ces trois critères, chacun dans une grille distincte, vous devez les combiner pour voir
quelles zones répondent à tous les critères. Pour ce faire, les rasters seront multipliés les uns par rapport aux autres.
Dans ce cas, tous les pixels qui se chevauchent et qui ont une valeur de 1 conserveront la valeur de 1 (c’est-à-dire
que l’emplacement répond aux critères), mais si un pixel de l’un des trois rasters a une valeur de 0 (c’est-à-dire que
l’emplacement ne répond pas aux critères), alors il aura une valeur de 0 dans le résultat. De cette façon, le résultat ne
contiendra que les zones de chevauchement qui répondent à tous les critères appropriés.

8.4.15 Combiner des rasters

1. Ouvrez la Calculatrice raster (Raster ► calculatrice raster…)
2. Construisez l’expression suivante (avec les noms appropriés pour vos couches): :

[aspect45_135] * [slope15_60] * [rainfall_1000]

3. Définissez l’emplacement de sortie dans le répertoire Rasterprac.
4. Nommez le raster en sortie : file:aspect_slope_rainfall.tif.

5. Assurez-vous que la case ouvrir le fichier après exécution de l’algorithme est cochée
6. Cliquez sur Exécuter

Le nouveau raster affiche désormais correctement les zones où les trois critères sont satisfaits.
Sauvegardez le projet.

Figure8.9: Vue de la carte où les trois critères sont satisfaits

Le prochain critère à remplir est que la zone doit être éloignée de 250 mètres des zones urbaines. Nous satisferons à
cette exigence en nous assurant que les zones que nous calculons se trouvent à l’intérieur de zones rurales et qu’elles
sont à 250mètres ou plus de la limite de la zone. C’est pourquoi nous devons d’abord trouver toutes les zones rurales.

8.4.16 Trouver les zones rurales

1. Cacher toutes les couches dans le panneau couche
2. Masquer la couche vecteur zoning
3. Faites un clic droit dessus et faites apparaître la boîte de dialogue table attribut. Notez les nombreuses façons

différentes dont la terre est zonée ici. Nous voulons isoler les zones rurales. Fermez la table des attributs.
4. Faites un clic droit sur la couche Zoning et sélectionnez filtrer… pour faire apparaître le dialogue constructeur

de requetes

5. Construisez la requête suivante: :

"Gen_Zoning" = 'Rural'
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Si vous êtes bloqué, consultez les instructions précédentes.
6. Cliquez sur OK pour fermer la fenêtre du Constructeur de requêtes. La requête devrait retourner une entité.

Zonage avec le constructeur de requêtes
Vous devriez voir les polygones ruraux de la couche zoning. Vous devrez les sauvegarder.

1. Dans le menu du clic droit pour Zoning, sélectionnez Exporter ► Sauvegarder les entités sous….
2. Enregistrez votre couche dans le répertoire Rasterprac.
3. Nommez le fichier de sortie : file:rural.shp.
4. Cliquez sur OK
5. Sauvegarder le projet

Il faut maintenant exclure les zones qui se trouvent dans un rayon de 250m de la limite des zones rurales. Pour ce
faire, il faut créer une zone tampon négative, comme expliqué ci-dessous.

8.4.17 Création d’un tampon négatif

1. Cliquez sur l’élément de menu vecteur ► outils de geoprocessing ► tampon…

2. Dans le dialogue qui apparaît, sélectionnez la couche rural comme couche vectorielle d’entrée (sélectionner
les entités seulement ne doit pas être coché)

3. Réglez Distance à -250. La valeur négative signifie que le tampon sera un tampon intérieur. Assurez-vous
que les unités sont des mètres dans le menu déroulant.

4. Check Dissoudre le résultat.
5. Dans Buffered, placez le fichier de sortie dans le répertoire Rasterprac, et nommez-le rural_buffer.

shp.
6. Cliquez sur sauver.
7. Cliquez sur executer et attendez que le traitement soit terminé
8. Fermez la boîte de dialogue Tampon.

Assurez-vous que votre tampon a fonctionné correctement en notant en quoi la couche rural_buffer est
différente de la couche rural. Vous devrez peut-être changer l’ordre de dessin afin d’observer la différence.

9. Supprimer la couche rural
10. Sauvegarder le projet
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Figure8.10: Vue de la carte avec le tampon rural (rural buffer)

Maintenant, vous devez combiner votre couche vecteur rural_buffer avec le raster
aspect_slope_rainfall. Pour les combiner, nous devrons modifier le format des données de l’une
des couches. Dans ce cas, vous vectoriserez le raster, car les couches vecteur sont plus pratiques lorsque nous voulons
calculer des surfaces.

8.4.18 Vectoriser le raster

1. Cliquez sur l’élément de menu Raster ► Conversion ► Polygoniser (Raster to Vector)…

2. Sélectionnez le raster aspect_slope_rainfall comme Couche d’entrée.
3. Définissez Nom du champ à créer`à ``suitable` (le nom du champ par défaut est DN - Digital number data)
4. Sauvegardez le résultat. Sous vectorisé, sélectionnez sauvegarder fichier sous. Définissez l’emplacement à

Rasterprac et nommez le fichier aspect_slope_rainfall_all.shp.

5. Assurez-vous que la case ouvrir le fichier après exécution de l’algorithme est cochée
6. Cliquez sur Exécuter
7. Fermer le dialogue lorsque le traitement est terminé
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Figure8.11: De raster à vecteur

Toutes les zones raster ont été vectorisées, vous devez donc sélectionner uniquement les zones qui ont une valeur de
1 dans le champ suitable. (Nombre numérique).

1. Ouvrez le dialogue constructeur requete (clic droit - Filtre…) pour la nouvelle couche vecteur
2. Construisez cette requête : :

"suitable" = 1

3. Cliquez sur OK
4. Après vous être assuré que la requête est complète (et que seules les zones qui répondent aux trois critères, c’est-

à-dire avec une valeur de 1, sont visibles), créez un nouveau fichier vecteur à partir des résultats, en utilisant la
commande Exporter ► Sauvegarder les entités sous… dans le menu contextuel de la couche

5. Enregistrez le fichier dans le répertoire Rasterprac.
6. Nommez le fichier aspect_slope_rainfall_1.shp
7. Supprimez la couche aspect_slope_rainfall_all de votre carte
8. Sauvegardez votre projet

Lorsque nous utilisons un algorithme pour vectoriser raster, l’algorithme produit parfois ce que l’on appelle des
« géométries non valides », c’est-à-dire qu’il y a des polygones vides, ou des polygones comportant des erreurs,
qui seront difficiles à analyser à l’avenir. Nous devons donc utiliser l’outil « reparer géométrie ».
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8.4.19 Réparation de géométrie

1. Dans la la boite a outil traitement, cherchez « reparer geometries », et l’executer…
2. Pour la Couche d’entrée, sélectionnez aspect_slope_rainfall_1
3. Sous reparer geometries, sélectionnez sauveharder fichier sous, et enregistrez la sortie dans Rasterprac et

nommez le fichier fixed_aspect_slope_rainfall.shp.

4. Assurez-vous que la case ouvrir le fichier après exécution de l’algorithme est cochée
5. Cliquez sur Exécuter
6. Fermer le dialogue lorsque le traitement est terminé

Maintenant que vous avez vectorisé le raster et fixé la géométrie résultante, vous pouvez combiner les critères d’aspect,
de pente et de précipitations avec la distance par rapport aux critères d’établissement humain en trouvant l’intersection
de la couche fixed_aspect_slope_rainfall et de la couche rural_buffer.

8.4.20 Déterminer l’intersection des vecteurs

1. Cliquez sur l’élément de menu vecteur ► outils géoprocessing ► Intersection…

2. Dans le dialogue qui apparaît, sélectionnez la couche rural_buffer comme Couche d’entrée
3. Pour la couche Overlay, sélectionnez la couche fixed_aspect_slope_rainfall.
4. Dans Intersection, placez le fichier de sortie dans le répertoire Rasterprac.
5. Nommez le fichier de sortie rural_aspect_slope_rainfall.shp
6. Cliquez sur sauver.
7. Cliquez sur executer et attendez que le traitement soit terminé
8. Fermez le dialogue Intersection.

Assurez-vous que votre intersection a fonctionné correctement en notant que seules les zones de chevauchement
subsistent.

9. Sauvegarder le projet
Le prochain critère de la liste est que la zone doit être supérieure à 6000 m2. Vous allez maintenant calculer les
zones de polygone afin d’identifier les zones qui ont la taille appropriée pour ce projet.

8.4.21 Calcul de l’aire pour chaque polygone

1. Ouvrez le menu contextuel de la nouvelle couche vecteur
2. Sélectionnez ouvrir la table attributs.

3. Cliquez sur le bouton basculer mode edition ` dans le coin supérieur gauche de la table, ou appuyez sur :kbd:`Ctrl+e.

4. Cliquez sur le bouton ouvrir calculateur de champ dans la barre d’outils en haut de la table, ou appuyez surCtrl+i.

5. Dans la boîte de dialogue qui apparaît, assurez-vous que la case créer un nouveau champ est cochée, et
définissez le nom du champ en sortie à area Le type de champ de sortie doit être un nombre décimal (réel).
Définissez Precision à 1 (une décimale).

6. Dans la zone Expression, tapez: :

$area
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Cela signifie que le calculateur de terrain va calculer l’aire de chaque polygone dans la couche vectorielle et va
ensuite remplir une nouvelle colonne d’entier (appelée area) avec la valeur calculée.

Figure8.12: Calculatrice de champs

7. Cliquez sur OK
8. Faites la même chose pour un autre nouveau champ appelé id. Dans Expression de la calculatrice de champ,

tapez: :

$id

Cela garantit que chaque polygone a un identifiant unique à des fins d’identification.

9. Cliquez sur basculer mode édition à nouveau, et enregistrez vos modifications si vous y êtes invité
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Figure8.13: Table d’attributs avec surface et colonnes id

8.4.22 Sélectionnez des surfaces d’une taille donnée

Maintenant que les surfaces sont connues :
1. Construisez une requête (comme d’habitude) pour sélectionner uniquement les polygones qui sont plus grands

que 6000m2. La requête est: :

"area" > 6000

2. Enregistrez la sélection dans le répertoire Rasterprac comme une nouvelle couche vecteur appelée
suitable_areas.shp.

Vous disposez maintenant des surfaces appropriées qui répondent à tous les critères d’habitat pour la plante rare qu’est
le fynbos, parmi lesquelles vous choisirez les quatre les plus proches de l’Université du Cap.

8.4.23 Numériser l’Université du Cap

1. Créer une nouvelle couche vecteur dans le dossier Rasterprac comme précédemment, mais cette fois,
utiliser Point comme Type de géométrie et la nommer university.shp.

2. Assurez-vous qu’il se trouve dans le SCR correct (Project CRS:EPSG:32733 - WGS 84 / UTM
zone 33S)

3. Terminez la création de la nouvelle couche (cliquez sur OK)
4. Cachez toutes les couches sauf la nouvelle couche university et la couche Streets.
5. Ajouter un fond de carte (OSM) :

1. Allez dans le panneau navigateur et naviguez jusqu’à tuiles XYZ ► OpenStreetMap.
2. Glissez et déposez l’entrée OpenStreetMap au bas du panneau couches
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À l’aide de votre navigateur Internet, recherchez l’emplacement de l’université du Cap. Compte tenu de la
topographie unique du Cap, l’université se trouve dans un endroit très reconnaissable. Avant de retourner à
QGIS, prenez note de l’endroit où se trouve l’université et de ce qui se trouve à proximité.

6. Assurez-vous que la couche Streets a été cliquée et que la couche University est en surbrillance dans
le panneau couches

7. Allez dans le menu vue ► barres outils et assurez-vous que numerisation est sélectionné. Vous devriez alors
voir une icône de barre d’outils avec un crayon ( basculer mode edition). C’est le bouton basculer mode edition.

8. Cliquez sur le bouton basculer en mode édition pour entrer dans le mode edition. Cela vous permet d’éditer une
couche vecteur

9. Cliquez sur le bouton ajouter un point, qui doit se trouver à proximité du bouton basculer mode edition.
10. Lorsque l’outil Ajouter une entité est activé, cliquez avec le bouton gauche de la souris sur votre meilleure

estimation de l’emplacement de l’université du Cap
11. Fournir un nombre entier arbitraire lorsqu’on demande l “ id.
12. Cliquez sur OK

13. Cliquez sur le bouton sauver modif.
14. Cliquez sur le bouton basculer en mode edition pour arrêter votre session d’édition
15. Sauvegarder le projet

8.4.24 Trouvez les lieux les plus proches de l’Université du Cap

1. Allez dans la Boîte à outils de traitement, localisez l’algorithme Joindre les attributs par le plus proche (Outils
généraux pour les vecteurs ► Joindre les attributs par le plus proche) et exécutez-le

2. Couche d’entrée devrait être university, et Couche d’entrée 2` suitable_areas.
3. Définir un emplacement et un nom de sortie appropriés (Joined layer)
4. Réglez le Maximum des plus proches voisins à 4.

5. Assurez-vous que la case ouvrir le fichier après exécution de l’algorithme est cochée
6. Laissez les autres paramètres avec leurs valeurs par défaut
7. Cliquez sur Exécuter

La couche de points qui en résultera contiendra quatre entités - elles auront toutes l’emplacement de l’université et ses
attributs, et en plus, les attributs des zones appropriées à proximité (y compris l”id), et la distance à cet emplacement.

1. Ouvrez la table d’attributs du résultat de la jointure
2. Notez l”id des quatre zones appropriées les plus proches, puis fermez la table d’attributs
3. Ouvrez la table d’attributs de la couche Suitable_areas
4. Construire une requête pour sélectionner les quatre zones appropriées les plus proches de l’université (en les

sélectionnant à l’aide du champ id)
C’est la réponse finale à la question de recherche.
Pour votre soumission, créez une mise en page entièrement étiquetée qui inclut la couche semi-transparente
« hillshade » sur un raster attrayant de votre choix (comme le DEM ou le raster de pente, par exemple). Incluez
également l’université et la couche suitable_areas, avec les quatre zones appropriées les plus proches de
l’université mises en évidence. Suivez toutes les bonnes pratiques en matière de cartographie pour créer votre carte
de sortie.
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Module : Extensions

Les extensions vous permettent d’étendre les fonctionnalités offertes par QGIS. Dans cemodule, nous vousmontrerons
comment activer et utiliser les extensions.

9.1 Leçon : Installation et gestion des extensions

Pour débuter l’utilisation des extensions, vous devez savoir comment les télécharger, les installer et les activer. Pour
ce faire, vous allez apprendre à utiliser le Plugin Installer et le Plugin Manager.
Le but de cette leçon : Comprendre le système des extensions de QGIS.

9.1.1 ��� Pas à pas : Gérer les extensions

1. Pour ouvrir le Gestionnaire d’extensions, cliquez dans le menu Extension ► Installer/Gérer les extensions.
2. Dans la fenêtre qui s’ouvre, trouvez l’extension Processing :
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3. Cliquez dans la case à côté de ce plugin et décochez-le pour le désactiver.
4. Cliquez sur Fermer.
5. En regardant le menu, vous remarquerez que le menu Processing est maintenant parti. Cela signifie que de

nombreuses fonctions de traitement que vous utilisiez auparavant ont disparu ! Par exemple, regardez les
menus Vector ► et Raster ►. C’est parce qu’ils font partie du plugin Processing, qui doit être activé pour les
utiliser.

6. Ouvrez à nouveau le Plugin Manager et réactivez le plugin Processing en cliquant dans la case à cocher à côté.
7. Fermer le dialogue. Le menu et les fonctions de Processing devraient être à nouveau disponibles.

9.1.2 ��� Pas à pas : Installer de nouvelles extensions

La liste des plugins que vous pouvez activer et désactiver s’inspire des plugins que vous avez actuellement installés.
Pour installer de nouveaux plugins :

1. Sélectionnez l’option Not Installed dans le dialogue Plugin Manager. Les plugins que vous pouvez installer
seront listés ici. Cette liste variera en fonction de la configuration de votre système existant.
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2. Trouvez des informations sur le plugin en le sélectionnant dans la liste

3. Installez ceux qui vous intéresse(nt) en cliquant sur le bouton Install Plugin situé sous le panneau d’information
des plugins.

Note: si le plugin comporte une erreur, il sera listé dans l’onglet Invalid. Vous pouvez alors contacter le propriétaire
du plugin pour résoudre le problème.
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9.1.3 ��� Pas à pas : Configurer des dépôts supplémentaires d’extensions

Les extensions sont disponibles dépendant de quels dépôts d’extensions à utiliser sont configurés.
Les plugins QGIS sont stockés en ligne dans des dépôts. Par défaut, seul le dépôt officiel est actif, ce qui signifie que
vous ne pouvez accéder qu’aux plugins qui y sont publiés. Compte tenu de la diversité des outils disponibles, ce dépôt
devrait répondre à la plupart de vos besoins.
Cependant, il est possible d’essayer plus d’extensions que celles par défaut. Premièrement, configurez les dépôts
supplémentaires. Pour ce faire :

1. Ouvrez l’onglet Parametres dans le dialogue Plugin Manager.

2. Cliquez sur Ajouter… pour trouver et ajouter un nouveau dépôt.
3. Fournissez un nom et une URL pour le nouveau dépôt que vous souhaitez configurer et assurez vous que la

case Activé est cochée.
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4. Vous devriez voir maintenant le nouveau dépôt listé dans la liste des dépôts d’extension configurés :

5. Vous pouvez également sélectionner l’option pour afficher les extensions expérimentales en cochant la case
Afficher les extensions expérimentales.

6. Si vous revenezmaintenant à l’ongletNot Installed, vous verrez que des plugins supplémentaires sont disponibles
pour l’installation.

7. Pour installer un plugin, cliquez sur celui-ci dans la liste et ensuite sur le bouton Install plugin.
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9.1.4 Conclusion

L’installation de plugins dans QGIS devrait être simple et efficace !

9.1.5 La suite ?

Nous allons ensuite vous présenter quelques extensions utiles comme exemples.

9.2 Leçon : Quelques extensions utiles dans QGIS

Maintenant que vous pouvez installer, activer et désactiver des extensions, regardons comment, dans la pratique, elles
peuvent vous aider au travers de quelques exemples d’extensions utiles.
Le but de cette leçon : Vous familiariser avec l’interface des extensions et vous faire prendre connaissance de certain
les extensions utiles.

9.2.1 ��� Follow Along: The QuickMapServices Plugin

The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has
many different options and settings. Let’s start to explore some of its features.

1. Commencez une nouvelle carte et ajoutez la couche roads du Geopackage training_data.
2. Installez le plugin QuickMapServices.
3. Click on Web ► QuickMapServices. The first menu lists different map providers (OSM, NASA) with available

maps.
4. Click on an entry and you would load the base map into your project.

Nice! But one of the main strengths of QMS is to provide access to many data providers. Let’s add them.
1. Click onWeb ► QuickMapServices ► Settings

2. Go to the More services tab.
3. Lisez attentivement le message de cet onglet et si vous êtes d’accord, cliquez sur le bouton Get Contributed

pack.
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4. Click Save.
5. Reopen theWeb ► QuickMapServices menu you will see that more providers are available.

6. Choose the one that best fits your needs, and load the data in the project!
It is also possible to search trough the now available data providers

1. Open the plugin’s search tab by clicking onWeb► QuickMapServices► Search QMS. This option of the plugin
allows you to filter the available base maps by the current extent of the map canvas or using a search word.

2. Click on the Filter by extent and you should see one service available. If no service is found, zoom out and pan
around the world (or your location) or search with a keyword.

3. Click on the Add button next to a returned dataset to load it.
4. The base map will be loaded and you will have a background for the map.
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9.2.2 ��� Follow Along: The QuickOSM Plugin

Avec une interface incroyablement simple, le plugin QuickOSM vous permet de télécharger des données
OpenStreetMap.

��� Follow Along: Using the Quick Query

1. Démarrez un nouveau projet vide et ajoutez la couche roads du GeoPackage training_data.
2. Installez le plugin QuickOSM. Le plugin ajoute deux nouveaux boutons dans la barre d’outils QGIS et est

accessible dans le menu vecteur ► QuickOSM.
3. Ouvrez le dialogue QuickOSM. Le plugin a de nombreux onglets différents : nous utiliserons celui de Quick

Query.
4. Vous pouvez télécharger des fonctionnalités spécifiques en sélectionnant un couple Key générique ou être plus

spécifique et choisir un couple Key et Value spécifique.

Astuce: si vous ne connaissez pas le système Key et Value, cliquez sur le bouton Help with key/value. Cela
ouvrira une page web avec une description complète de ce concept d’OpenStreetMap.

5. Cherchez railway dans le menu Key et laissez Value vide : nous téléchargeons donc toutes les entités de railway
sans spécifier de valeur.

6. Sélectionnez Layer Extent dans le menu déroulant suivant et choisissez roads.
7. Cliquez sur le bouton Run query.
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Après quelques secondes, le plugin téléchargera toutes les entités marquées dans OpenStreetMap comme railway
et les chargera directement dans la carte.
Rien de plus ! Toutes les couches sont chargées dans la légende et apparaissent dans le canevas de la carte.

Avertissement: QuickOSM creates temporary layer when downloading the data. If you want to save them
permanently, click on the icon next to the layer and choose the options you prefer. Alternatively you can
open the Advanced menu in QuickOSM and choose where to save the data in the Directory menu.

��� Follow Along: The QuickOSM Query engine

La façon la plus rapide de télécharger des données à partir du plugin QuickOSM est d’utiliser l’onglet Quick query et
de définir quelques petits paramètres. Mais si vous avez besoin de données plus spécifiques ?
Si vous êtes un maître de requêtes OpenStreetMap, vous pouvez utiliser le plugin QuickOSM également pour vos
requêtes personnelles.
QuickOSM dispose d’un incroyable analyseur de données qui, associé à l’incroyable moteur d’interrogation de
Overpass, vous permet de télécharger des données en fonction de vos besoins spécifiques.
Par exemple : nous voulons télécharger les pics montagneux qui appartiennent à une zone de montagne spécifique
appelée dolomites.
Vous ne pouvez pas accomplir cette tâche avec l’onglet Quick query, vous devez être plus spécifique et écrire votre
propre requête. Essayons de le faire.

1. Démarrez un nouveau projet.
2. Ouvrez le plugin QuickOSM et cliquez sur l’onglet Query.
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3. Copiez et collez le code suivant dans le canevas de requête: :

<!--
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
-->
<osm-script output="json">
<!-- search the area of the Dolomites -->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area -->
<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->
<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Note: Cette requête est écrite dans un langage de type xml. Si vous êtes plus habitué au Overpass QL,
vous pouvez écrire la requête dans ce langage.

4. Et cliquez sur Run Query :
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La couche des pics montagneux sera téléchargée et affichée dans QGIS :

Vous pouvez écrire des requêtes complexes en utilisant le langage de requête Overpass Query. Regardez quelques
exemples et essayez d’explorer le langage d’interrogation.

9.2.3 ��� Follow Along: The DataPlotly Plugin

Le plugin DataPlotly vous permet de créer des tracés D3 de données d’attributs vectoriels grâce à la bibliothèque
plotly.

1. Démarrer un nouveau projet
2. Chargez la couche sample_points dans le dossier exercise_data/plugins.
3. Installez le plugin en suivant les instructions décrites dans ��� Pas à pas : Installer de nouvelles extensions

searching Data Plotly.
4. Ouvrez le plugin en cliquant sur la nouvelle icône dans la barre d’outils ou dans le menu Plugins ► Data Plotly

Dans l’exemple suivant, nous créons un simple Scatter Plot de deux champs de la couche sample_points. Dans
le panneau DataPlotly :

1. Choisissez sample_points dans le filtre de couche, cl pour le champ X et mg pour le champ Y :
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2. Si vous le souhaitez, vous pouvez modifier les couleurs, le type de marqueur, la transparence et bien d’autres
paramètres : essayez de modifier certains paramètres pour créer le tracé ci-dessous.
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3. Une fois que vous avez défini tous les paramètres, cliquez sur le bouton Create Plot pour créer le plot
le graphique intéractif : cela signifie que vous pouvez utiliser tous les boutons supérieurs pour redimensionner,
déplacer ou zoomer sur le canevas du graphique. De plus, chaque élément du tracé est interactif : en cliquant ou
en sélectionnant un ou plusieurs points sur le tracé, le ou les points correspondants seront sélectionnés dans le canevas
du tracé.
Vous pouvez enregistrer le graphique en tant qu’image statique png ou en tant que fichier html en cliquant sur le
bouton ou sur le bouton dans le coin inférieur droit du graphique.
Ce n’est pas tout. Parfois, il peut être utile d’avoir deux (ou plusieurs) parcelles montrant différents types de graphique
avec différentes variables sur la même page. Faisons cela !

1. Retournez à l’onglet principal des paramètres du graphique en cliquant sur le bouton dans le coin supérieur
gauche du panneau des plugins

2. Changer le type graphique en graphique boite.
3. Choisissez group comme Grouping Field et ph comme Y Field.
4. Dans la partie inférieure du panneau, changez le Type of Plot de SinglePlot à SubPlots et laissez l’option par

défaut Plot in Rows sélectionnée.
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5. Une fois terminé, cliquez sur le bouton Create Plot pour dessiner le tracé

Maintenant, le nuage de points et le diagramme en boîte sont tous deux affichés sur la même page. Vous avez encore la
possibilité de cliquer sur chaque élément du diagramme et de sélectionner les entités correspondantes dans le canevas
de la carte.
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Astuce: Chaque graphique a sa propre page de manuel disponible dans . Essayez d’explorer tous les types de
tracés et de voir tous les autres paramètres disponibles.

9.2.4 Conclusion

Il existe de nombreuses extensions disponibles pour QGIS. En utilisant les outils intégrés pour l’installation et la
gestion de ces extensions, vous pouvez trouver de nouvelles extensions et en faire une utilisation optimale.

9.2.5 La suite ?

Nous allons ensuite voir comment utiliser en temps réel des couches qui sont hébergées sur des serveurs distants.
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Module : Ressources en ligne

Lorsque l’on considère les sources de données pour une carte, il n’y a pas besoin de se restreindre aux données que
vous avez sauvegardées sur votre ordinateur avec lequel vous travaillez. Il y a des sources de données en ligne depuis
lesquelles vous pouvez charger des données et ce tant que vous êtes connecté à Internet.
Dans ce module, nous aborderons deux sortes de services SIG basés sur le web : Web Mapping Services (WMS) et
Web Feature Services (WFS).

10.1 Leçon : Web Mapping Services (WMS)

Un Web Mapping Service (WMS, qui signifie Service de cartographie web en anglais) est un service hébergé sur un
serveur distant. Semblable à un site web, vous pouvez y accéder tant que vous avez une connexion au serveur. En
utilisant QIGS, vous pouvez charger un répertoire WMS directement dans votre carte existante.
Vous devez vous souvenir de la leçon sur les extensions qu’il est possible de charger une nouvelle image raster depuis
Google, par exemple. Cependant, il s’agit d’une transaction ponctuelle : une fois que vous avez téléchargé l’image,
elle ne change pas. Un WMS est différent dans le fait que c’est un service en direct qui actualisera automatiquement
sa vue si vous déplacez ou zoomez sur la carte.
Objectif de cette leçon : Utiliser un WMS et comprendre ses limites.

10.1.1 ��� Follow Along: Loading a WMS Layer

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and
load some existing layers into it. For this example, we used a new map and loaded the original places, landuse and
protected_areas layers and adjusted the symbology:
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1. Chargez ces couches dans une nouvelle carte, ou utilisez votre carte d’origine avec seulement ces couches
visibles.

2. Avant de commencer à ajouter la couche WMS, désactivez la projection « à la volée » (Projet ► Propriétés…
► SCR, cochez Aucun SCR (ou projection inconnue ou non-terrestre). Cela peut faire en sorte que les couches
ne se chevauchent plus correctement, mais ne vous inquiétez pas : nous corrigerons cela plus tard.

3. Pour ajouter des couches WMS, cliquez sur le bouton pour ouvrir la boîte de dialogue Gestionnaire source
donnees et activer l’onglet WMS/WMTS.
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Rappelez-vous comment vous vous êtes connecté à une base de données SpatiaLite ou GeoPackage au début
du cours. Les couches landuse, buildings, et roads sont stockées dans une base de données. Pour utiliser ces
couches, vous devez d’abord vous connecter à la base de données. L’utilisation d’un WMS est similaire, à
l’exception du fait que les couches se trouvent sur un serveur distant.

4. Pour créer une nouvelle connexion à un WMS, cliquez sur le bouton Nouveau.
Vous aurez besoin d’une adresse WMS pour continuer. Il existe plusieurs serveurs WMS gratuits sur Internet.
L’un d’entre eux est terrestris, qui utilise l’ensemble de données OpenStreetMap.

5. Pour utiliser ce WMS, configurez-le dans votre boîte de dialogue actuelle, comme ceci :
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• La valeur du champ nom doit être terrestris.
• La valeur du champ URL doit être https://ows.terrestris.de/osm/service.

6. Cliquez sur OK. Vous devriez voir le nouveau serveur WMS listé :
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7. Cliquez sur Connecter. Dans la liste d’en-dessous, vous devriez maintenant voir ces nouvelles entrées chargées
:
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Il y a toutes les couches hébergées par ce serveur WMS.
8. Click once on the OSM-WMS layer. This will display the default Coordinate Reference System in use and the

number of CRSes supported by the dataset:
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Since we’re not using EPSG:4326 - WGS 84 for our map, let’s find one that meets our needs.

1. Click the Select CRS button. Youwill see a standardCoordinate Reference System Selector dialog showing
all the CRS the data is published with.

2. We want a projected CRS, so let’s choose WGS 84 / Pseudo-Mercator with EPSG:3857. You can use
the top Filter widget.
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1. Cliquez sur OK. Le système de référence des coordonnées associé à l’entrée a changé.
9. Click Add to load the layer in your project using Layer name` (default is OpenStreetMap WMS - by terrestris).
10. Fermez le dialogue gestionnaire de source de donnees si ce n’est pas fait automatiquement
11. Dans le panneau couche, cliquez et faites-le glisser jusqu’au bas de la liste.
12. Faites un zoom arrière pour obtenir une vue globale des couches. Vous remarquerez que vos couches ne sont

pas situées correctement (près de l’ouest de l’Afrique). Cela est dû au fait que la projection « à la volée » est
désactivée.
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13. Activons à nouveau la reprojection, mais en utilisant la même projection que la couche OpenStreetMap WMS,
qui estWGS 84 / Pseudo Mercator.
1. Ouvrez la Projet ► Propriétés… ► onglet SCR

2. Décochez Aucun SCR (ou projection inconnue ou non-terrestre).
3. ChoisissezWGS 84 / Pseudo Mercator dans la liste.
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4. Cliquez sur OK.
14. Now right-click on one of your own layers in the Layers panel and click Zoom to layer(s). You should see the

Swellendam area:

344 Chapter 10. Module : Ressources en ligne



QGIS Training Manual

Remarquez comme les rues de la couches WMS et vos propres rues se superposent. C’est bon signe !

La nature et les limtes du WMS

Vous devriez maintenant avoir remarqué que cette couche WMS contient actuellement beaucoup d’entités. Il y a
les rues, rivières, réserves naturelles, et caetera. Qui plus est, même si elle ressemble à quelque chose composé de
vecteurs, elle semble être un raster, mais vous ne pouvez pas changer sa symbologie. Pourquoi donc ?
C’est comme cela que fonctionne un WMS : c’est une carte, semblable à une carte normale en papier, que vous
recevez comme une image. Ce qui se passe habituellement est que vous avez des couches vectorielles, que QGIS
affiche comme une carte. Mais en utilisant un WMS, ces couches vectorielles sont sur un serveur WMS, qui les
affiche comme une carte et vous envoie cette carte en tant qu’image. QGIS peut afficher cette image, mais ne peut
pas changer sa symbologie, car tout est géré sur le serveur.
Cela a plusieurs avantages, parce que vous n’avez pas besoin de vous inquiétez de la symbologie. Cela est déjà réglé,
et devrait être agréable à voir sur les WMS conçus avec compétence.
D’un autre côté, vous ne pouvez pas changer la symbologie si vous ne l’aimez pas, et si des choses sont modifiées
sur le serveur WMS, alors elles changeront également dans votre carte. C’est pourquoi vous voudrez parfois utiliser
un Web Feature Service (WFS) à la place, qui vous donne des couches vectorielles séparément, et pas dans le cadre
d’une carte de style WMS.
This will be covered in the next lesson, however. First, let’s add another WMS layer.

10.1.2 ��� Essayez vous-même

1. Add the eAtlasWMS server at this URL: https://maps.eatlas.org.au/maps/wms
2. Load aWorld: Hillshading layer into the map.
3. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster.
4. Your map should look like this (you may need to re-order the layers, and apply some transparency):
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Answer
1. Go to the Data Source Manager, WMS / WMTS tab and create a new connection entry

2. Use the text box to filter the list of layers and select the corresponding layer
3. Remember to check/turn its CRS into EPSG:3857 - WGS 84 / Pseudo Mercator as the rest of the map.

4. After the layer is loaded, you can modify its Opacity value (under the Transparency properties tab)

10.1.3 ��� Essayez vous-même

Une partie de la difficulté à utiliser le WMS est de trouver un bon serveur (libre).
• Trouvez un nouveau WMS sur directory.spatineo.com (ou ailleurs en ligne). Il ne doit pas être assorti de frais
ou de restrictions, et doit couvrir la zone d’étude Swellendam.
Souvenez-vous que tout ce dont vous avez besoin pour utiliser unWMS est seulement sonURL (et de préférence
une sorte de description).

Answer
Spatineo is one of many places you can search for a OGC data. Type in the text area a name, keyword, location of
your interest to see if you get some working results. For this lesson, you might want to filter the results to include
WMS only.
You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes
it is permanent. An example of a WMS server that worked at the time of writing is the MapServer
Demonstration Server WMS at https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetCapabilities. It does not require fees or have access constraints, and it is global. Therefore, it does
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satisfy the requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers
to choose from.

10.1.4 ��� Essayez vous-même

• Add the bluemarble layer from the MapServer Demonstration Server. Is that a suitable dataset for our study
area?

Answer
1. Cachez toutes les autres couches WMS pour éviter qu’elles ne s’affichent inutilement en arrière-plan.
2. Use the same approach as before to add the new server and the appropriate layer as hosted on that server:

3. If you zoom into the Swellendam area, you’ll notice that this dataset has a low resolution:
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Therefore, it’s better not to use this data for the current map. The Blue Marble data is more suitable at global
or national scales

10.1.5 Conclusion

En utilisant un WMS, vous pouvez ajouter des cartes inactives comme toile de fond pour vos données de carte
existantes.

10.1.6 Pour aller plus loin

• Répertoire Spatineo
• Liste des serveurs WMS OpenStreetMap.org

10.1.7 La suite ?

Maintenant que vous avez ajouté une carte inactive comme toile de fond, vous serez content d’apprendre qu’il est
également possible d’ajouter des données (comme les autres couches vectorielles que vous avez ajoutées avant). Un
ajout de données depuis les serveurs distants est possible en utilisant un Web Feature Service (WFS). C’est le sujet
de la prochaine leçon.
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10.2 Leçon : Web Feature Services

Un Web Feature Service (WFS) fournit à ses utilisateurs des données SIG dans des formats qui peuvent être
directement chargés dans QGIS. À la différence d’un WMS, qui vous fournit seulement une carte que vous ne pouvez
pas modifier, un WFS vous donne accès aux entités elles-mêmes.
Objectif de cette leçon : Utiliser un WFS et comprendre en quoi il est différent d’un WMS.

10.2.1 ��� Pas à pas : Charger une couche WFS

1. Ouvrez une nouvelle carte. C’est à des fins de démo et ça ne sera pas sauvegardé.

2. Cliquez sur le bouton Ouvrir le gestionnaire de source de données.

3. Activez l’onglet WFS / OGC API - Features.
4. Cliquez sur le bouton Nouveau.
5. Dans le dialogue qui apparaît, saisir comme Nom : nsidc.org et comme URL : https://nsidc.org/

cgi-bin/atlas_south?version=1.1.0.

6. Cliquez sur OK, et la nouvelle connexion apparaîtra dans votre Serveur de connexions.
7. Cliquez sur Connecter. Une liste de couches disponibles apparaîtra.
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8. Décochez l’option Ne demander que les entités qui sont dans l’étendue de la vue courante en dessous de la
liste des couches, étant donné que le canevas de votre carte actuelle peut ne pas couvrir notre zone d’intérêt :
l’Antarctique.

9. Trouvez la couche antarctica_country_border. Vous pouvez utiliser la boîte Filtre en haut.
10. Cliquez sur la couche pour la sélectionner :
11. Trouvez et sélectionnez également la couche south_poles_wfs. Vous devrez peut-être maintenir Ctrl.
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12. Cliquez sur Ajouter.
Le chargement des couches peut prendre un certain temps. Lorsqu’elles seront chargées, elles apparaîtront sur
la carte, montrant les contours de l’Antarctique et quelques points au-delà.
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Quelle est la différence avec une couche WMS ?
13. Sélectionnez l’une des couches et vous remarquerez que les outils de sélection d’éléments et de table d’attributs

sont activés. Ce sont des couches vecteur.
14. Sélectionnez la couche south_poles_wfs et ouvrez sa table d’attributs. Vous devriez voir ceci :

Comme les points ont des attributs, nous sommes capable de les étiqueter, tout comme de changer leur
symbologie. Voici un exemple :
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Différences avec des couches WMS

Un service de WFS retourne la couche en elle-même et pas uniquement une carte rendue avec. Cela vous donne un
accès direct à la donnée et signifie que vous pouvez changer sa symbologie et lancer des fonctions d’analyse dessus.
Néanmoins, cela se fait en transmettant beaucoup plus de données. Cela se révélera particulièrement inadapté si les
couches que vous chargez ont des formes complexes, un grand nombre d’attributs ou de nombreuses entités ou encore
si vous chargez un grand nombre de couches. Les couches WFS prennent un temps non négligeable à se charger à
cause de tout cela.

10.2.2 ��� Pas à pas : Requêter une couche WFS

Bien que cela soit possible d’interroger une coucheWFS après l’avoir chargée, c’est souvent plus efficace de l’interroger
avant de la charger. De cette façon vous n’interrogez que les entités que vous souhaitez, ce qui signifie que vous utilisez
moins de bande passante.
Par exemple, sur le serveur WFS que nous avons récemment utilisé, il y a une couche appelée countries (excluding
Antarctica). Supposons que nous voulons savoir où se trouve l’Afrique du Sud par rapport à la couche south_poles_wfs
(et peut-être aussi la couche antarctica_country_border) qui a déjà été chargée.
Il y a deux manières de le faire. Vous pouvez charger la couche countries … entièrement, et faire une requête comme
d’habitude une fois la couche chargée. Cependant, la transmission des données pour tous les pays mondiaux et
n’utiliser uniquement que les données pour l’Afrique du Sud semble être un peu du gaspillage de bande passante. En
fonction de votre connexion, ce jeu de données peut prendre plusieurs minutes à se charger.
La manière alternative est de faire une requête pour filter avant même de charger la couche du serveur.

1. Activez l’ongletWFS / OGC API Features dans la boîte de dialogue Gestionnaire de source de donnees.
2. Connectez-vous au serveur que nous avons utilisé précédemment et vous devriez voir la liste des couches

disponibles.
3. Trouvez et double-cliquez sur la couche countries (excluant l’Antarctique). Le nom de la couche est

country_borders_excluding_antarctica. Vous pouvez également sélectionner la couche et
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appuyer sur le bouton Construire la requête au bas de la boîte de dialogue :

4. Dans la boîte de dialogue qui s’affiche, saisissez la requête suivante : SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
dans la zone SQL.
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5. Pressez OK.
6. L’expression utilisée apparaîtra comme la valeur Sql de la couche cible :

7. Cliquez sur Ajouter avec la couche sélectionnée comme ci-dessus. Seul le pays dont la valeur Countryeng
est South Africa sera chargé à partir de cette couche :
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Avez-vous remarqué l’icône à côté de la couche country_borders_excluding_antarctica ?
Elle indique que la couche chargée est filtrée et n’affiche pas toutes ses entités dans le projet.

8. Vous n’avez pas à le faire, mais si vous avez testé les deux méthodes, vous remarquerez que cette dernière est
beaucoup plus rapide que le chargement complet des pays avant de les filtrer !

Notes sur la disponibilité des WFS

Il est rare de trouver un WFS hébergeant les entités dont vous avez besoin, surtout si votre besoin est très spécifique.
La raison pour laquelle un WFS est relativement rare est à cause des grandes quantités de données qui doivent être
transmises pour décrire toute une entité. Il n’est donc pas très rentable d’héberger un WFS plutôt qu’un WMS, qui
ne transmet que des images.
Le type le plus commun de WFS que vous rencontrerez sera probablement sur un réseau local ou même sur votre
propre ordinateur, plutôt que sur internet.

10.2.3 Conclusion

Les couches WFS sont préférables aux couches WMS si vous avez besoin d’un accès direct aux attributs et aux
géométries de ces couches. Cependant, en considérant le volume de données qui ont besoin d’être téléchargées (ce
qui mène à des problèmes de rapidité et aussi au manque de serveurs WFS publics facilement accessibles) ce n’est
pas toujours possible d’utiliser un WFS à la place d’un WMS.
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10.2.4 La suite ?

Dans la prochaine leçon, vous verrez comment utiliser QGIS pour fournir des services OGC.
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CHAPTER11

Module : QGIS Server

Ce module est une contribution de Tudor Bărăscu.
Dans ce module, nous allons voir comment installer et utiliser QGIS Server.
Pour en savoir plus sur QGIS Server, lisez le QGIS-Server-manual.

11.1 Leçon : Installer QGIS Server

Le but de cette leçon: Apprendre comment installer QGIS Server sur Debian Stretch. Avec des variations
négligeables, vous pouvez également le suivre pour toute distribution basée sur Debian comme Ubuntu et ses dérivés.

Note: Dans Ubuntu, vous pouvez utiliser votre utilisateur le plus couramment utilisé, en ajoutant sudo
aux commandes nécessitant des autorisations administrateur. Dans Debian, vous pouvez travailler en tant
qu’administrateur (root), sans utiliser sudo.

11.1.1 ��� Pas à pas : Installer à l’aide des paquets

In this lesson we’re going to do only the install from packages as shown here .
Installez QGIS Server avec:

apt install qgis-server --no-install-recommends --no-install-suggests

# if you want to install server plugins, also:
apt install python3-qgis

QGIS Server doit être utilisé en production sans que QGIS Desktop (avec le serveur X qui l’accompagne) soit installé
sur la même machine.
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11.1.2 ��� Pas à pas : L’exécutable de QGIS Server

L’exécutable QGIS Server est qgis-mapserv.fcgi. Vous pouvez vérifier à quel endroit il a été installé au moyen
de la commande: find / -name 'qgis_mapserv.fcgi' qui devrait renvoyer quelque chose comme /usr/
lib/cgi-bin/qgis_mapserv.fcgi.
Optionnellement, si vous voulez faire un test en ligne de commande à ce moment-là, vous pouvez lancer la commande
/usr/lib/cgi-bin/qgis_mapserv.fcgi --version qui devrait produire quelque chose comme :

QGIS 3.21.0-Master 'Master' (1c70953f1e)
QGIS code revision 1c70953f1e
Qt version 5.15.2
Python version 3.9.5
GDAL/OGR version 3.2.2
PROJ version 7.2.1
EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2
SQLite version 3.34.1
OS Ubuntu 21.04

Nous verrons plus loin comment faire des requêtes WMS.

11.1.3 ��� Configuration d’un serveur HTTP

Pour accéder au serveur QGIS depuis un navigateur internet, il faut mettre en place un serveur HTTP. L’installation
du serveur HTTP Apache est décrite dans la section httpserver.

Note: Si vous avez installé QGIS Server sans serveur X (inclus avec Linux Desktop) et si vous voulez aussi utiliser
la commande GetPrint alors il faut installer un serveur X factice et dire à QGIS Server de l’utiliser. Pour ce faire,
consultez le processus d’installation de Xvfb.

11.1.4 ��� Pas à pas : Créer un autre hôte virtuel

Créons un autre virtual host Apache pointant sur QGIS Server. Vous pouvez choisir n’importe quel nom vous faisant
plaisir (coco.bango, super.duper.training, example.com, etc.) mais pour faire simple nous allons
choisir myhost.

• Configurons le nom myhost pour qu’il pointe vers l’IP localhost en ajoutant 127.0.0.1 x au /etc/
hosts avec la commande suivante : sh -c "echo '127.0.0.1 myhost' >> /etc/hosts" ou
en éditant manuellement le fichier avec gedit /etc/hosts.

• Nous pouvons vérifier que myhost pointe sur le localhost en exécutant dans le terminal la commande ping
myhost qui devrait afficher :

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms

• Voyons si nous pouvons accéder à QGIS Server depuis le site myhost en exécutant : curl http://
myhost/cgi-bin/qgis_mapserv.fcgi ou en accédant à l’URL depuis le navigateur de votre box
Debian. Vous obtiendrez probablement :

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>

(suite sur la page suivante)
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(suite de la page précédente)
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
<hr>
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache ne sait pas qu’il est censé répondre à des requêtes pointant vers le serveur nommé myhost. Pour
configurer l’hôte virtuel, le plus simple serait de créer un fichier monhôte.conf dans le répertoire /
etc/apache2/sites-available qui aurait le même contenu que le fichier qgis.demo.conf sauf
pour la ligne ServerName qui devrait être ServerName myhost. Vous pouvez également changer
l’emplacement des logs, sinon les logs des deux hôtes virtuels seront partagés, mais ceci est optionnel.

• Activons maintenant l’hôte virtuel avec a2ensite myhost.conf et rechargeons ensuite le service Apache
avec service apache2 reload.

• Si vous essayez de nouveau d’accéder à http://myhost/cgi-bin/qgis_mapserv.fcgi vous verrez que tout
fonctionne maintenant !

11.1.5 Conclusion

Vous avez appris comment installer les différents versions de QGIS Server depuis les paquets, comment configurer
Apache avec QGIS Server, sur Debian basé sur Linux.

11.1.6 La suite ?

Maintenant que vous avez installé QGIS server et qu’il est accessible via le protocole HTTP, nous devons apprendre à
accéder à certains des services qu’il peut offrir. Le sujet de la prochaine leçon est d’apprendre comment accéder aux
services WMS de QGIS Server.

11.2 Leçon : Publier des WMS

Les données utilisées pour cet exercice sont disponibles dans le sous-répertoireqgis-server-tutorial-data
du répertoire training data que vous avez téléchargé. Pour des raisons de commodité et pour éviter d’éventuels
problèmes de permissions, nous supposerons que ces fichiers sont stockés dans le répertoire /home/qgis/
projets. Par conséquent, adaptez les instructions suivantes à votre chemin d’accès.
Le jeu de donnée contient un projet QGIS world.qgs, préparé pour être servi par QGIS Server. Si vous souhaitez
utiliser votre propre projet ou apprendre comment préparer un projet, allez voir la section Creatingwmsfromproject.

Note: Ce module présente les URL afin que le public puisse facilement distinguer les paramètres et les valeurs des
paramètres. Alors que le format normal est:

...&field1=value1&field2=value2&field3=value3

ce tutoriel utilise :

&field1=value1
&field2=value2
&field3=value3

Les coller dans Mozilla Firefox fonctionne parfaitement mais d’autres navigateurs internet comme Chrome peuvent
ajouter des espaces indésirables entre les paires field:parameter. Ainsi, si vous rencontrez ce problème vous
pouvez soit utiliser Firefox ou modifier les URL afin qu’il soit en format de ligne simple.

Faisons une requête WMS GetCapabilities dans le navigateur web ou avec curl :

11.2. Leçon : Publier des WMS 361

http://myhost/cgi-bin/qgis_mapserv.fcgi


QGIS Training Manual

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

Dans la configuration Apache de la leçon précédente, la variable QGIS_PROJECT_FILE définit le projet par défaut
à: file: /home/qgis/projects/world.qgs. Cependant, dans la demande ci-dessus, nous avons utilisé le paramètre map
pour être explicite et pour montrer qu’il peut être utilisé pour pointer n’importe quel projet. Si vous supprimez le
paramètremap de la demande ci-dessus, QGIS Server affichera la même réponse.
En interrogeant l’URL GetCapabilities avec un client WMS, celui-ci récupère en réponse un document XML
contenant des métadonnées sur le serveur (quelles couches il contient, son emprise, les formats, la version WMS,
etc.).
Comme QGIS est également un ogc-wms, vous pouvez créer une nouvelle connexion au serveur WMS à l’aide de l’url
GetCapabilities ci-dessus. Voir la section Leçon : Web Mapping Services (WMS) ou ogc-wms-servers sur la façon de
le faire.
En ajoutant la couche WMS countries à votre projet QGIS, vous devriez obtenir une image comme celle ci-
dessous :
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Figure11.1: QGIS Desktop consommant le service WMS de la couche pays QGIS Server

Note: QGIS server dessert les couches qui sont définies dans le projet world.qgs. En ouvrant le projet avec
QGIS, vous pouvez voir qu’il existe plusieurs styles pour la couche des pays. QGIS server en est également conscient
et vous pouvez choisir le style que vous souhaitez dans votre demande. Le style classé par population a
été choisi dans l’image ci-dessus.
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11.2.1 Journal

Lorsque vous installez un serveur, les journaux sont toujours importants car ils vous montrent ce qui se passe. Nous
avons mis en place dans le fichier *.conf les journaux suivants :

• les fichiers journaux de QGIS Server à /logs/qgisserver.log
• qgisplatform.demo Apache access log at qgisplatform.demo.access.log
• qgisplatform.demo Journal d’erreurs Apache à l’adresse qgisplatform.demo.error.log

Les fichiers journaux sont simplement des fichiers texte, vous pouvez donc utiliser un éditeur de texte pour les
consulter. Vous pouvez également utiliser la commande tail dans un terminal : sudo tail -f /logs/
qgisserver.log.
Le terminal produira ainsi en permanence ce qui est écrit dans ce fichier journal. Vous pouvez également faire ouvrir
trois terminaux pour chacun des fichiers journaux de cette manière :

Figure11.2: Utilisation de la commande tail pour visualiser la sortie des journaux de QGIS server

Lorsque vous utilisez QGIS Desktop pour consommer les services WMS QGIS server, vous verrez toutes les
demandes que QGIS envoie au serveur dans le journal d’accès, les erreurs QGIS server dans le journal QGIS Server,
etc.
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Note:
• Si vous regardez les journaux dans les sections suivantes, vous devriez avoir une meilleure compréhension de
ce qui se passe.

• En redémarrant Apache tout en regardant dans le journal QGIS server, vous pouvez trouver quelques pointeurs
supplémentaires sur la façon dont les choses fonctionnent.

11.2.2 Requêtes GetMap

Afin d’afficher la couche countries, QGIS Desktop, comme tout autre client WMS, utilise les requêtes GetMap.
Une simple requête ressemble à:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg

Avec la requête précédente, vous obtiendrez le résultat suivant :
Figure : simple requête GetMap QGIS server
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Figure11.3: Réponse de Qgis server après une simple demande GetMap

11.2.3 ��� Essayez vous-même : Modifier l’image et les paramètres de
couches

Sur la base de la demande ci-dessus, remplaçons la couche countries par une autre.
Afin de voir quelles autres couches sont disponibles, vous pouvez ouvrir le projet world.qgs dans QGIS et regarder
son contenu. Gardez cependant à l’esprit que les clients WMS n’ont pas accès au projet QGIS, ils se contentent
d’examiner le contenu des documents relatifs aux capacités.
Il existe également une option de configuration qui permet à certaines couches du projet QGIS d’être ignorées par le
QGIS lorsqu’il dessert le service WMS.
Ainsi, vous pouvez regarder la liste des couches lorsque vous pointez QGIS Desktop vers l’URL
GetCapabilities ou vous pouvez essayer de trouver d’autres noms de couches dans la réponse XML
GetCapabilities.
Un des noms de couches que vous pourriez trouver et qui fonctionne est countries_shapeburst. Vous pouvez
en trouver d’autres mais gardez à l’esprit que certains ne sont pas visibles à une si petite échelle et que vous pourriez
donc obtenir une image vierge comme réponse.
Vous pouvez également jouer avec d’autres paramètres, comme par exemple changer le type d’image retournée en
image/png.
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11.2.4 ��� Pas à pas : Utiliser des paramètres de filtre, d’opacité et de style

Faisons une autre requête ajoutant une autre couche, quelques paramètres basiques, FILTER et OPACITIES, mais
aussi le paramètre standard STYLES.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

Avec la requête précédente, vous obtiendrez le résultat suivant :

Figure11.4: Réponse à une demande GetMap avec les paramètres FILTER et OPACITIES

Comme vous pouvez le voir sur l’image ci-dessus, entre autres choses, nous avons demandé à QGIS Server de ne
rendre que Germany et Italy dans la couche des pays.
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11.2.5 ��� Pas à pas : Utiliser le surlignage rouge

Lançons une autre requête GetMap utilisant la fonctionnalité redlining et le paramètre SELECTION détaillé dans
la section WMS :

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000␣
↪→6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
↪→<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter␣
↪→name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
↪→SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
↪→LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,65

Avec la requête précédente dans un navigateur web, vous obtiendrez le résultat suivant :
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Figure11.5: Réponse à une demande avec la fonction REDLINING et le paramètre SELECTION

Vous pouvez voir sur l’image ci-dessus que les pays avec les ids 171 et 65 ont été mis en évidence en jaune (Roumanie
et France) en utilisant le paramètre SELECTION et nous avons utilisé la fonction REDLINING pour superposer
un rectangle avec le label QGIS Tutorial.

11.2.6 Demandes GetPrint

Une fonctionnalité géniale de QGIS Server est qu’il utilise les mises en page de QGIS Desktop. Vous pourrez en
apprendre plus dans la section wms_getprint.
Si vous ouvrez le projet world.qgs avec QGIS Desktop, vous trouverez une mise en page nommée Population
distribution. Une requête simplifiée GetPrint qui illustre cette fonctionnalité étonnante est :

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries
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Figure11.6: Montre le pdf résultant de la demande GetPrint ci-dessus

Naturellement, il est difficile d’écrire vos demandes GetMap, GetPrint, etc.
QGIS Web Client ou QWC est un projet de client Web qui peut fonctionner avec QGIS Server afin que vous puissiez
publier vos projets sur le Web ou vous aider à créer des requêtes QGIS Server pour une meilleure compréhension des
possibilités.
Vous pouvez l’installer comme ceci :

• En tant qu’utilisateur qgis, allez dans le répertoire home avec cd /home/qgis.
• Téléchargez le projet QWC depuis ici et dézippez-le.
• Faites un lien symbolique vers le répertoire /var/www/html car c’est le DocumentRoot que nous avons
mis en place dans la configuration de l’hôte virtuel. Si vous avez décompressé l’archive sous /home/qgis/
Downloads/QGIS-Web-Client-master, nous pouvons le faire avec sudo ln -s /home/qgis/
Downloads/QGIS-Web-Client-master /var/www/html/.

• Accédez à http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs à partir de votre navigateur Web.

Vous devriez maintenant être en mesure de voir la carte comme dans la figure suivante :
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Figure11.7: Le client Web QGIS consomme le projet world.qgs

Si vous cliquez sur le bouton Imprimer dans QWC, vous pouvez créer interactivement des demandes GetPrint.
Vous pouvez également cliquer sur l’icône ? dans le QWC pour accéder à l’aide disponible afin de mieux découvrir
les possibilités du QWC.

11.2.7 Conclusion

Vous avez appris comment utiliser QGIS server pour fournir des services WMS.
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11.2.8 La suite ?

Ensuite, vous verrez comment utiliser QGIS comme frontal pour le célèbre SIG GRASS.
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Module : GRASS

GRASS (Geographic Resources Analysis Support System) est un logiciel libre de SIG bien connu qui dispose d’une
large gamme de fonctions SIG. Il a été publié pour la première fois en 1984 et il a subit de nombreuses améliorations
au fil du temps. QGIS vous permet d’utiliser les performants outils SIG de GRASS directement.

12.1 Leçon : Configuration de GRASS

L’utilisation de GRASS dans QGIS vous oblige à penser l’interface d’une manière légèrement différente. Rappelez-
vous que vous ne travaillez pas directement dans QGIS, mais que vous travaillez dans GRASS via QGIS. Par
conséquent, assurez-vous que vous avez installé QGIS Desktop avec le support de Grass.

Pour ouvrir une session QGIS avec GRASS disponible surWindows, vous devez cliquer sur l’icône « Bureau QGIS
avec GRASS ».
Le but de cette leçon : commencer un projet GRASS dans QGIS.

12.1.1 ��� Pas à pas : Démarrer une nouvelle session GRASS

Pour lancer GRASS à partir de QGIS, vous devez l’activer comme pour tout autre extension :
1. Tout d’abord, ouvrir un nouveau projet QGIS.

2. In the Plugin Manager, enable GRASS 8 in the list:

373



QGIS Training Manual

La barre d’outils GRASS et le panneau GRASS apparaîtront :

Figure12.1: GRASS Toolbar and Panel

Le panneau GRASS n’est pas actif car, avant de pouvoir utiliser GRASS, vous devez créer un « MapSet ». GRASS
fonctionne toujours dans un environnement de base de données, ce qui signifie que vous devez importer toutes les
données que vous voulez utiliser dans une base de données GRASS.
La base de données GRASS a une structure simple, même si à première vue elle semble très compliquée. La chose
la plus importante que vous devez savoir est que le niveau supérieur de la base de données est la « localisation ».
Chaque « Localisation » peut contenir différents « Mapset » : dans tous les « Mapset », vous trouverez le « Mapset
PERMANENT » car il est créé par défaut par GRASS. Chaque « Mapset » contient les données (raster, vecteur, etc)
d’une structure particulière, mais ne vous inquiétez pas, GRASS s’en chargera pour vous.
Rappelez-vous simplement : Location contientMapset qui contient les données. Pour plus d’informations, visitez
le site web de GRASS.
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Figure12.2: Structure de la base de données GRASS (à partir des documents GRASS)

12.1.2 ��� Pas à pas : Démarrer une nouveau projet GRASS

1. Cliquez sur le menu Plugins ► GRASS ► Nouveau jeu de carte :

Il vous sera demandé de choisir l’emplacement de la base de données GRASS.
2. Définissez le dossier qui sera utilisé par GRASS pour y placer sa base de donnée :
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3. Cliquez sur Suivant
GRASS doit créer une « Localisation », qui décrit l’étendue maximale de la zone géographique dans laquelle vous
travaillerez, aussi appelée « Région ».

Note: la Région est extrêmement importante pour GRASS car elle décrit la zone dans laquelle toutes les couches
seront prises en compte pour GRASS. Tout ce qui est à l’extérieur ne sera pas pris en compte. Ne vous inquiétez pas,
vous pouvez toujours modifier l’étendue de la Région GRASS après la création du Secteur

1. Appelez le nouveau lieu « SouthAfrica » :

2. Cliquez sur Suivant
3. Nous allons travailler avec « TPS 84 », alors cherchez et sélectionnez ce CRS :
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4. Cliquez sur Suivant
5. Maintenant, sélectionnez la région Afrique du Sud depuis la liste déroulante et cliquez sur Définir :
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6. Cliquez sur Suivant
7. Créez un jeu de donnée, qui est le fichier sur lequel vous allez travailler.

Une fois que vous avez terminé, vous verrez un dialogue vous demandant un résumé de toutes les informations
saisies.
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8. Cliquez sur Terminer.
9. Cliquez sur OK dans la fenêtre de succès.

Vous verrez que le panneau GRASS deviendra actif et que vous pourrez commencer à utiliser tous les outils GRASS.

12.1.3 ��� Pas à pas : Charger des données vectorielles dans GRASS

Vous avez maintenant une carte vierge et avant de pouvoir commencer à utiliser tous les outils GRASS, vous devez
charger les données dans la base de données GRASS, plus précisément dans le « MapSet ». Vous ne pouvez pas
utiliser les outils GRASS avec des couches qui ne sont pas chargées dans un « MapSet » GRASS.
Il existe de nombreuses façons différentes de charger des données dans la base de données GRASS. Commençons
par la première.

��� Pas à pas : Charger des données via l’explorateur de QGIS

Dans la section ��� The Browser Panel nous avons vu que la façon la plus simple et la plus rapide de charger les
données dans QGIS est le panneau Explorateur.
Les données GRASS sont reconnues par le navigateur QGIS comme des données GRASS réelles et vous pouvez le

remarquer car vous verrez l’icône GRASS à côté du jeu de cartes GRASS. De plus, vous verrez l’icône à côté du
Mapset qui est ouvert.
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Note: Vous verrez une réplique de l’emplacement GRASS comme un dossier normal : Les données « MapSet » de
GRASS sont celles qui se trouvent dans le dossier

Vous pouvez facilement glisser et déposer des couches d’un dossier vers le GRASS Mapset.
Essayons d’importer la couche roads dans le jeu de cartes grass_mapset de la localisation SouthAfrica.
Allez dans le navigateur, et faites simplement glisser la couche roads du fichier training_data.gpkg
GeoPackage dans le jeu de cartes grass_mapset.
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C’est tout ! Si vous développez le Mapset, vous verrez la couche roads importée. Vous pouvez maintenant charger
dans QGIS la couche importée comme toutes les autres couches.

Astuce: Vous pouvez également charger des couches du panneau Légende des couches vers le jeu de cartes dans le
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panneau Navigateur. Cela accélérera incroyablement votre flux de travail !

��� Pas à pas : Charger des données via le panneau GRASS

Nous allons maintenant utiliser la méthode long pour charger la couche rivers.shp dans le même Mapset.
1. Chargez les données dans QGIS comme d’habitude. Utilisez l’ensemble de données rivers.shp (qui se

trouve dans le dossier exercise_data/shapefile/)
2. As soon as it is loaded, click on the Filter box of the GRASS Panel and find the vector import tool by

entering the term v.in.ogr.qgis (available under File management► Import into GRASS► Import vector
into GRASS):

Avertissement: Il existe deux outils similaires : « v.in.ogr.qgis » et « v.in.ogr.qgis.loc ». Nous recherchons
le premier.

Le v signifie vecteur, in signifie une fonction pour importer des données dans la base de données GRASS, ogr
est la bibliothèque logicielle utilisée pour lire les données vectorielles, et qgis signifie que l’outil va chercher
un vecteur parmi les vecteurs déjà chargés dans QGIS.

3. Une fois que vous avez trouvé cet outil, cliquez dessus pour faire apparaître l’outil lui-même. Choisissez la
couche rivers dans la case Charger couche et tapez et nommez le g_rivers pour éviter toute confusion :
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Note: ★★★ Note the extra import options provided under Advanced Options. These include the ability to
add a WHERE clause for the SQL query used for importing the data.

4. Cliquez sur Exécuter pour commencer l’import.
5. Une fois fait, cliquez sur le bouton Voir le résultat pour voir la nouvelle couche GRASS importée dans la carte.
6. Fermez d’abord l’outil d’import (cliquez sur le bouton Fermer juste à droite de Voir le résultat), puis fermez la

fenêtre Outils GRASS.
7. Supprimez la couche originale rivers.

Vous ne disposez désormais plus que de la couche GRASS affichée dans la carte QGIS.

12.1.4 ��� Pas à pas : Charger des données rasters dans GRASS

Vous pouvez importer une couche raster de la même manière que nous avons importé des couches vectorielles.
Nous allons importer dans le jeu de cartes GRASS la couche srtm_41_19_4326.tif.

Note: la couche raster est déjà dans le bon CRS, « TPS 84 ». Si vous avez des couches dans des CRS différents,
vous devez les reprojeter dans le même CRS du jeu de cartes GRASS

1. Charger la couche srtm_41_19_4326.tif dans QGIS
2. Ouvrez à nouveau les Outils GRASS.
3. Cliquez sur l’onglet Modules.
4. Search for r.in.gdal.qgis (available under File management ► Import into GRASS ► Import raster into

GRASS ► Import raster into GRASS from QGIS view) and double click the tool to open the tool’s dialog.
5. Configurez-le de sorte que la couche d’entrée soit srtm_41_19_4326.tif et la sortie soit g_dem.
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6. Cliquez sur Exécuter.
7. Une fois l’opération réussie, cliquez sur Voir le résultat.
8. Vous pouvez Fermer l’onglet actuel puis cliquez dans la boîte de dialogue suivante sur Fermer.

9. Vous pouvez maintenant supprimer la couche srtm_41_19_4326.tif originale.
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12.1.5 ��� Essayez vous-même : Ajouter des couches au jeu de cartes

Essayez d’importer dans le jeu de cartes GRASS les couches vecteur water.shp et places.shp du dossier
exercise_data/shapefile/. Comme nous l’avons fait pour rivers, renommez la couche importée en
g_water et g_places pour éviter toute confusion

Réponse
Vous pouvez ajouter des couches (raster et vecteur) dans le Mapset de GRASS via glisser-déposer à partir de
l’explorateur (voir ��� Pas à pas : Charger des données via l’explorateur de QGIS) ou en utilisant les commandes
v.in.gdal.qgis pour les couches vectorielles et r.in.gdal.qgis pour les rasters.

12.1.6 ��� Open an existing GRASS Mapset

Si vous avez un jeu de cartes GRASS existant, vous pouvez facilement le rouvrir dans une autre session de QGIS.
Vous avez plusieurs méthodes pour ouvrir une carte GRASS, nous allons en explorer quelques-unes.
Fermons le Mapset en cliquant sur le bouton Close Mapset de la fenêtre GRASS Tools.

��� Pas à pas : Utiliser l’extension GRASS

1. Click on the Plugins ► GRASS ► Open Mapset menu.
2. Naviguez vers le dossier de la base de données GRASS : soyez prudent ! Vous devez choisir le dossier parent,

et non celui de GRASS Mapset. En effet, GRASS lira toutes les « Locations » de la base de données et tous
les « Mapset » de chaque « Localisation » :

3. Choisissez le Location (guilabel:SouthAfrica) et le Mapset (guilabel:grass_mapset) que nous avons créés
auparavant.

C’est tout ! Le panneau GRASS devient actif, ce qui signifie que le mapset a été correctement ouvert.

��� Pas à pas : Utiliser l’explorateur de QGIS

L’ouverture d’un « mapset » à l’aide du navigateur QGIS est encore plus rapide et plus facile :
1. Fermez le Mapset (s’il est ouvert) en cliquant sur le bouton Close Mapset de la fenêtre GRASS Tools.
2. Dans le navigateur QGIS, naviguez jusqu’au dossier de la base de données GRASS.
3. Cliquez avec le bouton droit de la souris sur le mapset (rappelez-vous que le jeu de cartes comporte l’icône

GRASS à côté). Vous verrez quelques options.
4. Cliquez sur Open mapset :
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Le Mapset est maintenant ouvert et prêt à être utilisé !

Astuce: Un clic droit sur un jeu de cartes GRASS vous offre de nombreux paramètres différents. Essayez de les
explorer et de voir toutes les options utiles.
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12.1.7 Conclusion

La méthode de travail de GRASS pour la gestion des données est quelque peu différente de celle de QGIS car GRASS
les charge dans une base de donnée à structure spatiale. Toutefois, en utilisant QGIS comme interface, vous pouvez
rendre plus facile la création d’un jeu de donnée GRASS grâce aux couches QGIS comme sources de données pour
GRASS.

12.1.8 La suite ?

Maintenant que les données sont importées dans GRASS, nous pouvons nous intéresser aux opérations d’analyses
plus évoluées que nous permet GRASS.

12.2 Leçon : Outils GRASS

Dans cette leçon, nous vous présenterons une sélection d’outils afin de vous donner une idée des potentialités de
GRASS.

12.2.1 ��� Follow Along: Create an aspect map

1. Ouvrez l’onglet outils GRASS
2. Chargez la couche matricielle g_dem depuis le jeu de cartes grass_mapset
3. Recherchez le module r.aspect en le cherchant dans le champ Filtre de l’onglet liste des modules.
4. Ouvrez l’outil et configurez-le comme suit, puis cliquez sur le bouton Run :
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5. Lorsque le processus est terminé, cliquez sur voir le résultat pour charger la couche résultante dans le canevas :
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La couche g_aspect est stockée dans le Mapset grass_mapset afin que vous puissiez retirer la couche du canevas
et la recharger quand vous le souhaitez.

12.2.2 ��� Follow Along: Get basic statistic of raster layer

Nous voulons connaître quelques statistiques de base de la couche raster g_dem.
1. Ouvrez l’onglet outils GRASS
2. Chargez la couche matricielle g_dem depuis le jeu de cartes grass_mapset
3. Recherchez le module r.info en le cherchant dans le champ Filtre de l’onglet liste modules.
4. Configurez l’outil comme ceci et cliquez sur Run :
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5. Dans l’onglet Sortie, vous verrez s’imprimer certaines informations raster, comme le chemin d’accès au fichier,
le nombre de lignes et de colonnes et d’autres informations utiles :
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12.2.3 ��� Follow Along: The Reclass Tool

La reclassification d’une couche raster est une tâche très utile. Nous venons de créer la couche g_aspect à partir
de la couche g_dem one. La plage de valeurs va de 0 (Nord) à 360 (Nord à nouveau) en passant par 90 (Est), 180
(Sud), 270 (Ouest) et enfin 360 (Nord à nouveau). Nous pouvons reclassifier la couche g_aspect pour n’avoir que
4 catégories suivant des règles spécifiques (Nord = 1, Est = 2, Sud = 3 et Ouest = 4).
L’outil de reclassification Grass accepte un fichier « txt » avec les règles définies. L’écriture des règles est très simple
et le manuel GRASS contient une très bonne description.

Astuce: Chaque outil GRASS a son propre onglet Manuel. Prenez le temps de lire la description de l’outil que vous
utilisez pour ne pas manquer quelques paramètres utiles

1. Chargez la couche g_aspect ou, si vous ne l’avez pas encore créée, retournez à la section ��� Follow Along:
Create an aspect map.
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2. Recherchez le module r.reclass en le cherchant dans le champ Filtre de l’onglet liste modules.
3. Ouvrez l’outil et configurez-le comme sur l’image suivante. Le fichier contenant les règles se trouve dans le

dossier exercise_data/grass/, nommé reclass_aspect.txt.
4. Cliquez sur Executer et attendez que le processus soit terminé :

5. Cliquez sur visualiser résultats pour charger le raster reclassée dans le canevas
La nouvelle couche est composée de seulement 4 valeurs (1, 2, 3 et 4) et elle est plus facile à gérer et à traiter.
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Astuce: Ouvrez le fichier reclass_aspect.txt avec un éditeur de texte pour voir les règles et commencer à
vous y habituer. De plus, regardez attentivement le manuel GRASS : de nombreux exemples différents sont présentés.

12.2.4 ��� Essayez vous-même : Reclassifier selon vos propres règles

Essayez de reclasser la couche g_dem en 3 nouvelles catégories :
• de 0 à 1000, nouvelle valeur = 1
• de 1000 à 1400, nouvelle valeur = 2
• de 1400 à la valeur maximale du raster, nouvelle valeur = 3

Réponse
Pour trouver la valeur maximale du raster, exécutez l’outil r.info : dans la console vous verrez que la valeur
maximale est de 1699. Vous êtes maintenant prêt à écrire les règles.

1. Ouvrez un éditeur de texte et saisissez les règles suivantes

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. Enregistrez le fichier sous my_rules.txt et fermez l’éditeur de texte.
3. Exécutez l’outil r.reclass : choisissez la couche g.dem et chargez le fichier contenant les règles que vous

venez de créer.
4. Cliquez sur Exécuter puis sur Visualiser la sortie. Vous pouvez modifier les couleurs afin que le résultat final

ressemble quelque peu à l’image suivante :
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12.2.5 ��� Pas à pas : L’outil Mapcalc

L’outil Mapcalc est similaire à la calculatrice raster de QGIS. Vous pouvez effectuer des opérations mathématiques
sur une ou plusieurs couches raster et le résultat final sera une nouvelle couche avec les valeurs calculées.
Le but du prochain exercice est d’extraire les valeurs supérieures à 1000 de la couche raster g_dem.

1. Recherchez le module r.mapcalc en le cherchant dans le champ Filtre de l’onglet Liste de modules.
2. Lancez l’outil.

Le dialogue Mapcalc vous permet de construire une séquence d’analyses à effectuer sur un raster, ou une
collection de rasters. Vous utiliserez ces outils pour ce faire :

Dans l’ordre:
• Ajouter une carte : Ajoutez un fichier raster de votre jeu de cartes GRASS actuel.
• Ajouter une valeur constante : Ajoute une valeur constante à utiliser dans les fonctions, 1000 dans ce cas
• Ajouter un opérateur ou une fonction : Ajoutez un opérateur ou une fonction à connecter aux entrées et
sorties, nous utiliserons l’opérateur « supérieur ou égal à ».

• ajouter connection : Connecter des éléments. À l’aide de cet outil, cliquez et glissez du point rouge sur un
élément vers le point rouge sur un autre élément. Les points qui sont correctement connectés à une ligne
de connexion deviennent gris. Si la ligne ou le point est rouge, c’est qu’il n’est pas correctement connecté
!

• Sélectionner l’élément : Sélectionnez un élément et déplacez les éléments sélectionnés.
• Supprimer l’élément sélectionné : Supprime l’élément sélectionné de la feuille mapcalc actuelle, mais pas
du jeu de cartes (s’il s’agit d’unraster existant)
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• Ouvrir : Ouvrir un fichier existant avec l’opération définie
• Sauvegarder : Sauvegarder toute l’opération dans un fichier
• Sauvegarder sous : Enregistrez toutes les opérations dans un nouveau fichier sur le disque.

3. À l’aide de ces outils, construisez l’algorithme suivant :

4. Cliquez sur Exécuter et ensuite sur Visualiser les résultats pour voir la sortie affichée dans votre carte :
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Cela montre toutes les zones où le terrain est plus haut que 1000 mètres.

Astuce: Vous pouvez également sauvegarder la formule que vous avez créée et la charger dans un autre projet QGIS
en cliquant sur le dernier bouton de la barre d’outils GRASS Mapcalc.

12.2.6 Conclusion

Dans cette leçon, nous avons abordé seulement quelques-uns des outils que GRASS propose. Pour explorer les
fonctionnalités de GRASS par vous-même, ouvrez la boîte de dialogue Outils GRASS et déroulez la Liste des Modules.
Pour une approche plus structurée, consultez l’onglet Arbre des Modules qui organise les outils par type.
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Module : Évaluation

Utilisez vos propres données dans cette section. Vous aurez besoin de:
• un jeu de données vectorielles de points représentant des points d’intérêt, avec le nom des points et des
catégories multiples

• un jeu de données vectorielles de lignes représentant des routes
• un jeu de données vectorielles de polygones représentant l’utilisation du sol (utilisant les propriétés de contour)
• une image de spectre visuel (une photographie aérienne par exemple)
• un Modèle Numérique de Terrain (téléchargeable depuis le CGIAR-CSI si vous n’en disposez pas d’un)

13.1 Créer une carte de base

Avant de faire une analyse de données, vous aurez besoin d’une carte de base, qui fournira le résultat de votre analyse
du contexte.

13.1.1 Ajout de la couche de points

• Ajoutez la couche de points. Selon le niveau de cours que vous avez suivi, faites seulement ce qui est listé dans
la section appropriée ci-dessous :

���

• Étiquetez les points selon un attribut unique, comme les noms de lieux par exemple. Utilisez une petite police
et gardez des étiquettes discrètes. L’information doit être disponible, mais ne doit pas être une entité principale
de la carte.

• Classez les points entre eux avec différentes couleurs basées sur une catégorie. Par exemple, des catégories
peuvent représenter « destination touristique », « poste de police », et « centre-ville ».
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���

• Do the same as the ★☆☆ section.
• Classez la taille des points par importance : plus une entité est importante, plus son point sera grand. Cependant,
ne dépassez pas une taille de point de 2.00.

• Pour les entités qui ne sont pas localisées en un point unique (par exemple, les noms des provinces/régions, ou
les noms des villes à grande échelle), ne leur affectez aucun point du tout.

���

• N’utilisez pas les symboles en point pour symboliser la couche. À la place, utilisez les étiquettes centrées sur
les points ; les symboles en point ne doivent avoir aucune taille.

• Utilisez la :guilabel:Source de définition des paramètres` pour styliser les étiquettes en des catégories
significatives.

• Ajoutez des colonnes appropriées aux données attributaires si nécessaire. Quand vous faites cela, ne créez pas
de données fictives - utilisez plutôt la Calculatrice de champ pour remplir les nouvelles colonnes, qui se base
sur des valeurs existantes appropriées du jeu de données.

13.1.2 Ajout de la couche de lignes

• Ajoutez la couche des routes et ensuite changez sa symbologie. N’étiquetez pas les routes.

���

• Changez la symbologie des routes pour obtenir une couleur claire avec une large ligne. Ajoutez un peu de
transparence à cela.

���

• Créez un symbole avec plusieurs couches de symbole. Le symbole final devrait ressemble à une véritable route.
Vous pouvez utiliser un symbole simple pour cela ; par exemple, une ligne noire avec une fine ligne continue
blanche qui passe en son centre. Il peut être élaboré ainsi, mais la carte finale ne doit pas paraître trop chargée.

• Si votre jeu de données a une grande densité de routes à l’échelle à laquelle vous voulez montrer la carte, vous
pouvez avoir deux couches de routes : celle avec le symbole ressemblant à une route, et celle avec un symbole
plus simple pour une échelle plus petite. (Utilisez la visibilité selon l’échelle pour faire le changement entre les
deux couches aux échelles appropriées.)

• Tous les symboles devraient avoir des couches multiples de symbole. Utilisez des symboles pour les afficher
correctement.

���

• Do the same as in the ★★☆ section above.
• En outre, les routes doivent être classées. En utilisant les symboles ressemblant à une route, chaque type de
route devrait avoir son propre symbole ; par exemple, une autoroute devrait apparaître avec deux voies dans
chaque direction.

398 Chapter 13. Module : Évaluation



QGIS Training Manual

13.1.3 Ajout de la couche de polygones

• Ajoutez la couche de l’utilisation du sol et changez sa symbologie.

���

• Classez la couche selon l’utilisation du sol. Utilisez des couleurs continues.

���

• Classez la couche selon l’utilisation du sol. Où c’est approprié, incorporez des couches de symbole, différents
types de symbole, etc. Gardez cependant des résultats qui semblent modérés et uniformes. Gardez en tête que
cela fera partie d’une toile de fond !

���

• Utilisez une classification basée sur un ensemble de règles pour classer l’utilisation du sol en catégories
générales, telles que « urbain », « rural », « réserve naturelle », etc.

13.1.4 Création de la toile de fond raster

• Créez un ombrage à partir du MNE, et utilisez-le comme un revêtement pour une version classifiée du MNE
lui-même. Vous pourriez aussi utiliser l’extension Relief (comme montré dans la leçon sur les extensions).

13.1.5 Finalisation de la carte de base

• En utilisant les ressources ci-dessous, créez une carte de base en utilisant quelques unes ou toutes les couches.
Cette carte devrait inclure toutes les informations de base nécessaire pour orienter l’utilisateur, ainsi qu’être
visuellement unifiée / « simple ».

13.2 Analyse de données

• Vous recherchez une propriété qui satisfasse certains critères.
• Vous pouvez décider de vos propres critères, que vous devez documenter.
• Il y a des lignes directrices pour ces critères :

– la propriété-cible doit être d’un certain(s) type(s) d’utilisation du sol
– elle doit être à une distance donnée des routes, ou croiser une route
– elle doit être à une distance donnée des différentes catégories de points, comme un hôpital par exemple.
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13.2.1 ��� / ���

• Ajouter une analyse raster à vos résultats. Considérez au moins une propriété dérivée du rater, comme son
aspect ou sa pente.

13.3 Carte finale

• Utiliser Imprimer la Mise en page pour créer une carte finale qui contiendra les résultats de vos analyses.
• Insérez cette carte dans un document avec vos critères documentés. Si la carte est devenue visuellement trop
chargée en raison de la(des) couche(s) ajoutée(s), désélectionnez les couches que vous jugez lemoins nécessaire.

• Votre carte doit inclure un titre et une légende.
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Module : Application forestière

Dans les modules 1 à 13, vous avez déjà appris beaucoup à propos de QGIS et comment travailler avec. Si vous
êtes intéressé à en apprendre sur certaines applications forestières de base des SIG, suivre ce module vous donnera la
possibilité d’appliquer ce que vous avez appris et vous montrera quelques nouveaux outils utiles.

Le développement de ce module a été sponsorisé par l’Union Européenne.

14.1 Leçon : Présentation du module forestier

Suivre ce module sur une application forestière requière la connaissance que vous avez acquise à travers les modules
1 à 11 de ce manuel d’entraînement. Les exercices dans les leçons suivantes supposent que vous êtes déjà capable de
faire beaucoup d’opérations basiques dans QGIS et seuls les outils qui n’ont pas été utilisés avant sont présentés en
détail.
Néanmoins, le module suit un niveau basique tout au long des leçons de telle sorte que si vous avez une expérience
précédente avec QGIS, vous pouvez probablement suivre les instructions sans problèmes.
Notez que vous avez besoin de télécharger un paquet de données supplémentaire pour ce module.
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14.1.1 Échantillon de données forestières

Note: Le jeu de données utilisé dans ce module fait partie des données du manuel d’entraînement et est disponible
dans le dossier exercise_data\forestry\.

The forestry related sample data (forestry map, forest data), has been provided by the EVO-HAMK forestry school.
The datasets have been modified to adapt to the lessons needs.
Les données générales de l’échantillon (images aériennes, données LiDAR, cartes de base) ont été obtenues auprès
du service de données ouvertes de la National Land Survey of Finland et adaptées aux fins des exercices. Le service
de téléchargement de fichiers de données ouvertes est accessible en anglais ici.

Avertissement: Comme pour le reste de ce manuel d’exercices, ce cours comprend des instructions sur l’ajout, la
suppression et la modification des jeux de données SIG. Nous avons fourni des ensembles de données de formation
à cet effet. Avant d’utiliser les techniques décrites ici sur vos propres données, assurez vous toujours de disposer
des sauvegardes appropriées !

14.2 Leçon : Géoréférencement d’une carte

Une tâche forestière commune serait la mise à jour des informations relatives à une zone forestière. Il est possible que
les informations précédentes pour cette zone datent de plusieurs années et aient été collectées de manière analogique
(c’est-à-dire sur papier) ou peut-être qu’elles aient été numérisées mais qu’il ne vous reste que la version papier de ces
données d’inventaire.
Il est fort probable que vous souhaitiez utiliser ces informations dans votre SIG pour, par exemple, les comparer plus
tard avec des inventaires ultérieurs. Cela signifie que vous devrez numériser les informations dont vous disposez à
l’aide de votre logiciel SIG. Mais avant de pouvoir commencer la numérisation, il y a une première étape importante
à franchir, à savoir la numérisation et le géoréférencement de votre carte papier.
Le but de cette leçon: Apprendre à utiliser l’outil Georeferencer dans QGIS.

14.2.1 ��� Scanner la carte

La première tâche que vous aurez à faire est de scanner votre carte. Si votre carte est trop grande, vous pouvez
la numériser en plusieurs parties, mais n’oubliez pas que vous devrez répéter les tâches de prétraitement et de
géoréférencement pour chaque partie. Donc, si possible, scannez la carte en un nombre de parties aussi réduit que
possible.
Si vous devez utiliser une carte différente de celle fournie avec ce manuel, utilisez votre propre scanner pour scanner
la carte sous forme de fichier image, une résolution de 300 DPI fera l’affaire. Si votre carte comporte des couleurs,
scannez l’image en couleur afin de pouvoir utiliser ces couleurs plus tard pour séparer les informations de votre carte
en différentes couches (par exemple, les peuplements forestiers, les courbes de niveau, les routes…).
Pour cet exercice, vous allez utiliser une carte qui aura été scanné préalablement, que vous pouvez trouver sous le
nom rautjarvi_map.tif dans le dossier de données exercise_data/forestry.
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14.2.2 ��� Pas à pas : Géoréférencer la carte scannée

1. Ouvrez QGIS et définissez le SCR du projet comme EPSG:3067 - ETRS89 / TM35FIN(E,N) dans
Projet ► Propriétés ► SCR, qui est le SCR actuellement utilisé en Finlande.

2. Enregistrez le projet QGIS sous map_digitizing.qgs.
Vous allez utiliser l’outil de géoréférencement de QGIS nommé Géoréférencer. Pour géoréférencer la carte :

1. Ouvrez l’outil de géoréférencement, Couche ► Géoréférencer….
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2. Ajoutez le fichier image de la carte, rautjarvi_map.tif, en tant qu’image à géoréférencer, Fichier ►
Ouvrir un raster….

3. Cliquez sur OK.
Ensuite, vous devez définir les paramètres de transformation pour le géoréférencement de la carte :

1. Ouvrez Paramètres ► Paramètres de transformation.
2. Définissez le Type de transformation en Linéaire et la Méthode de ré-échantillonnage en Plus proche

voisin.

3. Cliquez sur le bouton Sélectionner le SCR à côté de l’option SCR cible et sélectionnez le SCR EPSG:2392 -
KKJ / Finland zone 2 ; c’est le SCR qui était utilisé en Finlande en 1994, quand cette carte a été créée.

4. Cliquez sur l’icône à côté de la boîte Raster de sortie, allez dans le dossier, créez le dossier exercise_data\
forestry\digitizing et nommez le fichier rautjarvi_georef.tif.

5. Cochez la case Charger dans QGIS lorsque terminé

6. Laissez le reste des paramètres à leur valeur par défaut.
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7. Cliquez sur OK.
La carte contient plusieurs croix marquant les coordonnées dans la carte, nous les utiliserons pour géoréférencer cette
image. Vous pouvez utiliser les outils de zoom et de panoramique comme vous le faites habituellement dans QGIS
pour inspecter l’image dans la fenêtre géoréférencer.

1. Zoomez sur le coin en bas à gauche de la carte et remarquez qu’il s’y trouve une croix avec une paire de
coordonnées X et Y qui sont, comme mentionné précédemment, dans le SCR KKJ / Finland zone 2.
Vous utiliserez ce point en tant que premier point de contrôle pour géoréférencer la carte.

2. Sélectionnez l’outil Ajouter point et cliquez dans l’intersection du réticule (pan et zoom si nécessaire).
3. Dans le dialogue Entrer les coordonnées de la carte, saisissez les coordonnées qui apparaissent sur la carte (X :

2557000 et Y : 6786000) et leur SCR (EPSG:2392 - KKJ / Finland zone 2)

4. Cliquez sur OK.
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La première coordonnée pour le géoréférencement est maintenant prête.
5. Recherchez d’autres croix de calage noires dans l’image, elles sont séparées de 1000 mètres dans les directions

nord et est. Vous devriez pouvoir calculer les coordonnées de ces points en relation avec le premier point.
6. Dézoomez l’image et déplacez-vous vers la droite ou le haut jusqu’à trouver une autre croix de calage, et estimez

de combien de kilomètres vous vous êtes déplacé. Essayez d’obtenir des points de contrôle les plus éloignés
possible les uns des autres.

7. Numérisez au moins trois points de contrôle supplémentaires de la même façon que pour le premier point.
Vous devriez obtenir quelque chose similaire à ceci :

Quand vous aurez numérisé trois points de contrôle, vous pourrez visualiser les erreurs de géoréférencement par une
ligne rouge partant des points. L’erreur en pixels peut aussi être vue dans le Tableau des points de contrôle, dans les
colonnes dX[pixels] et dY[pixels]. L’erreur en pixels ne doit pas dépasser 10 pixels. Si c’est le cas, vous devez revoir
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les points que vous avez numérisés et les coordonnées que vous avez entrées pour trouver où est le problème. Vous
pouvez utiliser l’image au-dessus pour vous guider.
Une fois que vous êtes satisfait de vos points de contrôle, vous pouvez les conserver pour une utilisation ultérieure :

1. Allez sur Fichier ► Enregistrer les points de contrôle sous….
2. Dans le dossier exercise_data\forestry\digitizing, nommez le fichier rautjarvi_map.

tif.points.
Pour terminer, géoréférencez votre carte :

1. Allez sur Fichier ► Débuter le géoréférencement.
2. Notez que vous avez déjà nommé le fichier rautjarvi_georef.tif quand vous avez modifié les

paramètres de géoréférencement.
A présent, vous pouvez voir la carte en tant que raster géoréférencé dans le projet QGIS. Notez que le raster
paraît légèrement de travers, mais c’est simplement dû au fait que les données sont en KKJ / Finland
zone 2 et votre projet est en ETRS89 / TM35FIN(E,N).

3. Pour vérifier que vos données sont correctement géoréférencées, vous pouvez
1. Ouvrir l’imagerie aérienne dans le dossier exercise_data\forestry, nommée

rautjarvi_aerial.tif.
2. Votre carte et l’image doivent plutôt bien correspondre : mettez la transparence de la carte à 50 % et

comparez avec l’image aérienne.
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4. Enregistrez les modifications apportées à votre projet QGIS, vous continuerez à partir de ce point pour la
prochaine leçon.
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14.2.3 Conclusion

Vous avez maintenant géoréférencé une carte papier, ce qui permet de l’utiliser comme couche cartographique dans
QGIS.

14.2.4 La suite ?

Dans la prochaine leçon, vous numériserez les peuplements forestiers de votre carte sous forme de polygones et y
ajouterez les données d’inventaire.

14.3 Leçon : Numériser les massifs forestiers

Àmoins que vous n’utilisiez votre carte géoréférencée comme une simple image de fond, la prochaine étape naturelle
consiste à en numériser les éléments. Vous l’avez déjà fait dans les exercices sur la création de données vectorielles
dans Leçon : Création d’un nouveau jeu de données vectorielles, lorsque vous avez numérisé les champs de l’école.
Dans cette leçon, vous allez numériser les limites des peuplements forestiers qui apparaissent sur la carte sous forme
de lignes vertes, mais au lieu de le faire à l’aide d’une image aérienne, vous utiliserez votre carte géoréférencée.
Objectif de cette leçon : Apprendre une technique d’aide à la tâche de numérisation, en numérisant des massifs
forestiers et en leur ajoutant finalement les données d’inventaire.

14.3.1 ��� Follow Along: Extracting the Forest Stands Borders

Ouvrez dans QGIS le projet map_digitizing.qgs que vous aviez sauvegardé dans la leçon précédente.
Une fois que vous avez scanné et géoréférencé votre carte, vous pouvez directement commencer la numérisation en
regardant l’image comme un guide. Cela sera probablement la façon avec laquelle vous procéderez si l’image que
vous avez numérisé est, par exemple, une photographie aérienne.
Si ce que vous utilisez pour numériser est une bonne carte, comme dans notre cas, il est probable que les informations
soient clairement affichées sous forme de lignes de couleurs différentes pour chaque type d’élément. Ces couleurs
peuvent être extraites relativement facilement sous forme d’images individuelles à l’aide d’un logiciel de traitement
d’images comme GIMP. Ces images séparées peuvent être utilisées pour faciliter la numérisation, comme vous le
verrez ci-dessous.
La première étape sera d’utiliser GIMP pour obtenir une image qui ne contienne que les massifs forestiers, c’est-à-dire
toutes ces lignes verdâtres que vous pouvez voir sur la carte scannée d’origine :

1. OuvrezGIMP (si vous ne l’avez pas déjà installé, téléchargez-le depuis internet ou demandez à votre professeur).
2. Open the original map image, File► Open, rautjarvi_map.tif in the exercise_data/forestry

folder. Note that the forest stands are represented as green lines (with the number of the stand also in green
inside each polygon).
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3. Vous pouvez maintenant sélectionner les pixels dans l’image qui coïncident avec les bordures des massifs
forestiers (les pixels verdâtres):
1. Ouvrez l’outil Sélection ► Par couleur.
2. With the tool active, zoom into the image (Ctrl + mouse wheel) so that a forest stand line is close

enough to differentiate the pixels forming the line. See the left image below.
3. Cliquez et faites glisser le curseur de la souris au milieu de la ligne afin que l’outil collecte plusieurs valeurs

de couleur de pixels.
4. Relâchez le clic de la souris et attendez quelques secondes. Les pixels aux couleurs récupérées par l’outil

seront sélectionnés à travers toute l’image.
5. Dézoomez pour voir comment les pixels verdâtres ont été sélectionnés sur toute l’image.
6. Si vous n’êtes pas content du résultat, répétez l’opération de cliquer et glisser la souris.
7. Votre sélection de pixels devrait ressembler à ce qu’on voit dans l’image de droite ci-dessous.
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4. Une fois que vous en avez terminé avec la sélection, vous devez copier cette sélection comme nouvelle couche
et ensuite la sauvegarder séparément comme fichier image :
1. Copiez (Ctrl+C ou Éditer ► Copier) les pixels sélectionnés.
2. And paste the pixels directly as a new layer (Edit► Paste as► New Layer). GIMP will display the pasted

pixels as a new layer (Pasted Layer) in the Layers panel.
3. Cliquez sur l’icône « oeil » à côté de la couche de l’image d’origine pour la désactiver, afin que seule la

Couche collée soit visible :
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5. Finally, select File► Export As…, set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it rautjarvi_map_green.tif. Select no compression when asked.

Vous pouvez faire le même processus avec d’autres éléments de l’image, par exemple extraire les lignes noires
représentant les routes, ou les brunes qui représentent les lignes de contour du terrain. Mais pour nous, les massifs
forestiers sont suffisants.

14.3.2 ��� Essayez vous-même : Géoreferencer les pixels verts de l’image

Comme vous l’avez fait dans la leçon précédente, vous devez géoréférencer cette nouvelle image pour pouvoir l’utiliser
avec le reste de vos données.
A noter que vous n’avez plus besoin de numériser les points de contrôle car cette image est en fait la même image que
l’image d’origine de la carte, dans la mesure où l’outil Géoréférenceur est concerné. Voici quelques éléments dont
vous devriez vous rappeler :

• Cette image est aussi, évidemment, dans le SCR KKJ / Finland zone 2.
• Vous devriez utiliser les points de contrôle que vous avez sauvegardé, Fichier ► Charger des points de contrôle
(GCP).

• Souvenez-vous de modifier les Préférences de transformation.
• Nommez le raster de sortie rautjarvi_green_georef.tif dans le dossier digitizing.

Vérifiez que le nouveau raster se superpose parfaitement avec la carte d’origine.

14.3.3 ��� Pas à pas : Créer des points de référence pour la numérisation

Si vous avez en-tête les outils de numérisation de QGIS, vous pouvez penser qu’il serait utile de s’accrocher à ces
pixels verts lors de la numérisation. C’est précisément ce que nous allons faire en créant des points à partir de ces
pixels pour les utiliser plus tard pour nous aider à suivre les bordures des forêts lors de la numérisation en utilisant les
outils d’accrochage disponible dans QGIS.

1. Utilisez l’outil Raster ► Conversion ► Polygoniser (Raster à Vecteur) pour vectoriser vos lignes vertes en
polygones. Si vous ne vous souvenez plus comment faire, vous pouvez le revoir dans Leçon : Conversion
Raster vers Vecteur.

2. Save as rautjarvi_green_polygon.shp inside the digitizing folder.
3. Zoomez et voyez à quoi ressemblent les polygones. Vous obtiendrez quelque chose comme ça :
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4. Next option to get points out of those polygons is to get their centroids:
1. Ouvrez Vecteur ► Outils de géométrie ► Centroïdes….

2. Set Input Layer to rautjarvi_green_polygon (the polygon layer you have just created)
3. Set Centroids output to green_centroids.shp file within the folder digitizing

4. Cochez Ouvrir le fichier après exécution de l’algorithme

5. Press Run. This will calculate the centroids for the polygons as a new layer and add it to the project.
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5. Now you can remove the rautjarvi_green_polygon layer from the TOC.
6. Change the symbology of the centroids layer as follows:

1. Open the Layer Properties for green_centroids.
2. Aller à l’onglet Symbologie.
3. Set Size to 1.00 and choose Map Units

Il n’est pas nécessaire de différencier les points les uns des autres, vous avez seulement besoin de les avoir pour que
les outils d’accrochage puissent les utiliser. Vous pouvez maintenant utiliser ces points pour suivre les lignes d’origine
plus facilement que sans eux.
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14.3.4 ��� Pas à pas : Numériser les peuplements forestiers

Maintenant, vous êtes prêt à lancer le travail de numérisation. Créez un fichier vecteur du type polygone mais pour
cet exercice, il existe déjà un fichier Shape sur les emprises d’intérêt. Il vous reste à terminer la numérisation de la
moitié des forêts qui restent entre les routes principales (lignes roses larges) et le lac:

1. Go to the digitizing folder using your file manager browser.
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2. Drag and drop the forest_stands.shp vector file to your map.
3. Change the new layer’s symbology so that it will be easier to see the polygons that have already been digitized.

1. Set Fill color to green - and change the Opacity to 50%.
2. Select Simple Fill and set Stroke width to 1.00 mm.

Maintenant, si vous vous souvenez des modules passés, nous devons définir et activer les options d’accrochage :
1. Allez au menu Projet ► Options d’accrochage…

2. Cochez sur Activer l’accrochage et sélectionnez Configuration avancée
3. Cochez les couches green_centroids et forest_stands
4. Ajustez chaque Type sur Sommet
5. Définissez la Tolérance à 10 pour chaque couche
6. Sélectionnez les pixels comme Unités pour chaque couche

7. Cochez Éviter les chevauchements pour la couche forest_stands

8. Appuyer sur Édition topologique

9. Choisissez Suivre la configuration avancée

10. Fermez la fenêtre

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the
centroids layer or any vertex of your digitized polygons, a pink square will appear on the point that will be
snapped to.

11. Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure that the
map image has not transparency any more.

A few important things to note before you start digitizing:
• N’essayez pas d’être trop précis avec la numérisation des bordures.
• Si une bordure est une ligne droite, numérisez-la avec seulement deux noeuds. En général, la numérisation
utilise aussi peu de noeuds que possible.

• Zoomez pour fermer les plages seulement si vous pensez que vous devez être précis, par exemple, à un coin ou
lorsque vous voulez connecter un polygone avec un autre polygone à un certain noeud.

• Utilisez le bouton du milieu de la souris pour zoomer/dézoomer et vous déplacer lors de la numérisation.
• Numérisez seulement un polygone à la fois.
• Après avoir numérisé un polygone, écrivez l’id du massif forestier que vous pouvez voir sur la carte.

Vous pouvez maintenant commencer la numérisation :
1. Locate the forest stand number 357 in the map window.
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2. Sélectionnez la couche forest_stands.

3. Click the Toggle Editing button to enable editing

4. Select Add Polygon Feature tool.
5. Start digitizing the stand 357 by connecting some of the dots. Note the pink crosses indicating the snapping.

Lorsque vous avez fini :
1. Right click to end digitizing that polygon.
2. Enter the forest stand ID within the form (in this case 357).
3. Cliquez sur OK.

Si une fenêtre de saisie ne s’est pas ouverte lorsque vous avez terminé la numérisation du polygone, rendez-vous dans
Préférences ► Options ► Numérisation et assurez-vous que Supprimer les avertissements de formulaire d’attribut lors
de la création d’entité n’est pas coché.
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Votre polygone numérisé ressemblera à cela :

Pour le second polygone, récupérez l’ilot 358. Assurez-vous que l’option Éviter les superpositions est cochée
pour la couche forest_stands (comme indiqué ci-dessus). Cette option permet aux polygones numérisés de ne pas se
superposer du tout. Si vous numérisez au dessus d’un polygone déjà existant, le nouveau polygone sera coupé à la
bordure du polygone déjà existant. Vous pouvez utiliser cette fonctionnalité pour obtenir une bordure commune.

1. Commencez à numériser le massif 358 à un des angles communs avec le massif 357.
2. Continuez normalement jusqu’à ce que vous arriviez à l’autre coin commun aux deux massifs.
3. Finalement, numérisez quelques points dans le polygone 357 en s’assurant que la bordure commune n’est pas

intersectée. Observez l’image de gauche ci-dessous.
4. Faites un clic-droit pour terminer la modification du massif forestier 358.
5. Entrez la valeur 358 dans le champ id.
6. Cliquez sur OK. Votre nouveau polygone devrait avoir une limite commune avec le stand 357 comme vous

pouvez le voir dans l’image ci-dessous.
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La partie du polygone qui chevauchait le polygone existant a été automatiquement découpée et vous avez obtenu une
bordure commune, comme on pouvait s’y attendre.

14.3.5 ��� Essayez vous-même : Finaliser la numérisation des peuplements
forestiers

Vous avez maintenant deux plages de forêts prêtes. Et une bonne idée de comment procéder. Continuez à numériser
de vous-même jusqu’à ce que vous ayez numérisé toutes les plages de forêt qui sont limitées par la route principale
et le lac.
Cela peut sembler être beaucoup de travail, mais vous serez bientôt habitué à la numérisation des massifs forestiers.
Cela devrait vous prendre environ 15 minutes.
Lors de la numérisation, vous pourriez avoir besoin demodifier ou de supprimer des nœuds, de séparer ou de fusionner
des polygones. Vous avez appris les outils nécessaires à cela dans Leçon : Topologie des données, c’est probablement
un bon moment pour relire à nouveau ce chapitre.
Souvenez-vous qu’en ayant coché Activer l’édition topologique, cela vous permet de déplacer des noeuds communs à
deux polygones afin que la bordure commune soit modifiée en même temps pour les deux polygones.
Votre résultat devra ressembler à cela :

14.3. Leçon : Numériser les massifs forestiers 419



QGIS Training Manual

14.3.6 ��� Follow Along: Joining the Forest Stand Data

Il est possible que les données d’inventaire des forêts que vous avez pour votre carte soit aussi écrites sur papier.
Dans ce cas, vous devrez tout d’abord écrire ces données dans un fichier texte ou un tableur. Pour cet exercice, les
informations de l’inventaire de 1994 (le même inventaire que la carte) sont prêtes dans un fichier texte séparé par des
virgule (fichier csv).

1. Ouvrez le fichier rautjarvi_1994.csv depuis le répertoire exercise_data\forestry dans un
éditeur de texte et notez que le fichier de données d’inventaire possède un attribut nommé ID qui contient les
numéros des massifs de forêts. Ces numéros sont les mêmes que les ids des massifs de forêts que vous avez
entrés pour vos polygones et peuvent être utilisés pour lier les données du fichier texte au fichier vectoriel. Vous
pouvez voir les métadonnées pour ces données d’inventaire dans le fichier rautjarvi_1994_legend.
txt dans le même dossier.
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2. Ajoutez maintenant ce fichier au projet :

1. Use the Add Delimited Text Layer tool. This is accessed via Layer ► Add Layer ► Add Delimited Text
Layer….

2. Set details in the dialog as follows:

3. Press Add to load the formatted csv file in the project.
3. To link the data from the .csv file with the digitized polygons, create a join between the two layers:

1. Open the Layer Properties for the forest_stands layer.
2. Rendez-vous à l’onglet Jointure.

3. Click Add new join on the bottom of the dialog box.
4. Select rautjarvi_1994.csv as the Join layer
5. Indiquez ID pour le champ Jointure
6. Indiquez ID pour le champ Cible
7. Cliquez sur OK deux fois.

Les données du fichier texte devraient être maintenant liées à votre fichier vectoriel. Pour voir ce qu’il s’est passé,
sélectionnez la couche forest_stands et appuyez sur Ouvrir la table attributaire. Vous pouvez voir que tous les
attributs du fichier de données d’inventaire sont maintenant liées à votre couche vectorielle numérisée.
You will see that the field names are prefixed with rautjarvi_1994_. To change this:

1. Open the Layer Properties for the forest_stands layer.
2. Rendez-vous à l’onglet Jointure.
3. Select Join Layer rautjarvi_1994

4. Click the Edit selected join button to enable editing
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5. Under Custom field name prefix remove the prefix name

The data from the .csv file is just linked to your vector file. To make this link permanent, so that the data is actually
recorded to the vector file you need to save the forest_stands layer as a new vector file. To do this:

1. Faites un clic droit sur la couche forest_stands.
2. Sélectionnez Exporter ► Sauvegarder les entités sous…

3. Définissez le guilabel:Format à ESRI Shapefile
4. Set file name to forest_stands_1994.shp under the forestry folder

5. To include the new file as a layer in the project, check Add saved file to map
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14.3.7 ��� Essayez vous-même : Ajouter une aire et un périmètre

Pour terminer sur l’information relative à ces lots forestiers, vous pourriez calculer la surface et le périmètre des lots.
Vous avez calculé les surfaces des polygones dans Leçon : Exercice Supplémentaire. Retournez consulter cette leçon
si vous en avez besoin et calculez les surfaces des lots forestiers. Nommez le nouveau champ Area et assurez-vous
que les valeurs soient calculées en hectares. Faites de même pour le calcul du périmètre.
Now your forest_stands_1994 layer is ready and packed with all the available information.
Save your project to keep the current map layers in case you need to come back later to it.
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14.3.8 Conclusion

Cela a pris plusieurs clics de souris mais vous avez désormais vos anciennes données d’inventaire dans un format
numérique et prêtes à être utilisées dans QGIS.

14.3.9 La suite ?

Vous pouvez lancer d’autres analyses sur votre nouveau jeu de données mais il est plus intéressant de les faire sur un
jeu de données plus récentes. Le sujet de la prochaine leçon concerne la création des massifs forestiers en utilisant
les dernières photos aériennes et l’ajout d’information plus précises à votre jeu de données.

14.4 Leçon : Mettre à jour les massifs forestiers

Now that you have digitized the information from the old inventory maps and added the corresponding information
to the forest stands, the next step is to create the inventory of the current state of the forest.
You will digitize new forest stands using an aerial photo. As with the previous lesson, you will use an aerial Color
Infrared (CIR) photograph. This type of imagery, where the infrared light is recorded instead of the blue light, is
widely used to study vegetated areas.
Après la numérisation desmassifs de forêt, vous ajouterez des informations telles que les nouvelles contraintes données
par les réglementations de conservation.
The goal for this lesson: To digitize a new set of forest stands from CIR aerial photographs and add information
from other datasets.

14.4.1 ��� Comparing the Old Forest Stands to Current Aerial Photographs

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical
data like aerial imagery, traditional topographicmaps, DEM, LiDAR data, etc. The service can be accessed in English
here. The aerial image used in this exercise has been created from two orthorectified CIR images downloaded from
that service (M4134F_21062012 and M4143E_21062012).

1. Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project ► Properties… ► CRS

2. Add the CIR image rautjarvi_aerial.tif to the project:
1. Go to the exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file rautjarvi_aerial.tif onto your project

3. Save the QGIS project as digitizing_2012.qgs
Les images CIR sont de 2012. Vous pouvez comparer les massifs qui ont été créés en 1994 avec la situation d’il y a
environ 20 ans.

1. Add the forest_stands_1994.shp layer created in the previous lesson:
1. Go to the exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file forest_stands_1994.shp onto your project

2. Set the symbology for the layer so that you can see through your polygons:
1. Right click forest_stands_1994
2. Select Properties

3. Go to the Symbology tab
4. Set Fill color to transparent fill
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5. Set Stroke color to purple
6. Set Stroke width to 0.50 mm

3. Étudiez comment les anciens massifs de forêt suivent (ou non) ce que vous pouvez visuellement interpréter
comme de la forêt homogène.

4. Zoomez et bouger autour de la zone. Vous remarquerez probablement que certains des anciens massifs de forêt
pourraient correspondre à l’image alors que d’autres non.
This is a normal situation, as some 20 years have passed and different forest operations have been carried
out (harvesting, thinning…). It is also possible that the forest stands looked homogeneous back in 1992 to
the person who digitized them but as time has passed some forest has developed in different ways. It is also
possible that that forest inventory priorities back then were different from those of today.

Ensuite, vous créerez de nouveaux massifs de forêt pour cette image sans utiliser les anciens. Plus tard, vous pourrez
les comparer pour voir les différences.

14.4.2 ��� Interpreting the CIR Image

Numérisons la même zone qui était couverte par l’ancien inventaire, limitée par les routes et par le lac. Vous n’avez
pas besoin de numériser l’entier de la zone, comme dans l’exercice précédent, vous pouvez commencer avec un fichier
vectoriel qui contient déjà la plupart des massifs de forêt.

1. Remove the layer forest_stands_1994

2. Add the file exercise_data\forestry\forest_stands_2012.shp to the project
3. Set the styling of this layer so that the polygons have no fill and the borders are visible

1. Open Properties dialog of the forest_stands_2012 layer

2. Go to the Symbology tab
3. Set Fill color to transparent fill
4. Set Stroke color to green
5. Set Stroke width to 0.50 mm
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You can see that the northern section of the inventory area is still missing. Your task is to digitize the missing forest
stands.
Before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in the
image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.
Some points to consider:

• Which forests have deciduous species (in Finland these are mostly birch forests) and which ones have conifers
(in this area these are pine or spruce)? In CIR images, deciduous species usually show up as a bright red color
whereas conifers show as a dark green color.
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• How old is the forest? The size of the tree crowns can be identified in the imagery.
• How dense are the different forest stands? A forest stand where a thinning operation has recently been done
would show spaces between the tree crowns and should be easy to differentiate from other forest stands around
it.

• Des zones bleutées indiquent des terrains stériles, routes et zones urbaines, les cultures qui ne sont pas ouvertes
à croître, etc.

• Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:5
000 should be enough for this imagery. See the image below (1:4000 scale):

14.4.3 ��� Try Yourself: Digitizing Forest Stands from CIR Imagery

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms of
tree species, forest age, stand density… Don’t be too detailed though, or you will end up making hundreds of small
forest stands - and that would not be useful at all. You should try to get stands that are meaningful in the context of
forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).
With these points in mind, you can now digitize the missing forest stands.

1. Set up the snapping and topology options:
1. Allez au menu Projet ► Options d’accrochage….

2. Cochez sur Activer l’accrochage et sélectionnez Configuration avancée

3. Check the forest_stands_2012 layer
1. Set Type to Vertex
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2. Set Tolerance to 10
3. Set Units to pixels
4. Check the box under Avoid Overlap

5. Appuyer sur Édition topologique

6. Choisissez Suivre la configuration avancée

7. Fermez la fenêtre

2. Select the forest_stands_2012 layer on the Layers list

3. Click the Toggle Editing button to enable editing
4. Start digitizing using the same techniques as in the previous lesson. The only difference is that you don’t have

any point layer that you are snapping to. For this area you should get around 14 new forest stands. While
digitizing, fill in the StandID field with numbers starting at 901.

5. Quand vous avez terminé, votre couche devrait ressembler à quelque chose comme ça :
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Now you have a new set of polygons showing the different forest stands in 2012 - as interpreted from the CIR images.
However, you are missing the forest inventory data. For that you will need to visit the forest and get some sample
data that you will use to estimate the forest attributes for each of the forest stands. You will see how to do that in the
next lesson.
You can add some extra information about conservation regulations that need to be taken into account for this area.

14.4.4 ��� Follow Along: Updating Forest Stands with Conservation
Information

For the area you are working in, there are some conservation regulations that must be taken into account when doing
the forest planning:

• Deux emplacements d’une espèce protégée d’écureuil volant de Sibérie (Pteromys volans) ont été identifiés.
Selon le règlement, une zone de 15 mètres autours des lieux devrait restée intacte.

• A riparian forest of special interest that is growing along a stream in the area must be protected. In a visit to
the field, it was found that 20 meters to both sides of the stream must be protected.

You have a vector file containing the information about the squirrel locations and another containing the digitized
stream running from the North area towards the lake.

1. From the exercise_data\forestry\ folder, add the squirrel.shp and stream.shp files to the
project.
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2. Use the Open Attribute Table tool to view the squirrel layer
Vous pouvez voir qu’il y a deux emplacements qui sont définis comme écureuil volant de Sibérie, et que la zone
à protéger est indiquée par une distance de 15 mètres des emplacements.

Let’s more accurately delimitate that area to protect. We will create a buffer around the point locations, using the
protection distance.

1. Ouvrez Vecteur ► Outils de géotraitement ► Tampon.

2. Set Input layer to squirrel

3. Set Distance to 15 meters

4. Set Buffered to exercise_data\forestry\squirrel_15m.shp

5. Check Open output file afer running algorithm

6. Cliquez sur Exécuter
7. Once the process is completed, click Close
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If you zoom in to the location in the northern part of the area, you will notice that the buffer area extends over two
neighbouring stands. This means that whenever a forest operation takes place in that stand, the protected location
should also be taken into account.

For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands that
will contain information about locations that have to be protected. This information will then be available whenever
a forest operation is planned, and the field team will be able to mark the area that has to be left untouched before the
work starts.
To join the information about the squirrels to your forest stands, you can use the Join attributes by location algorithm:

1. Ouvrez Vecteur ► Outils de gestion de données ► Joindre les attributs par localisation.

2. Set Join to features in to forest_stands_2012

3. In Geometric predicate, check intersect

4. Set By comparing to to squirrel_15m

5. Set Join type as Take attributes of the first matching feature only (one-to-one)
6. Leave unchecked Discard records which could not be joined
7. Set Joined layer to exercise_data\forestry\stands_squirrel.shp

8. Check Open output file afer running algorithm

9. Cliquez sur Exécuter
10. Once the process is completed, you can Close the dialog.
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Now you have a new forest stands layer, stands_squirrel.shp showing the protection information for the
Siberian flying squirrel.

1. Open the attribute table of the stands_squirrel layer
2. Sort the table by clicking on point_pr field in the table header.
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You can see that there are some forest stands that have the information about the protection locations. The
information in the forest stands data will indicate to the forest manager that there are protection considerations
to be taken into account. Then he or she can get the location from the squirrel dataset, and visit the area to
mark the corresponding buffer around the location so that the operators in the field can avoid disturbing the
squirrels environment.

14.4.5 ��� Try Yourself: Updating Forest Stands with Distance to the Stream

Following the same approach as for the protected squirrel locations you can now update your forest stands with
protection information related to the stream. A few points:

• Remember the buffer is 20 meters around the stream
• You want to have all the protection information in the same vector file, so use stands_squirrel.shp as
the base layer

• Name your output as forest_stands_2012_protect.shp
Once the process is completed, open the attribute table of the output layer and confirm that you have all the protection
information for the riparian forest stands associated with the stream.
When you are happy with the results, save your QGIS project.

14.4.6 Conclusion

Vous avez vu comment interprétez des images CIR pour numériser des massifs forestiers. Bien sûr cela demanderait
plus de pratique pour faire des massifs plus précis et le plus souvent avec d’autres informations, comme des cartes
pédologiques donneraient de meilleurs résultats, mais vous savez désormais les bases pour ce type de tâche. Et l’ajout
d’informations à partir de jeux de données s’est révélé être une tâche tout à fait banale.
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14.4.7 La suite ?

Les massifs de forêt que vous avez numérisés seront utilisés pour la planification des opérations forestières dans
l’avenir, mais vous avez besoin d’obtenir toujours plus d’informations sur la forêt. Dans la prochaine leçon, vous
verrez comment planifier un ensemble de parcelles d’échantillonnage pour inventorier la zone forestière que vous
venez de numériser, et obtenir l’estimation globale des paramètres de la forêt.

14.5 Leçon : Conception d’un échantillonnage systématique

Vous avez déjà numérisé un jeu de polygones qui représentent les massifs de forêt, mais vous n’avez pas eu
d’informations sur la forêt jusqu’à maintenant. Pour cela, vous pouvez concevoir une enquête pour inventorier la
zone forestière entière et ensuite estimer ses paramètres. Dans cette leçon, vous créerez un ensemble d’échantillons
de parcelles.
Lorsque vous commencez à planifier votre inventaire forestier, il est important de définir clairement les objectifs, les
types de parcelles d’échantillon qui seront utilisées, et les données qui seront collectées pour réaliser ces objectifs.
Pour chaque cas individuel, ceux-ci dépendront du type de forêt et des fins de gestion ; et devront être soigneusement
planifiés par quelqu’un qui possède des connaissances forestières. Dans cette leçon, vous implémenterez un inventaire
théorique basé sur une conception d’un échantillonnage systématique de parcelles.
Objectif de cette leçon : Créer un échantillonnage systématique de parcelles pour étudier la zone forestière.

14.5.1 Inventaire de la forêt

Il existe plusieurs méthodes pour inventorier des forêts, chacune d’elles convenant à différentes fins et conditions. Par
exemple, une façon très précise d’inventorier une forêt (si vous considérez seulement trois espèces) serait de visiter la
forêt et de faire une liste de chaque arbre et de ses caractéristiques. Comme vous pouvez l’imaginer, cette méthode
n’est pas vraiment applicable, sauf pour de petites zones ou pour des situations particulières.
La façon la plus courante de découvrir une forêt est de l’échantillonner, c’est-à-dire de prendre des mesures à différents
endroits de la forêt et de généraliser ces informations à l’ensemble de la forêt. Cesmesures sont souvent effectuées dans
des parcelles d’échantillonnage qui sont des zones forestières plus petites qui peuvent être facilement mesurées. Les
placettes d’échantillonnage peuvent être de n’importe quelle taille (par exemple 50 m2, 0,5 ha) et de n’importe quelle
forme (par exemple circulaire, rectangulaire, de taille variable), et peuvent être situées dans la forêt de différentes
manières (par exemple de manière aléatoire, systématique, le long de lignes). La taille, la forme et l’emplacement
des placettes d’échantillonnage sont généralement décidés en fonction de considérations statistiques, économiques et
pratiques. Si vous n’avez aucune connaissance en matière de foresterie, vous pourriez être intéressé par la lecture de
cet article Wikipedia.

14.5.2 ��� Follow Along: Implementing a Systematic Sampling Plot Design

Pour la forêt sur laquelle vous travaillez, le gestionnaire a décidé qu’une conception d’un échantillonnage systématique
est la méthode la plus appropriée pour cette forêt et a décidé qu’une distance fixe de 80 mètres entres les parcelles
d’échantillon et les lignes d’échantillonnage donnera des résultats fiables (dans ce cas, une erreur moyenne de +- 5%
pour une probabilité de 68%). Des parcelles de taille variables ont été sélectionnées comme étant la méthode la plus
efficace pour cet inventaire, pour des massifs matures et en croissance, mais les parcelles à un rayon fixe de 4 mètres
seront utilisées pour des massifs de semis.
Dans la pratique, vous devez simplement représenter les parcelles d’échantillon par des points qui seront utilisés plus
tard par les équipes de terrain :

1. Ouvrez dans QGIS le projet digitizing_2012.qgs que vous aviez sauvegardé dans la leçon précédente.
2. Remove all the layers except for forest_stands_2012.
3. Enregistrez votre projet QGIS sous le nom forest_inventory.qgs.
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Vous devez maintenant créer une grille rectangulaire de points séparés de 80 mètres les uns des autres :

1. Ouvrez Vecteur ► Outils de recherche Points réguliers.
2. Press the drop-down button next to the Input extent field and from the Calculate from Layer menu, select

forest_stands_2012.
3. In the Point spacing/count settings, enter 80 meters.
4. Check the Use point spacing box to indicate that the value represents the distance between the points.
5. Under Regular points, save the output as systematic_plots.shp in the forestry\sampling\

folder.
6. Check Open output file after running algorithm.
7. Appuyez sur Exécuter.

Note: The suggested Regular points creates the systematic points starting in the upper-left corner of the extent of
the selected polygon layer. If you want to add some randomness to this regular points, you could use a randomly
calculated number between 0 and 80 (80 is the distance between our points), and then write it as the Initial inset from
corner (LH side) parameter in the tool’s dialog.

Vous remarquez que l’outil a utilisé toute l’étendue de votre couche des massifs pour générer une grille rectangulaire
de points. Mais vous êtes seulement intéressé par ces points qui sont actuellement dans la zone forestière (voyez
l’image ci-dessous) :

1. From the Processing toolbox, open GDAL ► Vector geoprocessing ► Clip vector by mask layer.
2. Select systematic_plots as the Input layer.
3. Set forest_stands_2012 as the Mask layer.
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4. Save the Clipped (mask) result as systematic_plots_clip.shp in the forestry\sampling\
folder.

5. Check Open output file after running algorithm.
6. Appuyez sur Exécuter.

Vous avez maintenant les points que les équipes de terrain utiliseront pour naviguer aux endroits de conception
d’échantillon de parcelles. Vous pouvez toujours préparer ces points afin qu’ils soient plus utiles pour le travail de
terrain. Au minimum, vous devrez ajouter des noms significatifs pour les points et les exportez dans un format qui
puisse être utilisé avec leurs appareils GPS.
Let’s start with the naming of the sample plots. If you check the Attribute table for the plots inside the forest area,
you can see that you have the default id field automatically generated by the Regular points tool. Label the points to
see them in the map and consider if you could use those numbers as part of your sample plot naming:

1. Open the Layer Properties ► Labels for the systematic_plots_clip layer.
2. Turn the top menu into Single Labels.
3. For the Value entry, select the field id.
4. Go to the Buffer tab, check the Draw text buffer and set the buffer Size to 1.
5. Cliquez sur OK.

Regardez maintenant les étiquettes sur votre carte. Vous pouvez voir que les points ont été créés et numérotés d’abord
d’Ouest en Est puis de Nord au Sud. Si vous regardez à nouveau la table attributaire, vous remarquerez que l’ordre
dans la table suit aussi ce modèle. À moins que vous n’ayez une raison de nommer les parcelles d’échantillon d’une
autre façon, les nommer de la manière Ouest-Est/Nord-Sud suit un ordre logique et est une bonne option.
Nevertheless, the number values in the id field are not so good. It would be better if the naming would be something
like p_1, p_2.... You can create a new column for the systematic_plots_clip layer:

1. Go to the Attribute table for systematic_plots_clip.

2. Activez le mode édition : .

3. Ouvrez la Calculatrice de champs:
1. Cochez Créer un nouveau champ
2. Entrez Plot_id pour le Nom du champ de sortie

3. Set the Output field type to Text (string).
4. In the Expression field, write, copy or construct this formula concat('P_', @row_number ).

Remember that you can also double click on the elements inside the Function list. The concat function
can be found under String and @row_number is under the Variables group.

4. Cliquez sur OK.
5. Désactivez le mode d’édition et sauvegardez vos modifications.

Now you have a new column with plot names that are meaningful to you. For the systematic_plots_clip
layer, change the field used for labeling to your new Plot_id field.
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14.5.3 ��� Follow Along: Exporting Sample Plots as GPX format

The field teams will be probably using a GPS device to locate the sample plots you planned. The next step is to export
the points you created to a format that your GPS can read. QGIS allows you to save your point and line vector data
in GPS eXchange Format (GPX), which is an standard GPS data format that can be read by most of the specialized
software. You need to be careful with selecting the CRS when you save your data:

1. Right-click systematic_plots_clip layer and select Export ► Save features as….

2. Dans Format, sélectionnez GPS eXchange Format [GPX].
3. Save the output File name as plots_wgs84.gpx in the forestry\sampling\ folder.
4. Dans le SCR, sélectionnez SCR sélectionné.
5. Cherchez EPSG:4326 - WGS 84.

Note: The GPX format accepts only this CRS, if you select a different one, QGIS will give no error but you
will get an empty file.

6. Cliquez sur OK.
7. In the dialog that opens, select only the waypoints layer (the rest of the layers are empty).

The inventory sample plots are now in a standard format that can be managed by most of the GPS software. The field
teams can now upload the locations of the sample plots to their devices. That would be done by using the specific
devices own software and the plots_wgs84.gpx file you just saved. Other option would be to use the GPS Tools
plugin but it would most likely involve setting the tool to work with your specific GPS device. If you are working with
your own data and want to see how the tool works you can find out information about it in the section working_gps
in the QGIS User Manual.
Sauvegardez maintenant votre projet QGIS.
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14.5.4 Conclusion

Vous venez de voir comment vous pouvez facilement créer une conception d’échantillonnage systématique utilisée
dans un inventaire de forêt. La création d’autres types de conceptions d’échantillonnage impliquera l’utilisation de
différents outils dans QGIS, tableurs ou scripts pour calculer les coordonnées des parcelles d’échantillon, mais l’idée
générale reste la même.

14.5.5 La suite ?

Dans la prochaine leçon, vous verrez comment utiliser les capacités de l’Atlas dans QGIS pour générer
automatiquement des cartes détaillées que les équipes de terrain utiliseront pour naviguer dans les parcelles
d’échantillon qui leur sont attribuées.

14.6 Leçon : Création de cartes détaillées avec l’outil Atlas

La conception d’un échantillonnage systématique est prête et les équipes de terrain ont chargé les coordonnées GPS
dans leurs appareils de navigation. Elles ont aussi un formulaire de données de terrain dans lequel elles vont collecter
les informations mesurées sur chaque parcelle d’échantillon. Pour trouver plus facilement leur chemin vers chaque
parcelle d’échantillon, elles auront recours à un certain nombre de cartes détaillées sur lesquelles des informations de
terrain sont clairement visibles avec un petit sous-ensemble de parcelles d’échantillon et des informations sur la zone
de la carte. Vous pouvez utiliser l’outil Atlas pour générer automatiquement un nombre de cartes avec un format
commun.
Objectif de cette leçon : Apprendre à utiliser l’outil Atlas dans QGIS pour générer des cartes détaillées imprimables
pour assister le travail d’inventaire sur le terrain.

14.6.1 ��� Follow Along: Preparing the Print Layout

Avant que nous ne puissions automatiser les cartes détaillées de la zone forestière et de nos parcelles d’échantillon,
nous devons créer un modèle de carte avec tous les éléments que nous considérons comme utiles pour le travail de
terrain. Bien sûr, le plus important sera d’avoir un bon style mais, comme vous l’avez vu plus tôt, vous devrez aussi
ajouter beaucoup d’autres éléments qui complètent la carte imprimée.

1. Ouvrez le projet QGIS de la leçon précédente forest_inventory.qgs. Vous devriez au moins avoir les
couches suivantes :

• forest_stands_2012 (avec une transparence à 50%, un remplissage vert et une bordure verte plus foncée).
• systematic_plots_clip

• rautjarvi_aerial

2. Sauvegardez le projet sous un nouveau nom, map_creation.qgs.
Pour créer une carte imprimable, souvenez-vous que vous utilisez le Gestionnaire de mise en page:

1. Ouvrez Projet ► Gestionnaire de mise en page….
2. Dans la boîte de dialogue Gestionnaire de mise en page:

1. Sous Nouveau depuis un modèle, appuyez sur le bouton Créer… à côté de l’entrée Mise en page vide.
2. Nommez votre mise en page forest_map.
3. Appuyez OK. Une nouvelle mise en page est créée et s’ouvre, affichant une page blanche.

3. Dans la fenêtre de mise en page, assurez-vous que les propriétés sont définies pour du papier A4 :
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1. Faites un clic droit sur le papier et sélectionnez Propriétés de la page. Le panneau Propriétés de la page
s’ouvre sur la droite de la mise en page.

2. Vérifiez que la Taille est A4.
3. Vérifiez que l”Orientation est Paysage.

4. Enable the Layout tab next to the Page properties panel and set Export resolution to 300 dpi.
La composition d’une carte est plus facile si vous utilisez la grille du canvas pour positionner les différents éléments.
Passez en revue les paramètres de la grille de mise en page:

1. In the Layout tab expand the Guides and Grid region.
2. Check that Grid spacing is set to 10 mm and that Snap tolerance is set to 5 px.

Vous avez besoin d’activer l’utilisation de la grille :
1. Ouvrez le menu Vue.
2. Cochez Afficher la grille.
3. Cochez Accrochage à la grille.
4. Notice that options for using Guides are checked by default, which allows you to see guiding lines when you

are moving elements in the layout.
5. Vous pouvez maintenant commencer à ajouter des éléments à votre mise en page. Ajoutez d’abord un élément

de carte afin de pouvoir revoir l’aspect du canevas de la carte, car vous allez apporter des modifications à la
symbologie des couches :

1. Cliquez sur le bouton Ajouter une carte.
2. Cliquez et faites glisser une zone sur le canevas de sorte que la carte occupe la majeure partie de celui-ci.

Notez comment le curseur de la souris s’accroche à la grille du canevas. Utilisez cette fonction lorsque vous ajoutez
d’autres éléments. Si vous voulez avoir plus de précision, changer le paramètre d”Espacement de la grille. Si pour
quelque raison vous ne voulez pas accrocher à la grille à certains points, vous pouvez toujours cocher ou décocher
l’option dans le menu Vue.
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14.6.2 ��� Follow Along: Adding Background Map

Leave the layout open but go back to the map. Let’s add some background data and create some styling so that the
map content is as clear as possible.

1. Ajoutez le fond de plan raster basic_map.tif disponible dans le dossier exercise_data\
forestry\.

2. Lorsque vous y êtes invité, sélectionnez le SCR ETRS89 / ETRS-TM35FIN pour le raster.
Comme vous pouvez voir, la carte de fond a déjà un style. Ce type de raster cartographique prêt à l’emploi est
très courant. Il est créé à partir de données vectorielles, de style dans un format standard et enregistré comme
raster, de sorte que vous ne deviez pas créer plusieurs couches vectorielles et vous soucier d’obtenir un bon
résultat.

3. Zoomez maintenant sur vos parcelles d’échantillon, afin que vous puissiez voir seulement quatre ou cinq lignes
de parcelles.

The current styling of the sample plots is not the best:

While during the last exercises, the white buffer was OK on top of the aerial image, now that the background image
is mostly white you barely can see the labels. But how does it look in the print layout? Let’s check it:

1. Allez dans la fenêtre de mise en page.

2. Utilisez le bouton Sélectionner/Déplacer l’élément pour sélectionner l’élément de la carte dans la mise en page.
3. Rendez-vous à l’onglet Propriétés de l’objet.

4. Cliquez sur Fixer sur l’emprise courante du canevas de carte

5. Si vous devez rafraîchir l’élément, cliquez sur Mise à jour de l’aperçu.
Ce n’est de toute évidence pas suffisamment bon, vous voulez avoir des numéros de parcelle aussi visibles que possible
pour les équipes de terrain.
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14.6.3 ��� Essayez vous-même : Modifier la symbologie des couches

Vous avez travaillé la symbologie dansModule : Création et exploration d’une carte de base et l’étiquetage dansModule
: Classer des données vectorielles. Retournez à ces modules si vous avez besoin de quelques rappels sur certaines
options et les outils disponibles. Votre but est d’obtenir la localisation des parcelles et que leur nom soit visible aussi
clairement que possible, mais permettant toujours de voir les éléments de carte en arrière-plan. Vous pouvez prendre
une certaine direction de cette image :

Vous utiliserez plus tard le style vert de la couche forest_stands_2012. Pour le garder, et pour avoir une
visualisation de ce qui ne montre que les bordures du massif :

1. Faites un clic droit sur forest_stands_2012 et sélectionnez Dupliquer.
2. vous avez une nouvelle couche nommée forest_stands_2012 copy que vous pouvez utiliser pour définir un style

différent, par exemple sans remplissage et des bords rouges.
Vous avez maintenant deux visualisations différentes des massifs de forêt et vous pouvez décider lequel afficher
pour votre carte détaillée.

3. Retournez souvent à la fenêtre de mise en page pour voir à quoi ressemblerait la carte. Pour la création de cartes
détaillées, vous recherchez une symbologie qui soit belle non pas à l’échelle de toute la zone forestière (image
de gauche ci-dessous) mais à une échelle plus proche (image de droite ci-dessous). N’oubliez pas d’utiliser
Mettre à jour l’aperçu et Fixer sur l’emprise courante du canevas de carte chaque fois que vous modifiez le zoom de votre carte
ou la mise en page.
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14.6.4 ��� Essayez vous-même : Créer un modèle basique de carte

1. Une fois que vous avez une symbologie satisfaisante, vous êtes prêt à ajouter plus d’informations à votre carte
imprimée. Ajoutez au moins les éléments suivants :

• Titre.
• Une barre d’échelle
• Cadre de la grille de votre carte.
• Coordonnées au niveau des côtés de la grille.

2. Vous avez déjà créé une mise en page similaire dans Module : Mise en page des cartes. Revenez à ce module
autant que vous en avez besoin. Vous pouvez regarder cet exemple d’image à titre de référence :

3. Exportez votre carte en tant qu’image et observez-la.
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1. Layout ► Export as Image….
2. Utilisez par exemple le Format JPG.

C’est ce à quoi elle doit ressembler lorsqu’elle est imprimée.

14.6.5 ��� Follow Along: Adding More Elements to the Print Layout

Comme vous l’avez probablement remarqué dans les images du modèle de carte suggéré, il y a beaucoup de place sur
le côté droit du canevas. Voyons ce qu’il pourrait encore aller là-bas. Pour les fins de notre carte, une légende n’est
pas vraiment nécessaire, mais un aperçu de la carte et des zones de textes pourraient être ajoutés à la carte.
L’aperçu de la carte aidera les équipes de terrain à placer la carte détaillée dans la zone forestière générale :

1. Ajoutez un autre élément de carte au canevas, juste sous le texte du titre.
2. Dans l’onglet Propriétés de l’objet, ouvrez le menu déroulant Aperçu.
3. Mettez leCadre d’aperçu àCarte 0. Cela crée un rectangle d’ombre sur la plus petite carte représentant l’étendue

visible dans la plus grande carte.
4. Vérifiez également l’option Cadre avec une couleur noire et une Épaisseur de 0.30.

Remarquez que votre carte générale ne donne pas vraiment une vue d’ensemble de la zone forestière, ce qui est ce que
vous voulez. Vous voulez que cette carte représente la totalité de la zone forestière et vous voulez qu’elle ne montre
que la carte de fond et la couche forest_stands_2012, et non les placettes d’échantillonnage. Et vous voulez
aussi verrouiller sa vue pour qu’elle ne change plus chaque fois que vous modifiez la visibilité ou l’ordre des couches.

1. Retournez à la carte, mais ne fermez pas le composeur impression.
2. Faites un clic-droit sur la couche forest_stands_2012 et cliquez sur Zoomer sur l’emprise de la couche.
3. Désactivez toutes les couches exceptées basic_map et forest_stands_2012.
4. Expand the Manage map themes tool on the Layers panel and select Add theme.
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5. Nommez-le basic_overview.
6. Retournez à la mise en page.
7. With the small map selected, click the Set map extent to match main canvas extent to set its extents to what you

can see in the map window.
8. Lock the view for the overview map by checking Follow map theme and selecting basic_overview under

Main properties.
Now your overview map is more what you expected and its view will not change anymore. But, of course, now your
detail map is not showing anymore the stand borders nor the sample plots. Let’s fix that:

1. Go to the map window again and select the layers you want to be visible (systematic_plots_clip,
forest_stands_2012 copy and Basic_map).

2. Zoomez à nouveau pour avoir seulement quelques lignes de parcelles d’échantillon visibles.
3. Retournez à la fenêtre composeur impression.
4. Sélectionnez la carte la plus grande dans votre mise en page.
5. In Item properties click on Update preview and Set map extent to match main canvas extent.

Notez que seule la grande carte affiche la vue actuelle de la carte, et le petit aperçu conserve la même vue que vous
aviez lorsque vous l’avez verrouillé.
Notez également que l’aperçu montre un cadre ombragé pour le contenu affiché dans la carte détaillée.

Votre modèle de carte est presque prêt. Ajoutez maintenant deux zones de textes en-dessous de la carte, une contenant
le texte “Zone de la carte détaillée : “ et l’autre “Remarques : “. Placez-les comme vous pouvez le voir dans l’image
ci-dessous.
Vous pouvez également ajouter une flèche nord à la carte générale :
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1. Sélectionnez l’outil Ajouter une flèche du Nord.
2. Click and drag a rectangle at the upper right corner of the overview map.
3. In Item properties Check SVG image

4. Parcourez Explorateur SVG ► Groupes SVG pour sélectionner une image de flèche.
5. Sous Rotation de l’image, cochez Synchroniser avec la carte et sélectionnez Map 1 (la carte d’aperçu).
6. Redimensionnez l’image de la flèche en une taille qui semble bien avec la petite carte.

La mise en page de base de la carte est prête, maintenant vous voulez utiliser l’outil Atlas pour générer autant de
cartes détaillées dans ce format que vous le jugez nécessaire.

14.6.6 ��� Follow Along: Creating an Atlas Coverage

La couverture d’Atlas est juste une couche vectorielle qui sera utilisée pour générer des cartes détaillées; une carte
pour chaque entité dans la couverture. Pour avoir une idée de ce que vous ferez par la suite, voici un ensemble entier
de cartes détaillées pour la zone forestière :

La couverture pourrait être n’importe quelle couche existante, mais il est en général plus logique d’en créer une dans
ce but spécifique. Créons une grille de polygones couvrant la zone forestière :

1. Dans l’interface principale de QGIS, ouvrez Vecteur ► Outils de recherche Créer grille.
2. Configurez l’outil comme montrée dans cette image :
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3. Sauvegardez la sortie sous atlas_coverage.shp.
4. Style the new atlas_coverage layer so that the polygons have no filling.

Les nouveaux polygones recouvrent l’étendue de la forêt et ils vous donnent une idée du contenu de chaque carte
(créée à partir de chaque polygone).
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14.6.7 ��� Follow Along: Setting Up the Atlas Tool

La dernière étape est la configuration de l’outil Atlas :
1. Retournez à la mise en page.
2. Dans le panneau sur la droite, rendez-vous à l’onglet Génération d’Atlas.
3. Mettez les options comme suit :
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Cela indique à l’outil Atlas d’utiliser les caractéristiques (polygones) à l’intérieur de atlas_coverage
comme point central pour chaque carte détaillée. Il produira une carte pour chaque élément de la couche.
Le Couche de couverture cachée indique à l’Atlas de ne pas afficher les polygones dans les cartes de sortie.

Une chose doit encore être faite. Vous devez dire à l’outil Atlas quel élément de carte doit être mis à jour pour chaque
carte de sortie. À présent, vous pouvez probablement deviner que la carte qui doit changer pour chaque entité est
celle que vous avez préparé pour contenir les vues détaillées des parcelles d’échantillon, qui est la plus grande carte
dans votre canevas :

1. Sélectionnez la plus grande carte (Carte 0).
2. Rendez-vous à l’onglet Propriétés de l’objet.
3. Dans la liste, cochez Contrôlé par l’atlas.
4. And set the Marging around feature to 10%. The view extent will be 10% bigger than the polygons, which

means that your detail maps will have a 10% overlap.
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Vous pouvez maintenant utiliser l’outil de prévisualisation pour les cartes d’Atlas pour voir à quoi vos cartes
ressembleront :

1. Activez les prévisualisations de l’Atlas en utilisant le bouton ou si votre barre d’outil Atlas n’est pas visible,
via Atlas ► Aperçu de l’Atlas.

2. Vous pouvez utiliser les flèches dans la barre d’outils Atlas ou dans le menu Atlas pour se déplacer à travers les
cartes qui seront créées.

Note that some of them cover areas that are not interesting. Let’s do something about it and save some trees by not
printing those useless maps.

14.6.8 ��� Follow Along: Editing the Coverage Layer

Outre la suppression des polygones pour ces zones qui ne sont pas intéressantes, vous pouvez aussi personnaliser les
étiquettes de texte dans votre carte à générer avec le contenu de la Table attributaire de votre couche de couverture :

1. Retournez à l’affichage de la carte.
2. Activez l’édition pour la couche atlas_coverage.
3. Sélectionnez les polygones qui sont sélectionnés (en jaune) dans l’image ci-dessous.
4. Retirez les polygones sélectionnés.
5. Désactivez l’édition et sauvegardez les modifications.
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Vous pouvez retourner à la mise en page et vérifier que les aperçus de l’Atlas utilisent uniquement les polygones que
vous avez laissés dans la couche.
La couche de couverture que vous utilisez ne dispose pas encore d’informations utiles que vous pouvez utiliser pour
personnaliser le contenu des étiquettes de votre carte. La première étape est de les créer, vous pouvez ajouter par
exemple un code de zone pour les aires de polygones et un champ avec quelques remarques pour les équipes de terrain
à prendre en compte.

1. Ouvrez la Table attributaire de la couche atlas_coverage.
2. Activez l’édition.

3. Utilisez la calculatrice pour créer et compléter les deux champs suivants.
4. Créez un champ nommé Zone et de type Nombre entier (entier).
5. In the Expression box write/copy/construct @row_number.
6. Créez un autre champ nommé Remarks, de type Texte (chaîne de caractères) et d’une largeur de 255.
7. Dans la fenêtre Expression écrivez 'Pas de remarque.'. Cela va mettre cette valeur par défaut pour

tous les polygones.
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The forest manager will have some information about the area that might be useful when visiting the area. For
example, the existence of a bridge, a swamp or the location of a protected species. The atlas_coverage layer is
probably in edit mode still, add the following text in the Remarks field to the corresponding polygons (double click
the cell to edit it):

• For the Zone 2: Bridge to the North of plot 19. Siberian squirrel between p_13
and p_14.

• For the Zone 6: Difficult to transit in swamp to the North of the lake.`
• For the Zone 7: Siberian squirrel to the South East of p_94.

• Désactivez l’édition et sauvegardez vos modifications.
Almost ready, now you have to tell the Atlas tool that you want some of the text labels to use the information from
the atlas_coverage layer’s attribute table.

1. Retournez à la page composeur impression.
2. Select the text label containing Detailed map....
3. Mettez la taille de Police à 12.
4. Mettez le curseur à la fin du texte dans l’étiquette.
5. Dans l’onglet Propriétés de l’élément, à l’intérieur de Propriétés principales, cliquez sur Ajouter ou modifier une

expression ….
6. In the Function list double-click on the field Zone under Field and Values.
7. Cliquez sur OK.
8. The text inside the box in the Item properties should showDetail map inventory zone: [% "Zone"

%]. Note that the [% "Zone" %] will be substituted by the value of the field Zone for the corresponding
feature from the layer atlas_coverage.

9. Testez les contenus des étiquettes en regardant les différents aperçus des cartes de l’Atlas.
10. Do the same for the labels with the text Remarks: using the field with the zone information. You can leave a

break line before you enter the expression. You can see the result for the preview of zone 2 in the image below:
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11. Utilisez l’aperçu de l’Atlas pour naviguer à travers toutes les cartes que vous créerez bientôt et appréciez !

14.6.9 ��� Follow Along: Printing the Maps

Enfin et surtout, imprimer ou exporter vos carte en fichiers image ou PDF. Vous pouvez utiliser Atlas ► Exporter
l’Atlas en tant qu’image… ou Atlas ► Exporter l’Atlas au format PDF…. Actuellement, le format d’exportation SVG
ne fonctionne pas correctement et donnera un mauvais résultat.
Imprimons les cartes dans un seul PDF que vous pouvez envoyer au bureau des équipes de terrain pour impression :

1. Rendez-vous à l’onglet Génération d’Atlas sur le panneau de droite.
2. Sous la Sortie, cochez Export d’un seul fichier, si possible. Cela mettra toutes les cartes ensemble dans un fichier

PDF, si cette option n’est pas cochée, vous aurez un fichier pour chaque carte.
3. Ouvrez Layout ► Export as PDF….
4. Save the PDF file as inventory_2012_maps.pdf in your exercise_data\forestry\

samplig\map_creation\ folder.
5. Ouvrez le fichier PDF pour vérifier que tout est conforme à ce à que vous vous attendiez.
6. Vous pourriez tout aussi facilement créer des images séparées pour chaque carte (souvenez-vous de décochez

la création de fichier unique), ici vous pouvez voir les miniatures des images qui seront créées.
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7. In the Print Layout, press Save in order to save your print layout changes in the project. This also saves the
project file. You can reopen the project at any time and run or edit the atlas.
It is also possible to save your map as a layout template as forestry_atlas.qpt in your
exercise_data\forestry\map_creation\ folder. Use Layout ► Save as Template. You will be
able to use this template again and again in other projects.

8. Close the Print Layout and the project.

14.6.10 Conclusion

Vous avez réussi à créer unmodèle de carte qui peut être utilisé pour générer automatiquement des cartes détaillées qui
seront utilisées sur le terrain comme aide à la navigation vers les différentes parcelles. Comme vous l’avez remarqué,
ce n’était pas une tâche facile, mais le bénéfice viendra lorsque vous aurez besoin de créer des cartes similaires pour
d’autres régions et vous pourrez utiliser le modèle que vous venez de sauvegarder.

14.6.11 La suite ?

Dans la prochaine leçon, vous verrez comment vous pouvez utiliser des données LiDAR pour créer unMNE et ensuite
l’utiliser pour améliorer vos données et la visibilité de vos cartes.

14.7 Leçon : Calcul des paramètres forestiers

L’estimation des paramètres de la forêt est le but de l’inventaire de la forêt. En continuant l’exemple de la leçon
précédente, vous utiliserez les informations d’inventaire récoltées sur le terrain pour calculer les paramètres forestiers,
d’abord pour l’entier de la forêt, et ensuite pour les parcelles que vous avez précédemment numérisées.
Objectif de cette leçon : Calculer des paramètres forestiers à un niveau général et à un niveau de massif forestier.
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14.7.1 ��� Pas à pas : Ajouter les résultats d’inventaire

Les équipes de terrain ont visité la forêt et, avec l’aide des informations fournies, récolté des informations sur la forêt
à chaque parcelle d’échantillon.
Le plus souvent, les informations sont recueillies sur le terrain au moyen de formulaires papier, puis saisies dans
un tableur. Les informations des parcelles d’échantillonnage ont été condensées dans un fichier .csv qui peut être
facilement ouvert dans le QGIS.
Continuez avec le projet QGIS de la leçon sur la conception de l’inventaire, vous l’avez probablement nommé
forest_inventory.qgs.
Premièrement, ajoutez les mesures des parcelles d’échantillon à votre projet QGIS :

1. Rendez-vous à Couche ► Ajouter une couche ► Ajouter une couche de texte délimité….
2. Naviguez vers le fichier systematic_inventory_results.csv situé dans exercise_data/

forestry/results/.
3. Soyez sûr que l’option Coordonnées de point est cochée.
4. Définissez les champs pour les coordonnées sur les champs X et Y.
5. Cliquez sur OK.
6. Lorsque vous y êtes invité, sélectionnez ETRS89 / ETRS-TM35FIN comme CRS.
7. Ouvrez la Table attributaire de la nouvelle couche et regardez les données.

Vous pouvez lire le type de données qui sont contenues dans les mesures des placettes d’échantillonnage dans le
fichier texte legend_2012_inventorydata.txt situé dans le dossier exercise_data/forestry/
results/.
La couche systematic_inventory_results que vous venez d’ajouter n’est en fait qu’une représentation
virtuelle des informations textuelles contenues dans le fichier .csv. Avant de continuer, convertissez les résultats de
l’inventaire en un véritable ensemble de données spatiales :

1. Faites un clic droit sur la couche systematic_inventory_results.
2. Naviguez vers le dossier exercise_data/forestry/results/.
3. Nommez le fichier sample_plots_results.shp.
4. Cochez Ajouter les fichiers sauvegardés à la carte.
5. Supprimez la couche systematic_inventory_results de votre projet.

14.7.2 ��� Follow Along: Whole Forest Parameters Estimation

Vous pouvez calculer les moyennes pour toute cette zone forestière à partir des résultats de l’inventaire pour certains
paramètres intéressants, comme le volume et le nombre de tiges par hectare. Comme les placettes d’échantillonnage
systématiques représentent des superficies égales, vous pouvez calculer directement les moyennes des volumes et du
nombre de tiges par hectare à partir de la couche sample_plots_results.
Vous pouvez calculer la moyenne d’un champ dans une couche vectorielle en utilisant l’outil Statistiques basiques :

1. Ouvrez Vecteur ► outil d’analyse ► statistiques de base de champs.
2. Sélectionnez sample_plots_results comme couche source`.
3. Sélectionnez « Vol » comme champ cible.
4. Cliquez sur OK.

Le volume moyen dans la forêt est de 135,2 m3/ha.
Vous pouvez calculer la moyenne pour le nombre de tiges de la même manière, « 2 745 tiges/ha ».
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14.7.3 ��� Follow Along: Estimating Stand Parameters

Vous pouvez faire usage de ces mêmes parcelles d’échantillon systématiques pour calculer des estimations pour les
différentes parcelles de forêt que vous avez numérisées précédemment. Certains des massifs forestiers n’ont pas
reçu de parcelles d’échantillon et pour ceux-ci, vous ne recevrez pas d’information. Vous pourriez avoir planifié des
parcelles d’échantillon supplémentaires lorsque vous avez panifié l’inventaire systématique, de sorte que les équipes
de terrain auront mesuré quelques parcelles d’échantillon supplémentaires à cette fin. Ou vous pourriez envoyer une
équipe de terrain plus tard pour obtenir des estimations des massifs de forêt manquants pour compléter l’inventaire du
massif. Néanmoins, vous obtiendrez des informations pour un bon nombre de massifs juste en utilisant les parcelles
planifiées.
Ce dont vous avez besoin est d’obtenir les moyennes des parcelles d’échantillon qui tombent dans chacun des massifs
de forêt. Si vous souhaitez combiner de l’information basée sur leurs emplacements relatifs, vous effectuez une
jointure spatiale :

1. Ouvrez l’outil Vecteur ► Outils de gestion de données ► Joindre les attributs par localisation….
2. Définissez forest_stands_2012 comme la Couche vectorielle cible`. La couche pour laquelle vous voulez

les résultats.
3. Définissez sample_plots_results comme étant la couche de vecteurs de jointure. La couche à partir

de laquelle vous voulez calculer les estimations.
4. Cochez Prendre un résumé des entités intersectées.
5. Vérifiez que vous ne calculez que la Moyenne.
6. Nommez le résultat comme forest_stands_2012_results.shp et enregistrez-le dans le dossier

exercise_data/forestry/results/.
7. Finalement, sélectionnez Conservez tous les enregistrements…, afin que vous puissiez vérifier plus tard quels

massifs n’a pas reçu d’information.
8. Cliquez sur OK.
9. Accepter d’ajouter la nouvelle couche à votre projet quand demandé.
10. Fermez l’outil Joindre les attributs par localisation.

Ouvrez la table d’attributs table attribut pour forest_stands_2012_results et examinez les résultats que vous avez
obtenus. Notez qu’un certain nombre de peuplements forestiers ont « NULL » comme valeur pour les calculs, ce
sont ceux qui n’ont pas de placettes échantillons. Sélectionnez-les tous et visualisez-les sur la carte, ce sont certains
des plus petits peuplements :
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Calculons maintenant les mêmes moyennes pour l’ensemble de la forêt qu’auparavant, mais cette fois, vous utiliserez
les moyennes obtenues pour les peuplements comme base de calcul. Rappelez-vous que dans la situation précédente,
chaque placette d’échantillonnage représentait un peuplement théorique de 80 x 80 m. Vous devez maintenant
considérer la superficie de chacun des peuplements individuellement. De cette façon, les valeurs moyennes des
paramètres qui sont, par exemple, en m3/ha pour les volumes sont converties en volumes totaux pour les peuplements.
Vous devez d’abord calculer les aires pour les massifs et ensuite calculez les volumes totaux et les nombres de troncs
pour chacun d’entre eux :

1. Dans la Table d’attributs, activez l’édition.
2. Ouvrez la Calculatrice de champ.
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3. Créez un nouveau champ appelé « zone ».
4. Définissez le type de champ de sortie à Nombre décimal (réel).
5. Réglez Précision` à 2.
6. Dans Expression, écrivez $area/10000. Cela permettra de calculer la superficie des peuplements forestiers

en ha.
7. Cliquez sur OK.

Maintenant calculez un champ avec les volumes totaux et les nombres de troncs estimés pour chaque massif :
1. Nommez les champs s_vol et s_stem.
2. Les champs peuvent être des nombres entiers ou vous pouvez aussi utiliser des nombres décimaux.
3. Utilisez les expressions « zone » * « MEANVol » et « zone » * « MEANStems » respectivement pour les

volumes totaux et les tiges totales.
4. Sauvegardez les modifications lorsque vous avez fini.
5. Désactivez l’édition.

Dans la situation précédente, les aires représentées par chaque parcelles d’échantillon étaient les mêmes, ainsi il
était suffisant de calculer la moyenne des parcelles d’échantillon. Maintenant, pour calculer les estimations, vous
devez divisez la somme des volumes de massifs ou nombre de troncs par la somme des aires des massifs contenant
l’information.

1. Dans la table attributaire pour la couche forest_stands_2012_results, sélectionnez tous les stands
contenant des informations.

2. Ouvrez Vecteur ► outils analyse ► statistiques de base pour les champs.
3. Sélectionnez le fichier forest_stands_2012_results comme Couche d’entrée.
4. Sélectionnez « zone » comme Field to calculate statistics on.
5. Cochez la case Selected features only.
6. Cliquez sur OK.
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Comme vous pouvez le voir, la somme totale des superficies des peuplements est de 66,04 ha. Notez que la superficie
des peuplements forestiers manquants n’est que de « 7 ha » environ.
De même, vous pouvez calculer que le volume total de ces peuplements est de « 8908 m3/ha » et que le nombre total
de tiges est de « 179594 tiges ».
L’utilisation d’information provenant des massifs de forêt, plutôt que celle provenant directement des parcelles
d’échantillon, donne les estimations suivantes de moyenne :

• « 184.9 m3/ha » et
• 2719 stems/ha.

Enregistrez votre projet QGIS, forest_inventory.qgs.

14.7.4 Conclusion

Vous avez réussi à calculer des estimations de forêt pour l’ensemble de la forêt en utilisant l’information de vos
parcelles d’échantillonnage systématique, premièrement sans considérer les caractéristiques forestières et aussi en
utilisant l’interprétation de l’image aérienne des massifs de forêt. Et vous avez également obtenu de l’information
précieuse sur les massifs particuliers, qui pourrait être utilisée pour planifier la gestion de la forêt dans les années à
venir.
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14.7.5 La suite ?

Dans la leçon suivante, vous allez d’abord créer un fond ombragé depuis un jeu de données LiDAR que vous utiliserez
pour préparer une carte de présentation avec les résultats de la forêt que vous venez de calculer.

14.8 Leçon : MNE à partir de données LiDAR

Vous pouvez améliorer l’allure de vos cartes en utilisant différentes images de fond. Vous pourriez utiliser la carte
de base ou l’image aérienne que vous avez utilisées avant, mais un raster d’ombrage du terrain sera plus joli dans
certaines situations.
Vous utiliserez LAStools pour extraire un MNE depuis un jeu de données LiDAR et ensuite créerez un raster
d’ombrage pour l’utiliser dans votre carte de présentation plus tard.
Objectif de cette leçon : Installer LAStools et calculer un MNE depuis des données LiDAR et un raster d’ombrage.

14.8.1 ��� Pas à pas : Installer Lastools

Managing LiDAR data within QGIS is possible using the Processing framework and the algorithms provided by
LAStools.
Vous pouvez obtenir un modèle numérique d’élévation (MNE) à partir d’un nuage de points LiDAR et ensuite créer
un raster d’ombrage qui est visuellement plus intuitif à des fins de présentation. Premièrement, vous devrez configurez
les paramètres du Traitements pour fonctionner correctement avec LAStools :

• Fermez QGIS, si vous l’aviez déjà démarré.
• Une ancienne extension lidar devrait être installée par défaut sur votre système dans le dossier C:/Program
Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Si vous avez un dossier nommé lidar, supprimez-le. Ceci est valable pour les installations de QGIS 2.2 et
2.4.
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• Allez dans le dossier exercise_data\forestry\lidar\, vous y trouverez le fichier
QGIS_2_2_toolbox.zip. Ouvrez-le et extrayez le dossier lidar pour remplacer celui que vous
venez de supprimer.

• Si vous utilisez une autre version de QGIS, vous pouvez consulter d’autres instructions d’installation dans ce
tutoriel.

Vous devez maintenant installer LAStools sur votre ordinateur. Procurez-vous la dernière version de lastools ici et
extrayez le contenu du fichier lastools.zip dans un dossier de votre système, par exemple, C:\lastools\.
Le chemin d’accès au dossier lastools ne peut pas comporter d’espaces ni de caractères spéciaux.

Note: Lisez le fichier LICENSE.txt dans le dossier lastools. Certains des LAStools sont open-source
et d’autres sont à code source fermé et nécessitent une licence pour la plupart des utilisations commerciales et
gouvernementales. À des fins d’éducation et d’évaluation, vous pouvez utiliser et tester autant de LAStools que vous
en avez besoin.

L’extension et les algorithmes actuels sont maintenant installés sur votre ordinateur et bien que prêt à être utilisés,
vous devez juste configurez le Module de Traitements pour commencer à les utiliser :

• Ouvrez un nouveau projet dans QGIS.
• Mettez le SCR du projet en ETRS89 / ETRS-TM35FIN.
• Sauvegardez le projet sous forest_lidar.qgs.

To setup the LAStools in QGIS:
• Rendez-vous à Traitements ► Options et configuration.
• Dans la boîte de dialogue Options de traitements, rendez-vous à Prestataires et ensuite à Outils pour données
LiDAR.
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• Cochez Activer.
• Pour le dossier LAStools, mettez c:\lastools\ (ou le dossier que vous avez extrait de LAStools).

14.8.2 ��� Pas à pas : Calculer un MNT avec LAStools

Vous avez déjà utilisé la boîte à outils Traitements dans Leçon : Statistiques Spatiales pour faire tourner des algorithmes
SAGA. Vous allez maintenant l’utiliser pour faire tourner des programmes LAStools :

• Ouvrez Traitement ► Boîte à outils.
• En haut dans le menu déroulant, sélectionnez Interface avancée.
• Vous devriez voir la catégorie Outils pour données LiDAR.
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• Déroulez-le pour voir les outils disponibles, et déroulez aussi la catégorie LAStools (le nombre des algorithmes
peut varier).

• Faites défiler jusqu’à ce que vous trouviez l’algorithme lasview, double-cliquez dessus pour l’ouvrir.
• Sur Input LAS/LAZ file, naviguez vers exercise_data\forestry\lidar\ et sélectionnez le fichier
rautjarvi_lidar.laz.

• Cliquez sur Exécuter.
Vous pouvez maintenant visualiser les données LiDAR dans la fenêtre de dialogue Visualisateur LAS et LAZ:
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De nombreuses choses peuvent être faîtes dans ce visualiseur mais pour le moment, vous pouvez cliquer et vous
déplacer sur le nuage de points LiDAR pour voir à quoi il ressemble.

Note: Si vous voulez en savoir plus sur le fonctionnement de LAStools, vous pouvez lire les fichiers texte README
sur chacun des outils, dans le dossier C:lastools\bin\. Des tutoriels et d’autres documents sont disponibles sur
la page web Rapidlasso.

• Fermez le visualiseur lorsque vous avez fini.
La création d’un MNE avec LAStools peut être faite en deux étapes, premièrement en classant le nuage de points en
points de contrôle et pas de contrôle et ensuite en calculant un MNE en utilisant seulement les points
de contrôle.

• Retournez vers la Boîte à outils de traitements.
• Remarquez la boîte Recherche…, écrivez lasground.
• Double-cliquez pour ouvrir l’outil lasground et configurez-le comme montré dans cette image :
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• Le fichier de sortie est enregistré dans le même dossier où se trouve le fichier rautjarvi_lidar.laz et
il est nommé rautjarvi_lidar_1.las.

Vous pouvez l’ouvrir avec lasview si vous voulez le contrôler.
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The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to
visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the
points again. Check the lasview_README.txt file for more commands. If you are interested, also this tutorial
about editing LiDAR points manually will show you different operations within the viewer.

• Fermez à nouveau le visualiseur.
• Dans la Boîte à outils de traitements, cherchez las2dem.
• Ouvrez l’outil las2dem et configurez-le comme montré dans cette image :
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Le résultat MNE est ajouté à votre carte avec le nom générique Fichier raster de sortie.

Note: Les outils lasground et las2dem nécessitent une licence. Vous pouvez utiliser l’outil sans licence, comme
indiqué dans le fichier de licence, mais vous obtiendrez les diagonales que vous pouvez observer dans l’image des
résultats.

14.8.3 ��� Pas à pas : Créer un ombrage de terrain

À des fins de visualisation, une ombre portée générée à partir d’un MNE donne une meilleure
visualisation du terrain :

• Ouvrez Raster ► Analyse de terrain ► Ombrage.
• Comme le Output layer, naviguez vers exercise_data\forestry\lidar\ et nommez le fichier
hillshade.tif.

• Laissez la configuration par défaut pour le reste des paramètres.
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• Sélectionnez ETRS89 / ETRS-TM35FIN comme SCR quand demandé.
Malgré les lignes diagonales qui restent dans le résultat raster d’ombrage, vous pouvez voir clairement un relief précis
de la zone. Vous pouvez même voir les différentes canalisations du sol qui ont été creusées dans les forêts.
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14.8.4 Conclusion

L’utilisation des données LiDAR pour obtenir un MNE, en particulier dans les zones forestières, donne de bons
résultats avec peu d’efforts. Vous pouvez également utiliser des MNE dérivés du LiDAR ou d’autres sources comme
les MNE à résolution 9m de SRTM. Dans tous les cas, vous pouvez les utiliser pour créer une trame d’ombres de
collines à utiliser dans vos présentations cartographiques.
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14.8.5 La suite ?

Dans la prochaine leçon, et dernière étape de ce module, vous utiliserez le raster d’ombrage et les résultats de
l’inventaire forestier pour créer une carte de présentation des résultats.

14.9 Leçon : Présentation d’une carte

Dans la leçon précédente, vous avez importé un ancien inventaire forestier comme projet SIG, l’avez mis à jour avec
la situation actuelle, conçu un inventaire forestier, créé des cartes pour l’équipe de terrain et calculé des paramètres
forestiers à partir des mesures de terrain.
Il est souvent important de créer des cartes avec les résultats d’un projet SIG. Une carte présentant les résultats de
l’inventaire de forêt sera plus facilement créée si l’auteur a une bonne idée de ce que les résultats représentent en jetant
un rapide coup d’oeil, sans devoir regarder les chiffres précis.
Objectif de cette leçon : Créer une carte présentant les résultats de l’inventaire en utilisant un raster d’ombrage
comme fond.

14.9.1 ��� Pas à pas : Préparer les données de la carte

Ouvrez le projet QGIS de la leçon sur les paramètres de calcul, forest_inventory.qgs. Gardez au moins les
couches suivantes :

• forest_stands_2012_results.
• basic_map.
• rautjarvi_aerial.
• lakes (si vous ne l’avez pas, ajoutez-la depuis le dossier exercise_data\forestry\).

Vous allez présenter les volumes moyens de vos peuplements forestiers sur une carte. Si vous ouvrez la table attributs
pour la couche forest_stands_2012_results, vous pouvez voir les valeurs NULL des peuplements sans
information. Pour pouvoir intégrer ces peuplements dans votre symbologie, vous devez changer les valeurs NULL en,
par exemple, -999, sachant que ces nombres négatifs signifient qu’il n’y a pas de données pour ces polygones.
Pour la couche forest_stands_2012_results :

• Ouvrez la Table attributaire et activez l’édition.
• Sélectionnez les polygones avec les valeurs NULL.
• Utilisez la calculatrice pour mettre à jour les valeurs du champ MEANVol à -999 seulement pour les entités
sélectionnées.

• Désactivez l’édition et sauvegardez les modifications.
Vous pouvez maintenant utiliser un style sauvegardé pour cette couche :

• Aller à l’onglet Symbologie.
• Cliquez sur Style ► Load Style….
• Sélectionnez forest_stands_2012_results.qml depuis le dossier exercise_data\
forestry\results\.

• Cliquez sur OK.
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Votre carte ressemblera à quelque chose comme ça :
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14.9.2 ��� Essayez vous-même : Essayer différents modes de fusion

Le style que vous avez chargé :

472 Chapter 14. Module : Application forestière



QGIS Training Manual

utilise Lumière forte comme mode de Fusion de couche. Notez que les différents modes appliquent des filtres
différents combinant les couches sous-jacentes et superposées, dans ce cas le raster d’ombrage et vos peuplements
forestiers sont utilisés. Vous pouvez lire des informations sur ces modes dans le Guide Utilisateurs.
Essayez avec différents modes et voyez les différences dans votre carte. Puis choisissez celui que vous préférez pour
votre carte finale.

14.9.3 ��� Essayez vous-même : Créer une carte à l’aide d’un modèle de mise
en page

Utilisez un modèle préparé à l’avance pour présenter les résultats. Le modèle forest_map.qpt est situé dans
le dossier exercise_data\forestry\results. Chargez-le en utilisant le dialogue
:menuselection:`Project --> Layout Manager....
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Ouvrez la mise en page d’impression et modifiez la carte finale pour obtenir un résultat qui vous satisfasse.
Le modèle de carte que vous utilisez vous donnera une carte similaire à celle-là :
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Sauvegardez votre projet QGIS pour des références futures.
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14.9.4 Conclusion

Dans ce module, vous avez vu comment un inventaire forestier de base peut être planifié et présenté avec QGIS.
Beaucoup d’autres analyses forestières sont possibles avec la variété d’outils auxquels vous avez accès, mais nous
espérons que ce manuel vous a donné un bon point de départ pour explorer la façon dont vous pouvez obtenir les
résultats que vous voulez.
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Module : Concepts de bases de données avec PostgreSQL

Les bases de données relationnelles sont une part importante de tout système d’information géographique. Dans
ce module, vous aborderez les concepts de Système de Gestion de Bases de Données Relationnelles (SGBDR) et
utiliserez PostgreSQL pour créer une nouvelle base de données afin de stocker de la donnée mais aussi d’apprendre
les fonctions spécifiques du SGBDR.

15.1 Leçon : Introduction aux bases de données

Avant d’utiliser PostgreSQL, assurons-nous de consolider nos fondations en abordant la théorie générale de bases de
données. Vous n’aurez besoin d’entrer aucun des codes en exemple; ils ne servent qu’à des fins d’illustration.
Objectif de cette leçon: Comprendre les concepts fondamentaux des Bases de Données

15.1.1 Qu’est-ce qu’une Base de Données?

Une base de données consiste en un ensemble organisé de données destinées à une ou plusieurs utilisations,
généralement sous format numérique. - Wikipedia
Un Système de Gestion de Base de Données (SGBD) se compose d’un logiciel qui exploite des bases de données,
gère le stockage, l’accès, la sécurité, la sauvegarde/restauration et autres fonctionnalités. - Wikipedia

15.1.2 Tables

Dans les bases de données relationnelles et à plat, une table est un jeu de données (valeurs) qui est organisé en utilisant
un modèle de colonnes verticales (qui sont identifiées par leur nom) et de lignes horizontales. Une table contient un
nombre spécifique de colonnes mais elle peut avoir autant de lignes qu’il faut. Chaque ligne est identifiée par des
valeurs qui apparaissent dans un colonne particulière qui est identifiée comme une clef. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)
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Dans une base de données SQL, une table est aussi appelée relation.

15.1.3 Colonnes / Champs

Une colonne est un jeu de valeur d’un type particulier, pour une valeur par ligne. Les colonnes fournissent la structure
qui permet de composer les lignes. Le terme champ est souvent utilisé pour nommer la colonne même si certains
considère qu’il est plus correct d’employer le mot champ (ou valeur de champ) pour se référer à un élément spécifique
qui est présent à l’intersection entre une ligne et une colonne. - Wikipedia
Une colonne :

| name |
+-------+
| Tim |
| Horst |

Un champ :

| Horst |

15.1.4 Enregistrements

Un enregistrement est une information stockée dans une ligne d’une table. Chaque enregistrement aura un champ
pour chacune des colonnes de la table.

2 | Horst | 88 <-- one record

15.1.5 Types de Données

Les Types de données restreignent le genre d’informations pouvant être stockées dans une colonne. - Tim and Horst

Il existe différents type de données. Voyons les plus fréquents:
• “String” - pour stocker des données de texte libre
• “Integer” - pour stocker des nombres entiers
• “Real” - pour stocker les nombres décimaux
• Date - pour stocker l’anniversaire de Horst afin que personne n’oublie
• “Booléen” - pour stocker des valeurs vrai/faux

Dans une base de données, vous pouvez autoriser de ne rien stocker dans un champ. S’il n’y a rien dans un champ,
alors le contenu de ce champ est référencé comme une valeur “null”:

insert into person (age) values (40);

select * from person;

Résultat:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Beaucoup d’autres types de donnée peuvent être utilisés, référez-vous au manuel de PostgreSQL !
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15.1.6 Modéliser une base de données adresse

Etudions un cas simple pour voir comment est construite une base de données. Nous allons créer une base de données
adresse.

��� Try Yourself:

Ecrivez les propriétés qui composent une adresse et que vous voulez stocker dans la base.

Réponse
For our theoretical address table, we might want to store the following properties:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

When creating the table to represent an address object, we would create columns to represent each of these properties
and we would name them with SQL-compliant and possibly shortened names:

house_number
street_name
suburb
city
postcode
country

Structure d’une adresse

Les propriétés qui décrivent une adresse sont les colonnes. Le type d’information stockée dans chaque colonne est un
type de données. Dans la section qui suit, nous analyserons notre table d’adresse pour voir comment l’améliorer !

15.1.7 Théorie de base de données

Le processus de création d’une base de données implique la création d’un modèle basé sur le monde réel: prendre les
concepts du monde réel et les représenter dans une base de données en tant qu’entités.

15.1.8 Normalisation

Une des idées principales dans une base de données consiste à éviter la duplication/redondance de données. Le
processus de suppression de la redondance dans une base de données s’appelle Normalisation.
La normalisation est une méthode systémique qui permet de s’assurer que la structure de base de données est adaptée
aux requêtes génériques et qu’elle est débarassée de certaines caractéristiques non désirées liées aux anomalies lors
d’insertion, de mise à jour ou de suppression qui peuvent engendrer une perte d’intégrité des données. - Wikipedia
Il existe différents types de normalisation.
Examinons cet exemple tout simple:
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Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imaginez que vous avez beaucoup d’amis avec le même nom de rue ou de ville. Chaque fois que ces données sont
dupliquées, elles consomment de l’espace. Pire encore, si un nom de ville change, vous devrez effectuer beaucoup de
travail pour mettre à jour votre base de données.

15.1.9 ��� Try Yourself:

Reconstruisez la structure théorique de la table people ci-dessus pour réduire la duplication d’information et normaliser
la structure de données.
Pour en savoir plus sur la normalisation des bases de données, lisez ceci

Réponse
The major problem with the people table is that there is a single address field which contains a person’s entire address.
Thinking about our theoretical address table earlier in this lesson, we know that an address is made up of many
different properties. By storing all these properties in one field, we make it much harder to update and query our
data. We therefore need to split the address field into the various properties. This would give us a table which has the
following structure:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

In the next section, you will learn about Foreign Key relationships which could be used in this example to further
improve our database’s structure.
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15.1.10 Index

Un index de base de données est un lot de données destiné à accélérer les opérations de recherche de données. -
Wikipedia

Imaginez que vous lisez un bouquin et cherchez la définition d’un concept - et que le bouquin n’a pas d’index! Vous
devrez lire le livre depuis le début et page après page jusqu’à ce que vous trouviez l’information recherchée. L’index
à la fin du livre vous permet d’aller directement à la page contenant l’information pertinente.

create index person_name_idx on people (name);

Maintenant, les recherches sur le nom seront plus rapides:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Séquences

Une séquence est un générateur de nombre unique. Il est normalement utilisé pour créer un identifiant unique pour
une colonne d’une table.
Dans cet exemple, id est une séquence - le nombre est incrémenté chaque fois qu’un nouvel enregistrement est ajouté
à la table :

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Diagramme Entité-Relation

Dans une base de données normalisée, vous disposez de plusieurs relations (tables). Le diagramme entités-association
(ERD) est utilisé pour définir les dépendances logiques entre les relations. Voici notre modèle non normalisé de la
table people de notre leçon précédente:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Avec un peu d’effort, nous pouvons la séparer en deux tables en supprimant le besoin de répéter le nom de la rue pour
les individus qui vivent dans la même rue.
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select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

et :

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

Nous pouvons ensuite lier les deux tables en utilisant les clefs “keys” streets.id et people.streets_id.
Si nous dessinons un Diagramme entité-association pour ces tables, il devrait ressembler à ce qui suit:

Le diagramme entité-association nous aide à exprimer les relations “un à plusieurs”. Dans ce cas, le symbole de flèche
nous montre qu’une rue peut avoir plusieurs personnes qui vivent dedans.

��� Try Yourself:

Notre modèle de table people a encore des problèmes de normalisation. Essayez de les identifier et de les corriger à
l’aide d’un diagramme entité-association.

Réponse
Our people table currently looks like this:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

The street_id column represents a “one to many” relationship between the people object and the related street object,
which is in the streets table.
One way to further normalise the table is to split the name field into first_name and last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

We can also create separate tables for the town or city name and country, linking them to our people table via “one
to many” relationships:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

An ER Diagram to represent this would look like this:
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15.1.13 Contraintes, Clés Primaires et Clés Etrangères

Une contrainte de base de données est utilisée pour s’assurer que les données d’une relation correspondent à la vision
du modélisateur sur le stockage de l’information. Par exemple, un contrainte sur le code postal permet de s’assurer
que le nombre sera bien compris entre 1000 et 9999.
Une clef primaire est une ou plusieurs valeurs de champ qui identifie un enregistrement unique. En générale, la clef
primaire est appelé identifiant et elle correspond à une séquence.
Une clef étrangère est utilisée pour se référer à un enregistrement unique d’une autre table (en utilisant la clef primaire
de l’autre table).
Dans le diagramme entité-association, le lien entre les tables est basé sur la liaison entre les clefs étrangères et les
clefs primaires.
Si vous regardez notre exemple sur les personnes, la définition de la table montre que la colonne “street” est une clef
étrangère qui référence la clef primaire de la table des rues:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

15.1. Leçon : Introduction aux bases de données 483



QGIS Training Manual

15.1.14 Transactions

Lorsque vous ajoutez, modifiez ou supprimez une donnée dans une base de données, il est toujours important de laisser
la base de données dans un état consistant si quelquechose tourne mal. La plupart des bases de données fournissent
un mécanisme de transaction. Les transactions vous permettent de créer une position de retour sur laquelle on peut
revenir si les modifications ne se sont pas déroulées comme prévu.
Prenons un scénario ou vous avez mis en place un système de comptabilité. Vous devez transférer des fonds d’un
compte à l’autre. Les étapes se dérouleront de la manière suivante:

• Supprimer R20 du compte Joe.
• Ajouter R20 au compte Anne.

Si quelquechose se passe mal lors du processus (ex: une panne de courant), la transaction sera annulée.

15.1.15 Conclusion

Les bases de données vous permettent de gérer vos données de manière structurée en utilisant des structures de code
simple.

15.1.16 La suite ?

Maintenant que nous avons jeté un coup d’oeil sur le fonctionnement des bases de données, créons une nouvelle base
pour mettre en pratique ce que nous avons appris.

15.2 Leçon : Implémenter le modèle de données

Maintenant que toutes les notions théoriques ont été abordées, passons à l’étape de la création d’une base de donnés.
Cette base de données servira à tous les exercices de toutes les leçons à venir.
Le but de cette leçon: Installer les logiciels requis et les utiliser pour mettre en place notre base de données exemple.

15.2.1 Installer PostgreSQL

Note: You can find PostgreSQL packages and installation instructions for your operating system at https://www.
postgresql.org/download/. Please note that the documentation will assume users are running QGIS under Ubuntu.

Avec Ubuntu :

sudo apt install postgresql-9.1

Vous devriez obtenir un message similaire à celui-ci:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:

(suite sur la page suivante)
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(suite de la page précédente)
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Appuyez sur Y et sur Entrée et patientez jusqu’à ce que le téléchargement et l’installation soit terminés.

15.2.2 Aide

PostgreSQL a une très bonne documentation online.

15.2.3 Créer une base de données utilisateur

Avec Ubuntu :
Une fois l’installation complète, exécuter cette commande pour devenir l’utilisateur de postgres puis créez une nouvelle
base de données utilisateur :

sudo su - postgres

Saisissez votre mot de passe normalement lorsqu’il vous ait demandé (vous aurez besoin des droits sudo).
Maintenant, à la vue de l’invite de commande postgres, créez la base de données utilisateur. Vérifiez bien que le
nom d’utilisateur correspond à votre nom de session unix : cela vous facilitera la vie, car postgres vous identifiera
automatiquement lorsque vous vous connecterez avec cet identifiant :

createuser -d -E -i -l -P -r -s qgis

Saisissez un mot de passe lorsque c’est demandé. Il est conseillé d’utiliser un mot de passe différent de celui de votre
session.
Que signifient ces options?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Vous devriez maintenant quitter l’environnement postgres en tapant :

exit

15.2.4 Vérifier le nouveau compte

psql -l

devrait renvoyer quelque chose comme ceci:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |

(suite sur la page suivante)
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(suite de la page précédente)
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Tapez Q pour sortir.

15.2.5 Créer une base de données

La commande createdb est utilisée pour créer une nouvelle base de données. Elle doit être lancée à l’invite de
commande suivant :

createdb address -O qgis

Vous pouvez vérifier l’existence de votre nouvelle base de données avec cette commande:

psql -l

qui devrait renvoyer quelque chose comme ceci:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
(4 rows)

Tapez Q pour sortir.

15.2.6 Lancer une session de shell de base de données

Vous pouvez facilement vous connecter à votre base de données comme cela

psql address

Pour quitter la base de données de l’environnement psql, saisissez

\q

Pour obtenir de l’aide dans l’interface système, saisissez

\?

Pour obtenir de l’aide sur les commandes sql, saisissez

\help

Pour obtenir de l’aide spécifique sur une commande, saisissez (par exemple)

\help create table

voir aussi la feuille Psql.
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15.2.7 Créer des tables en SQL

Commençons à créer quelques tables ! Nous utiliserons notre modèle entité-relation comme guide. D’abord,
connectez-vous à l’adresse de la base de données:

psql address

Puis créez une table streets

create table streets (id serial not null primary key, name varchar(50));

serial etvarchar sont des types de données. serial indique à PostgreSQL de démarrer une séquence d’entier
(numérotation automatique) pour remplir le champ id automatiquement à chaque enregistrement. varchar(50)
indique à PostgreSQL de créer un champ de caractère de 50 caractères de long.
Vous remarquerez que les commandes se terminent par le caractère ;. Toutes les commandes SQL se terminent
ainsi. Lorsque vous appuyez sur Entrée, psql renvoie la sortie suivante:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

Ça signifie que votre table a été créée avec succès et possède une clé primairestreets_pkey basée surstreets.
id.
Note: si vous avez appuyé sur Entrée sans avoir saisi un ; alors vous aurez un prompt de la forme address-#. PG
s’attend à ce que vous terminiez votre commande. Entrez ; avant de la lancer.
Pour visualiser le schéma de votre table, vous pouvez saisir:

\d streets

Ce qui vous renverra quelque-chose comme:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

Pour visualiser le contenu de votre table, vous pouvez utiliser ceci:

select * from streets;

Ce qui vous renverra quelque-chose comme:

id | name
---+------
(0 rows)

Comme vous pouvez le voir, notre table est actuellement vide.
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��� Essayez vous-même

Utilisez l’approche présentée ci-dessus pour créer une table des personnes appelées:
Ajouter des champs tels que le numéro de téléphone, l’adresse résidentielle, le nom, etc. (ces noms ne sont pas valides,
arrangez-le pour qu’ils le soient). Assurez-vous de donner une colonne d’identifiant à la table avec le même type de
données que plus haut.

Réponse
The SQL required to create the correct people table is:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

The schema for the table (enter \\d people) looks like this:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

For illustration purposes, we have purposely omitted the fkey constraint.

15.2.8 Créer des clefs en SQL

Le problème de notre précédente solution est que la base de données ne connais pas les relations logiques entre les
personnes et les rues. Pour l’exprimer de manière formelle, nous devons définir des clefs étrangères qui pointent vers
la clef primaire de la table des rues.

Il y a deux manières de le faire:
• Ajouter la clef après que la table ait été créée.
• Définir la clef lors de la création de la table.

Notre table a déjà été créée, utilisons donc la première méthode:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Cela indique à la table people que le champ street_id doit être un id valide de la table streets.
La méthode la plus courante pour créer une contrainte consiste à le faire au moment de la création de la table:

488 Chapter 15. Module : Concepts de bases de données avec PostgreSQL



QGIS Training Manual

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

Après avoir ajouté la contrainte, notre table ressemble à:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Créer des index en SQL

Nous voulons accélérer les recherches sur les noms des personnes. Pour y parvenir, nous pouvons créer un index sur
la colonne de nom de notre table de personnes:

create index people_name_idx on people(name);

\d people

Qui résulte dans:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | ('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)
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15.2.10 Supprimer des tables en SQL

Si vous voulez supprimer une table, vous pouvez utiliser la commande drop:

drop table streets;

In our current example, the above command would not work. Why not?

Réponse
The reason the DROP command would not work in this case is because the people table has a Foreign Key constraint
to the streets table. This means that dropping (or deleting) the streets table would leave the people table with references
to non-existent streets data.
It is possible to “force” the streets table to be deleted by using the CASCADE command, but this would also delete the
people and any other table which had a relationship to the streets table. Use with caution!

Si vous avez utilisé la même commande drop table sur la table people, elle devrait avoir réussi:

drop table people;

Note: Si vous avez entré cette commande et supprimé la table people, il sera bon de la recréer car vous en aurez
besoin pour les prochains exercices.

15.2.11 Un mot sur pgAdmin III

Nous vous avons montré des commandes SQL lancées depuis le prompt psql car c’est un moyen très efficace
d’apprendre à utiliser des bases de données. Néanmoins, il existe des moyens plus rapides et plus simples pour le
faire. Installez pgAdmin III et vous pourrez créer, supprimer, modifier les tables en cliquant dans une interface
graphique.
Sous Ubuntu, vous pouvez l’installer comme suit:

sudo apt install pgadmin3

PgAdmin III sera détaillé dans un prochain module.

15.2.12 Conclusion

Vous avez étudié comment créer une nouvelle base de données à partir de rien.

15.2.13 La suite ?

Dans le prochain chapitre, nous allons étudier comment utiliser une base de données spatiale pour ajouter de nouvelles
données.
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15.3 Leçon : Ajouter des données au modèle

Les modèles que nous avons créés nécessitent maintenant d’être remplis avec les données qu’ils sont censés contenir.
Objectif de cette leçon: Apprendre à intégrer de nouvelles données dans des modèles de bases de données.

15.3.1 Insérer une déclaration

Comme ajoutez-vous des données à une table ? Le SQL INSERT fournit la fonctionnalité pour ceci

insert into streets (name) values ('High street');

Un certain nombre de choses à noter :
• Après le nom de la table (streets), vous listez les noms des colonnes que vous peuplerez (dans ce cas-là
seulement la colonne name).

• Après le mot clé valeurs, placez la liste des valeurs de champ.
• Des chaînes de caractères devraient être citées en utilisant des guillemets simples.
• Notez que nous n’avons pas inséré une valeur pour la colonne id ; c’est parce que c’est une séquence et qu’elle
sera auto-générée.

• Si vous remplissez manuellement le id, vous pouvez avoir de sérieux problèmes avec l’entier de votre base de
données.

Vous pourrez voir INSERT 0 1 si cela a fonctionné.
Vous pouvez voir le résultat de votre action d’insertion en sélectionnant toutes les données de la table

select * from streets;

Résultat:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

��� Essayez vous-même

Utiliser la commande INSERT pour ajouter une nouvelle rue à la table streets.

Réponse
La commande SQL que vous devez utiliser ressemble à ceci (vous pouvez remplacer le nom de la rue par un nom de
votre choix):

insert into streets (name) values ('Low Road');
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15.3.2 Séquençage d’ajout de données en fonction des contraintes

15.3.3 ��� Essayez vous-même

Essayez d’ajouter un objet personne à la table people avec les détails suivants

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Note: Rappelez-vous que dans cet exemple, nous avons défini les numéros de téléphone comme chaînes de caractères,
et non comme entiers.

À cette étape, vous devriez avoir un rapport d’erreur si vous essayez de faire cela sans d’abord créer un enregistrement
pour Main Street dans la table streets.
Vous devriez aussi avoir remarqué ceci :

• Vous ne pouvez pas ajouter la rue en utilisant son nom
• Vous ne pouvez pas ajouter une rue en utilisant un id de rue avant d’avoir d’abord créé l’enregistrement de la
rue dans la table des rues.

Souvenez-vous que nos deux tables sont liées via une paire de Clé Primaire / Clé Étrangère. Cela signifie qu’aucune
personne valide ne peut être créée sans qu’il y ait également un enregistrement valide de la rue correspondante.
En utilisant les connaissances ci-dessus, ajoutez une nouvelle personne à la base de données.

Réponse
Voici la syntaxe SQL correcte

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)

values ('Joe Smith',55,2,'072 882 33 21');

If you look at the streets table again (using a select statement as before), you’ll see that the id for the Main Road
entry is 2.
That’s why we could merely enter the number 2 above. Even though we’re not seeing Main Road written out fully
in the entry above, the database will be able to associate that with the street_id value of 2.
If you have already added a new street object, you might find that the new Main Road has an id of 3 not 2.

15.3.4 Sélectionner les données

Nous vous avons déjà montré la syntaxe pour sélectionner des enregistrements. Regardons quelques exemples de plus
:

select name from streets;

select * from streets;

select * from streets where name='Main Road';

Dans les sessions suivantes, nous irons plus en détail sur la façon de sélectionner et de filtrer des données.
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15.3.5 Mise à jour des données

Et si vous voulez faire un changement de quelques données existantes ? Par exemple, un nom de rue est changé

update streets set name='New Main Road' where name='Main Road';

Soyez très prudent en utilisant ces déclarations de mise à jour - si plus d’un enregistrement correspond à votre clause
WHERE, ils seront tous mis à jour !
Une meilleure solution est d’utiliser une clé primaire de la table pour référencer l’enregistrement qui doit être changé

update streets set name='New Main Road' where id=2;

Il devrait être retourné UPDATE 1.

Note: Les critères de déclaration WHERE sont sensibles aux majuscules et minuscules : Main Road n’est pas la
même chose que Main road.

15.3.6 Supprimer les données

Afin de supprimer un objet d’une table, utilisez la commande DELETE

delete from people where name = 'Joe Smith';

Regardons maintenant notre table de personnes :

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

15.3.7 ��� Essayez vous-même

Utilisez les compétences acquises jusqu’à maintenant pour ajouter quelques nouveaux amis à votre base de données

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 Conclusion

Vous savez maintenant comment ajouter de nouvelles données aux modèles existants que vous avez précédemment
créés. Souvenez-vous que si vous voulez ajouter de nouveaux types de données, vous pouvez modifier et/ou créer de
nouveaux modèles pour contenir ces données.
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15.3.9 La suite ?

Maintenant que vous avez ajouté des données, vous allez apprendre comment utiliser des requêtes pour accéder à ces
données de différentes façons.

15.4 Leçon : Requêtes

Lorsque vous écrivez une commande SELECT ..., cela est communément connu comme une requête - vous
interrogez la base de données pour une information.
Objectif de cette leçon : Apprendre comment créer des requêtes qui retourneront des informations utiles.

Note: Si vous ne l’avez pas fait dans la leçon précédente, ajoutez les objets personnes suivants dans votre table
people. Si vous recevez des erreurs liées à des contraintes de clé étrangère, vous devez d’abord ajouter l’objet
“Main Road” à votre table des rues.

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45');

insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');

insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38');

insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32');

15.4.1 Ordonner les résultats

Récupérons une liste de personnes triée par leur numéro de maison:

select name, house_no from people order by house_no;

Résultat :

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

Vous pouvez trier les résultats par les valeurs de plus d’une colonne :

select name, house_no from people order by name, house_no;

Résultat :

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)
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15.4.2 Filtrage

Souvent, vous ne voudrez pas voir chaque enregistrement individuel dans la base de données - en particulier s’il y a
des milliers d’enregistrements et que vous êtes seulement intéressés à en voir un ou deux.
Voici un exemple d’un filtre numérique qui retourne seulement des objets pour lesquels house_no est inférieur à
50 :

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Vous pouvez combiner les opérations de filtres (définies avec la clause WHERE ) avec les opérations de tri (définies en
utilisant la clause ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Vous pouvez aussi filtrer sur les données du texte :

select name, house_no from people where name like '%s%';

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Ici nous utilisons la cause LIKE pour trouver tous les noms qui contiennent un s. Vous noterez que cette requête est
sensible aux majuscules et minuscules, ainsi l’entrée Sally Norman ne sera pas retournée.
Si vous recherchez une chaîne de lettres indépendamment de la majuscule ou minuscule, vous pouvez faire une
recherche insensible aux majuscules et minuscules en utilisant la clause ILIKE :

select name, house_no from people where name ilike '%r%';

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Cette requête retourne chaque personne avec un r ou R dans son nom.
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15.4.3 Jointure

Et si vous voulez voir les détails de la personne et son nom de rue plutôt que l’ID ? Afin de faire cela, vous devez
joindre le deux tables ensemble dans une seule requête. Regardons un exemple :

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Note: Avec les jointures, vous devez toujours définir les deux tables d’où proviennent les informations, dans notre cas
personnes et rues. Vous devez également spécifier quelle clé sert à la correspondance (clé étrangère et clé primaire).
Si vous ne spécifiez pas cela, vous allez obtenir une liste de toutes les combinaisons possibles de personnes et de rues,
mais il ne sera pas possible de savoir qui habite dans quelle rue!

Voici à quoi la bonne sortie devra ressembler :

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

Nous reverrons des jointures plus tard lorsque nous créerons des requêtes plus complexes. Souvenez-vous juste
qu’elles permettent de combiner d’une façon simple l’information de deux ou plusieurs tables.

15.4.4 Sous-sélection

Des sous-sélections vous permettent de sélectionner des objets d’une table sur la base des données d’une autre table
qui est liée via une relation de clé étrangère. Dans notre cas, nous voulons trouver des personnes qui vivent dans une
rue spécifique.
Faisons tout d’abord un petit ajustement de nos données :

insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Jetons rapidement un coup d’œil à nos données après ces changements; nous pouvons réutiliser notre requête de la
section précédente :

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Résultat :

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

496 Chapter 15. Module : Concepts de bases de données avec PostgreSQL



QGIS Training Manual

Nous allons maintenant vous montrer une sous-sélection de ces données. Nous voulons afficher seulement les
personnes qui vivent dans la street_id numéro 1 :

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Résultat :

name
--------------
Roger Jones
Sally Norman

(2 rows)

Bien que ce soit un exemple très simple et inutile avec nos petits jeux de données, il illustre à quel point les sous-
sélections peuvent être utiles et importantes lors de requêtes sur des jeux de données grands et complexes.

15.4.5 Requêtes agrégées

Une des fonctionnalités puissantes d’une base de données est sa capacité à résumer les données dans ses tables. Ces
résumés sont appelés requêtes agrégées. Voici un exemple typique qui nous dit comment plusieurs objets « personne »
sont dans notre table personne :

select count(*) from people;

Résultat :

count
-------

4
(1 row)

Si nous voulons les totaux agrégés par nom de rue nous pouvons procéder ainsi:

select count(name), street_id
from people
group by street_id;

Résultat :

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Note: Comment nous n’avons pas utilisé la clause ORDER BY, l’ordre de vos résultats peut ne pas correspondre
avec ce qui est montré ici.

15.4. Leçon : Requêtes 497



QGIS Training Manual

��� Essayez vous-même

Résumez les personnes par nom de rue et montrez les noms de rue actuel à la place de street_ids.

Réponse
Voici la syntaxe SQL correcte à utiliser

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Résultat

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Vous noterez que nous avons préfixé les noms de champ du nom de la table (par exemple people.name ou
streets.name). Ceci est nécessaire chaque fois que le nom de champ est ambigu (c’est-à-dire non unique au sein
des tables de la base de données).

15.4.6 Conclusion

Vous avez vu comment utiliser des requêtes pour retourner les données dans votre base de données d’une façon qui
vous permet d’y extraire de l’information utile.

15.4.7 La suite ?

Ensuite vous verrez comment créer des vues depuis les requêtes que vous avez écrites.

15.5 Leçon : Vues

Lorsque vous créez une requête, vous devez fournir un effort non négligeable pour la formuler. Avec les vues, vous
pouvez sauvegarder votre définition dans une requête SQL sous la forme d’une “table virtuelle” réutilisable.
Objectif de cette leçon : Sauvegarder des requêtes en vues.

15.5.1 Créer une vue

Vous pouvez considérer la vue comme une table mais ses données sont issues d’une requête. Faisons un exemple
simple:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;
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Comme vous pouvez le voir, le seul changement se situe au niveau du début, sur la partie: create view
roads_count_v as. Nous pouvons maintenant sélectionner les données depuis cette vue:

select * from roads_count_v;

Résultat :

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Modifier une vue

Une vue n’est pas fixe et elle ne contient aucune donnée réelle. Cela signifie que vous pouvez facilement la modifier
sans impacter les données de votre base de données:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Cet exemple montre également la convention de bonne pratique d’utiliser les caractères MAJUSCULES pour les
mot-clefs du SQL.)
Vous pouvez voir que nous avons ajouté une clause ORDER BY de manière à trier les lignes:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Supprimer une vue

Si vous n’avez plus besoin de la vue, vous pouvez la supprimer de cette manière:

drop view roads_count_v;

15.5.4 Conclusion

En utilisant des vues, vous pouvez sauvegarder une requête et accéder à ses résultats comme s’il s’agissait d’une table.
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15.5.5 La suite ?

Parfois, lorsque vous changez une donnée, vous voulez que ces modifications entraînent des effets ailleurs dans la
base de données. La prochaine leçon nous permettra de voir comment on peut y parvenir.

15.6 Leçon : Règles

Les règles permettent à « l’arbre de requête » d’une requête entrante d’être réécrit. Une utilisation courante est
l’implémentation de vues, y compris des vues pouvant être mises à jour. -Wikipedia
Objectif de cette leçon: Apprendre à intégrer de nouvelles règles pour la base de données.

15.6.1 Création d’une règle de journalisation

Supposons que vous souhaitiez enregistrer chaque modification de phone_no dans votre table de personnes dans une
table people_log. Donc, vous configurez une nouvelle table :

create table people_log (name text, time timestamp default NOW());

Vous pouvez ensuite créer une règle qui trace tout changement de la colonne phone_no de la table people dans la
table people_log:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Pour vérifier le bon fonctionnement de la règle, modifions un numéro de téléphone:

update people set phone_no = '082 555 1234' where id = 2;

Vérifiez que la table people a été correctement mise à jour :

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Maintenant, grâce à la règle que nous avons créée, la table people_log ressemblera à ceci :

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Note: La valeur du champ time dépendra de la date et de l’heure courante.

500 Chapter 15. Module : Concepts de bases de données avec PostgreSQL



QGIS Training Manual

15.6.2 Conclusion

Les règles permettent d’ajouter ou de modifier automatiquement les données dans votre base de données pour refléter
des changements survenus ailleurs.

15.6.3 La suite ?

Le prochain module introduira les bases de données spatiales avec PostGIS, reprenant ainsi les concepts de bases de
données et les appliquant aux données SIG.
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Module : Concepts de bases de données spatiales avec PostGIS

Les bases de données spatiales permettent de stocker les géométries des documents à l’intérieur d’une base de données
et offrent des fonctionnalités de recherche et de récupération des enregistrements à l’aide de ces géométries. Dans
ce module, nous utiliserons PostGIS, une extension de PostgreSQL, pour apprendre à mettre en place une base de
données spatiales, à importer des données dans la base de données et à utiliser les fonctions géographiques offertes
par PostGIS.
Pendant que vous travaillez sur cette section, vous pouvez regarder une copie de la fiche PostGIS disponible auprès
du Boston GIS user group. Une autre ressource utile est la documentation en ligne de PostGIS.
Il existe également des tutoriels plus détaillés sur PostGIS et les bases de données spatiales créés Boundless et hébergés
aujourd’hui sur le site de PostGIS :

• Introduction à PostGIS
• Trucs et astuces de la base de données PostGIS

Voir également PostGIS In Action.

16.1 Leçon : Configuration de PostGIS

Configurer les fonctions PostGIS vous permettra d’accéder à des fonctions spatiales depuis PostgreSQL.
Objectif de cette leçon : Installer des fonctions spatiales et démontrer brièvement leurs effets.

Note: Nous assumerons que vous utilisez PostGIS version 2.1 ou ultérieure dans cet exercice. L’installation et la
configuration de la base de données sont différentes pour les versions plus anciennes. Néanmoins, le reste du module
devrait fonctionner. Consultez la documentation pour votre plate-forme pour vous aider à installer et configurer votre
base de données.
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16.1.1 Installation sous Ubuntu

Postgis s’installe facilement avec apt

$ sudo apt install postgresql
$ sudo apt install postgis

C’est aussi simple que ça…

Note: Les versions exactes qui seront installées dépendent de votre version d’Ubuntu et des dépôts que
vous avez configurés. Après installation, vous pouvez vérifier la version de PostGIS avec la requête select
PostGIS_full_version(); avec psql ou un autre outil.

Pour installer une version spécifique (par exemple, PostgreSQL 13 et PostGIS 3), vous pouvez utiliser les commandes
suivantes.

$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-
↪→key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-
↪→pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Installation sous windows

L’installation sur Windows peut se faire à l’aide de binaires, selon la procédure normale d’installation sous Windows,
c’est-à-dire avec navigation dans des fenêtres graphiques.
Visitez d’abord la page de téléchargement. Puis suivez ce guide.
More information about installing on Windows can be found on the PostGIS website.

16.1.3 Installation sur les autres plate-formes

Le site web de téléchargement de PostGIS contient des informations sur l’installation sur d’autres plateformes, y
compris macOS, et sur d’autres distributions Linux

16.1.4 Configurer les bases de données pour utiliser postgis

Lorsque PostGis est installé, vous allez devoir configurer votre base de données pour utiliser les extensions. Si vous
avez installé PostGis en version > 2.0, il suffit d’envoyer la commande suivante avec psql en utilisant l’adresse de la
base de donnée de l’exercice précédant.

$ psql -d address -c "CREATE EXTENSION postgis;"

Note: En fonction de votre version, vous pouvez trouver plus d’instructions sur l’activation de la cartouche spatiale
à https://postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Quelles-sont les fonctions installées par PostGIS ?

PostGIS peut être considéré comme une collection de fonctions internes à la baes de données qui étendent les
fonctionnalités de base de PostgreSQL de manière à ce qu’il puisse gérer des données spatiales. par “gérer”, on
entend stocker, récupérer, requêter et manipuler. Pour y parvenir, un certain nombre de fonctions sont installées dans
la base de données.
Notre base de données PostgreSQL address est maintenant géospatiale, grâce à PostGIS. Nous allons nous plonger
un peut plus dans les détails dans les prochains paragraphes mais faisons d’abord une petite introduction. Disons
qu’on souhaite créer un point à partir d’un texte. Nous utilisons d’abord la commande psql pour trouver les fonctions
relatives au point. Si vous n’est pas déjà connecté à la base de données address, faîtes-le puis lancez:

\df *point*

C’est la commande que nous recherchons : st_pointfromtext. Pour parcourir la liste, utilisez la flèche vers le
bas, puis appuyez sur Q pour revenir au shell psql
Essayez d’exécuter cette commande:

select st_pointfromtext('POINT(1 1)');

Résultat:

st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Trois choses à noter:
• Nous avons défini un point à la position 1,1 (dans le SRID EPSG:4326) en utilisant POINT(1 1),
• Nous avons lancé une commande sql non pas sur une table mais uniquement sur des données insérées depuis
le prompt SQL,

• La ligne de résultat n’est pas très significative.
La ligne de résultat est au format OGC dénommé “Well Known Binary” (WKB). Ce format sera détaillé dans la
prochaine section.
Pour obtenir les résultats sous forme de texte, nous pouvons faire un balayage rapide de la liste des fonctions qui
retournent du texte:

\df *text

La requête que nous cherchons est st_astext. Combinons-la à notre précédente requête:

select st_astext(st_pointfromtext('POINT(1 1)'));

Résultat:

st_astext
------------

POINT(1 1)
(1 row)

Ici nous avons inséré la chaîne POINT(1,1), nous l’avons transformée en point en utilisant la fonction
st_pointfromtext() et nous l’avons reconvertie sous forme lisible par l’humain avec la fonction
st_astext() qui nous redonne notre chaîne originelle.
Un dernier exemple avant d’aller plus dans les détails de l’utilisation de PostGIS:

select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));
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Qu’avons-nous fait ? Nous avons créé un tampon de 1 degré autour de notre point et nous avons renvoyé le résultat
sous forme de texte.

16.1.6 Système de référence spatiale

En plus des fonctions PostGIS, l’extension contient une collection de définitions de systèmes de référence spatiale
(SRS) telles que définies par l’European Petroleum Survey Group (EPSG). Ces définitions sont utilisées pour les
opérations qui impliquent des conversion de systèmes de coordonnées de référence (SCR).
Nous pouvons inspecter ces définitions de SRS dans notre base de données car elles sont stockées dans des tables
normales.
D’abord, jetons un oeil sur le schéma de la table par la commande suivante dans le prompt psql:

\d spatial_ref_sys

Le résultat devrait prendre la forme suivante:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
Indexes:

"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

Vous pouvez utiliser les requêtes SQL standards (que nous avons étudiées dans les sections d’introduction) pour
visualiser et manipuler la table même si ce n’est pas une bonne idée de mettre à jour ou de supprimer des
enregistrements sans comprendre ce qu’on fait.
Un SRID intéressant est l’EPSG:4326 qui correspond au système de latitude/longitude dans l’éllipsoïde WGS 84.
Etudions-là:

select * from spatial_ref_sys where srid=4326;

Résultat:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

Le champ srtext correspond à la définition de la projection au format Well Known Text (c’est le même qui est
utilisés dans les fichiers .prj des fichiers Shape).
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16.1.7 Conclusion

Les fonctions PostGIS sont maintenant installées dans votre copie de PostgreSQL. Nous pouvez maintenant utiliser
les fonctions spatiales de PostGIS.

16.1.8 La suite ?

Dans la prochaine leçon, nous allons étudier comment les entités spatiales sont représentées dans la base de données.

16.2 Leçon : Modèle d’Entité Simple

Comment pouvons-nous stocker et représenter des entités géographique dans une base de données ? Dans cette leçon
nous aborderons une seule approche: le Modèle d’Entité Simple défini par l’OGC.
Objectif de cette leçon: Apprendre à connaître et à utiliser le modèle SFS

16.2.1 Qu’est-ce-que l’OGC ?

L’OGC (Open Geospatial Consortium) est une organisation internationale bénévole d’élaboration de standards qui a
été fondée en 1994. Au sein de l’OGC, plus de 370 organisations commerciales, gouvernementales, associatives et
laboratoires de recherche à travers le monde participent au développement et à l’implémentation de standards pour
les services et le contenu géospatial, le traitement de données SIG et les formats d’échange. - Wikipedia

16.2.2 Quel est le modèle SFS ?

Le Modèle Simple Feature for SQL et une méthode non topologique pour stocker de l’information spatiale dans une
base de données. Il définit des fonctions pour accéder, faire des calculs et construire ces données.

Le modèle définit les données spatiales à partir des types Points, Linestring (polylignes) et Polygon (ainsi que leur
aggrégation sous forme d’objets multiples).
Pour de plus amples informations, se référer au standard OGC Simple Feature for SQL.
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16.2.3 Ajoutez un champ géométrique à la table

Ajoutons un champ de point à notre table de personnes:

alter table people add column geom geometry;

16.2.4 Ajoutez une contrainte basée sur le type de géométrie.

Vous pouvez remarquer que le type de champ « géométrie » n’indique pas explicitement de quel type de géométrie il
s’agit. C’est pourquoi nous ajoutons une contrainte:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(geom) = 'ST_Point'::text
OR geom IS NULL);

Ce code ajoute une contrainte à la table de manière à ce qu’elle n’accepte que les géométries de points ou les valeurs
vides.

16.2.5 ��� Essayez vous-même

Créez une nouvelle table appelée cities et donnez-lui des colonnes appropriées, incluant un champ de géométrie
pour stocker des polygones (les limites administratives). Assurez-vous d’avoir une contrainte géométrique sur les
polygones.

Réponse

16.2.6 Remplissez la table geometry_columns.

A ce stade, vous pouvez également ajouter une entrée dans la table geometry_columns:

insert into geometry_columns values
('','public','people','geom',2,4326,'POINT');

Pourquoi ? La colonne geometry_columns est utilisée par certaines applications pour savoir quelles sont les
tables de la base de données qui contiennent des données géométriques.

Note: Si la commande INSERT retourne une erreur, lancez d’abord cette requête:

select * from geometry_columns;

Si la colonne f_table_name contient la valeur people, alors cette table a déjà été enregistré et vous n’avez rien
à faire de plus.

La valeur 2 fait référence au nombre de dimensions; dans ce cas, deux: X et Y.
La valeur 4326 indique que la table utilise une projection WGS 84 qui est référencée par le numéro 4326 (référez-
vous à la discussion précédente à propos des codes EPSG).
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��� Essayez vous-même

Ajoutez une entrée dans la table geometry_columns pour la couche cities.

Réponse

insert into geometry_columns values
('','public','cities','geom',2,4326,'POLYGON');

16.2.7 Ajouter un enregistrement géométrique à la table en utilisant SQL

Maintenant que nos tables sont géométriquement adaptées, nous pouvons y stocker des géométries:

insert into people (name,house_no, street_id, phone_no, geom)
values ('Fault Towers',

34,
3,
'072 812 31 28',
'SRID=4326;POINT(33 -33)');

Note: Dans la nouvelle entrée ci-dessus, vous devez indiquer quelle projection (SRID) utiliser. Cette indication
est obligatoire lorsqu’on enregistre un point à l’aide d’une chaîne de caractères qui n’ajoute pas automatiquement
l’information de projection. Bien entendu, le nouveau point doit utiliser le même SRID que le jeu de données dans
lequel il est ajouté et vous devez le spécifier.
Si à ce stade vous utilisez une interface graphique, l’indication de la projection de chaque point se ferait
automatiquement. En d’autres termes, il n’y a généralement pas besoin d’ajouter la bonne projection à chaque point
que vous voulez ajouter si vous avez déjà indiqué le SRID pour le jeu de données utilisé, comme nous l’avons fait
auparavant.

C’est le bon moment pour ouvrir QGIS et tenter de visualiser la table people. De plus, nous pouvons essayer
d’éditer/ajouter/supprimer des enregistrements et réaliser des requêtes sur la base de données pour visualiser comment
la donnée est modifiée.
Pour charger une couche PostGIS dans QGIS, utilisez l’entrée de menu Couche ► Ajouter une couche PostGIS ou la
barre d’outils:

Ce qui ouvrira la boîte de dialogue suivante:
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Cliquez sur le bouton New pour ouvrir la boîte de dialogue suivante:
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Définissez alors une nouvelle connexion, par exemple:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Pour vérifier que QGIS trouve bien la base de données address et que votre compte/mot de passe sont corrects,
cliquez sur Tester la connexion. Si ça fonctionne, cochez les cases après Enregistrer le nom de l’utilisateur et Enregistrer
le mot de passe . Cliquez alors sur OK pour créer cette connexion.
Retournez dans la boîte de dialogue Ajouter une ou plusieurs tables PostGIS , cliquez sur Connecter et ajoutez les
couches à votre projet comme d’habitude.
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��� Essayez vous-même

Formulate a query that shows a person’s name, street name and position (from the geom column) as plain text.

Réponse

select people.name,
streets.name as street_name,
st_astext(people.geom) as geometry

from streets, people
where people.street_id=streets.id;

Résultat

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Comme vous pouvez le voir, notre contrainte autorise l’ajout de valeurs NULL à la base de données.

16.2.8 Conclusion

Vous avez vu comment ajouter des objets spatiaux à votre base de données et comment les visualiser dans un logiciel
de SIG.

16.2.9 La suite ?

Dans la prochaine leçon, nous verrons comment importer et exporter des données de la base de données.

16.3 Leçon : Importer et Exporter

Bien évidemment, une base de données sans un moyen facile de migrer des données dans et hors d’elle serait sans
grand intérêt. Heureusement, il existe de nombreux outils permettant de facilement déplacer les données vers et hors
de PostGIS.

16.3.1 shp2pgsql

shp2pgsql est un outil en ligne de commande pour importer des fichiers ESRI Shapefile dans une base de données.
Sous Unix, vous pouvez utiliser la commande suivante pour importer une nouvelle table PostGIS :

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Sous Windows, vous devez réaliser le processus d’importation en deux étapes:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql
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Vous pouvez rencontrer cette erreur:

ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

C’est un problème connu lié à la création in situ d’un index spatial sur la couche en cours d’importation. Pour éviter
l’erreur, excluez le paramètre -I. Cela signifie qu’aucun index spatial ne sera directement créé sur la table, et que
vous aurez besoin de le créer une fois la donnée importée dans la base de données. (La création d’un index spatial
sera abordée dans la prochaine leçon.)

16.3.2 pgsql2shp

pgsql2shp est un outil de ligne de commande pour exporter des tables, des vues ou des requêtes de sélection SQL.
Pour l’utiliser sous Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

Pour exporter des données à l’aide d’une requête:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr est un très puissant outil pour convertir les données entre PostGIS et beaucoup de formats de données.
ogr2ogr fait partie de la bibliothèque GDAL et doit être installé séparément. Pour exporter une table PostGIS en
GML, vous pouvez utiliser cette commande :

ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 Le Gestionnaire de Bases de Données

Vous avez dû remarquer une autre option dans le menu Base de données intitulée DB Manager. Il s’agit d’un outil qui
offre une interface unifiée pour interagir avec les bases de données spatiales incluses dans PostGIS. Il vous permet
également d’importer et exporter depuis les bases de données vers d’autres formats. Étant donné que le prochain
module est largement dévolu à l’utilisation de cet outil, nous ne ferons que le mentionner ici.

16.3.5 Conclusion

Importer et exporter vers et depuis une base de données peut être fait de diverses manières. Vous utiliserez
probablement ces fonctions (ou des similaires) si vous utilisez des données de sources disparates.
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16.3.6 La suite ?

Prochainement, nous verrons comment interroger les données que nous avons créées auparavant.

16.4 Leçon : Requêtes Spatiales

Les requêtes spatiales ne sont pas différentes des autres requêtes de base de données. Vous pouvez utiliser la colonne
de géométrie comme n’importe quelle colonne de base de données. Avec l’installation de PostGIS dans notre base de
données, vous avons ajouté des fonctions additionnelles pour requêter la base.
Objectif de cette leçon: Etudier comment les fonctions spatiales sont implémentées de manière similaire aux autres
fonctions non spatiales.

16.4.1 Opérateurs spatiaux

Lorsque vous souhaitez connaître quels sont les points distants de 2 degrés par rapport à un point (X,Y), vous pouvez
le faire ainsi:

select *
from people
where st_distance(geom,'SRID=4326;POINT(33 -34)') < 2;

Résultat :

id | name | house_no | street_id | phone_no | geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Note: geom value above was truncated for space on this page. If you want to see the point in human-readable
coordinates, try something similar to what you did in the section « View a point as WKT », above.

Comment savons-nous que la requête précédente retourne tous les points situés à moins de 2 degrés ? Pourquoi pas
2 mètres ? Ou dans une autre unité ?

Réponse
L’unité utilisée dans la requête en exemple est le degré, car le SCR de la couche est WGS 84. Il s’agit d’un SCR
géographique, et son unité est donc le degré. Un SCR projeté, tel que les projections UTM, est en mètres.
Rappelez-vous que lorsque vous rédigez une requête, vous devez connaître l’unité du SCR de la couche. Ceci vous
permettra d’écrire une requête correcte renvoyant les résultats tels qu’escomptés.
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16.4.2 Index spatiaux

Nous pouvons également définir des index spatiaux. Un index spatial permet de rendre les requêtes spatiales plus
rapides. Pour créer un index spatial sur une colonne de géométrie, utilisez:

CREATE INDEX people_geo_idx
ON people
USING gist
(geom);

\d people

Résultat :

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(geom) = 'ST_Point'::text
OR geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 ��� Essayez vous-même

Modifiez la table des villes de manière à ce que la colonne de géométrie utilise un index spatial.

Réponse

CREATE INDEX cities_geo_idx
ON cities
USING gist (geom);

16.4.4 Démonstration des fonctions spatiales de PostGIS

Pour faire une démonstration des fonctions spatiales de PostGIS, nous allons créer une base de données contenant des
données (fictives).
Pour commencer, créez une nouvelle base de données (sortez d’abord du shell psql):

createdb postgis_demo

Rappelez-vous d’installer les extensions PostGIS:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"
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Ensuite, importez les données fournies dans le répertoire exercise_data/postgis/. Référez-vous à la leçon
précédente mais souvenez-vous que vous devez créer une nouvelle connexion PostGIS à la nouvelle base de données.
Vous pouvez importer depuis le terminal ou via DB Manager. Importez les fichiers dans les tables suivantes de la
base:

• points.shp dans building
• lines.shp dans road
• polygons.shp dans region

Chargez ces trois couches dansQGIS via la boîte de dialogueAjouter des couches PostGIS, comme d’habitude. Lorsque
vous ouvrez les tables d’attributs, vous pouvez remarquer qu’elles ont un champ id et un autre gid, créés lors de l’import
PostGIS.
Maintenant que les tables sont importées, nous pouvons utiliser PostGIS pour requêter les données. Retournez dans
votre terminal (ligne de commande) et entrez le prompt psql en lançant:

psql postgis_demo

Nous allons présenter quelques-uns des traitements SQL en créant des vues avec eux pour que vous puissiez les ouvrir
dans QGIS pour visualiser les résultats.

Sélection par localisation

Récupérer tous les bâtiments de la région KwaZulu:

SELECT a.id, a.name, st_astext(a.geom) as point
FROM building a, region b
WHERE st_within(a.geom, b.geom)
AND b.name = 'KwaZulu';

Résultat :

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Ou, si nous créons une vue depuis la requête précédente:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.geom
FROM building a, region b

WHERE st_within(a.geom, b.geom)
AND b.name = 'KwaZulu';

Ajoutez la vue comme couche dans QGIS:
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Sélection des voisins

Affichez la liste des tous les noms de régions qui touchent la région Hokkaido:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.geom, b.geom)
AND a.name = 'Hokkaido';

Résultat :

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

En tant que vue:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.geom
FROM region a, region b

WHERE st_touches(a.geom, b.geom)
AND a.name = 'Hokkaido';

Dans QGIS:
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Vous pouvez noter qu’il manque une région (le Queensland). C’est sans doute dû à une erreur topologique. Des
artefacts comme celui-ci peuvent nous alerter sur des problèmes de données. Pour résoudre cette interrogation sans
analyser toutes les anomalies des données, nous pouvons utiliser une intersection de tampon à la place:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(geom, 100) as geom
FROM region

WHERE name = 'Hokkaido';

Cette requête créé un tampon de 100 mètres autour de la région d’Hokkaido.
La surface la plus sombre est le tampon:
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Sélection à l’aide du tampon:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.geom, b.geom)
AND b.name != 'Hokkaido';

Dans cette requête, la vue originelle du tampon est utilisée comme n’importe quelle autre table. Elle dispose d’un alias
a et son champ de géométrie, a.geom, est utilisé pour sélectionner un polygone dans la table region (alias b) qui
l’intersecte. Néanmoins, Hokkaido est exclue de cette sélection car nous n’en voulons pas, nous voulons seulement
les régions qui la touche.
Dans QGIS:
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Il est également possible de sélectionner les objets à une certaine distance sans avoir besoin de créer un tampon:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.geom
FROM region a, region b

WHERE ST_DISTANCE (a.geom, b.geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

Cela permet le même résultat sans avoir besoin de l’étape du tampon:
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Sélection de valeurs uniques

Affiche la liste des noms de ville uniques pour tous les bâtiments de la région du Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.geom, b.geom)
AND b.name = 'Queensland';

Résultat :

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Autres exemples…

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.geom, b.geom)) as text,
ST_SHORTESTLINE(a.geom, b.geom) AS geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.geom, b.geom)) as text,
ST_LONGESTLINE(a.geom, b.geom) AS geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.geom) as geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.geom) as geom
FROM region a

WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA(a.geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(geom, 20) AS geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(geom, 50) AS geom
FROM road;
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CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.geom)) AS geom
FROM building a
GROUP BY a.name;

16.4.5 Conclusion

Vous avez observer comment faire des requêtes spatiales sur des objets en utilisant les nouvelles fonctions apportées
par PostGIS.

16.4.6 La suite ?

Dans le prochain chapitre, nous allons étudier des structures de géométries plus complexes et voir comment les créer
en utilisant PostGIS.

16.5 Leçon : Construction de géométrie

Dans cette section nous allons creuser un peu plus profondément comment les géométries simples sont construites en
SQL. En réalité, vous utiliserez probablement un SIG comme QGIS pour créer des géométries complexes en utilisant
leurs outils de numérisation ; cependant, comprendre comment ils sont formulés peut être pratique pour écrire des
requêtes et comprendre comment la base de données est assemblée.
Objectif de cette leçon : Mieux comprendre comment créer des entités spatiales directement dans
PostgreSQL/PostGIS.

16.5.1 Création de polylignes

Retournons à notre base de données address et faisons en sorte que la table des rues corresponde à celles
précédemment étudiées, c’est-à-dire qu’il existe une contrainte géométrique, un index et en entrée dans la table de
métadonnées geometry_columns.

16.5.2 ��� Essayez vous-même

• Modifiez la table streets de sorte à ce qu’il y ait une colonne géométrie de type ST_PolyLigne.
• N’oubliez pas de faire la mise à jour d’accompagnement à la table des colonnes géométriques !
• Ajoutez également une contrainte pour empêcher toutes géométries ajoutées qui ne sont pas des POLYLIGNES
ou nulles.

• Créez un index spatial sur la nouvelle colonne géométrique

Réponse

alter table streets add column geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(geom) = 'ST_LineString'::text OR geom IS NULL);
insert into geometry_columns values ('','public','streets','geom',2,4326,

'LINESTRING');

(suite sur la page suivante)
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(suite de la page précédente)
create index streets_geo_idx

on streets
using gist
(geom);

Insérons maintenant une polyligne dans notre table rues. Dans ce cas nous mettrons à jour un enregistrement de rue
existant:

update streets
set geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;

Jetez un coup d’œil aux résultats dans QGIS. (Vous pouvez devoir faire un clic droit sur la couches streets dans la
“Légende” des couches, et choisissez “Zoomer sur l’emprise de la couche”.)
Créez maintenant plus d’entrées streets - certaines dans QGIS et d’autres depuis la ligne de commande.

16.5.3 Création de Polygones

Créer des polygones est tout aussi facile. Une chose à se souvenir est que par définition les polygones ont au moins
quatre sommets, avec le dernier et le premier co-localisés:

insert into cities (name, geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');

Note: Un polygone requière des doubles parenthèses autour de sa liste de coordonnées ; c’est pour vous permettre
d’ajouter des polygones complexes avec de multiples aires non connectées. Par exemple

insert into cities (name, geom)
values ('Tokyo Outer Wards',

'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))'

);

Si vous suivez cette étape, vous pouvez vérifier ce qui a été fait en chargeant le jeu de données villes dans QGIS, en
ouvrant sa table attributaire, et en sélectionnant la nouvelle entrée. Notez comment les deux nouveaux polygones se
comportent comme un polygone.

16.5.4 Exercice : Lier les Villes aux Personnes

Pour cet exercice, vous devriez faire comme suit :
• Supprimez toutes les données depuis votre table personne.
• Ajoutez une colonne clé étrangère aux personnes qui font référence à la clé primaire de la table des villes.
• Utilisez QGIS pour capturer quelques villes.
• Utilisez SQL pour insérer quelques nouveaux enregistrements de personnes, en vous assurant que chacun a une
rue et une ville associées.

Votre schéma de personnes mis à jour devrait ressembler à quelque chose comme cela:

\d people

Table "public.people"

(suite sur la page suivante)
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(suite de la page précédente)
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(geom) =

'ST_Point'::text OR geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Réponse

delete from people;
alter table people add column city_id int not null references cities(id);

Ajouter des villes dans QGIS

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('Faulty Towers',

34,
3,
'072 812 31 28',
1,
'SRID=4326;POINT(13 -15)');

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('IP Knightly',

32,
1,
'071 812 31 28',
1,
'SRID=4326;POINT(18 -24)');

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('Rusty Bedsprings',

39,
1,
'071 822 31 28',
1,
'SRID=4326;POINT(22 -25)');

Si vous obtenez le message suivant :

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

Alors cela signifie que vous avez probablement supprimé des entités lorsque vous avez expérimenté la création de
polygones dans la table « cities ». Vérifiez donc les entrées dans la table « cities » et utilisez n’importe quelle valeur
du champ id qui existerait encore.
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16.5.5 Regarder notre Schéma

Notre schéma devrait désormais ressembler à ça :

16.5.6 ��� Essayez vous-même

Créez des contours de ville en calculant l’enveloppe convexe minimum de toutes les adresses pour cette ville et en
calculant un tampon autour de cette zone.

Réponse
• Add some people in “Tokyo Outer Wards” city

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Bad Aboum',

57,
2,
'073 712 31 21',
2,
'SRID=4326;POINT(22 18)');

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Pat Atra',

59,
2,
'074 712 31 25',
2,
'SRID=4326;POINT(23 14)');

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Kat Herin',

65,
2,
'074 722 31 28',
2,
'SRID=4326;POINT(29 18)');

• Create myPolygonTable table

CREATE TABLE myPolygonTable (
id serial NOT NULL PRIMARY KEY,
city_id int NOT NULL REFERENCES cities(id),
geom geometry NOT NULL

);

(suite sur la page suivante)
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(suite de la page précédente)

ALTER TABLE myPolygonTable
ADD CONSTRAINT myPolygonTable_geom_polygon_chk
CHECK (st_geometrytype(geom) = 'ST_Polygon'::text );

• Create and load the convex hulls

INSERT INTO myPolygonTable (city_id, geom)
SELECT * FROM
(
SELECT

ROW_NUMBER() over (order by city_id)::integer AS city_id,
ST_CONVEXHULL(ST_COLLECT(geom)) AS geom
FROM people
GROUP BY city_id

) convexHulls;

16.5.7 Accès aux sous-objets

Avec les fonctions duModèle-SFS, vous avez une large variété d’options pour accéder aux sous-objets des Géométries
SFS. Lorsque vous voulez sélectionner le premier point du sommet de chaque géométrie de polygone dans la table
myPolygonTable, vous devez faire cela de cette manière :

• Transformez les contours du polygone en une polyligne:

select st_boundary(geom) from myPolygonTable;

• Sélectionnez le premier point du sommet de la polyligne résultante :

select st_startpoint(myGeometry)
from (

select st_boundary(geom) as myGeometry
from myPolygonTable) as foo;

16.5.8 Traitement de données

PostGIS supporte toutes les fonctions conformes à la norme OGC SFS/MM. Toutes ces fonctions commencent avec
ST_.

16.5.9 Découper

Pour découper une sous-partie de vos données, vous pouvez utiliser la fonction ST_INTERSECT() Pour éviter les
géométries vides, utilisez:

where not st_isempty(st_intersection(a.geom, b.geom))
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select st_intersection(a.geom, b.geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.geom,32734),

b.geom));
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16.5.10 Construction de géométries à partir d’autres géométries

À partir d’une table d’un point donné, vous voulez générer une polyligne. L’ordre des points est défini par leur id.
Une autre méthode d’ordre pourrait être un horodatage, comme celui que vous obtenez lorsque vous capturez des
points de navigation avec un récepteur GPS.

Pour créer une polyligne à partir d’une nouvelle couche de points appelée “points”, vous pouvez exécuter la commande
suivante:

select ST_LineFromMultiPoint(st_collect(geom)), 1 as id
from (

select geom
from points
order by id

) as foo;

Pour voir comme cela fonctionne sans créer une nouvelle couche, vous pourriez aussi lancer cette commande sur la
couche “people”, même si faire cela dans le monde réel aurait peu de sens.
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16.5.11 Nettoyage de géométrie

Vous trouverez sur ce blog plus d’informations à ce sujet.

16.5.12 Différences entre les tables

Pour déceler la différence entre deux tables ayant la même structure, vous pouvez utiliser le mot-clé EXCEPT de
PostgreSQL:

select * from table_a
except
select * from table_b;

Comme résultat, vous obtiendrez tous les enregistrements de la table_a qui ne sont pas stockés dans la table_b.
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16.5.13 Espaces de table

Vous pouvez définir où Postgre doit stocker ses données sur le disque en créant des espaces de table:

CREATE TABLESPACE homespace LOCATION '/home/pg';

When you create a database, you can then specify which tablespace to use e.g.:

createdb --tablespace=homespace t4a

16.5.14 Conclusion

Vous avez appris comment créer des géométries complexes en utilisant les déclarations PostGIS. Gardez à l’esprit que
vous avez amélioré votre connaissance globale sur les bases de données spatiales, à travers un outil SIG. Vous n’avez
généralement pas besoin d’utiliser ces déclarations manuellement mais disposer de compétences sur leur utilisation et
leur structure vous aidera à utiliser un SIG, particulièrement si vous rencontrez des erreurs qui pourraient apparaître
comme incompréhensibles autrement.
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Le Guide du module Traitements de QGIS

Ce module est une contribution de Victor Olaya et Paolo Cavallini.
Contenus:

17.1 Introduction

Ce guide décrit comment utiliser le framework de traitement QGIS. Il ne suppose aucune connaissance préalable du
framework de traitement ou des applications sur lesquelles il repose. Il suppose une connaissance de base du QGIS.
Les chapitres sur le scripting supposent que vous ayez une connaissance de base de Python et peut-être de l’API
Python de QGIS.
Ce guide est conçu pour un auto-apprentissage ou pour diriger un atelier sur le traitement.
Les exemples présentés dans ce guide utilisent le QGIS 3.4. Ils peuvent ne pas fonctionner ou ne pas être disponibles
dans d’autres versions que celle-ci.
Ce guide est composé d’un ensemble de petits exercices de complexité progressive. Si vous n’avez jamais utilisé
le framework de traitement, vous devez commencer dès le début. Si vous avez une certaine expérience préalable,
n’hésitez pas à sauter des leçons. Elles sont plus ou moins indépendantes les unes des autres, et chacune d’entre elles
introduit un nouveau concept ou un nouvel élément, comme indiqué dans le titre du chapitre et la courte introduction
au début de chaque chapitre. Cela devrait permettre de repérer facilement les leçons traitant d’un sujet particulier.
Pour une description plus systématique de toutes les composantes du framework et de leur utilisation, il est
recommandé de consulter le chapitre correspondant du manuel d’utilisation. Utilisez-le comme texte d’appui avec le
présent guide.
Tous les exercices de ce guide utilisent le même ensemble de données gratuit utilisé dans tout le manuel de formation
et référencé à la section Données. Le fichier zip à télécharger contient plusieurs dossiers correspondant à chacune des
leçons de ce guide. Dans chacun d’eux, vous trouverez un fichier du projet QGIS. Il vous suffit de l’ouvrir et vous
serez prêt à commencer la leçon.
Savourez!
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17.2 Une importante mise en garde avant de commencer

Tout comme le manuel d’un traitement de texte ne vous apprend pas à écrire un roman ou un poème, ou un didacticiel
de CAO ne vous montre pas comment calculer la taille d’une poutre pour un bâtiment, ce guide ne vous apprendra une
analyse de l’espace. Au lieu de cela, il vous montrera comment utiliser le cadre de traitement QGIS, un outil puissant
pour effectuer une analyse spatiale. C’est à vous d’apprendre les concepts requis pour comprendre ce type d’analyse.
Sans eux, il est inutile d’utiliser le framework et ses algorithmes, même si vous pourriez être tenté d’essayer.
Voyons cela plus clairement avec un exemple.
A partir d’un jeu de points et de la valeur d’une variable de chaque point, vous pouvez calculer une couche raster en
utilisant le géo-traitement Krigeage. Les paramètres de la boîte de dialogue de ce module sont les suivants:

Cela semble complexe, non ?
En lisant ce manuel, vous apprendrez à utiliser ce module, comment le lancer dans un traitement par lots pour créer
des couches rasters à partir de centaines de couches ponctuelles en une seule passe, ou bien ce qui résulte si la couche
d’entrée a certains points sélectionnés. Néanmoins les paramètres en eux-même ne sont pas expliqués. Un analyste
expérimenté disposant d’une bonne connaissance de géo-statistique n’aura aucun problème à les comprendre. Si vous
n’en êtes pas et que les termes seuil, plage ou Nugget se vous sont pas familiers alors vous ne pourrez pas utiliser le
module Krigeage. Ce qui est d’autant plus le cas que ce module requiert de connaître les concepts de l’auto-correlation
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spatiale ou les semi-variogrammes, ce dont vous n’avez sans doute jamais entendu parler ou que vous n’avez sans doute
pas étudié. Vous devez donc étudier et comprendre ces éléments avant de revenir à QGIS pour les utiliser et réaliser
des analyses. Les ignorer vous conduira a des résultats faussés et à des analyses de piètre qualité (et souvent inutiles).
Bien que tous les algorithmes ne soient pas aussi complexes que le krigeage (même si certains sont quand même plus
complexes), la plupart d’entre eux requièrent la compréhension des concepts fondamentaux sur lesquels ils sont basés.
Sans cette connaissance, leur utilisation mènera très probablement à des résultats médiocres.
Utiliser des géoalgorithmes sans avoir une bonne base en analyse spatiale revient à essayer d’écrire un roman sans
connaitre les règles de grammaire ou de syntaxe ni de narration. Vous obtiendrez un résultat, mais qui pourrait n’avoir
aucune valeur. De grâce, n’allez donc pas croire qu’une fois que vous aurez lu ce guide, vous serez capable de réaliser
des analyses spatiales et obtenir des résultats exacts. Il vous faudra tout de même étudier les analyses spatiales.
Voici une bonne référence que vous pourrez lire au sujet de l’analyse de données spatiales.
Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley
Il est disponible en ligne ici <https://www.spatialanalysisonline.com/> _

17.3 Installation du module de traitements

La première chose à faire avant d’utiliser le module de traitements est de le configurer. Il n’y a pas beaucoup à mettre
en place, c’est une tâche facile.
Plus tard, nous montrerons comment configurer les applications externes qui sont utilisées pour étendre la liste des
algorithmes disponibles, mais pour l’instant, nous allons nous contenter de travailler avec le module lui-même.
Le framework de traitement est un plugin QGIS de base, ce qui signifie qu’il devrait déjà être installé dans votre
système, puisqu’il est inclus avec QGIS. S’il est actif, vous devriez voir un menu appelé Processing dans votre barre
de menu. Là, vous pouvez accéder à tous les composants du framework.

Si vous ne pouvez pas trouver ce menu, vous devez activer l’extension en vous rendant dans le gestionnaire d’extensions
et en l’activant.
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L’élément principal avec lequel nous allons travailler est la barre d’outils. Cliquez sur l’entrée du menu correspondant
et vous verrez la barre d’outils épinglée sur le côté droit de la fenêtre QGIS.
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La boîte à outils contient une liste de tous les algorithmes disponibles, divisés en groupes appelés Fournisseurs. Les
fournisseurs peuvent être (dés)activés dans le menu Préférences ► Options ► Traitement. Nous discuterons de cette
fenêtre plus loin dans ce manuel.
Par défaut, seuls les fournisseurs qui ne reposent pas sur des applications tierces (c’est-à-dire ceux qui n’ont recours
qu’à QGIS pour fonctionner) sont activés. Les algorithmes qui nécessitent des applications externes peuvent avoir
besoin d’une configuration supplémentaire. La configuration des fournisseurs de traitements est détaillée dans un
prochain chapitre de ce manuel.
Si vous avez atteint ce point, vous êtes maintenant prêt à utiliser des géoalgorithmes. Il n’y a pas besoin de configurer
autre chose pour le moment. Nous pouvons déjà faire tourner notre premier algorithme, ce que nous ferons dans la
prochaine leçon.

17.4 Lancement de notre premier algorithme. La boîte à outils

Note: Dans cette leçon, nous allons lancer notre premier algorithme, et obtenir notre premier résultat de cela.

Comme nous l’avons déjà mentionné, le module de traitement peut lancer les algorithmes d’autres applications, mais
il contient également des algorithmes natifs qui ne nécessitent pas un logiciel externe pour être exécutés. Pour
commencer l’exploration du module de traitement nous allons lancer un de ces algorithmes natifs. En particulier,
nous allons calculer les centroïdes d’un jeu de polygones.
Ouvrez tout d’abord le projet QGIS correspondant à cette leçon. Il contient seulement une seule couche avec deux
polygones.

Rendez-vous maintenant à la zone de texte tout en haut de la boîte à outils. C’est le champ de recherche, et si vous
tapez du texte dedans, cela filtrera la liste des algorithmes de telle sorte que seuls les algorithmes contenant le texte
saisi seront affichés. S’il existe des algorithmes qui correspondent à votre recherche mais qui appartiennent à un
fournisseur désactivé, un message additionnel sera affiché dans la partie basse de la boîte à outils.
Saisissez centroïdes et vous devriez avoir quelque chose qui ressemble à ceci.

17.4. Lancement de notre premier algorithme. La boîte à outils 535



QGIS Training Manual

La zone de recherche est un moyen pratique de retrouver un algorithme. Au bas de la fenêtre, un message additionnel
indique l’existence d’autres algorithmes correspondant à votre recherche mais appartenant à un fournisseur désactivé.
Si vous cliquez sur le lien dans le message, ces algorithmes s’afficheront en grisé, dans la liste. De même un lien pour
activer le fournisseur d’algorithmes est disponible. Nous verrons plus tard comment activer d’autres fournisseurs.

Pour exécuter un algorithme, vous devez simplement double-cliquer sur son nom dans la boîte à outils. Lorsque vous
double-cliquez sur l’algorithme Centroïdes de Polygones, vous verrez la boîte de dialogue suivante.
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Tous les algorithmes ont une interface similaire qui contient essentiellement des paramètres d’entrée que vous avez
à remplir, et de sortie dont vous devez choisir l’emplacement de stockage. Dans le cas présent, la seule donnée en
entrée que nous avons est une couche vectorielle de polygones.
Sélectionnez la couche de Polygones en entrée. L’algorithme a une seule sortie, qui est la couche des centroïdes. Il y
a deux options pour définir où la sortie de données est sauvegardée : entrez un chemin de fichier ou sauvegardez-la
dans un fichier temporaire
Dans le cas où vous voulez définir une destination et ne pas sauvegarder le résultat dans un fichier temporaire, le format
de sortie est défini par l’extension du nom de fichier. Pour sélectionner un format, sélectionnez simplement l’extension
du fichier correspondante (ou ajoutez-la si vous tapez directement le chemin du fichier à la place). Si l’extension du
chemin de fichier que vous avez entrée ne correspond à aucun des formats pris en charge, une extension par défaut
(habituellement .dbf pour des tables, .tif pour des couches rasters et .shp pour des couches vectorielles) sera
ajoutée au chemin du fichier et le format de fichier correspondant à cette extension sera utilisé pour sauvegarder la
couche ou la table.
Dans tous les exercices de ce guide, nous enregistrerons les résultats dans un fichier temporaire, puisqu’il n’est pas
nécessaire de les sauvegarder pour une utilisation ultérieure. N’hésitez pas à les sauvegarder dans un endroit permanent
si vous le souhaitez.

Avertissement: Notez que les fichiers temporaires sont supprimés une fois que vous fermez QGIS. Si vous
créez un projet avec une sortie qui a été sauvegardée en tant que fichier temporaire, QGIS se plaindra lorsque
vous essayerez de rouvrir le projet plus tard, car le fichier de sortie n’existera plus.

Une fois que vous avez configuré la boîte de dialogue de l’algorithme, appuyez sur Run pour exécuter l’algorithme.
Vous obtiendrez le fichier de sortie suivant.
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Le fichier de sortie a le même SCR que celui d’entrée. Les géoalgorithmes supposent que toutes les couches d’entrée
partagent le même SCR et ne font aucune reprojection. Sauf dans le cas de certains algorithmes spéciaux (par exemple
ceux de reprojection), les fichiers de sortie auront aussi ce même SCR. Nous en verrons plus à propos de cela bientôt.
Essayez d’en enregistrer en utilisant différents formats de fichier (utilisez, par exemple, shp et geojson comme
extensions). Aussi, si vous ne voulez pas que la couche soit chargée dans QGIS après avoir été générée, vous pouvez
décochez la case qui se trouve en-dessous de la zone de saisie du fichier de sortie.

17.5 Plus d’algorithmes et types de données

Note: Dans cette leçon, nous lancerons trois algorithmes supplémentaires, apprendrons à utiliser d’autres types
d’entrées, et configurerons des sorties pour qu’elles soient sauvegardées dans un dossier donné automatiquement.

Pour cette leçon, nous aurons besoin d’une table et d’une couche de polygones. Nous allons créer une couche de
points basée sur des coordonnées dans la table, et ensuite compter le nombre de points dans chaque polygone. Si vous
ouvrez le projet QGIS correspondant à cette leçon, vous trouverez une table avec des coordonnées X et Y, mais vous
ne trouverez pas de couche de polygones. Ne vous inquiétez pas, nous la créerons en utilisant un géoalgorithme de
traitement.
La première chose que nous allons faire est de créer une couche de points à partir des coordonnées de la table, en
utilisant l’algorithme Convertir la table en points. Vous savez maintenant comment utiliser le champ de recherche, et
il ne devrait donc pas être trop difficile pour vous de le trouver. Double-cliquez dessus pour le lancer et accéder à la
boîte de dialogue suivante.
Cet algorithme, comme celui de la leçon précédente, génère qu’une seule sortie, et a trois entrées :

• Table: la table avec les coordonnées. Vous devrez sélectionner ici la table à partir des données de la leçon.
• Les champs X et Y : ces deux paramètres sont liés au premier. Le sélecteur correspondant montrera le nom de
ces champs qui sont disponibles dans la table sélectionnée. Sélectionnez le champ XCOORD pour le paramètre
X, et le champ YYCOORD pour le paramètre Y.
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• SCR : Comme cet algorithme ne prend pas de couche en entrée, il ne peut donc pas assigner un SCR à la
couche de sortie. À la place, il vous est demandé de sélectionner manuellement le SCR que les coordonnées
dans la table utilisent. Cliquez sur le bouton sur le côté gauche pour ouvrir le sélecteur du SCR de QGIS, et
sélectionnez EPSG:4326 comme SCR de sortie. Nous utilisons ce SCR car les coordonnées dans la table sont
dans ce SCR.

Votre boîte de dialogue devrait ressembler à cela.

Cliquez maintenant sur le bouton Exécuter pour obtenir la couche suivante (vous aurez peut être besoin de faire un
zoom arrière pour revenir sur les points nouvellement créés de la carte) :
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La prochaine chose dont nous avons besoin est la couche de polygone. Nous allons créer une grille régulière de
polygones en utilisant l’algorithme Créer une grille, qui a les paramètres suivants dans la boîte de dialogue.
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Avertissement: Les options sont plus simples dans les versions récentes de QGIS; vous devez juste rentrer les
valeurs min et max pour X et Y (suggestion de valeurs: -5.696226,-5.695122,40.24742,40.248171)

Les entrées requises pour créer une grille sont toutes des nombres. Lorsque vous devez entrer une valeur numérique,
vous avez deux options : la taper directement dans le champ correspondant, ou cliquer sur le bouton sur le côté droit
pour obtenir une boîte de dialogue comme celle montrée après.
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La boîte de dialogue contient une simple calculatrice, donc vous pouvez taper des expressions telles que 11 * 34.
7 + 4.6, et le résultat sera calculé et inséré dans le champ de texte correspondant dans la boîte de dialogue des
paramètres. En outre, elle contient des constantes que vous pouvez utiliser, et des valeurs d’autres couches disponibles.
Dans ce cas, nous voulons créer une grille qui couvre l’étendue de la couche de points d’entrée, de manière à pouvoir
utiliser les coordonnées pour calculer la coordonnée du centre de la grille ainsi que sa largeur et sa hauteur, puisque
ce sont les paramètres que l’algorithme prend pour créer la grille. Avec un peu de mathématiques, essayez de faire
ça par vous-même en utilisant la boîte de dialogue et les constantes de la couche de point d’entrée.
Sélectionnez Rectangles (polygones) dans le champ Type.
Comme dans le cas du dernier algorithme, nous devons entrer le SCR ici. Sélectionnez EPSG:4326 comme le SCR
cible, comme nous l’avons fait avant.
À la fin, vous devriez avoir une boîte de dialogue de paramètres comme ceci :
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(Il est plus sage d’ajouter un espacement sur la largeur et la hauteur: Espacement horizontal: 0.0001, Espacement
vertical: 0.0001, Largeur: 0.001004, Hauteur: 0.000651, X Centre: -5.695674, Y Centre: 40.2477955). Le cas du
centre X est un peu compliqué: -5.696126+(( -5.695222+ 5.696126)/2)
Cliquez sur Exécuter et vous obtiendrez la couche du graticule.
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La dernière étape consiste à compter les points dans chacun des rectangles de ce graticule. Nous utiliserons
l’algorithme Compter les points dans les polygones.

Nous avons maintenant le résultat que nous cherchions.
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Avant de terminer cette leçon, voici un rapide astuce pour vous simplifier la vie dans le cas où vous voulez sauvegarder
vos données de manière persistante. Si vous voulez sauvegarder tous vos fichiers de sortie dans un dossier donnée,
vous n’avez pas besoin de taper le nom du dossier à chaque fois. À la place, rendez-vous dans le menu de traitement
et sélectionnez l’élément Options et configuration. Cela va ouvrir la boîte de dialogue de configuration.

Dans l’entrée Dossier de sortie que vous trouverez dans le groupe Général, tapez le chemin de votre dossier de
destination.
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Désormais, quand vous lancez un algorithme, utilisez seulement le nom du fichier à la place de tout le chemin.
Par exemple, avec la configuration montrée ci-dessous, si vous entrez graticule.shp comme chemin de
sortie pour l’algorithme que nous venons d’utiliser, le résultat sera sauvegardé dans D:\processing_output\
graticule.shp. Vous pouvez toujours entrer un chemin entier au cas où vous voulez sauvegarder un résultat
dans un dossier différent.
Essayez vous-même l’algorithme Créer une grille avec différentes tailles de grille, et aussi avec différents types de
grille.

17.6 SCR. Reprojection

Note: Dans cette leçon, nous discuterons de comment les Traitements utilisent les SCR. Nous verrons également un
algorithme très utile : la reprojection.

Les SCR sont une grande source de confusion pour les utilisateurs de Traitements QGIS, alors voici quelques règles
générales sur la façon dont ils sont traités par les géoalgorithmes lors de la création d’une nouvelle couche.

• S’il y a des couches d’entrée, le SCR de la première couche sera utilisé. Celui-ci est supposé être le SCR de
toutes les couches d’entrée, car ils devraient avoir le même. Si vous utilisez des couches avec des SCR non
correspondants, QGIS vous en avertira. Notez que le SCR des couches d’entrées est affiché avec son nom dans
la boîte de dialogue des paramètres.
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• S’il n’y a pas de couche d’entrée, il utilisera le SCR du projet, sauf si l’algorithme contient un champ SCR
spécifique (comme cela s’est produit dans la dernière leçon avec l’algorithme du réticule)

Ouvrez le projet correspondant à cette leçon et vous verrez deux couches nommées 23030 et 4326. Elles contiennent
toutes les deux les mêmes points, mais dans des SCR différents (EPSG:23030 and EPSG:4326). Elles apparaissent à
la même place parce que QGIS reprojecte à la volée le SCR du projet (EPSG:4326), mais elles ne sont pas réellement
la même couche.
Ouvrez l’algorithme Exporter/ajouter des colonnes de géométrie.

Cet algorithme ajoute des nouvelles colonnes aux tables attributaires d’une couche vectorielle. Le contenu des colonnes
dépend du type de géométrie de la couche. Dans le cas des points, de nouvelles colonnes avec les coordonnées X et
Y de chaque point sont ajoutées.
Dans la liste des couches disponibles que vous pouvez trouver dans le champ de couche d’entrée, vous verrez chacune
avec son SCR. Cela signifie que, bien qu’elles apparaissent à la même place dans votre canevas, elles seront traitées
différemment. Sélectionnez la couche 4326.
L’autre paramètre de l’algorithme permet de définir la manière dont l’algorithme utilise des coordonnées pour calculer
la nouvelle valeur qu’il ajoute aux couches résultantes. La plupart des algorithmes n’ont pas d’option comme celle-ci,
et il suffit d’utiliser directement les coordonnées. Sélectionnez l’option SCR de la couche pour simplement utiliser des
coordonnées telles qu’elles sont. Voilà comment presque tous les géoalgorithmes sont.
Vous devriez obtenir une nouvelle couche avec exactement les mêmes points comme les deux autres couches. Si
c’est le cas, cliquez sur le nom de la couche et ouvrez ses propriétés, vous verrez qu’elle partage le même SCR que la
couche d’entrée, qui est EPSG:4326. Lorsque la couche est chargée dans QGIS, il ne vous sera pas demandé d’entrer
le SCR de la couche, dès lors que QGIS sait déjà lequel c’est.
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Si vous ouvrez la table attributaire de la nouvelle couche, vous verrez qu’elle contient deux nouveaux champs avec les
coordonnées X et Y de chaque point.

Ces valeurs de coordonnées sont données dans le SCR de la couche, puisque nous avons choisi cette option.
Cependant, même si vous choisissez une autre option, le SCR en sortie de la couche aurait été le même, car le
SCR d’entrée est utilisé pour définir le SCR de la couche de sortie. Si vous choisissez une autre option, les valeurs
seront différentes, mais pas le point résultant à modifier ou le SCR de la couche en sortie différent du SCR de la
couche en entrée.
Faites maintenant le même calcul en utilisant l’autre couche. Vous devriez trouver la couche résultante exactement à
la même place que les autres, et elle aura le SCR EPSG:23030, dès lors que c’était celui de la couche d’entrée.
Si vous vous rendez à sa table attributaire, vous verrez des valeurs qui sont différentes de celles dans la première
couche que nous avons créée.

Cela est dû au fait que les données originales sont différentes (elles utilisent un SCR différent), et ces coordonnées
sont prises de lui.
Que devons-nous en tirer ? L’idée principale derrière ces exemples est que les géoalgorithmes utilisent la couche telle
qu’elle est dans sa source originale de données, et ignorent complètement les reprojections que QGIS pourrait faire
avant le rendu. En d’autres termes, ne vous fiez pas à ce que vous voyez dans le canevas, mais gardez toujours en tête
que les données originales seront utilisées. Ce n’est pas si important dans ce cas, car nous n’utilisons qu’une seule
couche à la fois, mais dans un algorithme qui a besoin de plusieurs d’entre elles (comme un algorithme de découpage),
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des couches qui semblent correspondre ou se superposer pourraient être très loin l’une de l’autre, car elles pourraient
avoir des SCR différents.
Les algorithmes n’effectuent aucune reprojection (excepté dans l’algorithme de reprojection que nous verrons plus
tard), c’est donc à vous de vous assurez que les couches ont des SCR correspondants.
Un module intéressant qui travaille avec les SCR est celui de reprojection. Il représente un cas particulier, car il a une
couche d’entrée (celle à reprojeter), mais il n’utilise pas son SCR pour la couche de sortie.
Ouvrez l’algorithme Reprojection de couche.

Sélectionnez une des couches en entrée, et sélectionnez EPSG:23029 comme le SCR de destination. Lancez
l’algorithme et vous obtiendrez une nouvelle couche, identique à celle d’entrée, mais avec un SCR différent. Elle
apparaîtra dans la même région du canevas, comme les autres, tant que QGIS reprojette à la volée, mais ses
coordonnées originales sont différentes. Vous pouvez voir cela en lançant l’algorithme Exporter/Ajouter des colonnes
géométriques en utilisant cette nouvelle couche comme entrée, et en vérifiant que les coordonnées ajoutées sont
différentes que celles dans les tables des attributs des deux couches que nous avons calculées avant.
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17.7 Sélection

Note: Dans cette leçon, nous verrons comment les algorithmes de traitement gèrent les sélections dans les couches
vectorielles qui sont utilisées comme couches d’entrée, et comment créer une sélection en utilisant un type particulier
d’algorithme.

Contrairement à d’autres extensions d’analyse dansQGIS, vous ne trouverez pas de case à cocher «Utiliser uniquement
les valeurs sélectionnées » ou autre case similaire dans les géoalgorithmes de traitement. Le comportement concernant
la sélection est défini pour l’ensemble de l’extension et tous ses algorithmes, et non pour chaque exécution de
l’algorithme. Les algorithmes suivent les règles simples suivantes lors de l’utilisation d’une couche vecteur.

• Si la couche possède une sélection, seules les entités sélectionnées sont utilisées.
• S’il n’y a pas de sélection, toutes les entités sont utilisées.

Veuillez noter que ce comportement peut être modifié via le menu Traitement ► Options ► Général.
Vous pouvez vérifier par vous-même en sélectionnant quelques points dans une des couches que nous avons utilisées
dans le chapitre précédent, et lancer sur eux l’algorithme de reprojection. La couche reprojetée que vous obtiendrez
contiendra seulement ces points qui ont été sélectionnés, à moins qu’il n’y ait pas de sélection préalable auquel cas, la
couche résultante contiendra tous les points de la couche d’origine.
Pour faire une sélection, vous pouvez utiliser une des méthodes ou un des outils disponibles dans QGIS. Cependant,
vous pouvez également utiliser un géoalgorithme pour le faire. Les algorithmes pour créer une sélection se trouvent
dans la boîte à outils sous Vecteur/Sélection

Ouvrez l’algorithme Sélection aléatoire.
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En laissant les valeurs par défaut, cela va sélectionner 10 points à partir de la couche actuelle.

Vous remarquerez que cet algorithme ne produit pas de sortie, mais modifie la couche d’entrée (pas la couche elle-
même, mais sa sélection). C’est un comportement inhabituel, puisque tous les autres algorithmes produiront de
nouvelles couches et n’altérerons pas les couches d’entrée.
Étant donné que la sélection ne fait pas partie des données elles-mêmes, mais est quelque chose qui n’existe que dans
QGIS, ces algorithmes de sélection doivent seulement être utilisés pour la sélection dans une couche déjà ouverte
dans QGIS, et non une couche ajoutée avec l’option de sélection de fichier que vous pouvez trouver dans la boîte de
valeur du paramètre correspondant.
La sélection que nous venons de faire, comme la plupart de celles créées par les autres algorithmes de sélection, peut
également être faite manuellement depuis QGIS, donc vous pourriez peut-être vous demander à quoi ça sert d’utiliser
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un algorithme pour cela. Bien que cela pourrait actuellement ne pas avoir beaucoup de sens pour vous, nous verrons
plus tard comment créer des modèles et des scripts. Si vous voulez faire une sélection au milieu d’un modèle (qui
définit un flux de traitement), seul un géoalgorithme peut être ajouté à un modèle. Les autres éléments et opérations
de QGIS ne peuvent y être ajoutés. C’est la raison pour laquelle certains algorithmes de traitement dupliquent la
fonctionnalité déjà disponible dans d’autres éléments QGIS.
Pour l’instant, souvenez-vous simplement que des sélections peuvent être faites en utilisant des géoalgorithmes, et que
les algorithmes utiliseront seulement les entités sélectionnées si une sélection existe, ou toutes les entités autrement.

17.8 Lancement d’un algorithme externe

Note: Dans cette leçon, nous verrons comment utiliser des algorithmes qui dépendent d’une tierce application, en
particulier SAGA, qui est l’un des principaux fournisseurs d’algorithmes.

Tous les algorithmes que nous avons exécutés jusqu’à présent font partie du cadre de traitement. C’est-à-dire que
ce sont des algorithmes natifs implémentés dans le plugin et exécutés par QGIS tout comme le plugin lui-même
est exécuté. Cependant, l’une des plus grandes caractéristiques du cadre de traitement est qu’il peut utiliser des
algorithmes provenant d’applications externes et étendre les possibilités de ces applications. Ces algorithmes sont
intégrés et inclus dans la boîte à outils, de sorte que vous pouvez facilement les utiliser à partir de QGIS, et utiliser
les données de QGIS pour les exécuter.
Certains des algorithmes que vous voyez dans la vue simplifiée ont besoin d’applications tierces qui ont besoin d’être
installées sur votre système. Un fournisseur d’algorithmes ayant un intérêt particulier est SAGA (Système pour
l’Analyse Géospatiale Automatisée). Nous devons d’abord tout configurer pour queQGIS puisse correctement appeler
SAGA. Cela n’est pas compliqué, mais il est important de comprendre comment cela fonctionne. Chaque application
externe a sa propre configuration et, plus tard dans ce manuel, nous parlerons de certaines autres, mais SAGA va
devenir notre support principal et nous allons maintenant en discuter.
Si vous utilisez Windows, la meilleure façon de travailler avec des algorithmes externes est d’utiliser l’installateur
indépendant de QGIS. Il fera en sorte d’installer toutes les dépendances requises, y compris SAGA, ainsi si vous l’avez
utilisé, il n’y a rien à faire. Vous pouvez ouvrir la boîte de dialogue des paramètres et aller au groupe Pilotes/SAGA.
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Le chemin SAGA devrait déjà être configuré et pointer vers le dossier où SAGA est installé.
Si vous avez installé QGIS sans utiliser l’installateur indépendant vous devez alors indiquer le chemin d’accès à votre
installation de SAGA (que vous devrez avoir installé indépendamment).
Dans le cas où vous utilisez Linux, vous n’avez pas besoin de mettre le chemin de votre installation SAGA dans la
configuration du de l’outil Traitement. À la place, vous devez installer SAGA et être sûr que le dossier SAGA est dans
le PATH, de sorte qu’il puisse être appelé depuis la console (ouvrez simplement une console et tapez saga_cmd
pour le vérifier). Sous Linux, la version ciblée pour SAGA est aussi 2.1, mais dans certaines installations (comme par
exemple le OSGeo Live DVD) vous ne pourriez avoir que la version 2.0.8 de disponible. Il y a des compilations 2.1
disponibles, mais elles ne sont généralement pas installées et peuvent avoir quelques problèmes, donc si vous préférez
utiliser la version 2.0.8 plus courante et plus stable, vous pouvez le faire en activant la compatibilité 2.0.8 dans la
boîte de dialogue de configuration, sous le groupe SAGA.
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Une fois que SAGA est installé, vous pouvez lancer un algorithme SAGA en double-cliquant sur son nom, comme
avec n’importe quel autre algorithme. Étant donné que nous utilisons l’interface simplifiée, vous ne savez pas quels
algorithmes sont basés sur SAGA ou dans une autre application externe, mais si vous arrivez à double–cliquer sur un
des algorithmes et que l’application correspondante n’est pas installée, vous verrez quelque chose comme ceci.

Dans notre cas, et en supposant que SAGA est correctement installé et configuré, vous ne devriez pas voir cette
fenêtre, et vous obtiendrez à la place la boîte de dialogue des paramètres.
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Essayons avec un algorithme SAGA de base, celui nommé Séparer une couche de formes aléatoirement.

Utilisez la couche de points dans le projet correspondant à cette leçon comme entrée, et les valeurs de paramètre par
défaut, et vous obtiendrez quelque chose comme ceci (la séparation est aléatoire, donc votre résultat pourrait être
différent).

La couche en entrée a été séparée en deux couches, chacune avec le même nombre de points. Ce résultat a été calculé
par SAGA, récupéré ensuite par QGIS et ajouté au projet QGIS.
Si tout va bien, vous ne remarquerez aucune différence entre cet algorithme SAGAde base et un des autres algorithmes
que nous avons précédemment lancé. Cependant, SAGA peut, pour une raison quelconque, ne pas être capable de
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produire un résultat et ne pas pouvoir générer le fichier que QGIS attend. Dans ce cas, il y aura des problèmes en
ajoutant le résultat au projet QGIS, et un message d’erreur comme celui ci-dessous.

Ce type de problème peut se passer, même si SAGA (ou n’importe quelle autre application que nous avons appelé
à partir du module de traitements) est correctement installé, et il est important de savoir comment gérer ces erreurs.
Produisons un de ces messages d’erreur.
Ouvrez l’algorithme Créer un graticule et utilisez les valeurs ci-dessous.
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Nous utilisons les valeurs de largeur et de hauteur qui sont plus grandes que l’emprise indiquée, donc SAGA ne peut
pas produire de sortie. En d’autres mots, les valeurs des paramètres sont fausses, mais elles ne sont pas vérifiées
jusqu’à ce que SAGA les obtienne et essaie de créer la grille. Tant qu’il ne peut pas la créer, il ne produira pas la
couche attendue, et vous verrez un message d’erreur comme montré ci-dessus.

Note: Avec SAGA >=2.2.3, la commande ajustera automatiquement les valeurs erronées en entrée et vous
n’obtiendrez donc pas d’erreur. Afin de provoquer une erreur, indiquez des valeurs négatives pour la division.

La compréhension de ce type de problèmes vous aidera à les résoudre et à trouver une explication à ce qu’il se passe.
Comme vous pouvez le voir dans le message d’erreur, un test est effectué pour vérifier que la connexion avec SAGA
fonctionne correctement, vous indiquant qu’il peut y avoir un problème dans comment l’algorithme a été exécuté.
Cela s’applique non seulement à SAGA, mais aussi à d’autres applications externes.
Dans la prochaine leçon, nous introduirons le journal de progression, où l’information à propos des commandes
lancées par les géoalgorithmes est gardée, et vous verrez comment obtenir plus de détail lorsque des problèmes
comme ceci apparaissent.

17.8. Lancement d’un algorithme externe 557



QGIS Training Manual

17.9 Le journal des traitements

Note: Cette leçon décrit le journal du traitement.

Toutes les analyses effectuées avec le module de traitements sont enregistrées dans le système de suivi du journal de
QGIS. Cela vous permet d’en savoir plus à propos de ce qui a été fait avec les outils de traitement, pour résoudre des
problèmes quand ils surviennent, et aussi de re-exécuter les opérations précédentes, puisque le système de suivi du
journal met également en oeuvre une certaine interactivité.
To open the log, click on the balloon at the bottom right, on the QGIS status bar. Some algorithms might leave
here information about their execution. For instance, those algorithms that call an external application usually log the
console output of that application to this entry. If you have a look at it, you will see that the output of the SAGA
algorithm that we just run (and that fails to execute because input data was not correct) is stored here.
Ceci est utile pour comprendre ce qui se passe. Les utilisateurs avancés seront capables d’analyser cette sortie pour
trouver pourquoi l’algorithme n’a pas pu s’exécuter. Si vous n’êtes pas un utilisateur avancé, ceci permettra aux autres
personnes de vous aider à diagnostiquer le problème, qui peut être un problème dans l’installation du logiciel externe
ou un problème avec les données que vous avez fournies.
Même si l’algorithme peut être exécuté, certains algorithmes peuvent laisser des messages d’avertissements lorsque
le résultat peut ne pas être correct. Par exemple, lors de l’exécution d’un algorithme d’interpolation avec un très petit
nombre de points, l’algorithme peut tourner et produira un résultat, mais il est probable qu’il ne sera pas correct, car
plus de points auraient du être utilisés. Il est utile de vérifier régulièrement ce type d’avertissements si vous n’êtes pas
sûr de certains aspects d’un algorithme donné.
From the Processing► History…menu, you’ll find algorithms that are executed, regardless of they are executed from
the GUI or from the console (which will be explained later in this manual). The execution is stored in this dialog as a
console call. That means that everytime you run an algorithm, a console command is added to the log, and you have
the full history of your working session. Here is how that history looks like:
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Il peut être très utile lorsque l’on commence à travailler avec la console, d’apprendre la syntaxe des algorithmes. Nous
l’utiliserons lorsque nous discuterons de comment lancer des commandes d’analyses depuis la console.

17.9.1 ��� Pas à pas

The history is also interactive, and you can run any previous algorithm just by double-clicking on its entry. This is an
easy way of replicating the work we already did before.
For instance, try the following:

1. Open the data corresponding to the first chapter of this manual and run the algorithm explained there.
2. Now go to the History dialog and locate the last algorithm in the list, which corresponds to the algorithm you

have just run.
3. Double-click on it and a new result should be produced, just like when you run it using the normal dialog and

calling it from the toolbox.
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17.9.2 ��� Pas à pas

You can also modify the algorithm.
1. Copy the algorithm call
2. Open the Plugins ► Python console

3. Paste your copy to run the analysis; change the parameters at will.
4. To display the resulting file, you may want to replace processing.run in the pasted command with

processing.runAndLoadResults.

17.10 La calculatrice raster. Valeurs No-data

Note: Dans cette leçon, nous verrons comment utiliser la calculatrice raster pour effectuer des opérations sur des
couches raster. Nous expliquerons également qu’est-ce que sont les valeurs no–data et comment la calculatrice et les
autres algorithmes réagissent avec elles.

La calculatrice rester est un des plus puissants algorithmes que vous trouverez. C’est un algorithme très flexible et
souple qui peut être utilisé pour beaucoup de calculs différents, et il deviendra bientôt une partie importante de votre
boîte à outils.
Dans cette leçon, nous allons réaliser quelques calculs, plutôt simples, à l’aide de la calculatrice raster. Cela nous
permettra de voir comment l’utiliser et comment gérer certaines situations particulières que nous pourrons rencontrer.
Comprendre est une étape importante pour obtenir à l’avenir des résultats adaptés en utilisant la calculatrice et
également pour maîtriser certaines techniques qui sont courramment employées avec.
Ouvrez le projet QGIS correspondant à cette leçon et vous verrez qu’il contient plusieurs couches raster.
Ouvrez maintenant la boîte à outils et ouvrez la boîte de dialogue correspondant à la calculatrice raster.
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Note: L’interface est différente dans les versions récentes.

La boîte de dialogue contient 2 paramètres.
• Les couches à utiliser pour l’analyse. C’est une entrée multiple, ce qui signifie que vous pouvez sélectionner
autant de couches que vous voulez. Cliquez sur le bouton sur le côté droit et sélectionnez ensuite les couches
que vous voulez utiliser dans la boîte de dialogue qui apparaît.

• La formule à appliquer. La formule utilise les couches sélectionnées dans le paramètre du haut, qui sont
nommées en utilisant les lettres de l’alphabet (a, b, c...) ou g1, g2, g3... comme nom de variable.
Autrement dit, la formule a + 2 * b est la même que g1 + 2 * g2 et calculera la somme des valeurs
dans la première couche plus deux fois la valeur dans la seconde couche. L’ordre des couches est le même
ordre que vous voyez dans la boîte de dialogue de sélection.

Avertissement: La calculatrice est sensible à la casse.

Pour commencer, nous changerons les unités du MNE des mètres aux pieds. La formule dont nous avons besoin est
la suivante :

h' = h * 3.28084

Sélectionnez le MNE dans le champ des couches et tapez a * 3.28084 dans le champ de formule.

Avertissement: Pour les utilisateurs non anglophones : utilisez toujours « . », et non « , ».

Cliquez sur Exécuter pour lancer l’algorithme. Vous obtiendrez une couche qui a la même apparence que la couche
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d’entrée, mais avec des valeurs différentes. La couche d’entrée que nous avons utilisée possède des valeurs valides
dans toutes ses cellules, donc le dernier paramètre n’a pas du tout d’effet.
Effectuons maintenant un autre calcul, cette fois sur la couche accflow. Cette couche contient des valeurs de flux
cumulés, un paramètre hydrologique. Elle contient des valeurs seulement dans la zone d’un bassin hydrographique
donné, avec des valeurs no–data en dehors de celui-ci. Comme vous pouvez le voir, le rendu n’est pas très instructif, en
raison de la façon dont les valeurs sont distribuées. L’utilisation du logarithme de cette accumulation de flux donnera
une représentation beaucoup plus instructive. Nous pouvons calculer cela en utilisant la calculatrice raster.
Ouvrez à nouveau la boîte de dialogue de l’algorithme, sélectionnez la couche accflow comme la seule couche d’entrée,
et entrez la formule suivante : log(a)`.
Voici la couche que vous obtiendrez.

Si vous sélectionnez l’outil Identifier pour connaître la valeur d’une couche à un point donné, sélectionnez la couche
que nous venons juste de créer, et cliquez sur un point en dehors du bassin, vous verrez qu’il contient une valeur
no–data.
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Pour l’exercice suivant, nous allons utiliser deux couches à la place d’une, et nous allons obtenir un MNE avec des
valeurs d’élévation valides seulement dans le bassin défini dans la seconde couche. Ouvrez la boîte de dialogue de la
calculatrice et sélectionnez les deux couches du projet dans le champ des couches d’entrée. Entrez la formule suivant
dans le champ correspondant :

a/a * b

a fait référence à la couche de flux cumulé (car il est la premier à apparaître dans la liste) et b fait référence au
MNE. Ce que nous allons faire dans la première partie de cette formule ici est de diviser la couche de flux cumulé par
elle-même, ce qui donnera une valeur de 1 dans le bassin, et une valeur no–data à l’extérieur. Puis nous multiplions
par le MNE, pour obtenir la valeur d’élévation dans les cellules dans le bassin (MNE * 1 = MNE) et des valeurs
no–data à l’extérieur (MNE * no_data = no_data)
Voici la couche de résultat.

Cette technique est fréquemment utilisée pour masquer des valeurs dans une couche raster, et est utile toute les fois
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que vous voulez effectuer des calculs pour une région autre que la région rectangulaire arbitraire qui est utilisée par
une couche raster. Par exemple, un histogramme des élévations d’une couche raster n’a pas beaucoup de sens. S’il
est à la place calculé en utilisant seulement des valeurs qui correspondent à un bassin (comme dans le cas ci-dessus),
le résultat que nous obtenons a un sens et donne effectivement des informations sur la configuration du bassin.
Il y a d’autres choses intéressantes sur cet algorithme que nous venons juste d’exécuter en dehors des valeurs sans-
donnée et comment elles sont traitées. Si vous regardez l’emprise des couches que nous avons multipliées (vous
pouvez le faire en double-cliquant sur le nom des couches dans la table des matières et en inspectant leurs propriétés),
vous verrez que ce ne sont pas les mêmes, car l’emprise couverte par la couche d’accumulation de flux est plus petite
que l’emprise du MNE complet.
Cela signifie que ces couches ne correspondent pas et qu’elles ne peuvent pas être multipliées directement sans
homogénéiser leur tailles et leur emprises en ré-échantillonnant une ou les deux couches. Cependant, nous n’avons rien
fait. QGIS prend soin de cette situation et ré-échantillonne automatiquement les couches d’entrée lorsque nécessaire.
L’emprise de sortie est la couverture de l’emprise minimum calculée à partir des couches d’entrée et la taille de cellule
minimum de leurs tailles de cellule.
Dans ce cas (et dans la plupart des cas), cela produit les résultats souhaités, mais vous devriez toujours être conscient
des opérations supplémentaires qui ont lieu, car elles pourraient influencer sur le résultat. Dans les cas où ce
comportement ne devrait pas être désiré, un ré-échantillonnagemanuel doit être appliqué à l’avance. Dans les chapitres
suivants, nous en verrons plus sur le comportement des algorithmes lors de l’utilisation de plusieurs couches raster.
Finissons cette leçon avec un autre exercice de masquage. Nous allons calculer la pente dans toutes les aires ayant
une élévation entre 1000 et 1500 mètres.
Dans ce cas, nous n’avons pas de couche à utiliser comme masque, mais nous pouvons en créer une en utilisant la
calculatrice.
Lancez la calculatrice en utilisant le MNE comme seule couche d’entrée et la formule suivante

ifelse(abs(a-1250) < 250, 1, 0/0)

Comme vous pouvez le voir, nous pouvons utiliser la calculatrice non seulement pour faire de simples opérations
algébriques, mais aussi pour exécuter des calculs plus complexes impliquant des propositions conditionnelles, comme
celui ci-dessus.
Le résultat a une valeur de 1 dans la plage avec laquelle nous voulons travailler, et no–data dans les cellules à l’extérieur
de celle-ci.

La valeur no–data vient de l’expression 0/0. Comme c’est une valeur indéterminée, SAGA ajoutera une valeur NaN
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(Not a Numbre, pas un nombre en anglais), qui est en fait traitée comme une valeur no–data. Avec ce petit truc, vous
pouvez mettre une valeur no–data sans avoir besoin de savoir qu’est-ce que la valeur no–data de la cellule.
Vous n’avez plus qu’à maintenant la multiplier avec la couche de pente intégrée au projet, et vous obtiendrez le résultat
désiré.
Tout cela peut être fait en une simple opération avec la calculatrice. Nous laissons cela comme exercice au lecteur.

17.11 Calculatrice Vecteur

Note: Dans cette leçon, nous verrons comment ajouter de nouveaux attributs à une couche vectorielle en se basant
sur une expression mathématique, en utilisant la calculatrice vecteur.

Nous savons déjà comme utiliser la calculatrice raster pour créer de nouvelles couches raster en utilisant des
expressions mathématiques. Un algorithme semblable est disponible pour la couche vectorielle, et génère une nouvelle
couche avec les mêmes attributs que la couche d’entrée, plus un attribut supplémentaire avec le résultat de l’expression
entrée. L’algorithme est appelé Calculatrice de champ et offre les paramètres suivants.

Note: Les récentes versions de Traitement ont considérablement fait évoluer l’interface, devenant plus robuste et
plus facile à utiliser.

Voici quelques exemples d’utilisation de cet algorithme.
Tout d’abord, calculons la densité de population des personnes blanches dans chaque polygone, qui représente un
recensement. Nous avons deux champs dans la table attributaire que nous pouvons utiliser pour cela, à savoir WHITE
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et SHAPE_AREA. Nous avons juste à les diviser et les multiplier par un million (pour avoir la densité par km carré),
nous pouvons donc utiliser la formulaire suivante dans le champ correspondant :

( "WHITE" / "SHAPE_AREA" ) * 1000000

La boîte de dialogue des paramètres devrait être remplie comme montré ci-dessous :

Cela va générer un nouveau champ appelé WHITE_DENS
Calculons maintenant dans un nouveau champ le ratio entre les champs MALES` et FEMALES pour voir si la
population masculine est numériquement prédominante sur la population féminine.
Entrez la formule suivante

"MALES" / "FEMALES"

Cette fois, la fenêtre des paramètres devrait ressembler à cela avant de cliquer sur le bouton OK.
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Dans la version précédente, les deux champs étant de type entier, le résultat sera tronqué en un entier. Pour indiquer
que le résultat souhaiter doit être à virgule flottante, la formule devrait être: 1.0 * "MALES" / "FEMALES".
Nous pouvons utiliser des fonctions conditionnelles pour avoir un nouveau champ avec comme chaîne de caractères
mâle ou femelle à la place de ces valeurs de rapport, en utilisant la formule suivante:

CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

La fenêtre des paramètres devrait ressembler à ceci.
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Une calculatrice de champ python est disponible dans laCalculatrice de champ avancée Python qui ne sera pas détaillée
ici
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17.12 Définition des étendues

Note: Dans cette leçon, nous verrons comment définir les emprises qui sont nécessaires pour certains algorithmes,
en particulier ceux avec des rasters.

Certains algorithmes nécessitent une étendue pour définir l’aire à couvrir par l’analyse qu’ils effectuent, et
habituellement, définir l’étendue de la couche de résultat.
Lorsqu’une emprise est nécessaire, elle peut être définie manuellement en entrant les quatre valeurs qui la définissent
(X min, Y min, X max, Y max), mais il y a aussi d’autres façons plus pratiques et plus intéressantes de le faire. Nous
les verrons toutes dans cette leçon.
Premièrement, ouvrons un algorithme qui requière une étendue comme paramètre. Ouvrez l’algorithme Rasterisation,
qui crée une couche raster à partir d’une couche vectorielle.
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Tous les paramètres, sauf les deux derniers, sont utilisés pour définir quelle couche doit être transformée en raster,
et configurer la façon dont le processus de rasterisation doit fonctionner. Les deux derniers paramètres, en revanche,
définissent les caractéristiques de la couche en sortie. Cela signifie qu’ils définissent la zone couverte (qui n’est pas
nécessairement la même zone que celle couverte par la couche de type vecteur en entrée), et la résolution/taille de
cellule (qui ne peut être déduite de la couche vecteur, puisque les couches vecteur n’ont pas de taille de cellule).
La première chose que vous pouvez faire est de taper les 4 valeurs définies expliquées plus tôt, séparées par des
virgules.

Cela ne nécessite pas d’explication supplémentaire. Bien que ce soit l’option la plus flexible, c’est aussi la moins
pratique dans certains cas, et c’est pourquoi d’autres options sont mises en oeuvre. Pour y accéder, vous devez cliquer
sur le bouton sur le côté droit de la zone de texte étendue.

Voyons ce que fait chacune d’entre elles.
La première option est Utiliser l’emprise de la couche/du canevas, qui montrera la boîte de dialogue de sélection
montrée ci-dessous.
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Ici vous pouvez sélectionner l’étendue du canevas (dans la mesure prévue par le zoom en cours), ou l’extension de
n’importe quelles couches disponibles. Sélectionnez-la et cliquez sur OK, et la zone de texte sera automatiquement
remplie avec les valeurs correspondantes.
La seconde option est Sélectionner l’emprise depuis le canevas. Dans ce cas, la boîte de dialogue de l’algorithme
disparaît et vous pouvez cliquer et faire glisser sur le canevas QGIS pour définir l’étendue désirée.

Une fois que vous relâchez le bouton de la souris, la boîte de dialogue réapparaîtra et la zone de texte aura déjà les
valeurs correspondantes à l’emprise définie.
La dernière option est Utiliser l’étendue de couverture minimale depuis les couches d’entrée, qui est l’option par défaut.
Cette fonction calcule l’étendue de couverture minimale de toutes les couches utilisées pour exécuter l’algorithme,
et il n’y a pas besoin d’entrer de valeur dans la zone de texte. Dans le cas d’une seule couche d’entrée, comme dans
l’algorithme que nous avons lancé, la même étendue peut être obtenue en sélectionnant cette même couche d’entrée
dans Utiliser l’emprise de la couche/du canevas que nous avons déjà vu. Cependant, quand il y a plusieurs couches
d’entrée, l’étendue de couverture minimale ne doit correspondre à aucune étendue d’une des couches d’entrée, car elle
est calculée à partir de toutes les couches mises ensemble.
Nous utiliserons cette dernière méthode pour exécuter notre algorithme de mise en raster.
Remplissez la boîte de dialogue des paramètres comme montré par la suite et cliquez sur OK.
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Note: Dans ce cas, utilisez plutôt un entier (1 octet) au lieu d’un réel (4 octets), car NAME est un entier ayant une
valeur maximum=64. Une taille de fichier plus petite et des calculs plus rapides en résulteront.

Vous obtiendrez une couche de numérisation qui couvre exactement la zone couverte par la couche vecteur originale.
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Dans certains cas, la dernière option, Utiliser l’emprise de couverture minimale depuis les couches d’entrée, pourrait ne
pas être disponible. C’est le cas avec les algorithmes qui n’ont pas de couches d’entrée, mais seulement des paramètres
d’autres types. Dans ce cas, vous devrez entrer la valeur manuellement ou utiliser une des autres options.
Notez que, lorsqu’une sélection existe, l’emprise de la couche est celle de l’ensemble des entités et la sélection n’est
pas utilisée pour calculer l’emprise, même si la mise en raster ne se fait que sur les éléments sélectionnés. Dans ce
cas, vous pouvez alors vouloir créer une nouvelle couche à partir de la sélection et ensuite l’utiliser comme entrée.

17.13 Sorties HTML

Note: Dans cette leçon, nous apprenons comment QGIS gère les sorties en format HTML, qui sont utilisées pour
produire des sorties texte et graphiques.

Toutes les sorties que nous avons produites jusqu’à maintenant étaient des couches (soit raster soit vecteur).
Cependant, certains algorithmes génèrent des sorties sous forme de textes et de graphiques. Toutes ces sorties sont
intégrées dans des fichiers HTML et affichées dans un Affichage des résultats, comme appelé, qui est un autre élément
du module de traitement.
Voyons un de ces algorithmes pour comprendre comment ils fonctionnent.
Ouvrez le projet avec les données à utiliser dans cette leçon et ensuite ouvrez l’algorithme Statistiques basiques pour
champs numériques.
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L’algorithme est assez simple, et vous avez juste à sélectionner la couche à utiliser et un de ses champs (un numérique).
La sortie est de type HTML, mais le champ correspondant fonctionne exactement comme celui que vous pouvez
trouver dans le cas d’une sortie raster ou vecteur. Vous pouvez entrer un chemin de fichier ou le laisser blanc
pour sauvegarder en tant que fichier temporaire. Dans ce cas, cependant, seul le html et les extensions html
sont autorisés, il n’y a donc aucun moyen de modifier le format de sortie en utilisant un autre format.
Lancez l’algorithme en sélectionnant la seule couche dans le projet comme entrée, et le champ POP2000, et une
nouvelle boîte de dialogue comme celle montrée après apparaîtra une fois l’algorithme exécuté et la boîte de dialogue
des paramètres fermée.

574 Chapter 17. Le Guide du module Traitements de QGIS



QGIS Training Manual

Voici le Visualiseur de résultats. Il conserve tous les résultats HTML générés durant la session actuelle, et il est
facilement accessible. Vous pouvez donc les vérifier rapidement chaque fois que vous en avez besoin. Comme pour
les couches, si vous avez sauvegardé la sortie dans un fichier temporaire, il s’effacera une fois que vous fermerez
QGIS. Si vous avez sauvegardé sous un chemin non temporaire, le fichier restera, mais il n’apparaîtra pas dans le
Visualiseur de résultats la prochaine fois que vous ouvrirez QGIS.
Certains algorithmes génèrent du texte qui ne peut pas être divisé en d’autres sorties plus détaillées. C’est le cas,
par exemple, si l’algorithme saisit la sortie de texte à partir d’un processus externe. Dans d’autres cas, la sortie se
présente sous forme de texte, mais est divisée à l’intérieur en plusieurs petites sorties, habituellement sous forme de
valeurs numériques. L’algorithme que nous venons d’exécuter est l’un de ceux-ci. Chacune de ses valeurs est traitée
comme une sortie unique, et stockée dans une variable. Cela n’a pas du tout d’importance pour l’instant, mais une fois
que nous passerons au modeleur graphique, vous verrez que cela nous permet d’utiliser ces valeurs comme entrées
numériques pour d’autres algorithmes.
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17.14 Premier exemple d’analyse

Note: Dans cette leçon, nous effectuerons une véritable analyse en utilisant uniquement la boîte à outils, afin que
vous puissiez vous familiariser avec les éléments du module de traitements.

Maintenant que tout est configuré et que nous pouvons utiliser des algorithmes externes, nous avons un outil très
puissant pour effectuer une analyse spatiale. Il est temps de réaliser un exercice plus important avec des données du
monde réel.
Nous utiliserons l’ensemble de données bien connu que John Snow a utilisé en 1854, dans ses travaux
révolutionnaires (https://en.wikipedia.org/wiki/John_Snow_%28physician%29), et nous obtiendrons des résultats
intéressants. L’analyse de cet ensemble de données est assez évidente et il n’est pas nécessaire de recourir à des
techniques SIG sophistiquées pour obtenir de bons résultats et conclusions, mais c’est un bon moyen de montrer
comment ces problèmes spatiaux peuvent être analysés et résolus en utilisant différents outils de traitement.
Le jeu de données contient des fichiers Shape qui référencent les décès dus au choléra, les emplacements des pompes
à eau ainsi qu’une carte raster issue d’OSM au format TIFF. Ouvrez le projet QGIS correspondant à cette leçon.

La première chose à faire est de calculer le diagramme de Voronoï (alias polygones de Thiessen) de la couche des
pompes, pour obtenir la zone d’influence de chaque pompe. L’algorithme du diagramme de Voronoï peut être utilisé
pour cela.
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C’est assez facile, mais cela nous donne déjà des informations intéressantes.
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Il est clair que la plupart des cas soient dans un des polygones.
Pour obtenir un résultat plus quantitatif, nous pouvons compter le nombre de décès dans chaque polygones. Comme
chaque point représente un bâtiment où il y a eu un ou des décès, et que le nombre de décès est stocké dans un attribut,
nous ne pouvons pas simplement compter les points. Nous avons besoin d’un nombre pondéré, donc nous utiliserons
l’outil Compter les points dans les polygones (pondérés).
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Le nouveau champ sera appelé DEATHS, et nous utiliserons le champ COUNT comme champ de pondération. La
table de résultats reflète clairement que le nombre de décès dans le polygone correspondant à la première pompe est
beaucoup plus grand que celui des autres.
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Une autre bonne façon de visualiser la dépendance de chaque point dans la couche Cholera_deaths avec un
point dans la couche Pumps est de dessiner une ligne vers le plus proche. Cela peut être fait avec l’outil Distance au
nœud le plus proche, et en utilisant la configuration montrée ci-après.
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Le résultat ressemble à cela :
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Bien que le nombre de lignes soit plus grand dans le cas de la pompe centrale, n’oubliez pas que cela ne représente par
le nombre de décès, mais le nombre de lieux où des cas de choléra ont été détecté. C’est un paramètre représentatif,
mais il ne considère pas que certains emplacements puissent représenter plus de cas qu’un autre.
Une couche de densité nous donnera aussi une vision très claire de ce qu’il se passe. Nous pouvons la créer avec
l’algorithme Densité par noyau. En utilisant la couche Cholera_deaths et son champ COUNT comme champ de
pondération, avec un rayon de 100 ainsi que l’emprise et la taille des cellule de la couche raster des rues, nous
obtenons quelque chose comme ça.
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Souvenez-vous que pour obtenir l’emprise de sortie, vous ne devez pas la taper. Cliquez sur le bouton sur le côté droit
et sélectionnez Utiliser l’emprise de la couche/du canevas.
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Sélectionnez la couche raster des routes et son étendue sera automatiquement ajoutée au champ de texte. Vous devez
faire de même avec la taille de cellule, en sélectionnant la taille de cellule de cette couche.
En combinant la couche des pompes, nous voyons qu’il y a une pompe qui se trouve clairement dans le point chaud
où la densité maximale de cas de décès a été trouvée.

17.15 Découpage et fusion de couches raster

Note: Dans cette leçon, nous verrons un autre exemple de préparation de données spatiales, pour continuer à utiliser
des géoalgorithmes dans des scénarios du monde réel.

Pour cette leçon, nous allons calculer une couche de pente pour une zone entourant une zone de ville, qui est donnée
dans une couche vecteur avec un seul polygone. Le MNT de base est divisé en deux couches raster qui, ensemble,
couvrent une zone beaucoup plus grande que celle autour de la ville avec laquelle nous voulons travailler. Si vous
ouvrez le projet correspondant à cette leçon, vous verrez quelque chose comme ça.
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Ces couches ont deux problèmes :
• Elles couvrent une aire qui est trop grande pour ce que l’on veut (nous nous intéressons à une plus petite région
autour du centre ville)

• Elles sont dans deux fichiers différents (les limites de la ville tombent dans une seule couche raster, mais,
comme cela a été dit, nous voulons des zones supplémentaires autour d’elle).

Ces deux problèmes sont facilement résolvables avec les géoalgorithmes appropriés.
Premièrement, nous créons un rectangle définissant la zone que nous voulons. Pour faire cela, nous créons une couche
contenant l’emprise rectangulaire de la couche avec les limites de la zone de la ville, et ensuite nous lui ajoutons un
tampon, afin d’obtenir une couche raster qui couvre un peu plus que le strict nécessaire.
Pour calculer l’emprise rectangulaire, nous pouvons utiliser l’algorithme Créer un polygone à partir de l’emprise d’une
couche.
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Pour lui ajouter un tampon, nous utilisons l’algorithme Tampon à distance fixe, avec les valeurs de paramètres
suivantes.
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Avertissement: La syntaxe a changé dans les récentes versions; définissez la Distance et l’Arc de vertex à .25

Voici l’emprise résultante obtenue en utilisant les paramètres montrés au-dessus.

Il s’agit d’un rectangle arrondi, mais nous pouvons facilement obtenir l’emprise équivalente avec des angles droits, en
lançant sur elle l’algorithme Créer un polygone à partir de l’emprise de la couche. Nous aurions pu créer un tampon
sur les limites de la ville d’abord et ensuite calculer l’emprise rectangulaire, ce qui nous aurait économisé une étape.
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Vous remarquerez que les rasters ont une projection différente de celle du vecteur. Nous devons donc les reprojeter
avant de poursuivre, en utilisant l’outil Projection (reprojection).

Note: Les versions récentes ont des interfaces plus complexes. Sélectionnez au moins une méthode de compression.

Avec cette couche qui contient l’emprise rectangulaire de la couche raster que nous voulons obtenir, nous pouvons
recadrer les deux couches rasters, en utilisant l’algorithme Découper un raster selon une couche de masque.
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Une fois que les couches ont été recadrées, elles peuvent être fusionnées en utilisant l’algorithmeMosaic raster layers
de SAGA.
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Note: Vous pouvez gagner du temps en fusionnant d’abord et en recadrant ensuite, et vous éviterez d’appeler deux
fois l’algorithme de découpage. Cependant, s’il y a plusieurs couches à fusionner et qu’elles ont une assez grande
taille, vous finirez avec une grande couche qui pourra être difficile à traiter plus tard. Dans ce cas, vous devriez
appeler l’algorithme de découpage plusieurs fois, ce qui peut prendre beaucoup de temps, mais ne vous inquiétez pas,
nous verrons bientôt qu’il existe des outils supplémentaires pour automatiser cette opération. Dans cet exemple, nous
n’avons que deux couches, donc vous n’aurez pas besoin de vous soucier de cela maintenant.

Avec cela, nous obtenons le MNT final que nous voulons.
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Il est maintenant temps de calculer la couche de pente.
Une couche de pente peut être calculée avec l’algorithme Pente, Aspect, Courbes, mais le MNT obtenu dans la dernière
étape n’est pas approprié comme entrée, puisque les valeurs d’élévation sont en mètre mais la taille de cellule n’est pas
exprimée en mètre (la couche utilise un SCR avec des coordonnées géographiques). Une reprojection est nécessaire.
Pour reprojeter une couche raster, l’algorithme Projection (reprojection) peut encore être utilisé. Nous reprojetons
dans un SCR avec des mètres comme unités (par exemple 3857), donc nous pouvons ensuite calculer correctement
la pente, avec soit SAGA soit GDAL.
Avec ce nouveau MNT, la pente peut maintenant être calculée.
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Et voici la couche de pente de résultat.

592 Chapter 17. Le Guide du module Traitements de QGIS



QGIS Training Manual

La pente produite par l’algorithme Pente, Aspect, Courbes peut être exprimée en radians, mais les degrés sont une
unité plus pratique et plus commune. L’algorithme Conversions métriques nous aidera à faire la conversion (mais dans
le cas où vous ne sauriez pas que cet algorithme existe, vous pouvez toujours utiliser la calculatrice raster que nous
avons déjà manipulée).
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En reprojetant la couche de pente reconvertie avec la Reprojection de couche raster, nous obtenons la couche finale
que nous souhaitons.

Avertissement: todo: Ajouter image

Les processus de reprojection ont peut-être généré une couche finale qui contient des données en dehors de l’emprise
que nous avons calculée dans une des premières étapes. Cela peut être résolu en la découpant à nouveau, comme nous
l’avons fait pour obtenir le MNT de base.

17.16 Analyse hydrologique

Note: Dans cette leçon nous allons réaliser une analyse hydrographique. Cette analyse sera utilisée dans certaines
des leçons suivantes, car elle constitue un très bon exemple d’un flux de travail d’analyse, et nous l’utiliserons pour
démontrer certaines fonctionnalités avancées.

Objectifs : En partant d’un MNT, nous allons extraire un réseau de canaux, délimiter les bassins versants et calculer
quelques statistiques.

1. La première chose à faire est de charger le projet avec les données de la leçon qui contient uniquement un
MNE.
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2. Le premier module à exécuter est Zone de captage (dans certaines versions de SAGA, il est appeléAccumulation
de flux (Top Down)). Vous pouvez utiliser n’importe lequel des autres modules nommés Zone de captage. Ils
ont des algorithmes différents, mais les résultats sont fondamentalement les mêmes.

3. Sélectionnez le MNT dans le champ Elevation, et laissez les valeurs par défaut pour le reste des paramètres.
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Certains algorithmes calculent plusieurs couches, mais la couche Bassin versant est la seule que nous utiliserons.
Vous pouvez vous débarrasser des autres couches si vous le souhaitez.
Le rendu de la couche n’est pas très instructif.

596 Chapter 17. Le Guide du module Traitements de QGIS



QGIS Training Manual

Pour savoir pourquoi, vous pouvez jeter un coup d’œil à l’histogramme et vous verrez que les valeurs ne sont pas
distribuées de manière uniforme (il y a quelques cellules avec une valeur très élevée, celles qui correspondent
au réseau de canaux). Utilisez l’algorithme Raster calculator pour calculer le logarithme de la surface de la
valeur du bassin versant et vous obtiendrez une couche avec beaucoup plus d’informations.
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4. La zone de captage (également connue sous le nom d’accumulation de flux) peut être utilisée pour fixer un seuil
pour l’initialisation du canal. Ceci peut être fait en utilisant l’algorithme Réseau de canaux.

• Grille d’initialisation : utilisez la couche du bassin versant et non celle du logarithme.
• Seuil d’initiation : 10.000.000
• Type d’initialisation : Supérieur à

Si vous augmentez la valeur Seuil d’initialisation, vous obtiendrez un réseau de canaux plus clairsemé. Si vous
la diminuez, vous obtiendrez un réseau plus dense. Avec la valeur proposée, voici ce que vous obtenez.
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L’image ci-dessus montre juste la couche vecteur résultante et le MNT, mais il devrait y avoir aussi une couche
raster avec le même réseau de canaux. Cette couche raster sera, en fait, la couche que nous allons utiliser.

5. Maintenant, nous allons utiliser l’algorithme bassins versants pour délimiter les sous-bassins correspondant à ce
réseau de canaux, en utilisant comme points de sortie toutes les jonctions qu’il contient. Voici comment vous
devez définir le dialogue des paramètres correspondants.
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Et voici ce que vous obtiendrez.
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6. Il s’agit d’un résultat de type raster. Vous pouvez le vectoriser en utilisant l’algorithme Vectorisation des classes
de grille.
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Maintenant, essayons de calculer des statistiques sur les valeurs d’élévation dans un des sous-bassins. L’idée est d’avoir
une couche qui représente uniquement l’élévation au sein de ce sous-bassin et ensuite de la passer aumodule qui calcule
ces statistiques.

1. Tout d’abord, nous allons découper le MNT original avec le polygone représentant un sous-bassin. Nous allons
utiliser l’algorithme découper un raster avec un polygone. Si nous sélectionnons un seul polygone de sous-bassin
et appelons ensuite l’algorithme de découpage, nous pouvons découper le MNT dans la zone couverte par ce
polygone, puisque l’algorithme est conscient de la sélection.
1. Sélectionnez un polygone
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2. Appelez l’algorithme d’écrêtage avec les paramètres suivants :
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L’élément sélectionné dans le champ de saisie est, bien entendu, le MNT que nous voulons découper.
Vous obtiendrez quelque chose comme ça.

2. Cette couche est prête à être utilisée dans l’algorithme Statistiques des couches raster.
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Les résultats des statistiques sont les suivants.

Nous utiliserons tant la procédure de calculs de bassin que le calcul statistique dans d’autres leçons pour découvrir
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comment d’autres éléments peuvent nous aider à les automatiser les deux et à travailler plus efficacement.

17.17 Starting with the model designer

Note: Dans cette leçon nous utiliserons le modeleur graphique, un élément puissant que nous pouvons utiliser pour
définir un flux de traitements et exécuter une chaîne d’algorithmes.

Une session normale avec les outils de traitement comprend plus que l’exécution d’un algorithme unique.
Habituellement, plusieurs d’entre eux sont exécutés pour obtenir un résultat et les sorties de certains de ces algorithmes
sont utilisées comme entrée pour d’autres.
Using the model designer, that workflow can be put into a model, which will run all the necessary algorithms in a
single run, thus simplifying the whole process and automating it.
Pour commencer cette leçon, nous allons calculer un paramètre nommé Indice d’Humidité Topographique.
L’algorithme qui le calcule est appelé Indice d’Humidité Topographique (twi).

Comme vous pouvez le voir, il y a deux entrées obligatoires : Pente etBassin versant. Il y a aussi une entrée optionnelle,
mais nous ne l’utiliserons pas, donc nous pouvons l’ignorer.
Les données pour cette leçon comprennent juste unMNE, donc nous n’avons aucune des entrées requises. Cependant,
nous savons comment les calculer les deux avec ce MNE, étant donné que nous avons déjà vu les algorithmes pour
calculer une pente et un bassin versant. Donc nous pouvons d’abord calculer ces couches et ensuite les utiliser pour
l’algorithme TWI.
Voici les boîtes de dialogue des paramètres que vous devriez utiliser pour calculer les 2 couches intermédiaires.
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Note: La pente doit être calculée en radians, et non en degrés.

17.17. Starting with the model designer 607



QGIS Training Manual

Et c’est comme ça que vous devez configurer la boîte de dialogue des paramètres de l’algorithme TWI.
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C’est le résultat que vous obtiendrez (la palette par défaut de pseudo-couleurs inversées de bande unique a été utilisée
pour le rendu). Vous pouvez utiliser le style twi.qml fourni.
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What we will try to do now is to create an algorithm that calculates the TWI from a DEM in just one single step.
That will save us work in case we later have to compute a TWI layer from another DEM, since we will need just one
single step to do it instead of the three above. All the processes that we need are found in the toolbox, so what we
have to do is to define the workflow to wrap them. This is where the model designer comes in.

1. Ouvrez le modeleur en sélectionnant son entrée dans le menu du traitement.

Deux choses sont nécessaires pour créer un modèle : configurer les entrées qu’il faudra, et définir l’algorithme
qu’il contient. Tous les deux sont faits en ajoutant des éléments depuis les deux onglets sur la partie gauche de
la fenêtre du modeleur : Entrées et Algorithmes.

2. Commençons avec les entrées. Dans ce cas nous ne devons pas en ajouter plus. Nous avons juste besoin d’une
couche raster avec un MNE, et ceci sera notre seule entrée de données.

3. Double-cliquez sur l’entrée Couche raster et vous verrez la boîte de dialogue suivante.

4. Ici nous devons définir l’élément en entrée à utiliser :
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1. Puisque nous nous attendons à ce que cette couche raster soit un MNT, nous l’appellerons MNT. C’est le
nom que l’utilisateur du modèle verra lors de son exécution.

2. Puisque nous avons besoin de cette couche pour fonctionner, nous la définirons comme une couche
obligatoire.

Voici comment la boîte de dialogue devrait être configurée.

5. Cliquez sur OK et l’entrée apparaîtra dans le canevas du modeleur.

6. Passons maintenant à l’onglet Algorithmes.
7. Le premier algorithme que nous devons exécuter est l’algorithme Pente, aspect, courbure. Localisez-le dans la

liste des algorithmes, double-cliquez dessus et vous verrez le dialogue ci-dessous.
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Cette boîte de dialogue est très similaire à celle que vous pouvez trouver lorsque vous exécutez l’algorithme à
partir de la boîte à outils, mais les éléments que vous pouvez utiliser comme valeurs de paramètres ne sont pas
pris dans le projet QGIS actuel, mais dans le modèle lui-même. Cela signifie que, dans ce cas, nous n’aurons
pas toutes les couches raster de notre projet disponibles pour le champ Elevation, mais seulement celles définies
dans notre modèle. Puisque nous n’avons ajouté qu’une seule entrée raster nomméeMNT, ce sera la seule couche
raster que nous verrons dans la liste correspondant au paramètre Elevation.
Les résultats générés par un algorithme sont traités un peu différemment lorsque l’algorithme est utilisé comme
partie d’un modèle. Au lieu de sélectionner le chemin de fichier où vous voulez enregistrer chaque sortie,
vous devez simplement spécifier si cette sortie est une couche intermédiaire (et vous ne voulez pas qu’elle soit
conservée après l’exécution du modèle), ou si elle est finale. Dans ce cas, toutes les couches produites par
cet algorithme sont intermédiaires. Nous n’utiliserons qu’une d’entre elles (la couche de pente), mais nous ne
voulons pas la conserver, car nous en avons juste besoin pour calculer la couche TWI, qui est le résultat final
que nous voulons obtenir.
Lorsque des couches ne sont pas un résultat final, vous devriez juste laisser le champ correspondant. Autrement,
vous devez entrer un nom qui sera utilisé pour identifier la couche dans la boîte de dialogue des paramètres qui
apparaîtra lorsque vous exécuterez plus tard le modèle.

8. Il n’y a pas grand chose à sélectionner dans ce premier dialogue, puisque nous n’avons qu’une seule couche
dans notre modèle (l’entrée MNT que nous avons créée). En fait, la configuration par défaut du dialogue est la
bonne dans ce cas, donc vous devez juste appuyer sur OK. C’est ce que vous aurez maintenant dans le canevas
du modeleur.
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9. Le second algorithme que nous devons ajouter à notre modèle est l’algorithme de bassin versant. Nous
utiliserons l’algorithme nommé Bassin versant (Parallèle). Nous utiliserons à nouveau la couche MNE comme
entrée, et aucune des sorties produites seront des sorties finales, donc voici comment vous devez remplir la
boîte de dialogue correspondante.
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Votre modèle devrait maintenant ressembler à cela.
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10. La dernière étape consiste à ajouter l’algorithme indice topographique humidité, avec la configuration suivante.

Dans ce cas, nous n’utiliserons pas le MNE comme entrée, mais à la place, nous utiliserons les couches de pente
et de surface du bassin versant qui sont calculées par les algorithmes que nous avons précédemment ajoutés.
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Lorsque vous ajoutez de nouveaux algorithmes, les sorties qu’ils produisent deviennent disponibles pour les
autres algorithmes, et en les utilisant vous reliez les algorithmes, créant le flux de traitement.

11. Dans ce cas, la couche de sortie TWI est une couche finale, nous devons donc l’indiquer. Dans la zone de texte
correspondante, entrez le nom que vous souhaitez voir apparaître pour cette sortie.
Notre modèle est maintenant terminé et il devrait ressembler à cela.

12. Saisissez un nom et un nom de groupe dans la partie supérieure de la fenêtre du modèle.

13. Enregistrez-le en cliquant sur le bouton Sauvegarder. Vous pouvez l’enregistrer où vous voulez et l’ouvrir plus
tard, mais si vous l’enregistrez dans le dossier des modèles (qui est le dossier que vous verrez lorsque le dialogue
d’enregistrement du fichier apparaîtra), votre modèle sera également disponible dans la boîte à outils. Restez
donc dans ce dossier et enregistrez le modèle avec le nom de fichier que vous préférez.

14. Fermez maintenant la boîte de dialogue du modeleur et allez dans la boîte à outils. Dans l’entrée modèle, vous
trouverez votre modèle.
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15. Vous pouvez l’exécuter comme n’importe quel algorithme normal, en double-cliquant dessus.

Comme vous pouvez le voir, la boîte de dialogue des paramètres contient l’entrée que vous avez ajoutée au
modèle, de même que les sorties que vous avez configurées comme finales lors de l’ajout des algorithmes
correspondants.

16. Exécutez-le en utilisant le MNE comme entrée et vous obtiendrez la couche TWI en seulement une seule étape.
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17.18 Des modèles plus complexes

Note: Dans cette leçon nous travaillerons avec un modèle plus complexe dans le modeleur graphique.

Le premier modèle que nous avons créé dans le chapitre précédent était très simple, avec seulement une entrée et
trois algorithmes. Des modèles plus complexes peuvent être créés, avec différents types d’entrée et contenant plus
d’étapes. Dans ce chapitre nous travaillerons avec un modèle qui crée une couche vectorielle avec des bassins versants
basés sur un MNE et une valeur de seuil. Cela sera très utile pour calculer plusieurs couches vecteur correspondant
à différents bassins versants, sans avoir à répéter chacune des étapes à chaque fois.
Cette leçon ne contient pas d’instructions sur comment créer votremodèle. Vous connaissez déjà les étapes nécessaires
(nous les avons vues dans une leçon précédente) et vous avez déjà vu les bases du modeleur, donc vous devrez essayer
de le faire vous-même. Passez quelques minutes à essayer de créer votre modèle, et n’ayez crainte de faire des erreurs.
Souvenez-vous : premièrement, ajoutez les entrées et ensuite ajoutez les algorithmes qui les utilisent pour créer le
flux de traitements.

Note: Dans le cas où vous ne pourriez pas créer le modèle complet vous-même et que vous avez besoin d’aide
supplémentaire, le dossier de données correspondant à cette leçon contient la version “presque” terminée de celui-ci.
Ouvrez le modeleur et ensuite ouvrez le fichier modèle que vous trouverez dans le dossier de données. Vous devriez
voir quelque chose comme cela.

Ce modèle contient toutes les étapes nécessaires pour compléter le calcul, mais il n’a seulement qu’une entrée : le
MNE. Cela signifie que le seuil pour la définition du canal utilise une valeur fixe, ce qui rend le modèle pas aussi utile
qu’il aurait pu l’être. Ce n’est pas un problème, étant donné que nous pouvons modifier le modèle, et c’est exactement
ce que nous allons faire.

1. Premièrement, ajoutons une entrée numérique. Cela demandera à l’utilisateur de fournir un nombre que nous
pouvons utiliser lorsqu’une telle valeur est nécessaire dans un des algorithmes inclus dans notre modèle.

2. Cliquez sur l’entrée Nombre dans la liste des Entrées, et vous verrez la boîte de dialogue correspondante.
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3. Fill it with the following values.
• Nom du paramètre : Seuil pour la définition du canal

• Valeur par défaut: 1 000 000

Votre modèle devrait maintenant ressembler à cela.

L’entrée que nous venons d’ajouter n’est pas utilisée, donc le modèle n’a pas réellement changé. Nous devons
lier cette entrée à l’algorithme qui l’utilise, dans ce cas le réseau de canaux. Pour modifier un algorithme qui
existe déjà dans le modeleur, il suffit de cliquer sur l’icône du stylo sur la case correspondante dans le canevas.

4. Cliquez sur l’algorithme Réseau de canaux et vous verrez quelque chose comme ceci.
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Le dialogue est rempli avec les valeurs actuelles utilisées par l’algorithme. Vous pouvez voir que le paramètre
Seuil d’initialisation a une valeur fixe de 1 000 000 (c’est aussi la valeur par défaut de l’algorithme, mais n’importe
quelle autre valeur peut y être placée). Cependant, vous pouvez remarquer que le paramètre n’est pas saisi dans
une zone de texte ordinaire, mais dans un menu déroulant.

5. Déployez le menu des paramètres de seuil et vous verrez quelque chose comme ceci.
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L’entrée que nous avons ajoutée est là et nous pouvons la sélectionner. Chaque fois qu’un algorithme dans un
modèle requière une valeur numérique, vous pouvez la coder en dur et directement la taper, ou vous pouvez
utiliser l’une des entrées et valeurs disponibles (souvenez-vous que certains algorithmes génèrent des valeurs
numériques individuelles. Nous en verrons bientôt plus là-dessus). Dans le cas d’un paramètre de chaîne de
caractères, vous verrez également des entrées de chaînes de caractères et vous pourrez sélectionner l’une d’entre
elles ou taper la valeur fixe souhaitée.

6. Sélectionnez le paramètre Seuil de définition des canaux dans le paramètre Seuil d’initialisation.
7. Cliquez sur OK pour appliquer les modifications à votre modèle. La conception du modèle devrait maintenant

ressembler à ceci.
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8. Le modèle est maintenant complet. Exécutez-le en utilisant le MNT que nous avons utilisé dans les leçons
précédentes, et avec différentes valeurs de seuil.
Vous avez ci-dessous un échantillon du résultat obtenu pour différentes valeurs. Vous pouvez comparer avec
le résultat pour la valeur par défaut, qui est celle que nous avons obtenue dans hydrological analysis lesson.

Figure17.1: Seuil = 100 000
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Figure17.2: Seuil = 1 000 000

17.19 Calculs numériques dans le modeleur

Avertissement: Prenez garde, ce chapitre n’est pas bien testé, s’il vous plaît rapporter tous problèmes ; les images
sont manquantes

Note: Dans cette leçon nous verrons comment utiliser des sorties numériques dans le modeleur

Pour cette leçon, nous allons modifier le modèle hydrologique que nous avons créé dans le dernier chapitre (ouvrez-le
dans le modeleur avant de commencer), de sorte que nous puissions automatiser le calcul d’une valeur de seuil valide
et que nous n’ayons pas besoin de demander à l’utilisateur de l’entrer. Comme cette valeur fait référence à la variable
dans la couche raster de seuil, nous l’extrairons de cette couche, basée sur une analyse statistique simple.
En commençant avec le modèle précédemment mentionné, faisons les modifications suivantes :
Premièrement, calculons les statistiques de la couche d’accumulation de flux en utilisant l’algorithme Statistiques de
la couche raster.
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Cela va générer un ensemble de valeurs statistiques qui serontmaintenant disponibles pour tous les champs numériques
dans les autres algorithmes.
Si vous éditez l’algorithme Réseau de canaux comme nous l’avons fait dans la dernière leçon, vous verrez que vous
avez maintenant d’autres options en dehors de l’entrée numérique que vous avez ajoutée.
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Cependant, aucune de ces valeurs n’est apte à être utilisée comme un seuil valable, étant donné qu’elles auront comme
résultat des réseaux de canaux qui ne seront pas très réalistes. Nous pouvons, à la place, tirer quelques nouveaux
paramètres à partir d’elles, pour obtenir un meilleur résultat. Par exemple, nous pouvons utiliser la moyenne plus 2
fois l’écart-type.
Pour ajouter cette opération arithmétique, nous pouvons utiliser la calculatrice que vous trouverez dans le groupe
Géoalgorithmes/modeleur/outils du modeleur. Ce groupe contient des algorithmes qui ne sont pas très utiles en dehors
de ce modeleur, mais qui fournissent des fonctionnalités utiles lors de la création d’un modèle.
La boîte de dialogue des paramètres de l’algorithme de la calculatrice ressemble à ça :
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Comme vous pouvez le voir, la boîte de dialogue est différente des autres que nous avons vues, mais vous avez ici les
mêmes variables qui étaient disponibles dans le champ Seuil dans l’algorithme Réseau de canaux. Entrez la formule
ci-dessous et cliquez sur OK pour ajouter l’algorithme.

Si vous étendez l’entrée des sorties, comme montré ci-dessus, vous verrez que le modèle est relié à deux des valeurs,
à savoir la moyenne et l’écart-type, qui sont celles que nous avons utilisées dans la formule.
L’ajout de ce nouvel algorithme va ajouter une nouvelle valeur numérique. Si vous ouvrez de nouveau l’algorithme
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Réseau de canaux, vous pouvez maintenant sélectionner cette valeur dans le paramètre Seuil.

Cliquez sur OK et votre modèle devrait ressembler à cela.
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Nous n’utilisons pas l’entrée numérique que nous avons ajoutée au modèle, donc elle peut être supprimée. Faites un
clic–droit dessus et sélectionnez Supprimer.

Avertissement: todo: Ajouter image

Notre nouveau modèle est maintenant terminé.

17.20 Un modèle dans un modèle

Avertissement: Prenez garde, ce chapitre n’est pas bien testé, s’il vous plaît rapporter tous problèmes ; les images
sont manquantes

Note: Dans cette leçon nous verrons comment utiliser un modèle dans un modèle plus grand.

Nous avons déjà créé quelques modèles, et dans cette leçon nous allons voir comment nous pouvons les combiner
dans un seul plus grand modèle. Un modèle se comporte comme n’importe quel autre algorithme, ce qui signifie que
vous pouvez ajouter un modèle que vous avez déjà créé dans le cadre d’un autre modèle que vous créerez par la suite.
Dans ce cas, nous allons étendre notre modèle hydrologique en ajoutant la valeur moyenne TWI dans chacun des
bassins qu’il génère comme résultat. Pour ce faire, nous devons calculer le TWI et calculer les statistiques. Comme
nous avons déjà créé un modèle pour calculer le TWI depuis un MNE, c’est une bonne idée de réutiliser ce modèle
au lieu d’ajouter les algorithmes qu’il contient individuellement.
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Commençons avec le modèle que nous avons utilisé comme point de départ pour la dernière leçon.

Avertissement: todo: Ajouter image

Premièrement, nous ajouterons le modèle TWI. Pour qu’il soit disponible, il aurait dû être enregistré dans le dossier
des modèles, autrement il ne sera pas affiché dans la boîte à outils ou dans la liste des algorithmes dans le modeleur.
Assurez-vous que vous l’avez rendu disponible.
Ajoutez-le au modèle actuel et utilisez le MNE d’entrée comme son entrée. La sortie est temporaire, car nous voulons
juste la couche TWI pour calculer les statistiques. L’unique sortie de ce modèle que nous avons créé sera toujours la
couche vectorielle avec les bassins versants.
Voici la boîte de dialogue des paramètres correspondants :

Avertissement: todo: Ajouter image

Nous avons maintenant une couche TWI que nous pouvons utiliser avec la couche vectorielle des bassins versants
pour générer une nouvelle couche qui contienne les valeurs du TWI correspondant à chaque bassin versant.
Ce calcul est fait en utilisant l’algorithme Statistiques de la grille en polygones. Utilisez les couches mentionnées
ci-dessus comme entrée pour créer le résultat final.

Avertissement: todo: Ajouter image

La sortie de l’algorithme Classes des grilles vectorisées était à l’origine notre sortie finale, mais maintenant nous la
voulons simplement comme un résultat intermédiaire. Pour changer cela, nous devons modifier l’algorithme. Double–
cliquez simplement dessus pour voir la boîte de dialogue de ses paramètres, et supprimez le nom de la sortie. Cela
va faire une sortie temporaire, comme c’est le cas par défaut.

Avertissement: todo: Ajouter image

Voici à quoi le modèle final devrait ressembler :

Avertissement: todo: Ajouter image

Comme vous le voyez, utiliser un modèle dans un autre modèle n’est rien de spécial, et vous pouvez l’ajouter
simplement comme vous ajoutez un autre algorithme, tant que le modèle est sauvegardé dans le dossier des modèles
et est disponible dans la boîte à outils.

17.21 Utilisation d’outils de modélisation uniquement pour créer
un modèle

Note: Cette leçon montre comment utiliser quelques algorithmes disponibles seulement dans le modeleur, pour
apporter des fonctionnalités additionnelles aux modèles.

L’objectif de cette leçon est d’utiliser le modeleur pour créer un algorithme d’interpolation qui prend en compte la
sélection active , pas seulement pour utiliser les entités sélectionnées, mais pour utiliser l’emprise de cette sélection
afin de créer la couche raster interpolarisée.
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Le processus d’interpolation implique deux étapes, comme il a déjà été expliqué dans de précédentes leçons : rasteriser
les couches de points et remplir les valeurs absentes qui apparaissent dans la couche rastérisée. Dans le cas où la
couche de points a une sélection, seuls les points sélectionnés seront utilisés, mais si l’étendue de sortie est définie
pour être automatiquement ajustée, l’étendue complète de la couche sera utilisée. C’est-à-dire que l’étendue de la
couche est toujours considérée comme l’étendue totale de toutes les entités, et non celle calculée à partir des seules
sélectionnées. Nous allons essayer de résoudre ce problème en utilisant des outils supplémentaires dans notre modèle.
Ouvrez le modeleur et commencez le modèle en ajoutant les entrées demandées. Dans ce cas nous avons besoin
d’une couche vecteur (restreintes aux points) et un attribut en provenant, avec les valeurs que nous utiliserons pour la
rasterisation.

L’étape suivante consiste à calculer l’emprise de l’entité sélectionnée. C’est là que nous pouvons utiliser l’outil de
modélisation unique appelé Vector layer bounds. D’abord, nous allons devoir créer une couche qui possède une
emprise de ces entités sélectionnée. Ensuite nous pourrons utiliser cet outil sur cette couche.
Une manière simple de créer une couche avec l’étendue des entités sélectionnées consiste à calculer une enveloppe
convexe de la couche de points d’entrée. Cela utilisera uniquement les points sélectionnés, de sorte que l’enveloppe
convexe aura la même boîte englobante que la sélection. Ensuite, nous pouvons ajouter l’algorithme Limites de la
couche vecteur, et utiliser la couche de l’enveloppe convexe en entrée. Cela devrait ressembler à ça dans l’espace de
travail du modeleur :

630 Chapter 17. Le Guide du module Traitements de QGIS



QGIS Training Manual

Le résultat du Vector layer bounds est un ensemble de quatre valeurs numériques et d’une emprise d’objet. Nous
utiliserons à la fois les résultats numériques et l’emprise pour cet exercice.

Nous pouvons maintenant ajouter l’algorithme qui rasterise la couche vecteur, en utilisant comme source l’emprise
de l’algorithme du Vector layer bounds
Remplissez les paramètres de l’algorithme comme montré par la suite :
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Le canvas devrait être :
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Enfin, remplissez les valeurs absentes de la couche raster avec l’algorithme Close gaps.

L’algorithme est maintenant prêt à être sauvegardé et ajouté à la boîte à outil. Vous pouvez le lancer et cela génèrera
une couche raster depuis l’interpolation des points sélectionnés dans la couche d’entrée, et la couche aura la même
emprise que la sélection.
Voici une amélioration de l’algorithme. Nous avons utilisé une valeur programmée pour la taille de la cellule quand
s’est rasterisé. Cette valeur est bonne pour notre test de couche d’entrée, mais elle ne le sera peut être pas pour d’autres
cas. Nous pouvons ajouter de nouveaux paramètres, afin que l’utilisateur entre les valeurs qu’il souhaite, mais une
meilleur approche serait d’avoir cette valeur automatiquement calculer.
Nous pouvons utiliser la calculateur de modèle simple, et calculer cette valeur à partir des coordonnées d’étendue.
Par exemple, pour créer une couche avec une largeur fixe de 100 pixels, nous pouvons utiliser la formule suivante
dans la calculatrice.
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Maintenant, nous devons éditer l’algorithme de rasterisation, afin qu’il utilise la sortie de la calculatrice au lieu de la
valeur programmée.
Le script complet devrait être :
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17.22 Interpolation

Note: Ce chapitre explique comment interpoler des données points et présente un autre exemple concret d’utilisation
de l’analyse spatiale.

Dans cette leçon, nous allons interpoler des points afin d’obtenir une couche raster. Avant de le faire, nous devons
préparer les données. Nous modifierons également la couche obtenue après l’interpolation afin de couvrir l’intégralité
du processus d’analyse.
Ouvrez les données de l’exemple fourni pour cette leçon. Cela devrait ressembler à cela :

Ces données correspondent à des rendements agricoles tels qu’une moissonneuse moderne peut fournir, et nous les
utiliserons afin d’obtenir une couche raster. Nous ne prévoyons pas d’analyser cette couche davantage par la suite.
Nous allons juste l’utiliser comme fond de plan afin d’identifier facilement les zones les plus productives et celles où
la production pourrait être optimisée.
La première chose à faire est de nettoyer la couche car certains points sont redondants. Cela est dû à la conduite de la
moissonneuse : pour une raison ou une autre elle a dû tourner ou changer de vitesse à certains endroits. L’algorithme
Filtrer points sera utile pour ceci. Nous l’utiliserons deux fois afin de supprimer à la fois les points qui peuvent être
considérés comme aberrants car sortant de la norme par le haut ou par le bas.
Pour la première exécution, utilisez les valeurs suivantes des paramètres.
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Pour le second filtrage, utilisez les paramètres suivants :
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Notez que vous n’utilisez pas la couche de départ comme entrée, mais la sortie de la précédente itération.
La couche « filtrée » finale devrait ressembler à la couche originelle avec pour seule différence un nombre réduit de
points. Vous pouvez vérifier cela en comparant leurs tables d’attributs.
Transformons maintenant la couche en raster au moyen de l’algorithme « rasterize ».
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La couche Filtered points réfère à celle résultant de l’application du second filtre. Attention, étant donné que le nom
est assigné par l’algorithme, elle a le même nom que celle produite suite à l’application du premier filtre. Il faut utiliser
la seconde couche produite. Afin d’éviter toute confusion et étant donné que nous n’allons pas utiliser la première
couche produite, vous pouvez la supprimer de votre projet et ne garder que la dernière couche.
La couche raster résultante devrait ressembler à ceci :
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Il s’agit déjà une couche raster, mais certaines de ses cellules manquent de données. Elle ne contient des données que
dans les cellules où se trouvait un point. Toutes les autres cellules ont été attribuées la valeur « pas de donnée ». Afin
de compléter les valeurs manquantes, nous pouvons utiliser l’algorithme Close gaps.
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La couche complétée ressemble à ceci :
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Afin de restreindre la couche uniquement à la zone où les rendements agricoles ont été effectivement mesurés, nous
pouvons ne garder de la couche raster que ce qui correspond à la couche « limits » fournie.
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Et pour un résultat plus lissé (moins précis mais plus adéquat pour être utilisé comme couche de fond) nous pouvons
y appliquer un filtre Gaussien.
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Avec les paramètres précédents, vous obtiendrez le résultat suivant :
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17.23 Plus d’interpolation

Note: Ce chapitre montre un autre cas pratique où les algorithmes d’interpolation sont utilisés.

L’interpolation est une technique commune, et elle peut être utilisée pour démontrer plusieurs techniques qui peuvent
être appliquées en utilisant le module de traitements QGIS. Cette leçon utilise certains algorithmes d’interpolation
qui ont déjà été introduits, mais utilise une approche différente.
Les données pour cette leçon contiennent également une couche de points, dans ce cas avec des données d’élévation.
Nous allons les interpoler principalement de la même façon que nous l’avons fait dans la leçon précédente, mais
cette fois nous sauvegarderons une partie des données originales pour les utiliser pour évaluer la qualité du processus
d’interpolation.
Premièrement, nous devons pixeliser la couche de points et remplir les cellules no–data résultantes, mais en utilisant
seulement une fraction des points dans la couche. Nous sauvegarderons 10% des points pour une prochaine
vérification, donc nous avons besoin de 90% des points prêts pour l’interpolation. Pour se faire, nous pourrions utiliser
l’algorithme Séparer une couche de formes aléatoirement, que nous avons déjà utilisé dans une précédente leçon, mais
il y a une meilleure manière de faire cela, sans avoir à créer une nouvelle couche intermédiaire. À la place de cela,
nous pouvons simplement sélectionner les points que nous voulons utiliser pour l’interpolation (la fraction de 90%),
puis exécuter l’algorithme. Comme nous l’avons déjà vu, l’algorithme de pixelisation utilisera seulement les points
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sélectionnés et ignorera le reste. La sélection peut être faite en utilisant l’algorithme Sélection aléatoire. Lancez-le
avec les paramètres suivants.

Cela va sélectionner 90% des points dans la couche à pixeliser
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La sélection est aléatoire, donc votre sélection devrait différer de la sélection montrée dans l’image ci-dessus.
Exécutez maintenant l’algorithme Rastériser pour obtenir la première couche raster, et ensuite exécutez l’algorithme
Combler les lacunes pour remplir les cellules sans–données [Résolution de cellule : 100 m].
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Pour vérifier la qualité de l’interpolation, nous pouvons maintenant utiliser les points qui n’ont pas été sélectionnés.
Nous connaissons, en ce point, l’élévation réelle (la valeur dans la couche de points) ainsi que l’élévation interpolée
(la valeur présente dans la couche raster interpolée). Nous pouvons comparer les deux en calculant leur différence.
Comme nous allons d’abord utiliser les points qui ne sont pas sélectionné, inversons la sélection.

Les points contiennent la valeur originale, mais pas celles de l’interpolation. Pour les ajouter dans un nouveau champ,
nous pouvons utiliser l’algorithme Ajouter des valeurs de raster aux points.
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La couche raster à sélectionner (l’algorithme supporte plusieurs rasters, mais nous n’en avons besoin que d’un) est
celle qui résulte de l’interpolation. Nous l’avons renommée interpolation et ce nom de couche est celui qui sera utilisé
pour le nom du champ à ajouter.
Nous avons maintenant une couche vecteur qui contient ces deux valeurs, avec des points qui n’étaient pas utilisé pour
l’interpolation.
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Maintenant, nous utiliserons la calculatrice de champs pour cette tâche. Ouvrez l’algorithme Calculatrice de champs
et exécutez-le avec les paramètres suivants.
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Si votre champ avec les valeurs de la couche raster a un nom différent, vous devrez modifier la formule ci-dessus en
conséquence. En exécutant cet algorithme, vous obtiendrez une nouvelle couche avec uniquement les points que nous
n’avons pas utilisé pour l’interpolation, chacun d’eux contenant la différence entre les deux valeurs d’élévation.
Représenter cette couche selon cette valeur nous donnera une première idée d’où se trouvent les grands écarts.

650 Chapter 17. Le Guide du module Traitements de QGIS



QGIS Training Manual

Interpoler cette couche vous donnera une couche raster avec l’erreur estimée dans tous les points de la zone interpolée.

17.23. Plus d’interpolation 651



QGIS Training Manual

Vous pouvez aussi obtenir la même information (différence entre les valeurs des points d’origine et ceux interpolés)
directement avec GRASS ► v.sample.
Vos résultats devrait différer de ceux-ci, car il y a une composante aléatoire introduite lors de l’exécution de la sélection
aléatoire, au début de cette leçon.

17.24 Exécution itérative d’algorithmes

Note: Cette leçon montre une manière différente d’exécuter des algorithmes qui utilisent des couches vectorielles,
en les exécutant de manière répétitive, en itérant sur les caractéristiques dans une couche vecteur d’entrée.

Nous avons déjà vu le modeleur graphique qui est l’une des façons d’automatiser les tâches de traitement. Cependant,
dans certains cas, le modeleur n’est peut être pas ce dont nous avons besoin pour automatiser une tâche donnée.
Voyons l’une de ces situations et comment la résoudre facilement en utilisant une fonctionnalité différente : l’exécution
itérative des algorithmes.
Ouvrez les données correspondantes à ce chapitre. Cela devrait ressembler à cela.

Vous reconnaîtrez notre bien connuMNE des précédents chapitres et un ensemble de bassins versants extrait de celui-
ci. Imaginez que vous avez besoin de séparer le MNE en plusieurs couches plus petites, chacune d’elles contenant
uniquement les données d’élévation correspondant à un même bassin versant. Cela sera utile si vous voulez par la suite
calculer certains paramètres liés à chaque bassin versant, comme son élévationmoyenne ou sa courbe hypsographique.
Cela peut être une tâche longue et fastidieuse, spécialement si le nombre de bassins versants est grand. Cependant,
c’est une tâche qui peut facilement être automatisée, comme nous le verrons.
L’algorithme à utiliser pour couper une couche raster avec une couche polygone est appelé Découper le raster avec
des polygones, et possède la boîte de dialogue des paramètres suivante.
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Vous pouvez l’exécuter en utilisant la couche « watersheds » et le MNE en entrées et vous obtiendrez le résultat
suivant.
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Comme vous pouvez le voir, la zone couverte par tous les polygones des bassins versants est utilisée.
Vous pouvez avoir le MNE coupé avec un seul bassin versant en sélectionnant le bassin versant souhaité, puis en
exécutant l’algorithme comme nous l’avons fait avant.

Tant que seules les fonctionnalités sélectionnées sont utilisées, seul le polygone sélectionné sera utilisé pour découper
la couche raster.
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Faire ainsi pour tous les bassins versants produira le résultat que nous cherchons, mais cela ne semble pas être une
manière très pratique de procéder. À la place, voyons comment automatiser cette routine sélectionner et découper.
Avant toute chose, effaçons la sélection précédente, afin que tous les polygones soient à nouveau utilisables. Ouvrez
maintenant l’algorithme Découper la grille avec des polygones et sélectionnez les mêmes entrées qu’avant, mais cette
fois cliquez sur le bouton que vous trouverez sur le côté droit de la couche vecteur d’entrée où vous avez sélectionné
la couche des bassins versants.

Ce bouton permettra à la couche d’entrée sélectionnée d’être séparée en autant de couches qu’elle a de caractéristiques,
chacune d’entre elles contenant un simple polygone. Sur ce, l’algorithme sera appelé de manière répétitive, une
fois pour chacune des couches de polygone unique. Le résultat, à la place d’une seule couche raster dans le cas de
cet algorithme, sera un ensemble de couches raster, chacune d’entre elles correspondant à une des exécutions de
l’algorithme.
Voici le résultat que vous obtiendrez si vous exécutez l’algorithme de découpage comme expliqué.
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Pour chaque couche, la palette de couleur noire et blanche (ou n’importe quelle palette que vous utilisez) est réglée
différemment, de ses valeurs minimum à ses valeurs maximum. C’est la raison pour laquelle vous pouvez voir les
différentes pièces et que les couleurs ne semblent pas correspondre à la frontière des couches. Cependant, les valeurs
coïncident.
Si vous entrez un nom de fichier de sortie, les fichiers résultants seront nommés avec ce nom de fichier et un numéro
correspondant à chaque itération comme suffixe.

17.25 Plus d’exécution itérative d’algorithme

Note: Cette leçon montre comment combiner l’exécution itérative des algorithmes avec le modeleur pour obtenir
plus d’automation.

L’exécution itérative des algorithmes est disponible non seulement pour les algorithmes intégrés mais aussi pour les
algorithmes que vous pouvez écrire vous-même, tels que les modèles. Nous allons voir comment combiner un modèle
avec l’exécution itérative d’algorithmes pour pouvoir facilement obtenir des résultats plus complexes.
Les données que nous allons utiliser pour cette leçon sont les mêmes que celles que nous avons déjà utilisés à la
dernière leçon. Dans ce cas, à la place de simplement couper le MNE avec chaque polygone de bassin versant, nous
ajouterons quelques étapes supplémentaires et calculerons une courbe hypsométrique pour chacun d’entre eux, afin
d’étudier comment l’élévation est distribué au sein du bassin versant.
Tant que nous avons un flux de traitements qui implique plusieurs étapes (découpage + calcul de la courbe
hypsométrique), nous devrions aller dans le modeleur et créer le modèle correspondant pour ce flux de traitements.
Vous pouvez trouver le modèle déjà créé dans le dossier de données pour cette leçon, mais il serait bien que vous
essayiez d’abord de le créer vous-même. La couche découpée n’est pas un résultat final dans ce cas, puisque nous
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nous intéressons seulement aux courbes, donc ce modèle ne générera aucune couche, mais uniquement une table avec
les données de la courbe.
Le modèle devrait ressembler à cela :

Ajoutez le modèle à votre dossier de modèles, afin qu’il soit disponible dans la boîte à outils, et exécutez-le.
Sélectionnez le MNT et les bassins versants.
L’algorithme va générer des tables pour tous les bassins et les placer dans le répertoire de sortie.
Nous pouvons rendre cet exemple plus complexe en étendant le modèle et en calculant certaines statistiques de pente.
Ajoutez l’algorithme de pente au modèle, puis l’algorithme de statistiques matricielles, qui devrait utiliser la sortie de
la pente comme seule entrée.

Si vous exécutez maintenant le modèle, en dehors des tables, vous obtiendrez un ensemble de pages avec des
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statistiques. Ces pages seront disponibles dans la boîte de dialogue des résultats.

17.26 L’interface de traitements par lots

Note: Cette leçon introduit l’interface de traitements par lots, qui permet d’exécuter un seul algorithme avec un
ensemble de valeurs d’entrée différentes.

Parfois, un algorithme donné doit être exécuté de manière répétée avec des entrées différentes. C’est le cas, par
exemple, lorsqu’un ensemble de fichiers d’entrée doit être converti d’un format à un autre, ou lorsque plusieurs couches
d’une projection donnée doivent être converties en une autre projection.
Dans ce cas, appeler l’algorithme de manière répétitive dans la boîte à outils n’est pas la meilleure option. À la place,
l’interface de traitements par lots devrait être utilisée, ce qui simplifie grandement la réalisation d’une exécution
multiple d’un algorithme donné. Pour exécuter un algorithme en tant que traitement par lots, trouvez-le dans la boîte
à outils, et à la place de double–cliquer dessus, faites un clic droit et sélectionnez Exécuter en tant que traitement par
lots.

Pour cet exemple, nous utiliserons l’algorithme Reprojection, alors trouvez-le et suivez la description ci-dessus. Vous
obtiendrez la boîte de dialogue suivante.
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Si vous regardez les données pour cette leçon, vous verrez qu’elles contiennent un ensemble de trois shapefiles, mais
aucun fichier de projet QGIS. C’est parce que lorsqu’un algorithme est exécuté en tant que traitement par lots, les
couches en entrée peuvent être sélectionnées soit à partir du projet QGIS courant, soit à partir de fichiers. Cela permet
de traiter plus facilement de grandes quantités de couches, telles que par exemple toutes les couches dans un dossier
donné.
Chaque ligne dans la table de la boîte de dialogue de traitement par lots représente une seule exécution de l’algorithme.
Les cellules sur une ligne correspondent aux paramètres nécessaires pour l’algorithme, qui ne sont pas disposés l’un
en dessus de l’autre, comme dans la boîte de dialogue d’une exécution unique normale, mais horizontalement sur la
même ligne.
Définir les traitements par lots à lancer se fait en remplissant la table avec les valeurs correspondantes. La boîte de
dialogue contient plusieurs outils qui peuvent faciliter cette tâche.
Commençons par remplir les champs un par un. La première colonne à remplir est celle de la Couche d’entrée. À la
place d’entrer les noms de chacune des couches que nous voulons traiter, vous pouvez toutes les sélectionner et laisser
la boîte de dialogue en mettre une par ligne. Cliquez sur le bouton dans la cellule supérieure gauche, et dans la boîte
de dialogue de sélection de fichier qui apparaîtra, sélectionnez les trois fichiers à reprojeter. Comme un seul d’entre
eux est nécessaire pour chaque ligne, ceux restants seront utilisés pour remplir les lignes ci-dessous.

Le nombre par défaut de lignes est 3, ce qui est exactement le nombre de couches que nous devons convertir, mais si
vous sélectionnez plus de couches, de nouvelles lignes seront ajoutées automatiquement. Si vous voulez remplir les
entrées manuellement, vous pouvez ajouter plus de lignes en utilisant le bouton Ajouter une ligne.
Nous allons convertir toutes ces couches en EPSG:23029, donc nous devons sélectionner ce SCR dans le second
champ. Nous voulons le même pour toutes les lignes, mais nous ne devons pas le faire pour chaque ligne
individuellement. Configurez ce SCR pour la première ligne (celle du haut) en utilisant le bouton dans la cellule
correspondante, et ensuite double-cliquez sur l’en-tête de la colonne. Cela va permettre à toutes les cellules de la
colonne d’être remplies avec la valeur de la cellule du haut.
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Finalement, nous devons sélectionner un fichier de sortie pour chaque exécution, qui contiendra la couche reprojetée
correspondante. Une fois encore, faisons-le uniquement pour la première rangée. Cliquez sur le bouton dans la
cellule supérieure et, dans un dossier où vous voulez mettre vos fichiers de sortie, entrez un nom de fichier (par
exemple reprojected.shp).
Maintenant, lorsque vous cliquez sur OK sur la boîte de dialogue de sélection de fichier, le fichier ne s’écrit pas
automatiquement dans la cellule, mais une zone de saisie comme celle qui suit s’affiche à la place.

Si vous sélectionnez la première option, seule la cellule courante sera remplie. Si vous sélectionnez n’importe
quelles autres options, toutes les lignes en-dessous seront remplies avec un modèle donné. Dans ce cas, nous allons
sélectionner l’option Remplir avec la valeur de paramètre, et ensuite la valeur Couche d’entrée dans le menu déroulant
dessous. Cela ajoutera la valeur dans la Couche d’entrée (c’est-à-dire le nom de la couche) au nom de fichier que nous
avons ajouté, rendant chaque fichier de sortie différent. La table de traitement par lots devait maintenant ressembler
à ça.
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La dernière colonne indique s’il faut ou non ajouter les couches résultantes au projet courant QGIS. Laissez l’option
par défaut Oui, de sorte que vous puissiez voir vos résultats dans ce cas.
Cliquez sur OK et le traitement par lots sera exécuté. Si tout s’est bien passé, toutes vos couches auront été traitées,
et 3 nouvelles couches auront été créées.

17.27 Modèles dans l’interface de traitements par lots

Avertissement: Prenez garde, ce chapitre n’est pas bien testé, s’il vous plaît rapporter tous problèmes ; les images
sont manquantes

Note: Cette leçon montre un autre exemple de l’interface de traitements par lots, mais cette fois en utilisant un
modèle à la place d’un algorithme intégré.

Les modèles sont simplement comme tout autre algorithme, et ils peuvent être utilisés dans l’interface de traitements
par lots. Pour démontrer cela, voici un exemple simple que nous pouvons faire en utilisant notre modèle hydrologique
bien connu.
Soyez sûr que vous avez ajouté le modèle à votre boîte à outils, et ensuite exécutez-le dans un mode lot. Voici à quoi
la boîte de dialogue du traitement par lots devrait ressembler.

Avertissement: todo: Ajouter image

Ajoutez des lignes jusqu’à avoir un total de 5. Sélectionnez le fichierMNE correspondant à cette leçon comme l’entrée
pour tous. Ensuite, entrez 5 valeurs de seuil différentes comme montré après.
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Avertissement: todo: Ajouter image

Comme vous le voyez, l’interface de traitements par lots peut être exécutée non seulement pour exécuter le même
processus sur différents jeux de données, mais également sur le même jeu de données avec différents paramètres.
Cliquez sur OK et vous devriez obtenir 5 nouvelles couches avec les bassins versants correspondant aux valeurs
spécifiques aux 5 bassins versants.

17.28 Scripts de pré et post-exécution

Note: Ce cours explique comment utiliser des scripts de pré et post exécution pour réaliser des opération
supplémentaires avant ou après l’algorithme principal.

Les scripts de pré et post exécution sont exécutés avant ou après l’algorithme principal. Ce mécanisme peut être
utilisé pour automatiser des tâches qui doivent être lancées à chaque fois qu’un algorithme est exécuté.
La syntaxe des hooks est identique à la syntaxe des scripts de traitement, voir le chapitre
<https://docs.qgis.org/testing/en/docs/user_manual/processing/console.html> _ correspondant dans le guide utilisateur
de QGIS pour plus de détails.
En plus de toutes les fonctionnalités communes à tous les scripts, une variable globale nommée alg est disponible
dans les scripts de pré et post exécution. Elle représente l’objet alogrithme qui vient (ou qui va) être lancé.
Voici un exemple de script de post-exécution. Par défaut, Processing stocke les résultats d’analyse dans des fichiers
temporaires. Ce script copie ces fichiers vers un répertoire spécifique pour qu’ils ne soient pas effacés après la
fermeture de QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

Dans les deux premières lignes, les composants python nécessaires sont importés: os — pour la manipulation des
chemins d’accès, par exemple extraire le nom du fichier, et shutil— pour différentes opérations sur le système de
fichier comme la copie de fichier.
Ensuite, nous définissons la constante MY_DIRECTORY, qui contient le chemin vers le répertoire dans lequel nous
voulons stocker les résultats de l’analyse.
A la fin du script, nous avons le code principal. Dans la boucle, nous parcourons toutes les sorties de l’algorithme
pour vérifier s’il s’agit d’un fichier et s’il peut être copié. Si c’est le cas, nous déterminons l’emplacement de ce fichier
et nous le copions dans notre répertoire.
Pour activer ce hook, nous devons ouvrir les options de traitement, trouver l’entrée nommée Fichier de script de post-
exécution dans le groupe Général, et y spécifier le nom de fichier du script de hook. le hook spécifié sera exécuté
après chaque algorithme de traitement.
De la même façon, on peut créer un script de pré-exécution. Par exemple, créons un script pour vérifier la validité
de la géométrie des vecteurs en entrée.

662 Chapter 17. Le Guide du module Traitements de QGIS



QGIS Training Manual

from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
if isinstance(param, ParameterVector):

layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid␣
↪→geometries!')

Comme dans l’exemple précédent, on commence par importer les composant QGIS et Processing nécessaires.
Ensuite, nous parcourons tous les paramètres en entrée de l’algorithme et si un paramètre de type ParameterVector
est trouvé, on retrouve la couche vecteur correspondante. L’ensemble des vecteurs de la couche est parcouru et les
géométries sont vérifiées. Si au moins un vecteur comporte une géométrie invalide, un message d’alerte est généré.
Pour activer ce script, il faut ouvrir les options de Processing, trouver l’entrée Pre-execution script file, et y saisir le
nom du fichier contenant le script. Le script spécifié sera exécuté avant chaque algorithme de Processing.

17.29 Autres programmes

Module contributed by Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment utiliser des programmes supplémentaires à l’intérieur du module Traitement.
Pour le compléter, vous devez avoir installé, avec les outils pour votre système d’exploitation, les paquets concernés.

17.29.1 GRASS

GRASS est une suite de logiciels libres et open-source de SIG pour la gestion des données géospatiales et l’analyse,
le traitement d’images, la production de graphiques et de cartes, la modélisation spatiale, et la visualisation.
Elle est installée par défaut sur Windows via l’installeur indépendant OSGeo4W (32 et 64 bit), et il existe des
compilations pour toutes les distributions importantes de Linux.

17.29.2 R

R est un environnement logiciel libre et open-source pour le calcul statistiques et les graphiques.
Il doit être installé séparément, avec quelques bibliothèques nécessaires (LIST). Pour activer l’utilisation de R dans
QGIS, le plugin Processing R Provider doit également être installé.
La beauté de l’implémentation du module de Traitement est qu’elle vous permet d’ajouter vos propres scripts, simples
ou complexes, qui pourront être utilisés comme n’importe quel module, relié à des flux de traitements plus complexes,
etc.
Testez quelque uns des exemples pré-installés, si vous avez déjà installé R (souvenez-vous d’activer les modules R
depuis la configuration Générale du Module de Traitement).
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17.29.3 Autres

LASTools est un ensemble mixte, libre et propriétaire de commandes pour traiter et analyser des données LiDAR.
La disponibilité dans les différents systèmes d’exploitation varie.
D’autres outils sont disponibles via des extensions supplémentaires, par exemple :

• LecoS : une suite pour les statistiques de la couverture du sol et de l’écologie du paysage
• lwgeom : faisant autrefois partie de PostGIS, cette librairie apporte quelques outils utiles pour le nettoyage de
la géométrie.

• Animove: Outils pour analyser l’étendu du territoire d’animaux.
D’autres viendront.

17.29.4 Comparaison entre les backends

Tampons et distances

Chargeons points.shp et le type buf dans le filtre de la Boîte à outils, puis double-cliquons dessus :
• Distance tampon fixe : Distance de 10000
• Variable distance tampon : Champ de distance SIZE
• v.buffer.distance: distance de 10000
• v.buffer.column: bufcolumn TAILLE
• Formes de Tampon: 10000 de valeur fixe (dissoudre et pas), champ d’attribut (avec mise à l’échelle)

Voyez comme la vitesse est tout à fait différentes, et différentes options sont disponibles.
Exercice pour le lecteur : trouver les différences dans la sortie géométrique entre les différentes méthodes.
Maintenant, les tampons raster et les distances :

• premièrement, chargez et pixelliser le vecteur rivers.shp avec GRASS ► v.to.rast.value; Attention : la
taille des cellules doit être fixée à 100 m, autrement le temps de calcul sera énorme ; la carte résultante aura 1
et NULLs

• Faîtes de même avec SAGA ► Shapes to Grid ► COUNT (carte résultante: 6 = 60).
• puis proximité (valeur = 1 pour GRASS, une liste d’identifiants de rivières pour SAGA), r.buffer avec les
paramètres 1000,2000,3000, r.grow.distance (la première des deux cartes ; la seconde affichera les zones
pertinentes de chaque rivière, si calculée avec le raster SAGA).

Regrouper

Décomposer des entités basées sur un attribut commun :
• GRASS ► v.dissolve municipalities.shp dans PROVINCIA
• QGIS ► Fusionner municipalities.shp dans PROVINCIA
• OGR ► Dissoudre municipalities.shp sur PROVINCIA
• SAGA►Dissolve Polygone municipalities.shp dans PROVINCIA (NB : Garder les frontières internes
ne doit pas être sélectionné)

Note: Le dernier est cassé dans SAGA <= 2.10

Exercice pour le lecteur : trouvez les différences (géométriques et d’attributs) entre différentes méthodes.
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17.30 Interpolation et contour

Module contributed by Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment utiliser différents backends pour calculer différentes interpolations.

17.30.1 Interpolation

Le projet montre un gradient dans les précipitations, du sud au nord. Utilisons différentes méthodes pour
l’interpolation, toutes basées sur un vecteur points.shp, paramètre RAIN :

Avertissement: Entrez une taille de cellule de 500 pour les analyses.

• GRASS ► v.surf.rst

• SAGA ► Interpolation de B-spline multi-niveaux

• SAGA ► Distance inverse pondérée [distance inverse à une puissance ; Puissance : 4 ; Rayon de recherche :
Global ; Gamme de recherche : tous les points]

• GDAL ► Grille (Distance inverse à une puissance) [Puissance : 4]
• GDAL ► Grille (Moyenne de déplacement) [Rayon1&2 : 50000]

Puis mesurez la variation entre les méthodes et corrélez-les avec la distance aux points :
• GRASS ► r.series [Désélectionner la propagation des NULLs, Opération d’agrégation : stddev]
• GRASS ► v.to.rast.value sur points.shp
• GDAL ► Proximité

• GRASS ► r.covar pour montrer la matrice de corrélation ; vérifiez la validité de la corrélation, par exemple
avec http://vassarstats.net/rsig.html.

Ainsi, les zones loin des points auront une interpolation moins précise.

17.30.2 Contour

Diverses méthodes pour dessiner des lignes de contours [toujours étapes = 10] sur le raster stddev :
• GRASS ► r.contour.step

• GDAL ► Contour

• SAGA ► Lignes de contour depuis la grille [NB: la sortie shp n’est pas valide sur certaines anciennes versions
de SAGA, bogue connu]
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17.31 Simplification vectorielle et lissage

Ce module est une contribution de Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment simplifier des vecteurs, et lisser les coins pointus.

Parfois nous avons besoin d’une version simplifiée d’un vecteur, pour avoir une plus petite taille de fichier et se
débarrasser des détails inutiles. Beaucoup d’outils font ça d’une manière très approximative, et oublient l’adjacence
et parfois l’exactitude topologique des polygones. GRASS est l’outil idéal pour cela : étant un SIG topologique,
l’adjacence et l’exactitude sont préservées même à des niveaux de simplification très grande. Dans notre cas, nous
avons un vecteur résultant d’un raster, montrant ainsi un motif de « scie » aux bords. Appliquer une simplification
résulte dans les grandes lignes :

• GRASS ► v.generalize [Valeur de tolérance maximale : 30 m]
Nous pouvons aussi faire l’inverse, et faire une couche plus complexe, en lissant les coins pointus.

• GRASS ► v.generalize [méthode : chaiken]
Essayez d’appliquer cette deuxième commande sur le vecteur original et aussi sur celui résultant de la première analyse,
et voyez la différence. Notez que l’adjacence n’est pas perdue.
Cette seconde option peut être appliquée par exemple aux lignes de contour résultant d’un raster grossier, à des pistes
GPS avec de rares sommets , etc.

17.32 Prévoir une ferme solaire

Module contributed by Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment utiliser plusieurs critères pour localiser les zones adaptées à l’installation d’une
centrale photovoltaique

Pour commencer, créer une carte d’aspect à partir du MNT :
• GRASS ► r.aspect [Type de données : int ; taille de cellule : 100]

Dans GRASS, l’aspect est calculé en degrés, dans le sens horaire inverse à partir de l’Est. Pour extraire seulement les
pentes du versant Sud (270 degrés +- 45), nous pouvons le reclasser :

• GRASS ► r.reclass

avec les règles suivantes:

225 thru 315 = 1 south
* = NULL

Vous pouvez utiliser le fichier texte reclass_south.txt fourni. Notez qu’avec ces simples fichiers texte nous
pouvons aussi créer de très complexes reclassifications.
Nous souhaitons construire une grande ferme, donc nous ne sélectionnons que les grands espaces contiguës (> 100
ha) :

• GRASS ► r.reclass.greater

Finalement, nous convertissons en vecteur :
• GRASS ► r.to.vect [Type d’entité: surface ; Lisser les angles : oui]

Exercice pour le lecteur : répétez l’analyse, en replaçant les commandes GRASS par analogie avec d’autres
programmes.
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17.33 Utilisation de scripts R avec Processing

Module contribué par Matteo Ghetta - financé par Scuola Superiore Sant’Anna
L’outil Traitement (via le plugin Processing R Provider) permet d’écrire et d’exécuter des scripts R à
l’intérieur de QGIS

Avertissement: R doit être installé sur votre ordinateur et le PATH doit être correctement configuré. De plus,
Processing appelle simplement les paquets R externes, il n’est pas en mesure de les installer. Assurez-vous donc
d’installer les paquets externes directement dans R. Voir le chapitre correspondant dans le manuel de l’utilisateur.

Note: Si vous avez des problèmes de paquets, ils peuvent être liés à l’absence de paquets obligatoires requis par le
traitement, comme sp, rgdal et raster.

17.33.1 Ajout de scripts

L’ajout d’un script est simple. Le plus simple est d’ouvrir la boîte à outils de traitement et de choisir créer un nouveau
script R… dans le menu R (marqué d’une icône R) en haut de la boîte à outils de traitement. Vous pouvez également
créer le script dans un éditeur de texte par exemple et le sauvegarder dans votre dossier de scripts R (processing/
rscripts). Une fois enregistré dans ce dossier, il sera possible de le modifier en cliquant avec le bouton droit de
la souris sur le nom du script dans la Boîte à outils de traitement, puis en choisissant Edit Script…).

Note: Si vous ne pouvez pas voir R dans les outils de Traitement, vous devez l’activer dans Traitement► Options►
Fournisseurs

Il ouvre une fenêtre d’édition de script dans laquelle vous devez fournir quelques paramètres avant de pouvoir ajouter
le corps du script.
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17.33.2 Création de graphiques

Dans ce tutoriel nous allons créer une boîte à moustaches à partir d’un champ d’une couche vertorielle.
Ouvrir le r_intro.qgs projet QGIS sous exercise_data/processing/r_intro/ folder.

Paramètres du script

Ouvrez l’éditeur et commencez l’écriture au début.
Vous devez définir certains paramètres avant le corps du script :

1. Le nom du groupe (plots dans ce cas) dans lequel vous voulez mettre votre script (si le groupe n’existe pas, il
sera créé):

##plots=group

Vous trouverez votre script dans le groupe plots R dans la boîte à outils Traitement.
2. Vous devez indiquer à Processing que vous souhaitez afficher une parcelle (dans cet exemple):

##showplots

Vous trouverez ensuite un lien vers le tracé dans le panneau visualiseur résultats (peut être activé / désactivé
dans Vue ► Panneaux et avec Processing ► visualiseur résultats).

3. Vous devez également informer Processing de vos données d’entrée. Dans cet exemple, nous voulons créer un
tracé à partir d’un champ d’une couche vectorielle:

##Layer=vector

Le traitement sait maintenant que l’entrée est un vecteur. Le nom Couche n’est pas important, ce qui compte
c’est le paramètre vecteur.

4. Enfin, vous devez spécifier le champ de saisie de la couche vectorielle (en utilisant le nom que vous avez fourni
ci-dessus - Couche):

##X=Field Layer

Processing sait maintenant que vous avez besoin d’un champ de Couche, et que vous l’appellerez X.
5. Il est également possible de définir le nom de votre script en utilisant « name »:

##My box plot script=name

S’il n’est pas défini, le nom du fichier sera utilisé comme nom du script.
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Corps du script

Maintenant que vous avez établi l’en-tête du script vous pouvez ajouter la fonction

boxplot(Layer[[X]])

boxplot est le nom de la fonction R, le paramètre Layer est le nom que vous avez défini pour l’ensemble de données
d’entrée et X est le nom que vous avez défini pour le champ de cet ensemble de données.

Avertissement: Le paramètre X doit être entre doubles crochets ([[]]).

Le script complet se présente ainsi

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])

Enregistrez le script dans le chemin par défaut suggéré par Processing (processing / scripts). Si vous n’avez pas défini
de « nom » dans l’en-tête du script, le nom de fichier que vous choisissez deviendra le nom du script dans la boîte à
outils Traitement.

Note: Vous pouvez enregistrer le script où vous le souhaitez, mais Processing ne pourra pas l’inclure
automatiquement dans la boîte à outils de traitement, vous devrez donc le télécharger manuellement.

Maintenant exécutez le en utilisant le bouton en haut de la fenêtre de l’éditeur :
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Une fois la fenêtre de l’éditeur fermée, utilisez la zone de texte de Traitement pour trouver votre script :

Vous pouvez maintenant remplir les paramètres requis dans la fenêtre de l’algorithme de traitement :
• pour Couche choisissez sample_points
• pour le champ X, choisissez valeur.

Cliquez sur Lancer
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La Fenêtre des résultats devrait s’ouvrir automatiquement, sinon, cliquez simplement sur Processing ► Visualiseur
de Résultats….
Cliquez sur le lien dans la visionneuse et vous verrez :
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Note: Vous pouvez ouvrir, copier et enregistrer l’image en cliquant avec le bouton droit de la souris sur le diagramme.

17.33.3 Créer un vecteur

Vous pouvez également créer une couche vectorielle et la charger automatiquement dans QGIS.
L’exemple suivant est tiré du script « Grille d’échantillonnage aléatoire » qui se trouve dans la collection en ligne de
scripts R (les scripts de cette collection en ligne se trouvent à https://github.com/qgis/QGIS-Processing/tree/master/
rscripts).
Le but de cet exercice est de créer une couche vectorielle ponctuelle aléatoire en utilisant une couche vectorielle
d’entrée pour restreindre l’étendue en utilisant la fonction « spsample » du paquet « sp ».
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Paramètres du script

Comme auparavant, nous devons définir certains paramètres avant le corps du script :
1. Précisez le nom du groupe dans lequel vous voulez mettre votre script, dans ce cas Point pattern analysis:

##Point pattern analysis=group

2. Définissez un paramètre d’entrée (une couche vectorielle) qui limitera le placement des points aléatoires:

##Layer=vector

3. Définissez un paramètre d’entrée pour le nombre de points qui vont être créés (« Taille », avec une valeur par
défaut de « 10 »):

##Size=number 10

Note: Comme une valeur par défaut (10) est définie, l’utilisateur peut changer ce nombre ou peut laisser le
paramètre sans nombre.

4. Précisez qu’il existe une couche vecteurs de sortie (appelée « Output »):

##Output=output vector

Corps du script

Vous pouvez maintenant ajouter le corps de la fonction :
1. Utilisez la fonction « spsample »:

pts=spsample(Layer, Size, type="random")

La fonction utilise la couche pour contraindre le placement des points (s’il s’agit d’une couche de lignes, un point
devra se trouver sur une des lignes de la couche, s’il s’agit d’une couche de polygones, un point devra se trouver
à l’intérieur d’un polygone). Le nombre de points est tiré du paramètre Size. La méthode d’échantillonnage est
aléatoire.

2. Générer la sortie (le paramètre « Output »):

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Le script complet se présente ainsi

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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Enregistrez-le et exécutez-le, en cliquant sur le bouton « Exécuter ».
Dans la nouvelle fenêtre, entrez les bons paramètres :

et cliquez sur Lancer.
La couche de résultats sera ajoutée à la table des matières et ses points seront affichés sur le canevas de la carte :
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17.33.4 Textes et graphiques issus de - syntaxe-R

Le traitement (avec le plugin « Processing R Provider ») utilise une syntaxe spéciale pour obtenir les résultats de R :
• > avant votre commande, comme pour>lillie.test(Couche[[Champ]]) qui veut dire que le résultat
devrait être envoyé sur la sortie de R (Visionneur de Résultat)

• « + » après une parcelle permet de superposer les parcelles. Par exemple, « plot(Layer[[X]], Layer[[Y]]) +
abline(h=mean(Layer[[X]]))``

17.34 Prédire les glissements de terrain

Ce module est une contribution de Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment créer un modèle simplifié pour prédire la probabilité des glissements de terrain.

Premièrement, nous calculons la pente (choisir parmi les différents backends; le lecteur intéressé pourra calculer les
différences entre les sorties) :

• GRASS ► r.slope

• SAGA ► Slope, aspect, curvature

• GDAL Slope

Ensuite nous créons unmodèle de prédiction des précipitations, basé sur une interpolation des valeurs de précipitations
mesurées aux stations météorologiques.

• GRASS ► v.surf.rst (résolution : 500 m)
La probabilité d’un glissement de terrain est très approximativement liée à la fois à la quantité de précipitations et à la
pente (bien sûr un véritable modèle utilisera plusieurs couches et des paramètres appropriés), disons « (précipitations
* pente) / 100 ».

• SAGA ► Raster calculator rain, slope: (a*b)/100 (ou : GRASS ► r.mapcalc)
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• Ensuite nous calculons quelles sont les communes qui ont le plus grand risque de précipitations : SAGA ►
Raster statistics for polygons (les paramètres qui nous intéressent sont Maximum et Moyenne).
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Module : Utiliser des bases de données spatiales dans QGIS

Dans ce module, vous apprendrez l’utilisation des bases de données spatiales avec QGIS pour gérer, afficher et
manipuler des données dans la base de données ainsi que réaliser des analyses à partir de requêtes. Nous utiliserons
principalement PostgreSQL et PostGIS (qui ont été abordés dans les sections précédentes), mais les mêmes concepts
s’appliquent aux autres implémentations de bases de données spatiales notamment spatialite.

18.1 Leçon : Travailler avec les Bases de Données dans le
Navigateur de QGIS

Dans les 2 précédents modules, nous avons vu les concepts de base, les entités et fonctions des bases de données
relationnelles ainsi que les extensions qui nous permettent de stocker, gérer, interroger et manipuler des données
spatiales dans une base de données relationnelle. Cette section ira plus loin, notamment dans la façon dont les bases
de données spatiales sont utilisées dans QGIS.
L’objectif de cette leçon: Apprendre comment interagir avec des bases de données spatiales en utilisant le panneau
Parcourir de QGIS.

18.1.1 ��� Pas à pas : Ajouter des tables de bases de données via le panneau
Parcourir

Nous avions déjà brièvement vu comment ajouter des tables de base de données comme couches dans QGIS;
maintenant, nous allons l’aborder un peu plus en détail et voir les différentes manières d’opérer. Commençons donc
par la nouvelle interface du panneau Parcourir.

• Démarrer un nouveau projet dans QGIS.
• Ouvrez le panneau Parcourir en cliquant sur l’onglet Parcourir en bas du Panneau Couches
• Déroulez la partie PostGIS de l’arborescence. Vous devriez y voir la connexion précédemment configurée (il
vous faudra peut-être cliquer sur le bouton Actualiser en haut de la fenêtre Parcourir).
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• Un double-clic sur une table/couche de la liste l’ajoute automatiquement à la carte.
• Un clic droit sur une table/couche vous offre des options. Cliquez sur l’élément Propriétés pour voir les
propriétés de la table/couche.
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Note: Bien entendu, vous pouvez également utiliser cette interface pour vous connecter aux bases de données
PostGIS hébergées sur un serveur externe à votre poste de travail. Un clic droit sur l’entrée PostGIS dans
l’arborescence vous permettra de spécifier les paramètres de connexion pour une nouvelle connexion.

18.1.2 ��� Pas à pas : Ajouter des enregistrements filtrés comme couche

Maintenant que nous avons vu comment ajouter une table entière dans QGIS, il serait intéressant d’apprendre à ajouter
un jeu de données filtrées depuis une table en utilisant les requêtes, notion abordée dans les précédentes sections.

• Ouvrez dans QGIS un nouveau projet, vide de couches
• Cliquez sur le bouton Ajouter une couche PostGIS ou sélectionnez Couche► Ajouter une couche PostGIS depuis
le menu.

• Dans la fenêtre Ajouter une ou plusieurs table(s) PostGIS qui s’ouvre, connectez-vous à postgis_demo.
• Déroulez le schémapublic dans lequel vous devriez trouver les trois tables que nous utilisions précédemment.
• Sélectionnez la couche lines, mais au lieu de l’ajouter à la carte, cliquez sur le bouton Filtrer les fichiers afin
d’afficher la fenêtre Constructeur de requête.

• Construisez la requête suivante à l’aide des boutons ou en la saisissant directement:

"roadtype" = 'major'
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• Cliquez sur OK pour valider l’édition du filtre et sur Ajouter pour ajouter la couche filtrée à la carte.
• Renommez la couche lines dans l’arborescence en roads_primary.

Vous constaterez que seules les routes principales ont été ajoutées à votre carte et non la totalité de la couche.

18.1.3 Conclusion

Vous savez maintenant comment interagir avec les bases de données en utilisant le panneau Parcourir et comment
ajouter des couches pré-filtrées à votre carte.

18.1.4 La suite ?

Nous verrons ensuite comment vous pouvez accéder à des fonctions plus complètes de gestion de bases de données
via l’interface DB Manager.
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18.2 Leçon : Utiliser DB Manager pour travailler avec les Bases de
données Spatiales dans QGIS

Nous avons déjà vu comment réaliser plusieurs opérations de base de données avec QGIS ainsi qu’avec d’autres outils
mais il maintenant temps d’étudier l’outil DB Manager qui fournit les mêmes fonctionnalités ainsi que des outils plus
orientés vers l’administration.
L’objectif de cette leçon: Apprendre comment interagir avec des base de données spatiales en utilisant le DB
Manager de QGIS.

18.2.1 ��� Pas à pas : Administrer une Base de Données PostGIS avec DB
Manager

Vous devez premièrement ouvrir l’interface DB Manager en sélectionnant Base de Données ► DB Manager ► DB

Manager dans le menu ou en sélectionnant l’icône DB Manager dans la barre d’outils.
Vous devriez déjà voir les connexions que nous avons configurées précédemment et vous devriez pouvoir étendre la
section myPG et son schéma public pour voir les tables que nous avons utilisées dans les sections précédentes.
La première chose que vous pouvez remarquer est que vous pouvez maintenant lire les métadonnées des schémas
contenus dans la base de données.

Les schémas constituent un moyen de regrouper des tables de données et d’autres objets au sein d’une base de données
PostgreSQL. Ils contiennent également les permissions et les autres contraintes. Gérer des schémas PostgreSQL
dépasse la portée de ce manuel mais vous pouvez en apprendre plus dans la Documentation sur les schémas
PostgreSQL. Vous pouvez utiliser DB Manager pour créer de nouveaux schémas mais vous aurez sans doute besoin
d’outils comme pgAdmin III ou l’interface de ligne de commande pour aller plus loin.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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DB Manager peut également être utilisé pour gérer les tables de votre base de données. Nous avons déjà étudié
plusieurs méthodes pour créer et gérer des tables à partir de la ligne de commande mais regardons rapidement
comment on peut le faire avec DB Manager.
Il est d’abord intéressant de consulter les métadonnées de la table en cliquant sur son nom dans l’arbre et en lisant
l’onglet Info.

Dans ce panneau, vous pouvez lire les Informations Générales de la table ainsi que l’information que l’extension
PostGIS conserve sur la géométrie et le système de référence spatiale.
Si vous vous déplacez vers le bas de l’onglet Info, vous pouvez avoir plus d’information sur les Champs, les Constraintes
et les Index de la table sélectionnée.
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Vous pouvez également utiliser DB Manager pour observer le contenu de la base de données de la même manière
que vous utilisez la table des attributs d’une couche dans la Légende. Vous pouvez naviguer dans les données en
sélectionnant l’onglet Table.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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Il existe également l’onglet Aperçu qui vous montrera l’aspect de la couche de données dans une carte d’aperçu.
Effectuez un clic droit sur une couche dans l’arborescence et cliquez sur Ajouter au Canevas pour ajouter cette couche
à votre carte.
Jusqu’à présent, nous avons observé la base de données par ses schémas et ses tables ainsi que leurs métadonnées
mais qu’en est-il si nous voulons modifier la table pour ajouter une colonne ? DB Manager vous permet de le faire
directement.

1. Sélectionnez dans l’arborescence la table que vous souhaiter éditer.
2. Sélectionnez depuis le menu Table ► Éditer une table afin d’ouvrir la fenêtre Propriétés de la table.
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Vous pouvez utiliser cette fenêtre pour ajouter des colonnes, ajouter des colonnes géométriques, éditer des colonnes
existantes ou supprimer complètement une colonne.
Dans l’onglet Contraintes, vous pouvez gérer quels champs sont utilisés comme clé primaire ou supprimer des
contraintes existantes.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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L’onglet Index peut être utilisé pour ajouter et supprimer des index aussi bien normaux que spatiaux.
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18.2.2 ��� Pas à pas : Créer une nouvelle table

Maintenant que nous avons vu comment travailler sur les tables existantes dans notre base de données, voyons
comment créer une nouvelle table avec DB Manager.

1. Si elle n’est pas déjà ouverte, ouvrez la fenêtre de DB Manager et déroulez l’arborescence jusqu’à voir la liste
des tables déjà présentes dans votre base de données.

2. Depuis le menu, sélectionnez Table –> Créer une table pour afficher la fenêtre de création de table.
3. Utilisez le schéma par défaut Public et nommez la table places.
4. Ajoutez les champs id, place_name et elevation comme montré ci-dessous
5. Assurez-vous de définir le champ id comme clé primaire.
6. Cochez la case Créer une colonne géométrique et assurez-vous qu’elle est définie de type POINT et laissez le

nom geom et spécifiez 4326 comme SRID.
7. Cochez la case Créer un index spatial et cliquez sur Créer pour créer la table.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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8. Validez la fenêtre vous faisant savoir que la table a été créée et cliquez sur:guilabel:Fermer pour fermer la
fenêtre de création de table.

Vous pouvez maintenant inspecter votre table dans DB Manager et bien entendu, vous constaterez qu’elle ne contient
aucune donnée. Désormais, vous pouvez ajouter votre table au projet, la Basculer en mode édition depuis le menu
Couche et commencez à y ajouter des places.

18.2.3 ��� Pas à pas : Les rudiments de l’administration de bases de données

DB Manager vous permet aussi de faire d’autres tâches basiques d’administration de base de données. Ce n’est
certainement pas un substitut pour un outil complet d’administration de base de données, mais il vous fournit des
fonctions de maintenance de votre base de données.
Les tables des bases de données peuvent souvent devenir volumineuses et les tables qui sont fréquemment modifiées
laissent des enregistrements qui n’ont plus besoin d’être conservés par PostgreSQL. La commandeVACUUM s’occupe
de gérer la suppression de ces données invalidées pour compacter et analyser vos tables dans l’objectif d’être plus
performant.
Voyons comment réaliser une commande VACUUM ANALYZE à partir de DB Manager.

1. Sélectionnez une de vos tables dans l’arborescence de DB Manager
2. Sélectionnez menu Table ► Lancer Vacuum Analyze.

PostgreSQL va réaliser l’opération. Selon la taille de votre table, ceci peut prendre un certain temps.
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Vous pouvez trouver plus d’informations sur les processus de VACUUM ANALYZE dans la documentation de
PostgreSQL sur VACUUM ANALYSE.

18.2.4 ��� Pas à pas : Exécuter des requêtes SQL avec DB Manager

DBManager fournit également un moyen d’écrire des requêtes de tables et de visualiser les résultats. Nous avons déjà
vu ce type de fonctionnalité dans le panneau Navigation mais observons comment le faire avec DB Manager.

1. Sélectionnez la table lines dans l’arborescence.
2. Sélectionnez le bouton Fenêtre SQL dans la barre d’outils de DB Manager.

3. Composez la Requête SQL suivante dans l’espace disponible:

select * from lines where roadtype = 'major';

4. Cliquez sur le bouton Exécuter (F5) pour réaliser la requête.
5. Vous devriez maintenant voir les enregistrements correspondants dans le panneau Résultat.

6. Cochez la case Charger comme une nouvelle couche pour ajouter le résultat à votre carte.
7. Sélectionnez la colonne id en tant que Colonne avec des valeurs entières et uniques et la colonne geom en tant

que Colonne de géométrie.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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8. Saisissez roads_primary dans le Nom de la couche.
9. Cliquez sur Charger ! pour charger les résultats dans une nouvelle couche sur votre carte.

Les couches qui correspondent à votre requête sontmaintenant affichées sur la carte. Vous pouvez bien entendu utiliser
cet outil pour lancer n’importe quelle commande SQL, incluant celles que nous avons étudiées dans les modules et
les sections précédentes.

18.2.5 Importer des données dans une base de données avec DB Manager

Nous avons déjà étudié comment importer des données dans une base de données spatiale en utilisant la ligne de
commande. Voyons comment y parvenir en utilisant le Gestionnaire de Bases de Données.

1. Cliquez sur le bouton Importer une couche ou un fichier dans la barre d’outils de la boîte de dialogue de DB
Manager.

2. Sélectionnez le fichier urban_33S.shp depuis exercise_data/projected_data en tant que
donnée d’entrée.

3. Cliquer sur le bouton Options de mise à jour pour pré-remplir certaines valeurs du formulaire.
4. Assurez-vous que l’option Créer une nouvelle table est sélectionnée.

690 Chapter 18. Module : Utiliser des bases de données spatiales dans QGIS



QGIS Training Manual

5. Paramétrer le SCR Source à 32722 et le SCR Cible à 4326.
6. Cochez la case Créer un index spatial
7. Cliquez sur OK pour réaliser l’import

8. Fermer la boîte de message qui vous indique que l’export s’est correctement déroulé.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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9. Cliquez sur le bouton Rafraîchir de la barre d’outils de DB Manager
Vous pouvez maintenant inspecter la table dans votre base de données en cliquant dans l’arbre. Vérifiez que la donnée
a bien été reprojetée en vérifiant que Ref Spatiale: contient bien WGS 84 (4326).

Faîtes un clic droit sur la table dans l’arbre et sélectionnez Ajouter au Canevas pour ajouter la table comme couche
dans votre carte.

18.2.6 Exporter des données d’une base de données à l’aide de DB Manager.

Bien entendu, DB Manager peut également être utilisé pour exporter des données de base de données spatiales.
Voyons comment faire.

1. Sélectionnez la couche lines dans l’arbre et cliquez sur le bouton Exporter vers le fichier pour ouvrir la boîte
de dialogue Exporter vers un fichier vecteur.

2. Cliquez sur le bouton … pour sélectionner le Fichier en sortie et sauvegarder les données dans le répertoire
exercise_data sous le nom urban_4326.

3. Paramétrez le SCR cible à 4326.
4. Cliquez sur OK pour lancer l’export.
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5. Fermer la boîte de message vous indiquant que l’export s’est correctement déroulé et fermez DB Manager.
Vous pouvez maintenant inspecter le fichier Shape que vous avez créé en utilisant le panneau Navigation.

18.2. Leçon : Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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18.2.7 Conclusion

Nous avons étudié comment utiliser l’interface de DBManager sous QGIS pour gérer des bases de données spatiales,
exécuter des requêtes SQL et comment importer et exporter des données.

18.2.8 La suite ?

Dans la prochaine leçon, nous étudierons comment utiliser des techniques identiques sur les bases de données
SpatiaLite.

18.3 Leçon : Travailler avec les bases de données SpatiaLite dans
QGIS

Alors que PostGIS est généralement utilisé sur un serveur pour fournir des capacités de base de données spatiales
à plusieurs utilisateurs en même temps, QGIS prend également en charge l’utilisation d’un format de fichier appelé
SpatiaLite qui est un moyen léger et portable de stocker une base de données spatiales entière dans un seul fichier. Il
est évident que ces deux types de bases de données spatiales doivent être utilisés à des fins différentes, mais les mêmes
principes et techniques de base s’appliquent aux deux. Créons une nouvelle base de données SpatiaLite et explorons
les fonctionnalités fournies pour travailler avec ces bases de données dans le QGIS.
Le but de cette leçon: Apprendre à interagir avec les bases de données SpatiaLite en utilisant l’interface du navigateur
QGIS.

18.3.1 ��� Pas à pas : Créer une base de données SpatiaLite avec le
navigateur

En utilisant le panneau navigateur, nous pouvons créer une nouvelle base de données SpatiaLite et la configurer pour
une utilisation dans QGIS.

1. Faites un clic droit sur l’entrée SpatiaLite dans l’arbre du navigateur et sélectionnez créer base de donnees.
2. Précisez où vous voulez stocker le fichier sur votre système de fichiers et nommez-le qgis-sl.db.
3. Cliquez à nouveau sur l’entrée SpatiaLite dans l’arbre du navigateur et sélectionnezmaintenant l’élément nouvelle

connection. Trouvez le fichier que vous avez créé à la dernière étape et ouvrez-le.
Maintenant que vous avez configuré votre nouvelle base de données, vous pourrez remarquer que l’entrée de l’arbre de
Navigation n’a rien en dessous et que la seule chose que vous pouvez faire à ce niveau et de supprimer la connexion.
Ce comportement est présent uniquement parce que nous n’avons pas encore ajouté de tables à cette base de données.
Faisons-le.

1. Trouvez le bouton pour créer une nouvelle couche et utilisez la liste déroulante pour créer une nouvelle couche
SpatiaLite, ou sélectionnez Couche ► Nouveau ► Nouvelle couche SpatiaLite.

2. Sélectionnez dans la liste déroulante la base de données créée dans les étapes précédentes.
3. Donnez à la couche le nom de places.
4. Cochez la case à côté de Créer une clé primaire auto-incrémentée.
5. Ajoutez deux attributs comme indiqué ci-dessous
6. Cliquez sur OK pour créer la table.
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7. Cliquez sur le bouton Actualiser en haut du navigateur et vous devriez maintenant voir votre table places
listée.

18.3. Leçon : Travailler avec les bases de données SpatiaLite dans QGIS 695



QGIS Training Manual

Un clic droit sur la table vous permet de voir ses propriétés, comme vu dans l’exercice précédent.
A ce stade, vous pouvez commencer une session d’édition et ajouter des données directement à votre nouvelle base
de données.
Nous avons également appris comment importer des données dans une base de données en utilisant le gestionnaire
de BD et vous pouvez utiliser cette même technique pour importer des données dans votre nouvelle BD SpatiaLite.

18.3.2 Conclusion

Vous avez vu comment créer des bases de données SpatiaLite, y ajouter des tables et utiliser ces tables comme couches
dans QGIS.

696 Chapter 18. Module : Utiliser des bases de données spatiales dans QGIS



CHAPTER19

Annexe : Contribution à ce manuel

Pour ajouter du contenu à ce cours, vous devez suivre les recommandations dans cette annexe. Vous n’êtes pas autorisé
à changer les conditions dans ces annexes, sauf pour des clarifications. C’est pour s’assurer que la qualité et le contenu
de ce manuel puissent être maintenus.

19.1 Téléchargement des ressources

La source de ce document est disponible sur GitHub. Consultez GitHub.com pour les instructions d’utilisation du
système de contrôle de versionnement git.

19.2 Format du Manuel

Ce manuel est écrit en utilisant Sphinx, un générateur de documentation sous Python utilisant le langage de balise
reStructuredText. Les instructions sur l’utilisation de ces outils sont disponibles sur leurs sites respectifs.

19.3 Ajout d’un module

Pour ajouter un nouveau module :
1. Créez tout d’abord un nouveau répertoire (directement sous le plus haut niveau du répertoire

qgis-training-manual) avec le nom du nouveau module.
2. Sous ce nouveau répertoire, créez un fichier appelé index.rst. Pour l’instant laissez le fichier vierge.
3. Ouvrez le fichier index.rst sous le plus haut niveau du répertoire. Ses premières lignes sont

.. toctree::
:maxdepth: 2

foreword/index
introduction/index
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Vous remarquerez que c’est une liste de noms de répertoires, suivis par le nom index. Cela dirige le
fichier index au plus haut niveau dans chaque répertoire. L’ordre dans lequel ils sont listés détermine
l’ordre dans lequel ils apparaîtront dans le document.

1. Ajoutez le nom de votre nouveau module (c’est-à-dire le nom que vous avez donné au nouveau répertoire), suivi
par /index, à cette liste, là où vous voulez que votre module apparaisse.

2. Souvenez-vous de garder l’ordre des modules logique, de telle sorte que les modules suivants s’appuient sur la
connaissance présentée dans les modules précédents.

3. Ouvrez le fichier index de votre nouveau module ([module name]/index.rst).
4. En haut de la page, créez l’en-tête du module:

1. écrivez une première ligne d’astérisques (*)
2. Poursuivez avec une ligne contenant la balise Module:, suivi du nom de votre module
3. Terminez avec une autre ligne du même nombre d’astérisques.

Note: La ligne supérieur et la ligne inférieur d’astérisques ne doivent pas être plus courte que la ligne contenant
le nom du module.

5. Laissez une ligne ouverte sous ça.
6. Écrivez un court paragraphe expliquant la fonction et le contenu de ce module.
7. Laissez une ligne ouverte, puis ajoutez le texte suivant:

.. toctree::
:maxdepth: 2

lesson1
lesson2

… où :lesson1, lesson2, etc., sont les noms de vos leçons prévues.
Le fichier index au niveau du module ressemblera à ceci :

*******************************************************************************
Module: Module Name
*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Ajout d’une leçon

Pour ajouter une leçon à un module existant ou non:
1. Ouvrez le répertoire du module.
2. Ouvre le fichier index.rst (créé ci-dessus dans le cas de nouveaux modules)
3. Assurez-vous que le nom de la leçon prévue est listé sous la directive toctree, comme montré ci-dessous.
4. Créez un nouveau fichier sous le répertoire du module.
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5. Nommez ce fichier exactement de la même manière que le nom que vous avez fourni dans le fichier index.
rst du module, et ajoutez l’extension .rst.

Note: À des fins d’édition, un fichier .rst fonctionne exactement comme un fichier texte normal
(.txt).

1. Pour commencer à écrire la leçon, écrivez l’expression de balisage Lesson:, suivie du nom de la leçon.
2. Sur la ligne suivante, écrivez une ligne de signe égal (=), pas plus courte que le titre de la leçon.
3. Laissez une ligne ouverte après ceci.
4. Écrivez une courte description du but recherché de la leçon.
5. Incluez une introduction générale au sujet. Regardez les leçons existantes dans ce manuel pour les exemples.
6. Sous cela, commencez un nouveau paragraphe, débutant avec cette phrase

**The goal for this lesson:**

7. Expliquez brièvement le résultat escompté à la fin de cette leçon.
8. Si vous ne pouvez pas décrire le but de la leçon en une ou deux phrases, envisagez de couper le sujet en plusieurs

leçons.
Chaque leçon sera subdivisée en plusieurs sections, qui seront traitées après.

19.5 Ajout d’une nouvelle section

Il existe deux types de sections: « Étape par étape » et « Essayez vous-même ».
• Une section « Etape par étape » est un ensemble détaillé d’instructions destinées à apprendre au lecteur comment
utiliser tel ou tel aspect deQGIS. Cela se fait habituellement en donnant les instructions clic-par-clic aussi claires
que possible, entrecoupées de captures d’écran.

• Une section « Essayez vous-même » assigne au lecteur une petite mission à réaliser de lui-même. Elle est
généralement associée à une entrée dans la feuille de réponses à la fin de la documentation, qui va montrer ou
expliquer comment faire cet exercice, et affichera le résultat escompté si possible.

Chaque section est accompagnée d’un niveau de difficulté. Une section facile est désignée par ★☆☆, modérée par ★★☆
et avancée par ★★★.

19.5.1 Ajout d’une section « Etape par étape »

1. Pour commencer cette section, écrivez la balise du niveau de difficulté prévu (comme montré ci-dessus).
2. Laissez un espace puis écrivez Follow Along:.
3. Laissez un autre espace et écrivez le nom de la section (utilisez seulement une initiation en majuscule, ainsi que

les capitales pour les noms propres).
4. Sur la ligne suivante, écrivez une ligne de signe égal (=), pas plus courte que le titre de la section.
5. Écrivez une courte introduction à la section, expliquant ses objectifs. Puis donnez des instructions détaillées

(clic-pa-clic) sur la procédure à être démontrée.
6. Dans chaque section, incluez des liens internes, des liens externes et des captures d’écran au besoin.
7. Essayez de clore toute section avec un court paragraphe qui la conclut et fait naturellement un lien vers la

section suivante, si possible.
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19.5.2 Ajout d’une section « Essayez vous-même »

1. Pour commencer cette section, écrivez la balise du niveau de difficulté prévu (comme montré ci-dessus).
2. Laissez un espace puis écrivez Essayez vous-même:.
3. Sur la ligne suivante, écrivez une ligne de signe égal (=), pas plus courte que le titre de la section.
4. Expliquez l’exercice que vous voulez que le lecteur fasse. Référez-vous aux sections, leçons ou modules

précédents si nécessaire.
5. Incluez des captures d’écran pour clarifier les exigences si une description textuelle n’est pas claire.

Dans la plupart des cas, vous voudrez donner une réponse sur la façon de compléter la consigne donnée dans cette
section. Pour faire cela, vous aurez besoin de créer un bloc de réponse sous les instructions.

1. Tout d’abord, créez un widget pliable qui contient la réponse:

.. admonition:: Answer
:class: dropdown

2. En gardant l’indentation par rapport au bloc précédent, écrivez les instructions sur la manière de répondre à la
consigne, en utilisant des images et des liens si nécessaire.

19.6 Ajout d’une conclusion

Pour terminer la leçon:
1. Écrivez l’expression Conclusion, suivie d’une nouvelle ligne de tirets (-).
2. Écrivez une conclusion pour la leçon, expliquant les concepts traités dans la leçon.

19.7 Ajout d’une section Pour aller plus loin

Cette section est optionnelle.
• Écrivez la phrase Lectures complémentaires, suivie d’une nouvelle ligne de tirets/moins (-).
• Incluez des liens vers des sites externes appropriés.

19.8 Ajout d’une section La suite ?

1. Écrivez la phrase Quelle est la prochaine étape ?, suivie d’une nouvelle ligne de tirets/moins
(-).

2. Expliquez comment cette leçon a préparé les étudiants à la prochaine leçon ou au prochain module.
3. Pensez à changer la section « La suite ? » de la précédente leçon si nécessaire, afin qu’elle fasse référence à

votre leçon. Cela sera nécessaire si vous avez inséré une nouvelle leçon entre les leçons déjà existantes, ou
après une leçon existante.
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19.9 Utilisation des balises

Pour adopter les standards de ce document, vous devrez ajouter des balises standards à votre texte.

19.9.1 Nouveaux concepts

Si vous êtes en train d’expliquer un nouveau concept, vous devrez écrire le nom du nouveau concept en italique en
l’enfermant entre des astérisques (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Accentuation

• Pour accentuer un terme important qui n’est pas un nouveau concept, écrivez-le en gras en l’enfermant entre
des doubles astérisques (**).

• Utilisez cela avec modération ! Si vous l’utilisez trop, il peut sembler au lecteur que vous criez ou que vous
êtes condescendant.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Images

• Lorsque vous ajoutez une image, enregistrez-la dans un dossier img à côté du fichier de la leçon.
• Incluez-la dans le document comme ceci

.. figure:: img/image_file.extension
:align: center

• Souvenez-vous de laisser une ligne vide en-dessus et en-dessous de la balise de l’image.

19.9.4 Liens internes

• Pour créer un point d’ancrage pour un lien, écrivez la ligne suivante au-dessus de l’endroit où vous souhaitez
que le lien pointe

.. _link-name:

• Rappelez-vous de laisser une ligne vide avant et après cette ligne.
• Pour créer un lien, ajoutez cette ligne:

:ref:`Descriptive link text <link-name>`
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19.9.5 Liens externes

• Pour créer un lien externe, écrivez-le comme ceci:

`Descriptive link text <link-url>`_

19.9.6 Utilisant du texte mono-espacé

• Lorsque vous écrivez un texte qui indique que l’utilisateur doit saisir un emplacement de fichiers ou le nom
d’un élément de base de données tel qu’une table ou un nom de colonne, vous devez l’écrire en monospaced
text. Par exemple:

Enter the following path in the text box: ``path/to/file``.

19.9.7 Étiqueter les éléments de l’interface

• Quand vous faites référence à un élément de l’interface, comme un bouton, vous devez écrire son nom dans le
format des éléments de l’interface. Par exemple :

To access this tool, click on the :guilabel:`Tool Name` button.

• Cela s’applique également si vous mentionnez le nom d’un outil sans obliger l’utilisateur à cliquer sur un bouton.

19.9.8 Sélections de menu

• Si vous guidez un utilisateur à travers les menus, vous devez utiliser lemenu► sélection► format. Par exemple

To use the :guilabel:`Tool Name` tool, go to :menuselection:`Plugins -->
Tool Type --> Tool Name`.

19.9.9 Ajout de notes

• Vous devrez peut-être rédiger une note dans le texte qui donne plus de détails qui ne peuvent faire partie du
contenu général de la leçon. C’est la balise:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]
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19.9.10 Ajouter une note sur l’auteur ou le sponsor

Si vous écrivez un nouveau module, une nouvelle leçon ou une section par le financement d’un sponsor, vous devez y
inclure un message de leur choix. Cela indique au lecteur le nom du sponsor et il doit apparaître en dessous de l’entête
du module, de la leçon ou de la section sponsorisé(e). Néanmoins, il ne s’agit pas d’une publicité pour leur entreprise.
Si vous vous êtes porté volontaire pour écrire unmodule, une leçon ou une section et que vous n’être pas patronné, vous
pouvez inclure une note sur l’auteur en dessous de l’élément que vous avez créé. Cela doit prendre la forme ``Ce/Cette
[module/leçon/section] a été rédigé/e par [nom de l’auteur]`. N’ajoutez pas plus de texte, ni d’informations de contact,
etc. Ces détails sont à ajouter dans la section « Contributions » de l’avant-propos, avec les noms des parties que vous
avez ajoutées. SI vous avez seulement réalisé des améliorations, corrections ou ajouts, vous pouvez être listé dans les
éditeurs.

19.10 Merci !

Merci de votre contribution à ce projet ! En contribuant, vous rendez QGIS plus accessible aux utilisateurs et ajoutez
de la valeur au projet QGIS dans son ensemble.
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Préparation des données d’exercice

Important: Ce processus est prévu pour les formateurs ou les utilisateurs plus expérimentés de QGIS qui souhaitent
créer des jeux de données locaux pour leur formation. Les jeux de données par défaut sont fournis avec le manuel
d’exercice mais vous pouvez suivre les instructions qui suivent si vous désirez les remplacer.

Les données exemples fournies avec le manuel d’apprentissage concernent la ville de Swellendam et ses abords.
Swellendam est située à environ 2 heures à l’est de Cape Town dans l’ouest de l’Afrique du Sud. Les noms des
entités contenues dans le jeu de données sont en Anglais et en Afrikaans.
Tout le monde peut utiliser ce jeu de données sans aucune difficulté mais vous préférerez sans doute utiliser les
données de votre propre pays ou votre propre ville. Si vous choisissez cette voie, vos données propres seront utilisées
dans toutes les leçons du module 3 au module 7.2. D’autres modules utilisent des sources de données plus complexes
qui ne seront peut-être pas disponibles pour votre région.

Note: Ces instructions supposent que vous avez une bonne connaissance de QGIS et n’ont pas vocation à être utilisées
comme ressource pédagogique.

20.1 Créer des fichiers vectoriels basés sur OSM

Si vous voulez remplacer le jeu de données par défaut avec le votre pour la formation, vous pouvez le faire facilement
avec les outils inclus dans QGIS. La région que vous choisissez devrait avoir un mélange correct entre les zones
urbaines et rurales, contenir des routes de différentes classes, des limites administratives (comme les réserves
naturelles ou les fermes) et des surfaces en eau telles que les ruisseaux et les rivières.

1. Ouvrez un nouveau projet QGIS
2. Sélectionnez couche ► gestionnaire source de donnees pour ouvrir le dialogue gestionnaire source de donnees.
3. Dans l’onglet navigateur, développez le menu déroulant tuiles XYZ et double-cliquez sur l’élément

OpenStreetMap.
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Une carte du monde est maintenant visible sur le canevas cartographique.
4. Fermez le dialogue gestionnaire source de donnees.
5. Déplacez-vous vers la zone que vous souhaitez utiliser comme zone d’étude

Maintenant que nous avons la zone d’où nous allons extraire les données, activons les outils d’extraction.
1. Allez à Extensions ► Gérer/Installer des extensions…

2. Dans l’onglet tous, tapez QuickOSM dans la zone de recherche
3. Sélectionnez le plugin QuickOSM, appuyez sur Installer Plugin et ensuite fermer le dialogue.
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4. Exécutez le nouveau plugin à partir du menu Vecteur ► QuickOSM ► QuickOSM….
5. Dans l’onglet Quick query, sélectionnez building dans le menu déroulant Key.
6. Laissez le champ Valeur vide, ce qui signifie que vous interrogez tous les bâtiments.
7. Sélectionnez etendue canevas dans le menu déroulant suivant
8. Développez le groupe avancé ci-dessous et décochez tous les types de géométrie sur la droite sauf

Multipolygones.
9. Pressez executer requête

Une nouvelle couche building est ajoutée au panneau couches, montrant les bâtiments dans l’étendue
sélectionnée.

10. Procédez comme ci-dessus pour extraire d’autres données :
1. Key = landuse et type de géométrie Multipolygons.
2. Key = boundary, Value = protected_area et type de géométrie Multipolygons.
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3. Key = natural, Value = water et type de géométrie Multipolygons.
4. Key = highway et vérifiez les types de géométrie Lines et Multilines.
5. Key = waterway, Value = river et vérifier les types de géométrie Lines et Multilines.
6. Key = place et type de géométrie Points.

Ce processus ajoute les couches sous forme de fichiers temporaires (indiqués par l’icône à côté de leur nom).

Vous pouvez échantillonner les données que contient votre région afin de voir quel type de résultats votre région
produira.
Nous devons maintenant sauvegarder les données résultantes pour les utiliser pendant votre cours. Nous utiliserons
les formats ESRI Shapefile, GeoPackage et SpatiaLite en fonction des données.
Pour convertir la couche temporaire place en un autre format :

1. Cliquez sur l’icône à côté de la couche place pour ouvrir le dialogue sauvegarder couche temporaire.

Note: Si vous avez besoin de changer une des propriétés de la couche temporaire (CRS, étendue, champs…),
utilisez plutôt le menu contextuel Exporter ► sauvegarder entités sous … et assurez-vous que l’option ajouter
fichiers sauvegardés à la carte est cochée. Ceci ajoute une nouvelle couche.

2. Sélectionnez le format ESRI Shapefile
3. Utilisez le bouton… pour naviguer dans le dossier exercise_data/shapefile/ et enregistrez le fichier

sous le nom places.shp.
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4. Cliquez sur OK
Dans le panneau couches, la couche temporaire place est remplacée par la couche shapefile enregistrée places
et l’icône temporaire à côté est supprimée.

5. Double-cliquez sur la couche pour ouvrir son onglet proprietes couche ► Source et mettez à jour la propriété
nom de la couche pour qu’elle corresponde au nom du fichier.

6. Répétez le processus pour les autres couches, en les renommant comme suit :
• natural_water en water
• waterway_river en rivers
• boundary_protected_area en protected_areas.

Chaque ensemble de données résultant doit être enregistré dans le répertoire exercise_data/
shapefile/.

L’étape suivante consiste à créer un fichier GeoPackage à partir de la couche building à utiliser pendant le cours :

1. Cliquez sur l’icône à côté de la couche building
2. Sélectionnez le format GeoPackage
3. Enregistrez le fichier sous le nom training_data.gpkg dans le dossier exercise_data/
4. Par défaut, le nom de couche nom de la couche est rempli comme nom de fichier. Remplacez-le par

buildings.
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5. Cliquez sur OK
6. Renommer la couche dans le dialogue de ses propriétés
7. Répétez le processus avec la couche highway, en l’enregistrant comme roads dans la même base de données

GeoPackage.
La dernière étape consiste à enregistrer le fichier temporaire restant sous la forme d’un fichier SpatiaLite.

1. Cliquez sur l’icône à côté de la couche landuse
2. Sélectionnez le format SpatiaLite
3. Enregistrez le fichier sous le nom landuse.sqlite dans le dossier exercise_data/. Par défaut, le

fichier nom couche est rempli comme nom de fichier. Ne le modifiez pas.
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4. Cliquez sur OK
Vous devriez maintenant avoir une carte qui ressemble à ceci (la symbologie sera certainement très différente, car
QGIS attribue des couleurs de façon aléatoire lorsque des couches sont ajoutées à la carte) :

L’important est que vous ayez 7 couches vecteur correspondant à celles indiquées ci-dessus et que toutes ces couches
contiennent des données.

20.1. Créer des fichiers vectoriels basés sur OSM 711



QGIS Training Manual

20.2 Créer des fichiers SRTM MNE tiff

Pour les modules Module : Créer des données vectorielles et Module : Rasters, vous aurez également besoin d’images
raster (SRTM DEM) qui couvrent la région que vous avez sélectionnée pour votre cours.
Le CGIAR-CGI fournit quelques modèles numériques de terrain SRTM que vous pouvez télécharger sur https://srtm.
csi.cgiar.org/srtmdata/.
Vous aurez besoin d’images qui couvrent toute la région que vous avez choisi d’utiliser. Pour trouver les coordonnées
de l’étendue, dans QGIS , zoomez sur l’étendue de la plus grande couche et choisissez les valeurs dans la case

etendues de la barre d’état. Conservez le format GeoTiff. Une fois le formulaire rempli, cliquez sur le bouton
Cliquez ici pour commencer la recherche >> et téléchargez le(s) fichier(s).
Une fois que vous avez téléchargé le/les fichier(s) requis, vous devriez les sauvegarder dans le répertoire
exercise_data sous raster/SRTM.

20.3 Créer des fichiers images Tiff

Dans le moduleModule : Créer des données vectorielles, la leçon ��� Follow Along: Data Sourcesmontre des images
rapprochées de trois terrains de sport scolaires que les élèves sont invités à numériser. Vous devrez donc reproduire
ces images à l’aide de votre ou vos nouveaux fichiers tiff SRTM DEM. L’utilisation des terrains de sport scolaires
n’est pas obligatoire : trois types d’utilisation du sol peuvent être utilisés (par exemple, différents bâtiments scolaires,
terrains de jeux ou parkings).
Pour référence, l’image dans l’exemple de données est :
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20.4 Remplacements

Après avoir créé votre jeu de données localisées, la dernière étape consiste à remplacer les tokens dans le fichier
substitutions.txt afin que les noms appropriés apparaissent dans votre version localisée du manuel de
formation.
Les variables qui doivent être remplacées sont les suivantes:

• MajorUrbanName : par défaut, il s’agit de « Swellendam ». Remplacez par le nom de la grande ville de
votre région.

• schoolAreaType1 : par défaut, c’est « athletics field ». Remplacez par le nom du plus grand type de zone
scolaire de votre région.

• LargeLandUseArea : par défaut, il s’agit du « Bontebok National Park ». Remplacez par le nom d’un
grand polygone d’utilisation des terres dans votre région.

• srtmFileName : la valeur par défaut est srtm_41_19.tif. Remplacez-le par le nom de fichier de votre
fichier SRTM DEM.

• localCRS : par défaut, il s’agit de « WGS 84 / UTM 34S ». Vous devez le remplacer par le CRS correct pour
votre région.
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